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About This Guide
Purpose and scope

Purpose and scope

Assumptions

Related information

Technical assistance

Xvi

The purpose of this guide is to help you successfully use the 9102
Handheld Spectrum Analyzer features and capabilities. This guide
includes task-based instructions that describe how to install, configure,
use, and troubleshoot the 9102 Handheld Spectrum Analyzer. Addi-
tionally, this guide provides a description of Aeroflex’'s warranty,
services, license, and repair information as well as the software license
agreement.

This guide is intended for novice and intermediate users who want to
use the 9102 Handheld Spectrum Analyzer effectively and efficiently.
We are assuming that you are familiar with basic telecommunication
concepts and terminology.

Use this guide in conjunction with the following information:

Aeroflex 9100 Handheld Spectrum Analyzer Series: getting started
manual, order number AG 295 204

Aeroflex 9100 Handheld Spectrum Analyzer Series: applications guide,
AG 290 504

If you need assistance or have questions related to the use of this
product, call Aeroflex’s support. You can also contact Aeroflex by
e-mail at support-muc@aeroflex.com.
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Conventions

About This Guide
Conventions

This guide uses naming conventions and symbols, as described in the

following tables.

Table 1

Typographical conventions

Description

Example

User interface actions appear in
this typeface.

Buttons or switches that you
press on a unit appear in this
TYPEFACE.

Code and output messages
appear in this typeface.

Text you must type exactly as
shown appears in this type-
face.

Variables appear in this <type-
face>.

Book references appear in this
typeface.

A vertical bar | means “or”: only
one option can appear in a sin-
gle command.

Square brackets [ ] indicate an
optional argument.

Slanted brackets <> group
required arguments.

On the Status bar, click Start.

Press the ON switch.

All results okay

Type: a:\set.exe in the dia-
log box.

Type the new <hostname>.
Refer to Newton's Telecom Dic-
tionary

platform [a]b]e]

login [platform name]

<password>

Table 2 Keyboard and menu conventions

Description

Example

A plus sign + indicates simulta-
neous keystrokes.

A comma indicates consecutive
keystrokes.

A slanted bracket indicates
choosing a submenu from
menu.

Press Ctrl+s

Press Alt+f,s

On the menu bar, click
Start > Program Files.

9102 Handheld Spectrum Analyzer
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Table 3 Symbol conventions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

| > B

NOTE
This symbol represents a note indicating related information or tip.
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Safety Notes

This chapter provides the safety notes for the 9102 Handheld Spec-
trum Analyzer.
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Safety Notes
Safety warnings

Safety warnings

> b B B> b P

> B

XX

This product is designed for indoor use. As exposure to water can
damage the instrument it has to be protected against moisture when

used outdoors.

WARNING

This is a safety class A equipment in accordance with EN 61326. It
may produce radio interference affecting household equipment; the
user may be forced to execute appropriate measures against radia-
tion.

WARNING

Only use a 50 Q N-type connector to connect to the RF IN port of
the 9102. Use of any other connector may result in damage of the
instrument.

WARNING

Do not cover the ventilation slits (at the bottom left-hand corner and
on the top). Covering them may result in serious damage and fire.

WARNING

The maximum input power level at the RF IN connector is 30 dBm
(1 W). Higher input levels may result in serious damage of the instru-
ment.

WARNING

Operate the instrument within the temperature range from 5°C
(40°F) to 45°C (110°F) only. Operation outside this range will lead to
invalid results.

Safety advice for the battery

Do not crush. Do not heat or incinerate. Do not short-circuit. Do not
dismantle. Do not immerse in any liquid, it may vent or rupture! Do
not charge below 0°C (32°F) nor above 45°C (110°P).

Battery usage

The battery is for use with the 9102 only. Aeroflex does not accept
any liability for damage of the battery or other equipment if the bat-
tery is used with other electric or electronic equipment.

WARNING

The 9162 Insertion Power Sensor may be hot during and after oper-
ation.

WARNING

Do not feed more than +47 dBm into the 9162 Insertion Power Sen-
sor, the device may be destroyed otherwise.
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Overview

This chapter provides a general description of the 9102 Handheld
Spectrum Analyzer. Topics discussed in this chapter include the
following:

— “About the 9102 Handheld Spectrum Analyzer” on page 2
— “What's new” on page 3

— “Features and capabilities” on page 5

— “Options and accessories” on page 5

— “Physical description” on page 10

— “Maintaining your unit” on page 10
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About the 9102 Handheld Spectrum Analyzer

About the 9102 Handheld Spectrum Analyzer

™
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The 9102 is a lightweight, full-featured spectrum analyzer for many
applications:

— Installation troubleshooting, repair and maintenance.

— Acceptance and installation troubleshooting of antenna and cable
installations.

— Assessment and verification of electromagnetic radiation to verify
against EMI.

— Production test and alignment of the output of RF modules.
— Field measurements and verification of base station emissions.

— Used to detect and locate faulty mobile phone parts and compo-
nents.

Typical measurements with the 9102 Handheld Spectrum Analyzer
include transmitter testing, alignment of modulators and measuring
switch breakthrough. Additional options such as a tracking generator
option, the 9160 VSWR/DTF Bridge and the 9130 VSWR/DTF Reflec-
tion Measurement Option expand the capabilities of the 9102 towards
a scalar network analyzer. The analyzer is fully controllable via front
panel or by remote control from a PC.

For base station installation or maintenance engineers the 9102 offers
the full scope of common performance measurements of the BTS
antenna systems: Return Loss (Reflection), Tower-Mounted Amplifier
(Transmission) and Distance to Fault measurement with a standard
resolution of 500 points (min. 0.05 m) in one lightweight device.

Measurement results and instrument settings can easily be transferred
to a PC for presentation or post-processing. This rugged instrument is
suitable for stationary and mobile usage and meets many application
needs.
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What's new

Version 5.31

Version 5.30

Version 5.20

Version 5.12

Version 5.10

Version 5.00

Version 4.50

Version 4.11

Chapter 1 Overview
What's new

9100 in DTF mode now transmits VSWR reference level to 9100 Data
Exchange Software when necessary

Firmware now shows Aeroflex logo

Supports Reference Level Offset

Temperature correction for high band corrected

In DTF mode, the VSWR unit is displayed.

Supports external time base (reference frequency), shown in 9100
Data Exchange when active.

Improved remote control commands for Power Sensor mode.

New options supported:

— 9168 GPS Receiver Option
— 9162 Insertion Power Sensor
— 9151 Frequency Extension 7.5 GHz

New features in 9100 Data Exchange Software version 5.00

— Marker description with break-out line can be added to the trace

— Trace data or graphics can be copied to the clipboard and pasted
into a word processor or spreadsheet application

— Printout header can be defined

In DTF mode, the calibration cable dielectric and length can be
entered.

Minor corrections.

Improvements:

— Trace average function corrected.
— Too low sweep time at 200 kHz RBW now gets an UNCAL warning.
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What's new

Version 4.10

Version 4.01

Version 3.10

New features:

— Supports 100 Hz and 300 Hz RBW filters, 10 kHz span and 250 s
sweep time in 9101B and 9102B models. Those features are not
available for older instruments.

Improvements:

— SCPI remote control bugfix for marker value.

New features:

— New EMF (EMI) Measurement Option.
For an extensive description of the new EMF (EMI) measurement
mode available with this option refer to Chapter 11 “EMF (EMI)
Operation”.

— New features within the 9100 Data Exchange Software supporting
the new EMF (EMI) Measurement Option.
For further details refer to Chapter 14 “9100 Data Exchange Soft-
ware”.

— New trace finder functionality.
For further details refer to “Trace finder” on page 21.

New features:

— New VSWR/DTF Reflection Measurement Option including the
measurement modes reflection, distance to fault and cable loss

— Marker functionality: six markers for all measurement modes,
markers can be set on trace A and trace B.

— New look and feel of the parameter windows

— Direct printing

— New Printer Config menu

— RMS Option with RMS detector

— Absolute and relative display within Transmission mode
— Trace offset by division within Transmission mode

— Trace Memory menu: functions Store Trace and Recall Trace act on
both traces.

— Channel Power mode: Measure menu moved to main menu.

— Specific backlight display settings for operation on battery to save
energy.

Improvements:

— Full support of external device in the Mode window
— Improved frequency counter
— Improved Level StepDown functionality of MinValue
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— Improved Color Scheme menu: eight input fields available for all
screen components

Version 3.01  New feature:

New function in the Trace Function menu: Add A + B —» A. For a
description of these functions refer to the “Setting up the trace”
sections of in Chapter 3 “Spectrum Analysis Operation” and
Chapter 4 “Channel Power Operation”.

Improvement:

Measure menu improved. Access to Measure menu from Spectrum
Analysis main menu.

Features and capabilities

— VSWR and DTF measurements supporting antenna installation and
verification (option)

— Tracking generator option enables cable measurements in the field

— Radiation measurements of base stations and broadcast stations
(EMF option)

— Scalar network analysis (@mplifier gain over frequency or filter char-
acteristics) and antenna measurements

— Prequalification for EMC (electromagnetic compatibility) tests
— Displayed average noise level at —117 dBm
— Dynamic range of 70 dB

Options and accessories

The following options and acessories are available:

Table 4 Options for the 9102 Handheld Spectrum Analyzer

Order
number

AG 897 261 9130 VSWR/DTF Reflection Measurement Option
AG 897 274 9131 EMF Measurement Option

AG 897 275 9132 RMS Detector Option

AG 248 966 9160 VSWR/DTF Bridge

AG 248 804 Tracking Generator Upgrade

AG 248 811 9168 GPS Receiver Option

AG 248 968 9162 Insertion Power Sensor

Description
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Table 4 Options for the 9102 Handheld Spectrum Analyzer

Order
number

Description

AG 230 035

9151 Frequency Extension 7.5 GHz

Table 5 Accessories for the 9102 Handheld Spectrum Analyzer

Order
number

Description

AG 205 012
AG 241 015
AG 241 013
AG 204 097
AG 248 328
AG 860 389
AG 867 037
AG 897 137
AG 860 388
AG 248 640

AG 248 971

AG 860 368
AG 248 809
AG 860 158
AG 860 159
AG 860 264
AG 860 261
AG 860 262
AG 860 260
AG 860 146
AG 886 098
AG 886 097
AG 886 205
AG 886 204

Battery module (rechargeable, 7.2 Ah)
9100 outdoor backpack

9100 soft carrying bag

1500 battery charger

9100 power supply

9100 12 V car adapter

9100 safety lock

9100 Data Exchange Software

9100 serial communication cable

1205 RF Probe 20 dB (includes N to BNC
adapter)

frequency range 100 kHz to 4 GHz

RF attenuation (nominal at 50 Q2) 20 dB
including adapter N (male), BNC (female)

1207 Inductive Probe
frequency range 4 MHz to 6 GHz
30 dB amplifier

9170 Biconical Antenna

9171 Isotropic Antenna

9172 Directional Antenna, 80 to 1000 MHz
9172 Directional Antenna, 300 to 3000 MHz
Antenna, 400 MHz band (TNC)

Antenna, 900 MHz band (TNQO)

Antenna, 1800 MHz band (TNC)

Antenna, 1880 MHz band (BNC)

Antenna, 2400 MHz band (TNC)

Adapter N (male) to TNC (female)

Adapter N (male) to BNC (female)

Matching pad N 50 Qto N 75 Q

Matching pad N 50 Qto F 75 Q

6 9102 Handheld Spectrum Analyzer
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Table 5 Accessories for the 9102 Handheld Spectrum Analyzer

Order Description

number P

AG 874 061 Attenuator 18 GHz, 6 dB

AG 860 548 Calibration set Open/Short/Load,
type DIN 7/16 inch male

AG 860 549 Calibration set Open/Short/Load,
type N male

AG 860 396 Composite cable 10 m for 9171

AG 860 256 Antenna tripod

AG 860 395 Bag for antenna tripod

AG 897 828 OASIS Spectrum Monitoring Software

9100 battery module

1500 battery charger

9100 soft carrying bag

[EROFLEX

9100 outdoor backpack
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9100 12 V car adapter

9100 safety lock

9100 serial communication
cable

1205 RF Probe 20 dB

1207 Inductive Probe

9168 GPS Receiver Option

9162 Insertion Power Sensor
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v<

. e
9172 and 9173 Directional

Antennas ’ }

9170 Biconical Antenna

9171 Isotropic Antenna

T

Antenna 900 MHz band
(TNO)

Antenna 1800 MHz band
(TNO)

Antenna 1880 MHz band
(BNO)

Antenna 2400 MHz band
(TNO)

Adapter N - TNC
Adapter N - BNC

Matching pad N 50 Ohm to
N 75 Ohm

Matching pad N 50 Ohm to
F75 Ohm
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Physical description

Maintaining your unit

10

Attenuator 18 GHz, 6 dB

Calibration Set Open/Short/
Load, type DIN 7/16 inch
male

Calibration Set Open/Short/
Load,
type N male

The 9102 Handheld Spectrum Analyzer is delivered with the 9100 Data
Exchange Software which can also be ordered separately.

The user-accessible parts of the 9102 can be broken down into several
sections:

— Front panel with large screen, softkeys, numeric, cursor and func-
tion keys.

— Connectors accessible from the top and the left-hand side of the
9102.

— On/off switch, power supply connector and battery shelf.

— Handle which can be turned in steps to serve as a stand, allowing
the 9102 to be operated at an angle.

The 9102 Handheld Spectrum Analyzer is a measurement device. As
with all such instruments, the 9102 should be calibrated on a regular
basis to ensure accuracy. Aeroflex recommends calibration of the
9102 at yearly intervals.

Please take also advantage of our Frequently Asked Questions and our
electronic newsletter, both available on the Internet.
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Maintaining your unit

Further questions regarding the 9102 Handheld Spectrum Analyzer
can be directed to support-muc@aeroflex.com.
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General Operation

This chapter describes the instrument's functions that are independent
of the selected mode. Topics discussed in this chapter are as follows:

— “Connecting the 9102 Handheld Spectrum Analyzer” on page 14
— “Powering up the unit” on page 17

— “Starting measurements” on page 17

— “Using the front panel” on page 17

— “Selecting the measurement mode” on page 29

— “Working with the markers” on page 31

— “Using limit lines” on page 34

— “Printing” on page 38

— “Logging the current position (GPS-assisted)” on page 39
— “Controlling the 9102 from a PC” on page 41

— “Returning from remote control to local mode” on page 41
— “Checking general settings” on page 41

— “Working with stored settings” on page 52

— “Restoring factory settings for all modes” on page 54
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Connecting the 9102 Handheld Spectrum Analyzer

Connecting the 9102 Handheld Spectrum Analyzer

DC IN connector

RF IN connector

> B

14

RFin  RFout DCin

Multi Port  Ext. Ref. in/Ext. Trigger Headphone jack

Figure 1 9102 connectors on the top of the instrument

The 9102 can be operated either from the internal battery or from an
external DC source such as the power supply which is delivered with

the 9102. In addition, the battery is loaded when an external DC source
is connected. See the specifications in your getting started manual for
details of the required DC source. Here you will also find detailed infor-
mation on installing and maintaining the battery.

Apply the source to the DC IN connector at the top of the 9102.

RF in is a 50 Q N-type connector (female).

If you have a 50 Q shielded RF cable with an N-type connector (male)
to connect to the device under test, simply screw the connector tightly
to the 9102.

If you have a 50 Q shielded RF cable with a BNC connector (male), use
an N to BNC adapter to connect the cable to the 9102. Aeroflex offers
an appropriate adapter; see section “Options and accessories” on
page 5.

WARNING

The maximum allowable input power level at the RF IN connector is
30 dBm (1 W). Higher levels at this port can damage the instrument!

CAUTION

Only use a 50 Q N-type connector to connect to the RF IN port of
the 9102. Use of any other connector may result in damage of the
instrument.

9102 Handheld Spectrum Analyzer  Software version 5.31



RF ouTt connector

EXT. REF. IN/ EXT. TRIG.
connector

A\

Multi Port

Headphone jack

Chapter 2 General Operation
Connecting the 9102 Handheld Spectrum Analyzer

Take care of proper termination

Use of cables and sources with an impedance other than 50 Q
results in inaccurate measurements.

If you want to test a device with an impedance of 75 Q, refer to section
“Changing the input impedance” on page 62 to adapt the 9102
settings.

RF ouT is a 50 Q N-type connector (male).

The link between the device under test and the 9102 Handheld Spec-
trum Analyzer may be attenuated, for example because the link is an
antenna or includes a power splitter, or a long cable. The effect of the
attenuation on the measurement results can be compensated by
entering the attenuation value in the 9102, see section “Compensating
gains and losses” on page 61.

Can either be used as an input for an external time base (reference
clock) or as an input for an external trigger signal for the spectrum
analyzer sweep (an external device that triggers the measurement by
sending an impulse can be connected for example). Only one of the
two signal types can be connected at any one time.

See “Improving the frequency accuracy” on page 54 on how to make
use of the external time base input.

More on external trigger signals can be found in sections “Using a
trigger” on page 64 and on page 125.

WARNING

The EXT. TRIG. input is designed for TTL input levels only. Higher lev-
els at this port can damage the instrument!

Note

The external time base feature is available in instruments with serial
number 0704001 or higher.

In order to provide for external adapters, amplifiers and accessories
the instrument offers a multifunction connector. The Multi Port enables
the instrument to trigger a measurement onto an external signal.
Furthermore it can be used to read data stored in external devices (e.g.
calibration data).

In addition to the build-in loudspeaker the instrument also offers a stan-
dard 3.5 mm headphone jack. When you connect the headphones to
the instrument the loudspeaker will be disabled automatically.
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16

SERIAL (RS-232)
connector

LAN connector

Serial

Figure 2 9102 connectors on the left-hand side of the
instrument

This 9-pin sub-D connector on the left-hand side of the 9102 Hand-
held Spectrum Analyzer can be used to control the instrument
remotely via serial interface (RS-232). The command set and responses
are explained in section “SCPI Command Reference” on page 257.

Use a null modem (PC to PC) cable to connect the 9102 to a controlling
PC.

The 9102 can also be controlled via local area network (LAN) using a
TCP/IP connection. The LAN connector is located on the left side of the
instrument. The IP address can be set up in the System Configuration
menu or via RS-232. The 9102 can be operated in networks operating
at 100 Mbps, but is capable of transmitting and receiving at 10 Mbps
only.

The command set to control the 9102 and the responses from the
9102 are explained in section “SCPI Command Reference” on
page 257.

Connect the 9102 to the LAN with a standard LAN cable with RJ-45
connectors.
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Powering up the unit

Starting measurements

Using the front panel

Overview

Battery status LED

Chapter 2 General Operation
Powering up the unit

The 9102 is switched on and off using the power switch located at the
top of the instrument. It takes about 55 seconds for the 9102 to load

and start its software.

The 9102 starts measuring and displaying results automatically after
powering the instrument. It starts in the measurement mode last active.

The front panel is divided into different sections as follows:

display cursor keys function keys

i (:\EROF]_E X 9100 Handheld Spectrum Analyzer

DD
G &ODOD

Spam Ref® MK

horizontal (menu) softkeys numeric keys

vertical (function) softkeys enter keys

Figure 3 Front panel elements

This LED has different states:

— The LED lights green when the 9102 is being operated from its
battery and no external power is supplied.

— The LED lights yellow when the battery is connected to an external

power supply and being loaded.

— The LED is off when the loading procedure is completed, the
battery is fully loaded or when there is no battery in the 9100's
battery compartment.

9102 Handheld Spectrum Analyzer ~ Software version 5.31
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Display

18

— When the LED is flashing yellow quickly and permanently, there is a
problem with the battery or the charger. Please report this problem
to a Aeroflex service center.

NOTE

Signal level measurement results may be impaired when the battery
is low, that means when the battery has less than 10% of its nominal
capacity. See Table 6 on page 19 for an indication when the battery
is low. For a detailed description on installing and charging the bat-
tery please refer to your getting started manual.

The 6.5 inch display is divided into the following sections (see
Figure 4):

— Results area

Marker field

Input field

Softkey descriptions

Marker field Input field
Results area

Al -62.6dBm / 552.5110MHz  Marker 1 &
DAZ  -6.2dB { -23.00000kHz
DA3  -6.3dB /23.00000kH; STAANINY MHz on
Ref. -30.0 -~
Level
dBm ' HEL
-50.0 ! DA3
REL
Count '
67 : A4
-70.0 ' .
»
Max
Peak !
-90.0
Pos./Heg. Hext
A (ACT e,
-110.0 :
dolf 50.00kHzidiv Center: 552.5000MHz Span: 500.0000kHz | Marker
Mkr Mkr Mkr Main i
Transfer More Freq Count Center !
Softkey

descriptions

Figure 4 Display sections
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Results area

Chapter 2 General Operation
Using the front panel

Results area (graph)

The results area utilizes most of the screen and provides you with the
measurement results. A grid of ten vertical and eight horizontal rows
eases readability of results from the axes. There may be one or two
graphs, depending on the number of traces selected.

Horizontal axis

The horizontal axis is the frequency axis for the spectral components.
The zero span mode is an exception, as the horizontal axis is the time
axis in this case. Another exception is the Distance to Fault mode, as in
this mode this axis displays the distance in metres or feet depending

on the unit you select. The values of the frequencies at both ends of the
scale are indicated (start and stop frequencies).

Vertical axis

The vertical axis reflects the RF power. Depending on your choice of
the level unit, the RF power is indicated in dBm, dBV, dBmV, or dBpV.
The top end of the power scale is called the reference level.
Symbols (icons)

Apart from the results graph itself, several icons are available to indi-
cate the status of the 9102 as follows:

Table 6 Icons on the display

Symbol Meaning

i The 9102 is taking its operating current from the bat-

I tery. The colored area marks how much of the capac-
ity is still available.
For 30% or more, the area is indicated in yellow; from
10% to 30%, the area is shown in red, and in white for
less than 10%. The 9102 sounds a double beep when
the capacity goes below 30% of its nominal value and
two double beeps below 10%.

The 9102 is connected to an external DC supply.
+
e
=

The 9102 cannot determine the battery charge
although the battery can still be used and recharged.
Please contact Aeroflex service to have your battery
checked.

The 9102 cannot determine the battery charge; typi-

@ cally appears during the last third of operating time of
battery operation. Please contact Aeroflex service to
have your battery checked.

v The battery is not installed and the 9102 is operated
>|<’l!l' from the external power supply.
The 9102 is connected to a local area network (LAN).
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Table 6 Icons on the display

Symbol Meaning

» A video trigger has been set at the power level indi-
cated. The icon also displays the slope of the trigger.

N Demodulation is switched on so that the 9102 emits
the demodulated signal at the loudspeaker.

"

Other screen elements

The bar to the left of the vertical axis carries some or all of the elements
shown below:

Table 7 Texts on the left-hand side

Text Meaning

Ref. Level Indicates the top-most level on the vertical (power)
axis. Can be modified with the REF function key.

dBm Shows the unit in which power, is displayed. Can be
dBuVv changed in the Level > Units menu. Units can be
dBmV switched between logarithmic and linear by pressing
dBV the Units softkey.

\ Logarithmic units are: dBm, dBpV, dBmV, dBV, dBuVv/
mV m, dBmV/m, dBVm.

Y Linear units are: V, mV, gV, mW uW, V/m, mW/mZ2.
mw

UW

dBpV/m

dBmV/m

dBV/m

V/m

mw/m?2

HOLD Indicates when measurements have been halted with

a press of the HOLD/RUN function key.

Count The number following shows the progress of the mea-
surements, that means it indicates how many mea-
surements with the present configuration have already
been taken. The counter continues while the trace
hold mode is enabled. It is reset whenever a parame-
ter affecting the measurements is changed, that
means frequencies, filters or attenuation.

Ext. Dev. Indicates that the external device compensation is
turned on, that means the attenuation of any coupling
device is taken into account. The external device com-
pensation can be set up as shown in section “Com-
pensating gains and losses” on page 61.

UNCAL When displayed, the filter and sweep time setting do
not permit proper measurements.
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Trace finder

Marker field

Chapter 2 General Operation
Using the front panel

Table 7 Texts on the left-hand side

Text Meaning

Pos./Neg. Shows the current detector setting. The detector can
Pos. Peak  be changed as explained in section “Selecting the

Neg. detection method” on page 71. The RMS detector is
Peak available if the 9132 RMS Detector Option is installed
Sample and activated on your 9102.

RMS

A/B Shows the currently selected trace mode for the
(ACT) respective trace. The background color of the text
A/B coincides with the color of the graph. For more infor-
(HLD) mation on trace modes, see section “Selecting the
A/B trace mode” on page 68.

(MAX)

A/B

(MIN)

A/B

(AVG)

Trace ﬂ

If more than 90 percent of a results trace is not shown onscreen
because it is above or below screen boundaries, a trace finder icon
consisting of an up or down arrow and the word “Trace” shows where
the trace can be found. The trace finder icon is positioned in the middle
of the results display. By modifying the reference level accordingly you
can bring the trace back into view.

Al -G8.0dBm f2.246400GHz
DAL Z.0dB r921.6000MHz

B5 -53.5dBm /2.806000GHz

B2 -54.3dBm /1.500000GHz
If any of the markers is active, the marker field is displayed, showing the
measurement values at the marker positions. Up to four markers are
displayed with their level and frequency values. If you use four markers
and activate a fifth (up to six markers are available) one marker value
will be hidden and the new one will be displayed instead. By pressing
the relevant marker softkey you can display the hidden marker value
again. A marker can be switched from absolute to relative values. The
values are then shown relative to those of marker 1 (e.g. A1).
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Input field

Softkey descriptions

Keypad

Function keys

RBW

30.00 kHz

Fstep: 1/3110 kHz

The input field allows you to enter a number or a text, depending on
the selected function. The meaning of the input value is expressed by
the header line. Some input fields have an additional explanation of the
step size beneath. The step size applies when the value is changed
using the up/down cursor keys instead of the numeric keys.

The softkey descriptions indicate the assignment of a function to a
softkey. They are aligned to the lower side with the horizontal softkeys
and to the right-hand side with the vertical softkeys. See “Softkeys” on
page 25 for more information.

The front panel carries a large number of keys, giving you direct access
to functions and menus and allowing you to enter test parameters such
as the center frequency. The keypad is divided into the following
sections:

The function keys have specific functions which do not change. There-
fore they are sometimes also referred to as “hardkeys” in contrast to
the softkeys, whose functions change with the description given on the
screen.

The function keys are:

9102 Handheld Spectrum Analyzer  Software version 5.31



Chapter 2 General Operation
Using the front panel

Table 8 Function keys

Key

Function

Mode

[]

Preset

9

Hold/Run

a

Param

9

Rcl/Store

E

Cir Trc

9

Cent

Measurement mode selection. This function key

allows you to select between different predefined
types of measurements for specific applications.

It also provides access to system settings.

Presets all the entry fields of the selected mode
to the factory default settings. It does not affect
the settings of other modes.

To prevent accidental resets, the preset function
does not execute after a short keypress. Press
this function key for at least half a second to
return to the defaults. In addition to this function
key the 9102 Handheld Spectrum Analyzer offers
the Factory Settings function for resetting all
modes. See “Restoring factory settings for all
modes” on page 54 for more information.

Stops and starts sweeps.

This function key calls up the parameter pages
summarizing the current settings. Press Exit to
close the parameter window.

Note that the parameter windows differ between
the measurement modes.

Parameters that lead to an UNCAL warning are
marked with a diamond.

Provides access to the Memory menus.

This function key resets previous results (includ-
ing averages), the sweep counter and the failure
counter, and starts a new sweep.

Direct access to the center frequency input field
within the Frequency menu.

Direct access to the frequency span input field
within the Frequency menu.
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Table 8 Function keys

Key Function

Ref Direct access to the reference level input field.

Access to the Marker menu.

Cursor keys

In an input field, the up and down cursor keys are used to increase or

decrease the current value. The left and right cursor keys move the
cursor position by one digit.

If a marker field is active, the up and down cursors move the marker by
half a division up or down, respectively. The left and right cursor keys
move the marker pixelwise.

= | |mmediate reaction

Any change of an input parameter with the cursor keys has immedi-
ate effect. With the straight feedback on the screen, you can easily
adjust parameters to the optimum values with a trial-and-error
approach.

Numeric keys

The numeric keys allow you to enter a value in a way similar to a pocket
calculator. On some input fields, you can enter text instead, as on a
mobile phone.

mmmw | |nvalid entries

If you enter an invalid number or string, the 9102 beeps and corrects
the entry to the closest valid value.
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Escape key

Backspace key

Softkeys
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The * key offers an additional feature. After connecting a PCL printer
to the 9102 you can print screens directly by pressing this key. For
details on configuring printers and printing refer to “Configuring a
printer” on page 50 and “Printing” on page 38.

Any input of numerical or alphanumerical entries must be closed or
can be affected by one of the enter keys. The meaning of the individual
enter keys is as follows:

Table 9 Enter keys

Key Function

GHz/dBm In frequency input fields, closes the entry by
applying the unit GHz (gigahertz). In power input
fields, assigns the unit dBm to the entered value.

MHz/dB/ps In frequency input fields, closes the entry by
applying the unit MHz (megahertz). In power
input fields, assigns the unit dB to the entered
value. In time parameter input fields, assigns the
unit ps to the value.

®

kHz/dBpV/ms  In frequency input fields, closes the entry by
applying the unit kHz (kilohertz). In power input
fields, assigns the unit dBpV to the entered value.
In time parameter input fields, assigns the unit ms
to the value.

5

Enter Confirms an entry without a unit and with the
units hertz and seconds.

If pressed while an input field is open, the ESCAPE key
closes this input field without changing the previous
value.

Deletes the last entered alphanumerical (backspace).

ONONo

When an input field is entered, all digits are marked. By
pressing the backspace key, the entire entry is deleted.

The functions of the softkeys change with the description on the screen
given next to the respective key.
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Horizontal (menuw softkeys

Freq Level

The horizontal softkeys provide access to the various menus. The name
of the active menu is highlighted; the functions of a menu are offered
on the vertical softkeys. Submenus are indicated with three dots (“...");
the menu softkey without the dots leads you one level up in the menu
hierarchy.

Vertical (function) softkeys

¥ |

Stop

al e
L= i
L L e

The vertical softkeys allow you to change the settings of the 9102.

The vertical softkeys in the 9102 carry out one of the following func-
tions:

— Normal settings — by pushing the softkey, an entry field appears on
the top of the display, allowing you to enter numerical or alphanu-
merical data. The data become valid after pushing one of the enter
keys. Some of the softkeys for normal settings also describe the
currently set value.

Example: The Channel softkey in channel power mode.

Channel
36

— Combined entry and selection — this type of softkey allows you to
change a value and also to change a related setting, for example
changing between automatic and manual parameter setting. The
first push on the softkey opens the entry field like the normal
settings softkey. Pushing it several times results in the 9102
toggling between the available options. The option currently
selected is indicated in blue while the inactive options are shown in
white.

Example: The RBW softkey.
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RBW

30.00 kHz

F3tep: 17310 kHz
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RBW
30 kHz

anko

— Execution — by pushing the softkey, the function described is
performed. An execution softkey is indicated by an exclamation
mark.

Example: Max Peak softkey in the Marker menu.

Max
Peak, !

— Selection — several selection softkeys allow you to choose between
different options. The selection softkeys for one function are indi-
cated by a vertical bar connecting the softkeys, and a text
describing the function. The option currently active is highlighted,
i.e. indicated by inverted colors.

Example: The TrigMode softkeys in the Sweep menu.

Sweep

Single

Whenever an input field is open, it expects you to enter either numbers
or characters (where characters may also include numerical digits).
You will notice immediately what the 9102 expects as the numeric keys
have the appropriate function.

When the 9102 software expects a numerical entry, pressing a numeric
key results in the appropriate digit to appear in the input field. The 9102
may or may not allow you to enter a decimal number or a signed value,
so the keys for the decimal point and for changing the sign of the
number are either active or not.

When all digits, the sign and the decimal point have been entered as
required, one of the enter keys must be pressed. Numbers often carry
a unit with them; the enter keys provide the appropriate units.
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Filling in a text input field
Store Settings

RT1HN8Z
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Acoustical reaction on inputs

After entering a new parameter value, one of two acoustical alarms
may appear:

— Short beep (hint): The parameter is out of limits, or the input affects
an associated parameter; the respective parameter has been
corrected by the 9102 Handheld Spectrum Analyzer.

Example 1: An invalid stop frequency of 8 GHz has been entered,
resulting in a short beep and the maximum stop frequency being
set.

Example 2: The start frequency is set to 2 GHz, the stop frequency
is set to 4 GHz and the user enters a new span of 3 GHz. For units
without the frequency extension, this results in the start frequency
being changed to 1 GHz and a short beep to sound because the
new span would result in a stop frequency beyond the maximum of
4 GHz.

— Long beep (error): A parameter is set to an invalid value and the
9102 Handheld Spectrum Analyzer resumes the old value,
sounding an error beep.

Example: After entering a new (invalid) attenuation value of 60 dB,
the 9102 Handheld Spectrum Analyzer sounds a long beep and
sets the attenuation back to the previous value.

Some input fields can be filled with alphanumerical text instead. The
numeric keys can then be used to enter characters. The keys may have
several letters or numbers assigned. The assignment of the keys in this
case is as follows:

Table 10 Keys for alphanumerical text entry

Key Assignment
0 0

1 1

2 A B C 2

3 D,EF3
4 G HI 4

5 JKL5

6 M, N, O, 6
7 PQRS,7
8 TUVs8

9 W, XY, 29

not assigned

[3ts

not assigned
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To enter a character, push the key rapidly and repeatedly until the
desired character appears in the input field.

Changing the input  Once an input field is open, you can move the cursor with the LEFT/
RIGHT cursor keys to place it within the number or text. Additional digits
or characters can be entered, or you can delete the digit or character
in front of the cursor using the BACKSPACE key.

Selecting the measurement mode

The 9102 provides different measurement modes:

— The spectrum analysis mode is most versatile. It provides most of
the options included in all other modes. For more information on
this mode, refer to page 55.

— The channel power mode allows you to measure the radiated
power within a certain frequency band. Read more about the
channel power mode on page 81.

— The transmission mode, which is available in the (VSWR/)Tracking
... submenu accessible from the Mode menu, allows you to deter-
mine the frequency characteristics of active and passive devices.
Read more about this mode on page 115.

— The signal generator mode, which is also available in the (VSWR/
)Tracking ... submenu, can be used to generate a signal for stimu-
lating an electronic circuit. Read more about this mode on
page 109.

If the 9130 VSWR/DTF Reflection Measurement Option is installed and
activated on your 9102, three additional modes are available in the
VSWR/Tracking ... submenu. If the option is not installed, this submenu
has the menu name Tracking ... and the additional modes are not avail-
able. For details on the 9130 VSWR/DTF Reflection Measurement
Option please refer to Chapter 8: “The 9130 VSWR/DTF Reflection
Measurement Option”. For details on checking installed options and
installing new ones refer to “Checking installed options” on page 43
and “Installing a new option” on page 44.

All three modes can be selected in the VSWR/Tracking ... submenu
accessible from the Mode menu:

— The reflection mode provides high-precision measurements of the
reflection of antenna systems via vector measurements on the
reflected wave. Read more about this mode on page 143.

— The distance to fault mode offers a detailed analysis of antenna
feeder cables in order to identify causes for faults like weak
connectors, cable kinks etc. Read more about this mode on
page 163.

— The cable loss mode allows you to determine the average cable
loss. Read more about this mode on page 173.
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If the 9131 EMF Measurement Option is installed and activated on your
9102, an additional measurement mode is available for selection:
The EMF (EMD mode allows you to measure radiation from transmitters,
€.g. base stations and broadcast stations, easily and efficently. In this
mode the 9102 measures the electromagnetic field over a user-defin-
able frequency range and displays field strength or power density.
Read more about this mode on page 181.

In addition, the Mode menu provides access to the system settings, e.g.
the 1/0 configuration, and to version information. See section
“Checking general settings” on page 41 for more details.

9100 Handheld Spectrum Analyzer s
Mode

Spectrum Analysis
Channel Power
VSWR / Tracking ...

EMF (EMI)

System Calibration External Factory
Information Device Settings

Figure 5 Selecting a measurement mode

To select the measurement mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears (see Figure 5).

2 Select a new mode or return to the mode last active by pressing
the respective softkey. To select the modes signal generator, trans-
mission, reflection, distance to fault and cable loss select the
(VSWR/)Tracking... softkey followed by the relevant mode softkey.

The modes reflection, distance to fault and cable loss are available if
the 9130 VSWR/DTF Reflection Measurement Option is installed and
activated on your 9102. The EMF (EMI mode is available, if the 9131
EMF Measurement Option is installed and activated. For details on
checking installed options and installing new ones refer to “Check-
ing installed options” on page 43 and “Installing a new option” on
page 44.
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The main menu of the selected mode appears. If you select a new
mode, all parameters are set to the values which were used when
the mode was last active. If, however, you resume the last active
mode, measurements are continued.

Working with the markers

Al -62.6dBm f552.5110MHz  arker 1 Al
o Lu ool o we
Ref. -30.0 DAZ
Level
dBm -
-50.0 pA3

Count

-70.0

Max
Peak !
-90.0
Pos./Hey. Hext
A (ACT Peak !
110.0 !
gl 50.00kHz div Center: 552.5000MHz Span: 500.0000kHz Marker

Mkr Mkr Mkr Mkr Main e .
Peak Transfer More Freq Count el

Figure 6 Example of markers

The 9102 includes powerful and easy-to-use marker functions. Up to
six markers can be used; up to five of them can be delta markers.
Markers are easy to place and you can easily affect the center
frequency and the reference level upon a keypress. If you use two
traces you can also use markers on trace A and trace B. The markers
are named accordingly (e.g. A1, B1). Delta markers are identified by D
(e.g. DA1).

It is important to note that if you place the cursor on a signal peak and
then reduce the span, the marker position may be offset a little from
the peak. This is due to the limited resolution of the displayed frequen-
cies when using a high span. After reducing the span, the marker
should be readjusted to the new peak.

Enabling and movinga 1 From the main menu, select Marker. Or push the MKR function key
marker in any menu.
If you select Marker from the main menu when no marker is active,
the softkey for marker 1 is highlighted.
To enable marker 1, toggle the softkey until “ON“ is highlighted.
The input field for marker 1 appears.
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Disabling a marker

Enabling a delta marker

Disabling a delta marker

32

RN

If you use the MKR function key when no marker is active, marker 1
(A1 or B1 will be enabled at the maximum peak. The input field for
marker 1 appears.

If you want to enable another marker, push the appropriate softkey
(A1 through A4 or B1 trough B4). If you want to use more than four
markers, press the Mkr More softkey to display the marker softkeys
for marker 5 and marker 6 and proceed as described for markers 1
to 4.

The marker is enabled and the input field opens; the selected
marker appears in the marker field in the top bar of the display.

If required, move the marker to another position using the cursor
keys, one of the softkeys Max Peak and Next Peak, or by entering
the frequency with the numeric keys and the appropriate enter key.

From the main menu, select Marker. Or push the MKR function key
in any menu.
The Marker menu appears and the input field for marker 1 appears.

Push the softkey (one of A1 through A6 or B1 through B6) for the
marker which you want to disable. If you use more than four
markers you can display the softkeys for marker 5 and 6 by
pressing the Mkr More softkey.

Toggle the softkey until “OFF” is highlighted. The marker is disabled
and the respective marker values disappear in the marker field at
the top. By toggling to “ON*" again the marker will be enabled again.

For delta markers, the power level and frequency relative to marker 1
is displayed in the marker field. Marker 1 cannot be a delta marker. If
marker 1 is not yet enabled when you enable another marker as a delta
marker, marker 1 will be enabled automatically.

1

From the main menu, select Marker, or push the MKR function key
in any menu.

Select the softkey for the marker which you want to turn into a delta
marker (A2 through A6 or B2 through B6). If you use more than four
markers you can display the softkeys for marker 5 and 6 by
pressing the Mkr More softkey.

If not already enabled, the marker is turned on.

Push the softkey until “REL" is highlighted. The respective marker in
the marker field is indicated as a delta marker, e.g. DA2 instead of
A2.

From the main menu, select Marker, or push the MKR function key
in any menu.
The Marker menu and the marker 1 input field appear.
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Select the softkey for the delta marker that you want to disable (e.g.
DA2). If you use more than four markers you can display the soft-
keys for marker 5 and 6 by pressing the Mkr More softkey.

To disable the marker completely, push the softkey until “OFF” is
highlighted.

To turn the delta marker into a normal marker displaying absolute
values again toggle the softkey to “ON”.

Enable a delta marker as described in “Enabling a delta marker”.
For the selected delta marker, the input field shows the frequency
relative to marker 1.

Enter a (signed) frequency relative to the frequency at marker 1,
either using the numeric keys and the respective enter key, or
moving the cursor to that frequency with the help of the cursor
keys.

The marker field indicates the desired frequency offset for that
marker, along with the power level relative to the power at marker
1.

This function modifies the center frequency, adapting the frequency of
a selectable marker.

1

From the main menu, select Marker, or push the MKR function key
in any menu.
The Marker menu and the input field for marker 1 appear.

If you want to use the frequency at a marker position other than
marker 1, push the appropriate softkey (A2 through A6 or B2
through B6). If you use more than four markers you can display the
softkeys for marker 5 and 6 by pressing the Mkr More softkey.

Push the Marker to Center softkey.

The center frequency changes to the frequency at which the
selected marker is located. The frequency span only changes if the
change in center frequency would lead to an invalid start or stop
frequency.

The reference level can be changed to the level at a marker position as
follows:

1

From the main menu, select Marker, or push the MKR function key
in any menu.

2 Select the Mkr Transfer menu.

If you want to use the power level at a marker position other than
marker 1, push the appropriate softkey (A2 through A6 or B2
through B6). If you use more than four markers you can display the
softkeys for marker 5 and 6 by pressing the Mkr More softkey.
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frequency to FStep

Using limit lines
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4 Push the Marker to Ref. Lvl softkey.
The reference level changes to the level of the selected marker.

For measurements of harmonics or intermodulation products, it can be
useful to easily change between frequencies in user-defined steps. The
“Marker to FStep” function assigns the active marker (or delta marker)
frequency to FStep, the step width for the selection of center frequency
and marker frequency.

Assumption: One of the markers A1 through A6 or B1 to B6 is active.

1 From the main menu, select Marker > Mkr Transfer to access the
Marker Transfer menu.

2 Push Marker to FStep.
The FStep parameter assumes manual mode. If the currently active
marker is an absolute marker, the frequency at the marker position
becomes the new FStep value.
Alternatively, if the currently active marker is a relative (delta)
marker, the difference between the frequencies at the active
marker and marker 1 becomes the new FStep value.
If the new FStep value is higher than 1 GHz, the old FStep value is
maintained and the 9102 sounds a hint beep.

Limits: LIMITS4

 Pass | |

Al.ialy15|s "

Ref. -25.0 : : : : I : : : :
Level : : : : | : : : : Upper

Lower

Upper
Limit

Lower
Limit

Fail Count

-85.0 off

Fail Beep
off

-105.0 : : : : ' : : : :
ol 200.0kHzfdiv Start: 102.0000MHz Stop: 104.0000MHz
Limit: Limits Ext. D Mai Fail Hold
_ mits i HL. Dev. ain
] i Memory Memory off

Figure 7 Example of limit lines in spectrum analysis
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A very useful feature of the 9102 is the possibility to set limits for the
trace A results. These are displayed on the screen and the 9102 can
show if the results exceed the limits.

Two different limit modes exist in the 9102. In the first case, the limits
exist of horizontal lines for the upper and lower limit. This method is
called “simple limits”; the limits can be entered directly in the Limits
menus of the 9102.

In the second case, there are more complex limits as shown in the
example in Figure 7. These limits can be entered with a comfortable
tool on a PC and loaded to the 9102 via RS-232 or LAN interface. A set
of limit lines can be used to define a measurement template. There are
versatile tools around these limits available on the 9102, such as a fail
counter, a beep when a failure occurs, or a measurement hold function
upon failure. The limits can be used both in the frequency and in the
time domain.

Up to 99 sets of limits can be stored on the 9102.

The actual limit values must be defined on a PC and loaded to the 9102
using the 9100 Data Exchange Software. Several limit files can be
stored on the 9102. The name of the current limit file is indicated in the
upper left-hand corner.

Note that the limits are defined within a grid, no matter what the units
on the vertical and horizontal axes are. This way, you can apply the
limits to different frequency ranges and power levels. It is your respon-
sibility, however, to select a useful frequency range, reference level and
level scale.

Note that a FAIL indication may occur if the start frequency is O Hz and
an upper limit is set at this frequency.

Simple limits consist of constant upper and lower limits. They must be
activated to take effect. Once activated, each measurement is accom-
panied by a Pass/Fail verdict indicating whether or not the measure-
ment result was within the limits.
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Switching simple limits on
and off
Simple
Limits
on
Upper
-10.0 dB

Lower
-f0.0 dB

Defining upper and lower
limits

Using limit templates

By switching limit lines on, any previously active limit template is
disabled.

1 Press Level > Limits Memory.

2 Press the Simple Limits softkey so that the new choice (on or off) is
highlighted.
When switching limits on, red horizontal lines indicating the upper
and lower limits appear. A Pass/Fail verdict is displayed with every
new measurement in the upper left corner of the screen. The text
above the verdict (“Simple Limits”) indicates that the verdict applies
to simple limits.
When switching limits off, the limit lines and the verdict disappear.

The limits can be changed only when simple limits are activated. The
range of valid entries depends on the power scale displayed (vertical
axis) as follows:

Table 11 Valid entries for upper/lower simple limits (relative to
reference level

Scale Valid range
1 dB/division -8...0dB
3 dB/division —24 ... 0dB
5 dB/division -40...0dB
10 dB/division -80...0dB
15 dB/division —120 ... 0dB
20 dB/division —160 ... 0 dB

Follow the steps below to define simple upper and lower limits.

1 Press Level > Limits Memory.

2 Press the Upper softkey, enter a new value for the upper limit (in dB,
relative to the reference level) (or move the upper limit with the Up/
DowN cursor keys) and confirm with MHz/DB/Ms or ENTER.

The upper limit line is moved to the new value.

3 Press the LOWER softkey, enter a new value for the lower limit (in
dB) (or move the lower limit with the UP/DOWN cursor keys) and
confirm with MHz/DB/ms or ENTER.

The lower limit line is moved to the new value.

Limits can be comfortably defined with a PC-based tool and loaded to
the 9102. This is described in full detail in chapter “9100 Data
Exchange Software” on page 223. The sections below describe how to
recall, delete, activate and deactivate limit templates.
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From the main menu, select Level > Limits Memory.
The Limits Memory menu appears.

Push the Recall Limit Template softkey.
An entry field appears, together with a file selection box.

Select a file either by moving the selection to its file name using the
UP/DOWN cursor keys, or by entering the file name in the entry field
and closing the input field by pressing ENTER.

The file with the limits is loaded and the upper/lower limits are acti-
vated immediately.

Select a limits file (see section “Selecting limit lines within
the 9102").

Select Level > Limits Evaluation
The Limits Evaluation menu appears.

Select the limits option you want by pushing the appropriate
softkey from the following choice: Off, Upper/Lower, Upper Limit,
Lower Limit.

If you selected Off, no limits are displayed. Otherwise, the selected
limits curve (upper and/or lower limits) appears on the screen. A
Pass/Fail indication is given for each measurement trace in the
upper left-hand corner.

From the main menu, select Level > Limits Memory.

a. To delete an individual file, push Delete Limit Template, select a
limits file with the UP/DOWN cursor keys and push ENTER to delete
an individual file (pressing Esc aborts the process before the file is
deleted).

b. To delete all limit files stored in the 9102, push Delete All
Templates. Confirm by pressing ENTER, if you really want to delete
all limit files.

When limit checking is enabled, a failure counter can be activated. The
number of failures appears below the Pass/Fail verdict. The counter
makes particular sense for statistical evaluations. For this application, it
is important to define the number of measurements. The following
sequence can be useful to obtain a failure count in conjunction with a
defined number of measurement traces.

1

Select a limited number of traces (Freq > Sweep, see “Performing a
limited number of measurements” on page 66).

From the main menu, select Level > Limits Evaluation > Fail Count
to turn the failure counter on; if it was on already it should be
switched off and on again.

The failure counter is reset to 0.
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3 Push the HOLD/RUN softkey to start the measurement.
Both the measurement counter and the failure counter start from O.
When the selected number of traces has been reached, the
measurements are stopped and you can read the failure count.

Resetting the counter  The failure counter for the limits check can be reset by turning it off and
then on again (in the Level > Limits Evaluation menu).

Enabling a beep upon 1 From the main menu, select Level > Limits Evaluation.
failures The Limits Evaluation menu appears.

2 Push the Fail Beep softkey to activate or deactivate the beep
counter:
If activated, a beep sounds each time the measured signal exceeds
the limits.

Viewing a failed  This feature can be useful if you want to stop the measurement and
measurement View the measured signal when it fails the limits. Note that the 9102
should be set to continuous measurements.

1 From the main menu, select Level > Limits Evaluation.

2 Push the Fail Hold softkey once or twice to enable or disable the
hold-on-fail function.
The measurements are halted when a failure occurs. The trace of
the failed signal remains on screen.

Measurements can also be stored and recalled in the 9102 for later
analysis or comparison. This is shown in “Storing and loading traces”
on page 73.

With the 9100 Data Exchange Software, traces can also be transferred
to and viewed and stored on a PC. For more details, please refer to
chapter “9100 Data Exchange Software” on page 223.

Printing

The 9102 offers the possibility of printing measurement results, for
example traces, directly from the instrument. In order to print results
screens on a connected printer simply press the * key on the numeric
keypad of the 9102’s front panel.

If an input field is active while you press the * key, it has the + func-
tionality assigned to it. In this case printing is not possible. In order to
be able to print deactivate the input field first by deselecting the
respective softkey.
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For details on supported printers and configuring a printer refer to
“Configuring a printer” on page 50.

Logging the current position (GPS-assisted)

Connecting the GPS
receiver

Enabling the GPS
receiver

The 9102 can show the current location and record measurement data
along with the actual position at the time of the measurement. This can
be useful when taking measurements of the electromagnetic immis-
sion (EM) at various points.

All it needs is the 9168 GPS Receiver Option. With the option installed
and switched on, the 9102 can indicate the coordinates (in minutes or
degrees), the altitude (in meters or feeb), the speed (in kilometers per
hour or knots) and date and time.

This information is available on the screen of the 9102 Handheld Spec-
trum Analyzer, via remote control applying the set of SCPI commands
over RS-232 or LAN, or in the measurement trace after data transfer to
a PC with the 9100 Data Exchange Software.

The option requires Aeroflex’'s GPS receiver for the 9100 series, plus
an option key installed in the 9100. See “Installing a new option” on
page 44 on how to install a new software option.

1 Plug the RS-232 connector of the GPS receiver into the RS-232 jack
of the 9102 Handheld Spectrum Analyzer.

2 Connect the other connector of the GPS receiver to the Multi Port
of the 9102.

Before the current location and be viewed, the GPS receiver must be
switched on (see below).

The GPS Receiver Option is switched on by selecting the MODE > GPS
Data menu and turning GPS Data on.
The GPS Data menu indicates the current position.

The location data can also displayed as part of the trace loaded onto

the PC with the 9100 Data Exchange Software. See section “Viewing
the actual trace on the PC” on page 228 for more information.
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Logging the current position (GPS-assisted)

Taking GPS-assisted
location measurements

40

9100 Handheld Spectrum Analyzer s
Mode
é‘% GPS Data [(:P;
Latitude: 48° 14.1036° N &
Longitude:  011° 40.8410° E o
Quality: Ho GPS receiver ! Coordin.
Satellites: 7 T,
HDOP: 1.4
Altitude: 536.8 m Altitude
Speed: 0.2 KPH m

Time {GMT): 11:49:26
Date: 22.06.06 Speed

System Calibration External GP3 Factory Main
Information Device Data Settings

Note

GPS receivers work best in outdoor environments with not too many
clouds. No signal may be received and hence no location presented
while the receiver is located indoors.

Note

After activation of the GPS receiver, it may take 45 s until the first
measurement is displayed.

The coordinates are shown in the GPS Data menu; they are also logged
together with the trace. The coordinates can be displayed along with

the measurements in the 9100 Data Exchange Software; see section

“Including the GPS position in the trace” on page 255.

The GPS Data menu shows one of the following GPS status messages
in the Quality field:

— “No GPS receiver!”: The 9102 did not find a valid GPS receiver
connected.

— “No Signal”: The 9102 found a GPS receiver, but there are no GPS
coordinates available as yet.

— “Receiver Warning”: Measurement data are available, but from less
than four satellites. Four satellites are necessary to determine lati-
tude, longitude and altitude.

— “Data OK”: Measurements are available from at least four satellites,
resulting in the valid display of the information.
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In the MODE > GPS Data menu, use the Coordin. key to toggle between
longitude and latitude display in degrees only (decimal scale) or in
degrees and minutes.

The altitude can be displayed in either meters or feet. In the MODE >
GPS Data menu, use the Altitude key to toggle between meters and
feet.

The speed of the measuring device can be displayed in either kilome-
teres per hour (KPH) or in knots. (KTS). In the MODE > GPS Data menu,
use the Speed key to toggle between KPH and KTS.

Controlling the 9102 from a PC

The 9102 can be used under remote control from a PC. The interfaces
supported for this are the serial interface (RS-232) and the LAN (TCP/
IP). Please refer to section “SCPI Command Reference” on page 257
for more information on remote control.

Returning from remote control to local mode

To gain manual control after using the 9102 under remote control,
press ESCAPE.

Checking general settings

Reading the serial
number

This section covers information about the unit, setting display bright-
ness, time and date, and configuring the remote control interfaces of
the 9102.

You can find the serial number of your 9102 as follows:

1 Push the MoDE function key.
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Reading the software
version number

Reviewing the calibration
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2 Select System.
The System Information display appears (see Figure 8), showing
the serial number, the installed software version and the installed
option.

9100 Handheld Spectrum Analyzer s
Mode

0604050

Software Version

Application:  4.11.0000 May 18 2006
Boot: 4.00 Jan 9 2006

Hardwrare Version

PC Unit: 4
RF Unit: 0
IF Unit: 4
Keyboard: 2

System . Settings 11O Config Color Main
. Options
Information Scheme

Figure 8 System Information menu

Before loading a new software version or reporting problems, you may
want to check the currently installed version.

1 Press the MoDE function key followed by the System softkey.
The System Information menu appears.

2 Read and note the software version number in the field entitled
Application.

As for all test instruments, the 9102 Handheld Spectrum Analyzer's
accuracy should be checked against its specifications. This process is
called calibration. If the 9102 accuracy falls outside the specified toler-
ance, it may be necessary to correct the instrument.

Aeroflex recommends a calibration interval of one year. The 9102
stores the date of the last calibration by a Aeroflex-certified lab and the
date when the next calibration is due. In addition, you can document
when the calibration date has been reviewed last.

To check if the 9102 is due for calibration, proceed as follows:
Press the MoDE function key followed by the Calibration Information

softkey.
The Calibration Information menu appears.
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9100 Handheld Spectrum Analyzer s
Mode

Calibration Mumber

A3S106050AN

calibration Data: 03.05.2006 by: Willtek Last Ch.

Last Check:  [03.05.2006 |by: [VAlltek

Hext Check: 03.05.2007 Hame
Last Ch.

System Calibration External Factory Main
Information Device Settings

Figure 9 Calibration Information menu

1

Here the calibration details for the instrument are displayed.

The Calibration Number area shows the calibration number.

The first line of the Calibration area indicates the date of the last
calibration and the organization calibrating the 9102.

The second line indicates when and by whom the calibration has
been checked last.

The third line indicates when the next calibration is due. This date is
typically one year after the last calibration.

Push the Date Last Check softkey to change the last check date. It
will be set to the actual date as set by the built-in real-time clock.

Push the Name Last Check softkey to enter the name of the person
that carried out the last calibration date review.

Aeroflex provides different application programs and options for the
9102 Handheld Spectrum Analyzer. These may or may not be active on
your instrument. To check which options are actually installed on your
9102, take the following steps:

1 Press the MoDE function key followed by the System softkey.

The System Information menu appears.

2 Select Options.

The Options menu appears, indicating the installed options in bold
print with a tick in front; the options not installed are shown in grey.
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Installing a new option  Software options can be installed by entering an activation key which
you can purchase from Aeroflex or one of its representatives. To install

a new option:

1 Press the MoDE function key followed by the System softkey.

The System Information menu appears.

N

Select Options and press Activate Options.

w

Enter the activation key and press ENTER.

If the code is valid, the appropriate option is shown in bold print
with a tick in front, indicating that the option is accessible now.

Changing the display 1 Push the MoDE function key.
brightness

N

Select System > Settings.

The general settings display appears (see Figure 10), showing the

current display backlight setting as a percentage.

3 Press the Display Extern softkey to change the backlight setting for
usage while the 9102 is connected to an external power supply
Press the Display Battery softkey to change the backlight setting for
running the 9102 on battery. Here, you can specify a reduced
backlight setting for battery usage in order to save energy.

In both cases the backlight input field is highlighted.

4 Enter a new value in the field for the backlight setting you intend to
change and confirm with ENTER, or change the current value with

the UP/DOWN cursor keys.

The 9102 display uses the new brightness values.

9100 Handheld Spectrum Analyzer

Settings

Display Extem: [100 %
Display Battery:|4|] Yo

Beep: OHN
Device Mame: |HSA9102B

General Timef Back Main
Settings Date

Figure 10 General Settings menu
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NOTE

The display setting for adjusting the brightness is not affected by a
press on the PRESET function key but by a push on the Back to
Defaults softkey.

Warning and error beeps can be turned off and on in the General
Settings menu:

1 Push the MoDE function key.

2 Select System > Settings.
The general settings display appears, showing the current setting
for beeps (on or off).

3 Press the Beep softkey several times until the desired setting is
highlighted (on or off).
The beep input field shows the current setting.

NOTE

This parameter is not affected by a press on the PRESET function key
but by a push on the Back to Defaults softkey.

A device name for the 9102 can be useful if you have several units of
the 9102 Handheld Spectrum Analyzer. They can be identified if you
choose different names for them. The name also appears on traces
transferred to the PC with the 9100 Data Exchange Software.

You can enter a new name as follows:

1 Push the MoODE function key.

2 Select System > General Settings.
The general settings display appears, showing the current device
name.

3 Press the Device Name softkey.
The device name input field is active so you can overwrite the
current name.

4 Enter a new name (max. 11 characters; see section “Filling in a text
input field” on page 28 to learn how to do this) and close the entry
field by pressing ENTER.

The new name is displayed in the device name field.

NOTE

This parameter is not affected by a press on the PRESET function key
but by a push on the Back to Defaults softkey.
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Adjusting date and time

in the instrument

Changing the baud rate

46

on the RS-232 port

The 9102 Handheld Spectrum Analyzer includes a real-time clock. It
can be used to show the actual date and time or to compare it with the
date when the next calibration is due.

In order to change the date and time, proceed as follows:

1 Push the MoDE function key.

2 Select System > Settings > Time/Date.
The time/date display appears showing the current date and time.

9100 Handheld Spectrum Analyzer (it
Mode
Time:  [12:55:08 Time

Date:

|1B.1l].2l]l]4

Date

General Timef Back Main
Settings Date
Figure 11 Time/Date menu

3 Press the Time softkey.
The time input field is active so you can move the cursor with the
LEFT/RIGHT cursor keys behind a digit that needs to be changed,
push the BACKSPACE key to erase it and enter a new digit.

4 Press the Date softkey.
The date input field is active so you can overwrite the old date with
a new one or move the cursor with the LEFT/RIGHT cursor keys
behind a digit that needs to be changed, push the BACKSPACE key
to erase it and enter a new digit.

5 Press ENTER or another function key to confirm the entry.
The new date and time are shown on the Time/Date menu.

NOTE

These parameters are affected neither by a press on the PRESET
function key nor by a push on the Back to Defaults softkey.

1 Push the MoDE function key.
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2 Select System > 1/0 Config > RS 232 Config.
The RS 232 Config menu is displayed (see Figure 12), showing the
current RS-232 bit rate (or baud rate) and interface settings.

3 To change the data rate, push the Baudrate softkey and select a
new rate with the UP/DOWN cursor keys.
The change takes effect immediately.

This parameter is not affected by a press on the PRESET function key
but by a push on the Back to Defaults softkey.

9100 Handheld Spectrum Analyzer Last
Mode
Bauarate
Rate: |573|]|] Bd 37600
Back
TCF/IP RS 232 Back Main to
Config Config Default !

Figure 12 RS 232 Configuration

The described procedure for changing the baud rate applies to
serial numbers 5004001 and higher.

Changing the IP address  The IP address should be adapted to the address space in use in your
of the 9102  environment and should be unique for each device on that network.
1 Push the MoDE function key.

2 Select System > 1/0 Config
The TCP/IP Config menu is displayed, showing the current TCP/IP
settings.
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Changing the IP address
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of the PC

9100 Handheld Spectrum Analyzer past
Mode

TCF/IP

Target IP
Target (910x):[172.16.17.138 (910x)
Subnet Mask: [121.212.121.212
Gateway: 172.16.16.1 Subnet
Mask
Host (PC): 172.16.16.43
Port: 49200
Gateway
Host IP
(PC)
Port
49200
Back
TCP{IP RS 232 Printer Back Main to
Config Config Config Default !

Figure 13 TCP/IP Configuration

3

Select System > 1/0 Config.
The port configuration display appears, showing the current TCP/IP
settings.

To change the IP address of the 9102, press the Target IP softkey.
The address field is highlighted.

Overwrite the entire IP address or select a field with the LEFT/
RIGHT cursor keys, enter a new IP address and press ENTER.

To change the subnet mask press the Subnet Mask softkey. The
Subnet Mask field is highlighted.

Overwrite the entire subnet mask or select a field with the LEFT/
RIGHT cursor keys, enter a new one and press ENTER.

To change the gateway press the Gateway softkey. The Gateway
field is highlighted.

Overwrite the entire gateway or select a field with the LEFT/RIGHT
cursor keys, enter a new one and press ENTER.

10 For the change to take effect, switch the 9102 off and then on

again.

11 Ensure that your application on the PC addresses the 9102 using

this IP address so that the two units can communicate with each
other.

For remote control of the 9102 Handheld Spectrum Analyzer from a
PC, the IP address of that PC can be entered on the instrument.
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1 Push the MoDE function key.

2 Select System > 1/0 Config
The TCP/IP Config menu is displayed (see Figure 13), showing the
current TCP/IP settings.

3 Select System > I/0 Config.
The port configuration display appears, showing the current TCP/IP
settings.

4 To change the IP address of the 9102, press the Host IP softkey.
The address field is highlighted.

5 Overwrite the entire IP address or select a field with the LEFT/
RIGHT cursor keys, enter a new IP address and press ENTER.

6 Reboot the 9102 (that means, switch it off and on again) for the
new settings to work.

When the 9102 Handheld Spectrum Analyzer is to be controlled
remotely from a PC, the PC must address the remote control applica-
tion within the 9102 with an IP port number. The 9102 uses a default of
49200 which can be changed easily as follows:

1 Push the MoDE function key.

2 Select System > 1/0 Config
The TCP/IP Config menu is displayed, showing the current TCP/IP
settings.

3 To change the IP port of the 9102, push the Port softkey.
The address field is highlighted.

4 Qverwrite the entire IP address or select a field with the LEFT/
RIGHT cursor keys, enter a new IP address and press ENTER.

5 Reboot the 9102 (that means, switch it off and on again) for the
new settings to work.

The Back to Default softkey resets the parameter to its default value.
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Configuring a printer  You can connect a printer for direct printing via the * key on the 9102’s
front panel.

1 Push the MoDE function key.

2 Select System > 1/0 Config > Printer Config
The printer settings are displayed.

9100 Handheld Spectrum Analyzer Last

Mode

Printer Type: 0 - Off
1 - PCL Mode
Printer
Type
off

Printer Rate: |192|]|] Bd [FAiEEL
Baudrate
19200
Back
TCPfIP RS 232 Printer Back Main to
Config Config Config Default !

Figure 14 Printer Configuration menu

3 In order to configure a connected PCL 5 printer for direct printing
press the softkey Printer Type and toggle it to PCL by pressing it
until this option is highlighted.

4 In order to specify the baud rate of the printer press the Printer
Baudrate softkey. The Printer Rate input field is highlighted. The
default is 19200.

Direct printing works with PCL 5 printers with integrated drivers.
Pure GDI printers are not supported.

Selecting user interface
colors You can change the colors of some of the user interface elements in
the Color Scheme menu. The available colors are shown in the color
palette at the top of the display and in Table 12.

Table 12 Color palette in the 9102 user interface

Color number Color
1 black
2 grey
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Table 12 Color palette in the 9102 user interface

Color number Color

blue
green
violet
yellow

red

0o N O O » W

brown

The colors of the traces, the grid and the limit lines can be modified as
follows:

1 Push the MoDE function key.

2 Select System > Color Scheme.

The color scheme display appears (see Figure 15), showing the
current color settings.

Last
9100 Handheld Spectrum Analyzer
Mode
Color Palette Trace A
Color
H HEE N :
12 3 4 53 6 7 8 Trace B
Color
3
Grid
Color
) 2
Color Setting
Trace A: [ B Limits
Trace B: 3 [ | Color
Grid: b v
Limits: 7 B Trace Off.
Trace Offset: |4 . Color
4
Back
System Ontions General 11O Config Color Main to
Information P Settings Scheme Default !

Figure 15 Color scheme menu

3 To change the color of a user interface element, push the appro-
priate softkey (Trace A, Trace B, Grid, Limits or Trace Offset Color).
The input field on the left is activated.

4 To select a new color, enter a number corresponding to the colors
in the color palette and press ENTER, or use the UP/DOWN cursor
keys to change the color.

The color field to the left of the input field changes according to the
selection made.

5 Press the Last Mode softkey to return to the measurement screen.
The new color scheme takes effect immediately.
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Storing instrument
settings

The 9102 Handheld Spectrum Analyzer provides the capability of
storing all the parameters for a particular measurement, allowing to
recall these parameters whenever the measurement shall be repeated
under the same conditions, and this includes the measurement mode.
A large number of parameter sets can be stored under different names
that allow fast and easy identification; each parameter set name may
consist of up to 11 characters.

In addition to using these files of parameter sets on the same 9102, you
can also transfer them to a PC for backup, easy modification and
amendment using a standard text editor, or for using the same param-
eters on multiple 9102 instruments. This is described in more detail in
sections “Working with settings” on page 251 and “Managing files on
the PC and on the 9102" on page 252.

You can store the instrument settings as a whole under a name with up
to 11 characters. The procedure to enter text in alphanumerical input
fields is explained in section “Entering numbers and text” on page 27.

1 From the main menu, select RCL/STORE > Settings > Store Setting.
An input field opens, allowing you to enter a name for the instru-
ment settings. Below the input field, a list of existing settings fies is
indicated.

2 Enter a name for the settings. To use and modify an existing name,
you can move the cursor to a suitable settings name with the UP/
DoOWN cursor keys. The selected trace name also appears in the
input field; use the LEFT/RIGHT cursor keys to move the cursor to
the appropriate position within the settings name to enter addi-
tional characters or delete existing ones.

3 Confirm your choice by pressing ENTER.
The input field closes and the instrument settings are stored under
the selected name.
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You cannot overwrite an existing settings file using the same settings
name. If you want to reuse a settings name, you will have to delete the
old one first.

From the main menu, select RCL/STORE > Settings > Recall
Setting.

An input field opens, allowing you to enter the settings name.
Below the input field, a list of existing settings is indicated.

Enter the name of the settings file to load, or choose one with the
UP/DOWN cursor keys.

Confirm your choice by pressing ENTER.

The input field closes and the selected settings are loaded. The
previously active settings are not stored automatically but
discarded.

Stored settings files can be deleted. Note that there will be no warning;
once you have selected and requested a file to be deleted, this will
occur immediately.

1

From the main menu, select RCL/STORE > Settings > Delete
Setting.

An input field for the name of the settings file to be deleted
appears, together with a file selection box.

Select the settings file to be deleted using the UP/DOWN cursor
keys. Alternatively, enter the settings name with the numeric keys.

Confirm your choice by pressing ENTER.
The settings file is deleted from the list.
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4 Select another instrument settings file for deletion, or press
ESCAPE to leave the entry field and the file selection box.

Deleting all intrument  Instead of deleting settings files individually, all files can be deleted in
settings files  one step. You will be asked to confirm this step.

1 From the main menu, select RCL/STORE > Settings > Delete All
Settings.
A query appears, asking you to confirm your selection.

2 Press ENTER to have all settings files deleted.
The query disappears. All settings files are deleted.

Restoring factory settings for all modes

In addition to the PRESET function key (see “Using the front panel” on
page 17), which resets the mode currently selected to its factory
default settings, the 9102's Mode menu offers the Factory Settings
function. This function resets all modes to their factory default settings
and returns you to the spectrum analysis mode. In order to restore the
factory settings for all modes proceed as follows:

1 Press the MoDE function key.
The Mode menu is displayed.

2 Press the Factory Settings softkey. The Factory Settings menu
appears.

3 Press the Preset All softkey. A message will be displayed asking you
to confirm that all modes should be reset.

4 Press ENTER to confirm the process. All modes will now be reset to
their factory settings.

Improving the frequency accuracy

The 9102 Handheld Spectrum Analyzer has an internal time base that
is used to generate the internal frequencies for both the receiver and
the optional tracking generator. The accuracy of the internal time base
is specified in the data sheet for the 9102.

If necessary, the frequency accuracy can be further improved by using
an external, high-precision time base. The time base should consist of
a stable frequency of either 5, 10 or 13 MHz. This reference clock
signal should have a power level of at least 0 dBm and should be fed
to the EXT. REF. IN/ EXT. TRIG. BNC connector (see “EXT. REF. IN/ EXT.
TRIG. connector” on page 15).
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This chapter describes the instrument’s functions that are specific to
the spectrum analysis mode. Topics discussed in this chapter are as
follows:

— “Selecting the measurement mode” on page 56

— “Changing the frequency settings” on page 56

— “Selecting RBW, VBW and SWT" on page 59

— “Setting up the level parameters” on page 60

— “Changing the input impedance” on page 62

— “Applying special functions on the signal” on page 64

— “Setting up the trace” on page 67

— “Storing and loading traces” on page 73

— “Special measurement functions” on page 75

— “Viewing the spectrum analysis mode parameters” on page 79
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Selecting the measurement mode

The 9102 provides different measurement modes. To select spectrum
analysis mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears.

2 Select Spectrum Analysis.
The Spectrum Analysis main menu appears.

Changing the frequency settings

Spectrum
- Center
Analysis
Ref. -10.0
Level Span
dBm
-30.0
Start
Stop
FStep
100 MHz
auto
Full
Span !
[
S | 1l
100.0MHz/div Center: 500.0000MHz Span: 1.000000GHz -
ro
Freq . Main '
Mode Sweep Trigger Demod N Span !

Figure 16 Frequency menu

There are different methods to set the frequency range to be
measured; the range can be expressed by either the start and stop
frequencies (i.e. first and last frequencies on the display), or by center
frequency and span (i.e. the center and the frequency range), or by

other combinations of center frequency, span, start and stop frequen-
cies.

All four parameters are accessible in the Freq menu. On the main
menu, however, only one of the combinations mentioned above is
shown, depending on the parameter last entered.

Changing a frequency parameter may affect an associated parame-
ter.

Example: If you change the span to the maximum of 4 GHz (without
the frequency extension being installed), the start and stop frequen-
cies are changed to 0 and 4 GHz, respectively.
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1 Push the CENT function key (or the Freq softkey in the main menu).
The vertical softkeys include Start and Stop softkeys.

2 Push the Start softkey.
An entry field appears, indicating the start frequency currently set
and the step size for the UP/DOWN cursor keys.

3 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

4 Conclude the entry by pushing an enter key for the unit (GHz or
MH2).
If the start frequency entered is lower than the stop frequency, the
horizontal axis will display the range from the new start to the stop
frequency.
If the new start frequency is higher than or equal to the stop
frequency, the start frequency is used as the center frequency with
zero span, i.e. the signal at the selected frequency will be shown in
the time domain.

5 Push the Stop softkey and enter the frequency for the right end of
the display.

You can also place softkeys for the start and stop frequencies available
on the main menu by changing the frequency mode, see page 58.

1 Push the CENT function key (or the Freq softkey in the main menu).
The vertical softkeys include Center and Span. An entry field
appears, indicating the center frequency currently set and the step
size for the UP/DOWN cursor keys.

2 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

3 Conclude the entry by pushing an enter key for the unit (GHz or
MH2).

4 Push the Span softkey and enter the frequency for the range from
the left to the right end of the display.

You can also place softkeys for the center frequency and the span
available on the main menu by changing the frequency mode, see
section “Changing the main menu for different frequency parameters”
below.
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58

The main menu shows two softkeys for the definition of the frequency
range on the display. Different methods exist to define the range as
depicted above; you can configure these softkeys to one of the two
allowable combinations as follows:

1
2

From the main menu, select Freq > Freq Mode.

Select the combination of softkeys that you want to see in the main
menu (Start/Stop or Center/Span).

Return to the main menu by pushing the Main ... softkey.
The main menu appears and displays the selected combination of
keys.

Note that the description of the horizontal frequency axis changes with
the selected parameter set.

To change the frequency range to the full bandwidth supported by the
9102, proceed as follows:

1

From the main menu, push the Freq softkey.
The Frequency menu is displayed.

Push the Full Span softkey.

The leftmost frequency changes to O Hz and the rightmost
frequency to 4 GHz, or to 7.5 GHz if the Frequency Extension
7.5 GHz option is installed.

Measurements on a selected center frequency can also be displayed
in the time domain.

1

From the main menu, push the Freq softkey.
The Frequency menu is displayed.

Push the Center softkey and enter the desired center frequency;
close the input field by selecting the appropriate unit with one of
the enter keys.

Push the Zero Span softkey.
The horizontal axis becomes the time axis. The scale width is iden-
tical to the sweep time. See Figure 17 on page 65 for an example.

The center, start and stop frequencies can be set by either entering a
new value with the numeric keys, or by using the arrow keys (Up,
DownN) to increase or decrease the current setting. The step size for an
arrow keypress can be either automatically selected by the 9102, or
manually adjusted.

Manually setting the frequency step size

1

9102 Handheld Spectrum Analyzer

From the main menu, select Freq.
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2 Push the FStep key.
The Freq Step entry field opens.

3 Enter a new frequency step value and close the entry field by
pressing the appropriate enter key determining the unit (GHz/DBm
for gigahertz, MHz/pDB/ms for megahertz, KHz/DBMV/Ms for kilo-
hertz, or ENTER for hertz).

The auto/manual selection switches to manual and the selected
frequency step size is displayed on the softkey.

Setting the frequency step size selection to automatic
1 From the main menu, select Freq.

2 Push the FStep softkey several times until the “auto” selection is
highlighted.

Selecting RBW, VBW and SWT

RBW
1 MHz

aukto

VBW
1 MHz

auko

SWT
43.2 ms
auko

The resolution bandwidth (RBW) is the 3 dB bandwidth of the IF filter
for selecting the signal to be measured. The resolution bandwidth
describes the ability of the spectrum analyzer to discriminate between
adjacent signals of similar amplitude. Only signals spaced at a
frequency of more than the RBW can be discriminated from one
another.

The 9102 can be set to automatically select the resolution bandwidth,
depending on the frequency span.

The video bandwidth (VBW) is the lowpass bandwidth over which
several results for one frequency point are smoothened. The lower the
video bandwidth, the smoother the signal curve and the less variations
there are.

The 9102 can be set to select the video bandwidth automatically as a
function of the resolution bandwidth.

The sweep time (SWT) determines how long it takes for a complete
sweep over the measured frequency range (span).

The 9102 can be set to automatically select the sweep time, depending
on RBW and VBW. If manually set, the sweep time should be selected
long enough for the filtered signal to reach steady state. The 9102 will
output an “UNCALibrated” warning if the sweep time is too low.

To set the resolution bandwidth, the video bandwidth or the sweep
time, proceed as follows:

1 In the main menu, select the appropriate softkey (RBW, VBW, or
SWT).

2 Enter the value and complete the entry with the appropriate enter
key for the unit, select a new value with the help of the UP/DOWN
cursor keys, or switch to auto to leave the setting to the 9102.
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Changing between automatic and manual mode

Push the appropriate softkey (RBW, VBW, or SWT) several times until
the desired selection (auto or manual is highlighted.

Setting up the level parameters

The accuracy and the dynamic range between the measured signal
and the noise floor depend on the proper setting of the level settings.
These consist of the reference level and the attenuation.

The reference level basically determines the level at the top of the
display. The vertical axis is divided into eight horizontal lines; you can
adjust the scale (which defaults to 10 dB per line) to your preferences.

The attenuation setting can be coupled to automatically follow the
reference level setting. For reference levels of —20 dBm and lower, the
attenuation is set to 10 dB; the maximum attenuation is 50 dB.

Attenuation or gain due to external coupling can be compensated by
frequency-dependent coupling factors, so that the displayed measure-
ment values reflect the power at the device under test.

WARNING

The maximum input power level at the RF IN connector is 30 dBm
(1 W). Higher input levels may result in serious damage of the instru-
ment.

Setting the reference 1 Inthe main menu, push the Ref. softkey or select Level followed by
level Ref. Alternatively, push the REF function key.
The reference level input field opens.

2 Enter the new reference level either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actually set output power.

Setting the hardware 1 In the main menu, push the Attenuation softkey.
attenuation The Attenuation input field opens.

2 Enter a new attenuation value in the range from 0 to 50 dB (in
10 dB steps) and close the input field with one of the enter keys, or
use the UP/DOWN arrow keys to select the attenuation value in the
range 10 to 50 dB.
If the attenuation value is changed, the attenuation option will
change to “manual”.
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NOTE

The attenuation value of O dB can be set only with the numeric keys
to avoid accidental deactivation. The O dB setting should be selected
carefully because too high input levels at the input may damage the
instrument.

NOTE

For precision measurements, the input level subtracted by the atten-
uation should not exceed —23 dBm.

The scale for the vertical axis (power) can be changed in the range
from 1 to 20 dB per division (vertical line in the displayed grid) in 1-3-
5 steps as follows:

1 From the main menu, select Level.

2 Push the Scale softkey.
The Scale input field opens.

3 Select a new scale by entering a new number of dB per division
numerically and pressing the ENTER or MHz/DB/Ms key, or by
pushing the UP/DOWN cursor keys.

1 In the main menu, select Level > Units.

2 You can use logarthmic or linear units. In order to toggle the
display between logarithmic and linear units press the Unit softkey
in the lower right corner of the display and select log or lin.

3 You can now choose between the following units via the Unit
softkey in the upper right corner of the display.
Logarithmic units: dBM, dBpV, dBmV and dBV
Linear units: V, mV, yvV, mW, uW.

If the device under test is connected to the 9102 Handheld Spectrum
Analyzer via an amplifier or a device attenuating the signal, such as an
antenna or a long cable, the measurement results are wrong by the
gain or loss factor. This factor may be a constant or even frequency-
dependent.

To view the correct measurement results, the gain or loss can be
compensated. The 9102 can even compensate a frequency-depen-
dent factor; a correction curve or table can be entered on an external
PC using the 9100 Data Exchange Software and loaded to the 9102.
The section “Defining and loading external coupling parameters” on
page 243 explains this part in more detail.

Once correction values are stored in the 9102, they can be selected
and activated as follows:
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Turning external device
compensation off

Deleting files for external
device compensation

1 From the main menu, select Level > Ext. Dev. Memory.

2 Push Recall Ext. Dev. Comp.
A pull-down menu appears with a list of names for the compensa-
tion tables available in the 9102.

3 Select a compensation table using the UP/DOWN cursor keys and
confirm your choice by pressing ENTER.
Compensation is still off, but the 9102 changes automatically to the
Level menu.

4 Push the Ext. Dev. Comp. softkey until “on” is highlighted.
The text “Ext. Dev.", together with the name of the file loaded,
appears on the upper left-hand corner of the results display.

NOTE

If a file was selected previously, steps 1 thru 3 can be omitted. In this
case, select Level and continue with step 4.

1 From the main menu, select Level.

2 Press Ext. Dev. Comp. until “off” is highlighted.
The text “Ext. Dev.” to the left of the results display disappears.

You can delete files containing compensation parameters as follows:

1 From the main menu, select Level > Ext. Dev. Memory.

2 a. To delete an individual compensation file from the 9102 memory,
push Delete Ext. Dev. Comp. Select a file name and press ENTER.
The compensation file is deleted from the list. Note that there will
be no warning; once you have selected and requested a file to be
deleted, this will occur immediately.

b. To delete all the compensation files from the 9102, push Delete
All and confirm with ENTER.
All compensation files are deleted.

Changing the input impedance

62

73 Ohm

Impedance

Most RF applications are using an impedance of 50 Q; other applica-
tions such as cable TV apply 75 Q. The 9102 is designed with an input
impedance of 50 Q; it can, however, be used for testing a device with
an impedance of 75 Q by using the software impedance switch. The
measurement results from the 50 Q input are recalculated to fit the
different impedance.

On the 9102, simply select the correct impedance value so that the
9102 can translate the internal measurement values to the power
before the coupler.

1 Connect the device under test to the 9102 Handheld Spectrum
Analyzer.
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2 From the main menu, select Level.

3 In the vertical menu, select the impedance of the device, that
means select Impedance: 50 Q or Impedance: 75 ), respectively.
New measurement results are presented with the new impedance
value taken into account. In addition, if the impedance is changed
to 75 Q and the power had been displayed in dBm, the new
measurements are shown in dBpuV. If the impedance is changed to
50 Q and the power had been displayed in dBuV, the new
measurements are shown in dBm.

NOTE

Signal reflections on the cable between the 50 Q and the 75 Q
device affect the measurement accuracy of the 9102 Handheld
Spectrum Analyzer. For more accurate results, Aeroflex recom-
mends using an impedance converter; such a converter will cause
attenuation affecting the results. This attenuation can be compen-
sated as explained in section “Compensating gains and losses” on
page 61.
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Applying special functions on the signal

Using a trigger
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Trigger
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This section shows how the measurement can be triggered, how the
number of measurements can be limited and how you can listen to the
sound of the demodulated signal.

The 9102 can either start signal analysis at a random point in time, or
start the measurement when a given signal threshold is passed.
Starting measurements depending on the actual signal level is only
supported in zero span mode.

Selecting untriggered signal analysis

1 From the main menu push Freq > Trigger.
The Trigger menu appears.

2 Push the Free Run softkey.
The softkey is highlighted and the 9102 is ready for measurements
at random times.

Selecting a trigger threshold in the RF signal

1 From the main menu push Freq > Trigger.
The Trigger menu appears.

2 Push the Video softkey.
The Video softkey is highlighted and an input field for the trigger
level appears.

NOTE

The Video trigger is available in zero span mode only, otherwise the
softkey description is grayed out.

3 Enter the trigger level (in dBm) and complete the entry by pushing
either the GHz/DBMm or the ENTER key.
The trigger threshold is displayed at the power axis; the symbol
also indicates the slope (direction in which the signal passes the
threshold to start the measurement).

4 If necessary, change the slope between positive and negative
direction by pushing the Slope softkey.
The active slope is indicated at the power axis by the following
symbol (see also Figure 17): [
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Figure 17 Triggered measurement (in the time domain)

Using an external trigger

In order to use a TTL trigger signal generated by an external device,
proceed as follows:

1

Connect the external device to the EXT. TRIG. connector on the top
of the instrument (see “EXT. REF. IN/ EXT. TRIG. connector” on
page 15).

In the the main menu, enter the Sweep menu by pushing Freq >
Trigger.
The Trigger menu appears.

Push the Extern softkey.

The softkey is highlighted.

After activating the external trigger the instrument waits to receive
an impulse. When an impulse is detected on the external trigger
entrance one sweep is performed. Afterwards the instrument waits
for the next trigger event.
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The 9102 can run measurements continuously or a defined number of
times. Limiting the number of measurements can be useful for statis-
tical analyses.

1 From the main menu, select Freq > Sweep.
The Sweep menu appears.

2 Select the trigger mode: Push Cont. for continuous measurements
or Single for a limited number of measurements.
The selected trigger mode is highlighted.

3 To enter the number of measurements, push the Single Count
softkey, enter a number in the range from 1 to 1000 and press
ENTER
If Trigger Mode is set to Single, the 9102 performs the defined
number of measurements and enters Hold mode.

— To restart single-mode measurements, push the HOLD/RUN func-
tion key or the Single softkey.

— To stop a continuous measurement, push the HOLD/RUN function
key. Push it again to resume measurements.

The 9102 has the ability to demodulate an AM (amplitude modulation)
or FM (frequency modulation) signal and to output the signal at the
built-in loudspeaker. The signal should have a signal strength of at least
—50 dBm; the demodulation bandwidth is about 10 kHz.

The 9102 can be set to either demodulate one signal permanently, or
to toggle between the different frequencies. When set to permanently
demodulate one signal, the 9102 demodulates the signal at the center
position.

When the 9102 is set to toggle between frequencies, it uses the marker
frequencies (marker M1 is enabled if not already active). After
performing and displaying a new measurement, the 9102 demodulates
and outputs the received signal for a short duration. This duration is
selectable in the range from 1 to 10 seconds. The 9102 demodulates
the carrier at the marker position; the demodulated signal is output for
the selected duration. If more than one marker is active, demodulation
is resumed at the next marker frequency and so on until a piece of the
signal at all active markers has been demodulated. The process starts
anew with a new measurement.

The speaker volume can be selected as a percentage of the speaker’s
maximum capacity.

1 Set a marker to the center frequency of the signal to be demodu-
lated (see section “Setting up the trace” on page 67).

2 From the main menu, select Freq > Demod.
The Demodulation menu appears.

3 Select the demodulation method (AM, FM, or Off).
The selected method is highlighted.
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4 Choose between permanent demodulation and intermittent
demodulation at multiple markers by pressing the respective
Demod softkey.

5 If demodulation at marker is selected, you can change the duration
of the output of the demodulated signal:

— Push the Duration softkey.
The Demod Duration input field opens.

— Enter the new duration using the numeric keys. Conclude the
entry with a push on one of the enter keys with the appropriate
unit: push KHz/bBmV/Mms for milliseconds or ENTER for seconds.

6 To adjust the speaker volume, push the Volume softkey, enter a
new volume level from O to 100% and press ENTER.
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Figure 18 Example of two traces

The trace functions provide different views of the measurements, for
example the actual measurement or an average over the last couple of
measurements. You can even select two different views of the
measurement. Another possibility is to compare the actual measure-
ment with an older measurement which has been stored in the 9102
and loaded to one of the trace views (see section “Storing and loading
traces” on page 73).

The 9102 samples many measurements for each frequency point. With

the detector functions, you can define the method to select which of
the samples is displayed.
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The 9102 has five different modes to display a trace:

— In actual mode, the 9102 shows a complete new measurement in

each trace. Subsequent traces are independent of each other.

— In hold mode, the last measurement is kept on the display;

measurements continue but are not displayed.

— In max hold mode, the 9102 takes new measurements and, for

each frequency point, compares the new measurement with the
previous result. If the new measurement value is higher than the
previous result, the new measurement value becomes the new

result value; otherwise the old result value is kept. This way, the

highest result since the start of the Max hold measurement (or a
parameter change) is kept and displayed.

— Similarly, in min hold mode, the 9102 takes hew measurements

and compares the new measurement with the previous result. If the
new measurement value is lower than the previous result, the new
measurement value becomes the new result value; otherwise the
old result value is kept. This way, the lowest result since the start of
the Min hold measurement (or a parameter change) is kept and
displayed.

— In average mode, the new measurement and previous ones are

averaged for each frequency point displayed. The 9102 uses a
recursive algorithm for averaging.

To select whether you want to view an actual measurement, stop and
hold the last measurement, see the lowest or highest data for each
frequency or an average value, proceed as follows:

1 In the main menu, select Trace.

2 Select the trace you want to modify (Trace A or Trace B) using the

horizontal softkeys.

3 Select the trace mode with the vertical softkeys (Actual, Hold, Max

hold, Min hold, Average).
The trace mode is shown at the left-hand side of the vertical axis,
e.g. A (ACT).

NOTE

For fastest valid results it is advisable to briefly activate the actual
mode before selecting any other mode.

NOTE

When the trace is on hold, the measurement and failure counters
continue counting. A second trace, if active, continues updating.
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You can define two different trace views, e.g. one with the actual values
and one with the maximum values. While the first view (Trace A) is
always active, the second can be switched off. The functions of turning
Trace B on or off and selecting the trace mode are combined as
follows:

1 From the main menu, select Trace > Trace B.

2 To turn trace B on, select the trace mode (Actual, Hold, Max hold,
Min hold, or Average). To turn trace B off, select Off.
If activated, the trace mode is displayed left to the vertical axis, e.g.
B (MAX).

If you have used two different trace views as described above, you can
show the difference between trace A and trace B by subtracting trace
B from trace A as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Subtract A-B — A.

2 Select on to subtract trace B from trace A. On the left-hand side of
the result area the term “Subtract” will now be displayed to indicate
that a mathematical function is being performed.

3 The result is displayed in trace A.

NOTE

If trace A is on Hold, this function is not available and thus the
Subtract A - B — A softkey is greyed out.
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Adding trace B to

trace A If you have used two different trace views, you can also show the sum

of
trace A and trace B by adding the two traces as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Add A+ B — A.

2 Select on to add B to trace A. On the left-hand side of the result
area the term “Add” will now be displayed to indicate that a mathe-
matical function is being performed.

3 The result is displayed in trace A.
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When the trace mode is set to averaging, it may be useful to adjust the
number of measurements over which the 9102 averages the results.
The average count value that can be defined in the Trace menus
applies to both traces alike.

The 9102 uses a recursive algorithm in which a new result is added to
the older averages with a weighting factor; the description below indi-
cates how to change this weighting factor.

1 Enter the Trace menu (select Trace > Trace A or Trace B from the
main menu).

2 Push the Average Count softkey.
The Average input field opens.

3 Enter the number of measurements over which to average the
results, in the range from 2 to 128.

4 Press ENTER

For each new measurement, the 9102 selects one or two values from
a number of measurements for each frequency value. The method is
user-definable; the following methods are available (see also

Figure 20):

— Positive/negative peak: Both the largest and smallest values are
taken and displayed as a vertical bar.

— Positive peak: Only the largest value is displayed.
— Negative peak: The smallest value is shown.
— Sample: A sample measurement value is picked.

— If the 9132 RMS Detector Option is installed and activated on your
9102, the root mean square detector showing the RMS-effective
level of the measured signal is also available. If the 9132 RMS
Detector Option is not installed on your instrument, the RMS
detector will be greyed out.

Pos. Peak  Pos.fNeq. Peak

A
&
E
e
oo
@

Figure 20 Trace detectors
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The detection method applies to both traces. Select the detection
method as follows:

1 From the main menu, select Trace > Detect.

2 Select the trace method from the Detector section of the vertical
softkeys.
The selected detection method is indicated at the left-hand side of
the display.

You can copy an actual measurement from trace A to trace B or vice
versa; this way you can keep the last measurement results on the
screen and at the same time continue measuring or change the
settings of the 9102 Handheld Spectrum Analyzer. The previous results
in the target trace will be erased; the target trace will assume hold
mode.

To copy the measurement data from one trace to another, proceed as
follows:

1 From the main menu, select Trace > Trace Function.

2 To copy the measurement results in trace A to trace B, press
Copy A —» B.
To copy results from trace B to trace A, press Copy B — A.

Spectrum Copy
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Figure 21 Trace Function menu

NOTE

If you first press Copy A — B, then Copy B — A (or vice versa), both
traces will display the same results and will be in hold mode.
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Storing and loading traces
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The 9102 provides the capability to store up to 99 traces in the 9102
and load them again at random. The stored trace can then be exam-
ined or compared to a recent measurement. In addition, stored traces
can also be transferred to a PC using the 9100 Data Exchange Soft-
ware which is delivered with the 9102. For details on the software refer
to Chapter 15 “9100 Data Exchange Software”.

You can store either trace A and trace B. Any trace can be stored under
a name with up to 11 characters. The procedure to enter text in alpha-
numerical input fields is explained in section “Entering numbers and
text” on page 27. Note that along with the trace, the instrument settings
such as frequency range, level range and markers are stored.

1 From the main menu, select Trace > Trace Memory.

2 Push either Store Trace.
An input field opens, allowing you to enter a name for the trace.
Below the input field, a list of existing traces is indicated.

3 Enter a name for the trace. To use a modified trace name, you can
move the cursor to a suitable trace name with the UP/DOWN cursor
keys. The selected trace name also appears in the input field; use
the LEFT/RIGHT cursor keys to move the cursor to the appropriate
position within the trace name to enter additional characters or
delete existing ones.

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is stored under the selected
name.
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Reusing a trace name  You cannot overwrite an existing trace using the same trace name. If
you want to reuse a trace name, you will have to delete the old trace
first.

Reloading atrace 1 From the main menu, select Trace > Trace Memory.

2 Push Recall Trace.
An input field opens, allowing you to enter the trace name. Below
the input field, a list of existing traces is indicated.

3 Enter the name of the trace to load, or choose one with the Up/
DOWN cursor keys.

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is displayed.

Along with the trace, the 9102 also loads the settings that were used
when the trace was saved. These will overwrite the current settings
such as frequency range, reference level and markers.

Deleting a trace  Stored traces can be deleted. Note that there will be no warning; once
you have selected and requested a file to be deleted, this will occur
immediately.

1 From the main menu, select Trace > Trace Memory.

2 Push Delete Trace.
An input field for the name of the trace to be deleted appears,
together with a trace selection box.

3 Select the trace to be deleted using the UP/DOWN cursor keys.
Alternatively, enter the trace name with the numeric keys.

4 Confirm your choice by pressing ENTER.
The trace is deleted from the trace list.

5 Select another trace for deletion, or press ESCAPE to leave the
entry field and the trace selection box.

Deleting all traces Instead of deleting traces individually, all traces can be deleted in one
step. You will be asked to confirm this step.
1 From the main menu, select Trace > Trace Memory.

2 Press Delete All.
A query appears, asking you to confirm your selection.

3 Press ENTER to have all traces deleted.
The query disappears. All traces are deleted.
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Special measurement functions

Channel power

Adjacent channel power
ratio (ACPR)

Within spectrum analysis mode, three different frequency-selective
types of power measurements are supported:

— Channel power
— Adjacent channel power ratio (ACPR)
— Occupied bandwidth (OBW)

These are similar to the measurement types in channel power mode
(see chapter “Channel Power Operation” on page 81), without the
restrictions that the channel power mode poses with predefined
parameters such as span and resolution bandwidth.

This measurement includes the power of the selected channel. A
channel is defined by center frequency and channel width (not the
span in this case); see “Changing the channel width” on page 78.

The 9102 displays the numerical result of the channel power measure-
ment on the top-left. The measured bandwidth is indicated graphically
with bandwidth boundaries shown in red.
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ACPR is the relation between the power transmitted in a neighboring
(upper and/or lower) channel and that in the communication channel
used. The measurement can be used to assess the quality of the modu-
lator and the transmitter. The higher the result, the worse the trans-
mitter because transmission in other channels may interfere with
another ongoing communication.

9102 Handheld Spectrum Analyzer  Software version 5.31 75



Chapter 3 Spectrum Analysis Operation

Special measurement functions

Occupied bandwidth
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The 9102 determines the adjacent channels by the channel width and
channel spacing input parameters (see sections “Changing the channel
spacing” and “Changing the channel width” on page 78). It displays the
numerical results of the adjacent channel power ratio measurements
for the left (lower and right (upper) channels on the top-left. The
measured bands are indicated graphically with bandwidth boundaries
shown in red.

ACFPR Main: -586dBm M1 -80.7dBm f 935.7168MHz

ACPR left: 8.7 dB D2 saB 161 2000k SPpectrum Channel
ACPR right: -7.3dB A“alysis Power
Ref. -50.0 '

=

OBW

Level

dBm

-70.0

Count
28

-90.0

Channel
Width
300 kHz

Channel

' Spacing
-110.0 ! 200 kHz
[ Sample | ; o
A (ACT ! OBW
. l 90 %
-130.0 !
="="="= F6.00kHz/div Center: 935.6000MHz Span: 760.0000kHz
Adjust

Freq Level Marker Trace m Main Settings

The occupied bandwidth identifies the frequency range into which a
given percentage of the signal power falls. The frequency range is not
necessarily symmetric around the center frequency but is selected so
that the bandwidth to hold a certain user-defined OBW percentage is
minimized. See section “Changing the occupied bandwidth
percentage” on page 78.

OBW is indicated as an absolute value in the upper left-hand corner of
the display, together with the OBW percentage; marker A1 and delta
marker DA2 are assigned the lower and upper frequencies character-
izing the frequency range. The power is measured over three times the
normal channel bandwidth. The red boundary indicators mark the
normal channel bandwidth as selected in the Channel System menu.
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If the selected resolution bandwidth is high and the occupied band-
width very low, there may be rare cases in which all the power for
the occupied bandwidth is mapped to one point in the spectrum dis-
play. In such a case, the 9102 displays “N/A" (not available) instead
of the bandwidth, and the markers usually indicating the bandwidth
boundaries are invisible.

Increase the occupied bandwidth or decrease the resolution band-
width to receive results.

Selecting the  To select the type of measurement within spectrum analysis mode,
measurement type  Proceed as follows:

1 From the Spectrum Analysis main menu, select Measure.

2 Select a measurement type using the vertically aligned softkeys in
the Measure section.

The numerical result for the selected measurement appears in the
upper left-hand corner of the display.

Switching special  To return to normal spectrum analysis measurements without special
measurement functions  measurement functions, simply press the softkey of the selected
off measurement type again. This will deactivate the special measure-
ments.
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spacing

Reading the channel
power

Changing the occupied
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The channel width is the bandwidth which the transmission is expected
to occupy. It can be set for channel power and ACPR measurements as
follows:

1 From the Spectrum Analysis main menu, select Measure.

2 Press Channel Width, enter a new value and press the respective
enter key for the unit.
The new measurement bandwidth for channel power and ACPR is
displayed with the softkey.

The channel spacing is distance in frequency between two adjacent
channels. It can be set for the ACPR measurements as follows:

1 From the Spectrum Analysis main menu, select Measure.

2 Press Channel Spacing, enter a new value and press the respective
enter key for the unit.
The new channel spacing for ACPR is displayed with the softkey.

In addition to the display elements explained on page 17, the channel
power mode also includes a large display of the channel power, along
with the channel, resolution bandwidth and sweep time. Please see the
graphs on page 75 and the following for typical measurements.

OBW measurements identify the frequency range in which a certain
percentage of the transmit power falls. The percentage value can be
changed as follows:

1 From the Spectrum Analysis main menu, select Measure.

2 Press % OBW and enter a new percentage value in the range from
5 to 99.

3 Push ENTER to close the input field.
If the OBW measurement type is selected, the new OBW
percentage value is indicated in the upper left-hand corner of the
display.
The 9102 recalculates the frequency range based on the new
percentage value.
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Changing general  For the channel power, ACPR and OBW measurements within the spec-
analyzer parameters ~ trum
analysis mode, the general settings such as center frequency, span,
resolution bandwidth, can be changed as usual. A single-button
approach to adjusting span, resolution bandwidth, video bandwidth,
detector and trace mode is described below.

1 From the Spectrum Analysis main menu, select Measure.

2 Press Adjust Settings.
Resolution bandwidth and video bandwidth are automatically set to
optimum values (automatic mode). The trace detector is set to
sample and the trace mode is set to actual.
If channel power measurements are selected, the span is set to
120% of the selected channel width. For ACPR measurements, the
span is adjusted to 1.2 x channel width + 2 x channel spacing. The
OBW span is three times the channel width.

Viewing the spectrum analysis mode parameters

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey.

Spectrum
Analysis
15:12:43 Parameter Window 06.06.2003
Center : 1.800000 GHz Start : 0.000000 Hz
Span : 3.600000 GHz Stop : 3.600000 GHz
Ref. Level 0.0 dBm Trigger Mode : Free Run
Attenuation : 30 dB Trigger Level : -40.0 dBm
Impedance : a0 Ohm Sweep : Continuous
Single Count : 1
RBW : 1 MHz Detector : Pos.fHeq.
VBW : 1 MHz
SWT: 43.2 ms
Press <Exit> to continue

Freq Level Marker Trace m Exit
Measure

Figure 23 Spectrum analysis mode parameters
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Channel Power Operation

This chapter describes the instrument’s functions in channel power
measurement mode. Topics discussed in this chapter are as follows:

— “About the channel power mode” on page 82

— “Selecting the measurement mode” on page 85

— “Operating in channel power mode” on page 86

— “Reading the channel power” on page 87

— “Changing the occupied bandwidth percentage” on page 87

— “Working with communication systems and frequency settings” on
page 87

— “Setting up the level parameters” on page 90

— “Changing the input impedance” on page 93

— “Setting up the trace” on page 94

— “Storing and loading traces” on page 99

— "Viewing the channel power mode parameters” on page 101
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About the channel power mode
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The 9102 offers different measurement modes, e.g. spectrum analysis
and channel power measurements. The channel power mode allows
you to measure the radiated power within a certain frequency band
with a single button press. This mode reduces the complexity of all the
setup possibilities for defined communication systems. Several
communication systems are predefined in the 9102 or can be down-
loaded from a PC using the 9100 Data Exchange Software; see section
“Managing communication systems for channel power measurements”
on page 245 for more details.

Within channel power mode, three different frequency-selective types
of power measurements are supported, for details on selecting the
measurement type refer to “Selecting the measurement mode” on
page 85:

— Channel power
— Adjacent channel power ratio (ACPR)

— Occupied bandwidth (OBW)

These measurement types are available both in channel power and in
spectrum analysis mode. However, in contrast to the spectrum analysis
mode, which looks at the power level at a certain frequency, the
channel power mode uses a system approach. A system consists of
several channels, each channel has a unique channel number assigned
to it. Within a system the channels have the same bandwidth and
channel spacing. Depending on the system the channels may overlap,
follow each other directly or be separated by spaces.

In order to distinctly specify a system the following parameters have to
be set on the 9102:

— First channel

— Last channel

— Channel width
— Channel spacing
— First frequency
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You can define systems and store them on the 9102. However, you can
also make use of predefined systems available on the instrument. For
a complete listing of the communication systems preinstalled on the
instrument refer to “Preinstalled systems on the 9102” on page 359.

This measurement includes the power of the selected channel. The
channel can be selected in the main menu whereas parameters like
channel width (the measurement bandwidth) and channel spacing can
be viewed and changed in the Channel System menu.

The 9102 displays the numerical result of the channel power measure-
ment on the top-left. The measured bandwidth is indicated graphically
with bandwidth boundaries shown in red.
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s m Power SR
RBW: 10 kHz SWT: 57.6 ms
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Level i Full
: System
dBm : Span
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="="="= A8.00kHz/div Center: 949.4000MHz Span: 460.0000kHz VBW

Ch. System Level Marker Trace RIS m 10 kHz
auto
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Adjacent channel power ACPR is the relation between the power transmitted in a neighboring
ratio (ACPR)  (upper or lower) channel and that in the channel used for communica-
tion. The measurement can be used to assess the quality of the modu-
lator and the transmitter; the higher the result, the worse the
transmitter because transmission in other channels may interfere with
another ongoing communication.

The 9102 displays the numerical results of the adjacent channel power
ratio measurements for the left lower and right (upper) channels on
the top-left. The measured bands are indicated graphically with band-
width boundaries shown in red.

Channel: # 4 -73.5 dBm
ACPRleft: -13.2dB Channel Recall
ACPR right: -11.4dB System
RBW: 10kHz SWT:76.8 ms Power
Ref. -50.0 |
Level : Full
| System
dBm Span
-70.0 Single
Channel
Count
65 1l Channel
-90.0 I
Y sl @ !
il i1 2
TH
g
i I Ref.
1100 Level
ET ! ATTH.
A (ACT AT
o ' auto
-130.0 ]
ol 64.00kHz/div Center: 935.8000MHz Span: 640.0000kHz VBW

Ch. System Level Marker Trace RIS m 10 kHz
auto

For further details on the selection and availability of the ACPR
measurement type refer to “Selecting the measurement mode” on
page 85.

Occupied bandwidth  The occupied bandwidth identifies the frequency range into which a
(OBW) given percentage of the signal power falls. The frequency range is not
necessarily symmetric around the center frequency but is selected so
that the bandwidth to hold a certain user-defined OBW percentage is
minimized. See section “Changing the occupied bandwidth
percentage” on page 87.

OBW is indicated as an absolute value in the upper left-hand corner of
the display, together with the OBW percentage; marker A1 and delta
marker DA2 are assigned the lower and upper frequencies character-
izing the frequency range. The power is measured over three times the
normal channel bandwidth. The red boundary indicators mark the
normal channel bandwidth as selected in the Channel System menu.
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If the selected resolution bandwidth is high and the occupied band-
width very low, there may be rare cases in which all the power for
the occupied bandwidth is mapped to one point in the spectrum dis-
play. In such a case, the 9102 displays “N/A" (not available) instead
of the bandwidth, and the markers usually indicating the bandwidth
boundaries are invisible.

Increase the occupied bandwidth to receive results.

Selecting the measurement mode

To select the channel power mode, proceed as follows:

1 Push the MoDE function key.

2 Select the Channel Power softkey.
The main menu of the channel power mode appears. If you select a
new mode, all parameters are set to the values used when the
mode was last active. If, however, you resume the last active mode,
the measurements continue without any changes to the parame-
ters.

To select the type of measurement within the channel power mode,
proceed as follows:

1 Push the Measure softkey.

2 Select a measurement type using the vertically aligned function
softkeys (Channel Power, ACPR, or OBW).
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NOTE

Adjacent Channel Power Ratio (ACPR) measurements are available
only in those communication systems where the channel bandwidth
does not exceed the channel spacing; otherwise, the measurement
range of the adjacent channel would overlap with that in the
selected channel.

As an alternative, use the ACPR measurements within the spectrum
analysis mode (page 75).

Operating in channel power mode

86
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Figure 24 Example of a channel power measurement

This mode provides a measurement of the integral power within a
given bandwidth. The measurement mode can be selected as
described on page 85.

In channel power mode, the frequency parameters, filters and sweep
time cannot be selected individually. Instead, a communication system
can be selected or defined in which the 9102 shall measure the
channel power; the frequency parameters are stored with the commu-
nication system settings.

A few communication systems such as GSM are predefined in the
9102. More predefined system settings are available in the 9100 Data
Exchange Software and can be downloaded to the 9102. In addition,
the settings for an alternative communication system can be defined by
the user, stored in the 9102 and recalled for channel power measure-
ments.
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Reading the channel power

In addition to the display elements explained on page 18, the channel
power mode also includes a large display of the channel power, along
with the channel, resolution bandwidth and sweep time. In the example
in Figure 24 on page 86, the 9102 indicates the frequency range over
which the channel power is measured between red vertical bars.

Changing the occupied bandwidth percentage

OBW measurements identify the frequency range in which a certain
percentage of the transmit power falls. The percentage value can be
changed as follows:

1 From the Channel Power main menu, select Channel System.

2 Press % OBW and enter a new percentage value in the range from
5 to 99.

3 Press ENTER to close the input field.
If the OBW measurement type is selected, the new OBW
percentage value is indicated in the upper left-hand corner of the
display.
The 9102 recalculates the frequency range based on the new
percentage value.

NOTE

The occupied bandwidth can also be changed via the Measure
menu.

Working with communication systems and frequency settings

Selecting a
communication system
on the 9102

You can activate communication system settings stored on the 9102 as
follows:

1 In the main menu of the channel power mode, select Ch. System >
System Memory.
The System Memory menu appears.

2 Press Recall System.
A scroll box appears, showing the available communication
systems. Enter the system name as stored in the 9102, or move the
UP/DOWN cursor keys to move the cursor to the system to be
measured.

3 Press ENTER to confirm.
The input field and the scroll box disappear and the spectrum of
the selected band is measured. The channel power of the first
channel is displayed in the upper left-hand corner.
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Setting up a new
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The 9102 comes with preinstalled communication systems. For a listing
of all the channel systems preinstalled on the 9102 refer to “Prein-
stalled systems on the 9102" on page 359.

NOTE

Apart from the channel width the parameters for preinstalled config-
uration systems cannot be modified.

A new communication system can be defined in terms of frequency
range, channel bandwidth and spacing, and channel numbering; chan-
nels can then be addressed easily by their channel number rather than
the carrier or center frequency. You can set up a new communication
system as follows:

1 In the main menu, select Ch. System.
The Channel System menu appears.

2 Press First Channel and enter the first channel number in use by
the system, then close the input field by pressing ENTER.

3 Press Last Channel to enter the number of the last channel in use
by the system; close the input field by pressing ENTER.

4 Press Channel Width to change the measurement bandwidth;
ensure to select the right unit (e.g. kH2).

5 Select the Channel Spacing softkey, enter the spacing between
channel numbers and close the input field by pressing the enter
key for the appropriate frequency unit.

6 Press the 1st Ch. Center softkey and enter the carrier frequency for
the first channel in use (channel number defined with the first
softkey). Close the input field using the enter key for the appro-
priate unit (e.g. MH2).

7 For occupied bandwidth (OBW) measurements, select % OBW and
enter the percentage value. Confirm the value by pressing ENTER.

8 Select System Memory > Store System, enter a new name for the
system and press ENTER.

NOTE

Existing systems cannot be overwritten; you must delete the old sys-
tem first.

If you delete a predefined system that is delivered with the 9102, it
can be restored as depicted in section “Undeleting default commu-
nication systems” on page 89.
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To delete a the communication system settings stored on the 9102,
take the following steps.

1 From the main menu, select Ch. System > System Memory.
The System Memory menu appears.

2 Push the Delete System softkey.
A scroll box with the list of available communication systems
appears.

3 Select the system settings to be deleted by moving the UP/DOWN
cursor keys to the respective system settings name, and confirm by
pressing ENTER.

The system settings are deleted from the list.

4 Press ESCAPE to close the input field and the scroll box.

You can clean up previously stored communication systems and easily
delete all of them, including those that were originally delivered with
the 9102.

1 From the main menu, select Ch. System > System Memory.
The System Memory menu appears.

2 Push the Delete All softkey.
A box appears, asking you to confirm that you want to delete all
communication system settings.

3 Press ENTER to confirm deletion or ESCAPE to prevent the 9102
from deleting all the communication systems.
If confirmed, all the communication systems are deleted, that
means the list of communication systems will be empty.

If you have deleted communication systems that were delivered with
the 9102, you can restore these system settings.

1 From the main menu, select Ch. System > System Memory.
The System Memory menu appears.

2 Push the Restore Default Systems softkey.
The 9102 creates all the communication systems that were origi-
nally delivered with the 9102.

With the 9100 Data Exchange Software, more communication systems
can be defined, loaded to the 9102 and selected for use. See section
“Managing communication systems for channel power measurements”
on page 245 for more information. Furthermore, within the 9100 Data
Exchange Software fruther predefined communication systems are
available for transfer to your 9102. For a listing of the communication
systems available refer to “Predefined systems in the 9100 Data
Exchange Software” on page 360.
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Defining the frequency  The 9102 can display either the full spectrum used by the system, or
span the channel to be measured. Select the frequency span as desired:

In the main menu, select either Full System or Single Channel.

If you select Full System, the full frequency band as defined for the
communication system will be displayed. If you select Single
Channel, only the frequency range of the currently selected
channel will be shown.

Changing the channel 1 Inthe main menu, push the Channel softkey.
The Channel input field opens.

2 Enter the desired channel number within the communication
system at hand, or select the channel number with the UP/DOWN
cursor keys.

3 Press ENTER to confirm.
The channel power for the selected channel is indicated in the
upper left-hand corner.

Changing the sweep time

The sweep time (SWT) determines how long it takes for a complete
sweep over the measured frequency range (span).

By default, the 9102 automatically selects the sweep time depending
on other measurement parameters such as the span. In some cases it
may be an advantage to manually select a different sweep time. This is
the case with pulsed signals where a longer sweep time may increase
the measurement accuracy. If manually set, the sweep time should be
selected long enough for the filtered signal to reach steady state. The
9102 will output an “UNCALibrated” warning if the sweep time is too
low.

To change the sweep time in channel power mode, proceed as follows:

1 From the main menu, select Measure.
2 Push the SWT softkey.

3 Enter the new sweep time and confirm with the appropriate enter
key for the unit.

Setting up the level parameters

The accuracy and the dynamic range between the measured signal
and the noise floor depend on the proper setting of the level settings.
These consist of the reference level and the attenuation.

The reference level basically determines the level at the top of the

display. The vertical axis is divided into eight horizontal rows; you can
adjust the scale (which defaults to 10 dB per line) to your preferences.
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Setting up the level parameters

The attenuation setting can be coupled to automatically follow the
reference level setting. For reference levels of —20 dBm and lower, the
attenuation is set to 10 dB; the maximum attenuation is 50 dB.

Attenuation or gain due to external coupling can be compensated by
frequency-dependent coupling factors, so that the displayed measure-
ment values reflect the power at the device under test.

WARNING

The maximum allowable input power level at the RF IN connector is
30 dBm (1 W). Higher input levels may result in serious damage of
the instrument.

1 In the main menu, push the Ref. softkey or select Level followed by
Ref. Alternatively, push the REF function key.
The Reference Level input field opens.

2 Enter the new reference level either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actually set output power.

1 In the main menu, push the Attenuation softkey.
The Attenuation input field opens.

2 Enter a new attenuation value in the range from 0 to 50 dB (in
10 dB steps) and close the input field with one of the enter keys, or
use the UP/DOWN arrow keys to select the attenuation value in the
range from 10 to 50 dB.
If the attenuation value is changed, the attenuation option will
change to “auto”.

NOTE

The attenuation value of O dB can be set only with the numeric keys
to avoid accidental deactivation. The O dB setting should be selected
carefully because input levels that are too high at the input may
damage the instrument.

NOTE

For precision measurements, the input level subtracted by the atten-
uation should not exceed —23 dBm.
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Changing the vertical  The scale for the vertical axis (powen can be changed in the range
scale from 1 to 20 dB per division (vertical line in the displayed grid) in 1-3-
5 steps as follows:

1 In the main menu, select Level.

2 Push the Scale softkey.
The Scale input field opens.

3 Select a new scale by entering a new number of dB per division
numerically and pressing the ENTER or MHz/DB/MS key, or by
pushing the UP/DOWN cursor keys.

Selecting the level unit 1 In the main menu, select Level > Units.

for input and output 5 vy can use logarthmic or linear units. In order to toggle the
display between logarithmic and linear units press the Unit softkey
in the lower right corner of the display and select log or lin.

3 You can now choose between the following units via the Unit
softkey in the upper right corner of the display.
Logarithmic units: dBm, dBpV, dBmV and dBV
Linear units: V, mV, pVvV, mW, uW.

Compensating gains and  If the device under test is connected to the 9102 Handheld Spectrum
losses Analyzer via an amplifier or a device atttenuating the signal, such as an
antenna or a long cable, the measurement results are wrong by the
gain or loss factor. This factor may be a constant or even frequency-
dependent.

To view the correct measurement results, the gain or loss can be
compensated. The 9102 can even compensate a frequency-depen-
dent factor; a correction curve or table can be entered on an external
PC using the 9100 Data Exchange Software and loaded to the 9102.
Section “Defining and loading external coupling parameters” on
page 243 explains this part in more detail.

Enabling external device  Once correction values are stored in the 9102, these can be selected
compensation  and activated as follows:

1 In the main menu, select Level > Ext. Dev. Memory.

2 Press Recall Ext. Dev. Comp.
A pull-down menu appears with a list of names for the compensa-
tion tables available in the 9102.

3 Select a compensation table using the UP/DOWN cursor keys and
confirm your choice by pressing ENTER.

4 Select the Level menu and push the Ext. Dev. Comp. softkey until
“On” is highlighted.
The text “Ext. Dev.” appears to the left of the results display.
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1 In the main menu, select Level.

2 Push Ext. Dev. Comp. until “Off" is highlighted.
The text “Ext. Dev.” to the left of the results display disappears.

You can delete files containing compensation parameters as follows:

1 In the main menu, select Level > Ext. Dev. Memory.

2 a.To delete an individual compensation file from the 9102 memory,
press Delete Ext. Dev. Comp. Select a file name and press ENTER.
The compensation file is deleted from the list. Note that there will
be no warning; once you have selected and requested a file to be
deleted, this will occur immediately.

b. To delete all the compensation files from the 9102, push Delete
All and confirm by pressing ENTER.
All compensation files are deleted.

Changing the input impedance

75 Ohm

Impedance

Most RF applications are using an impedance of 50 Q; other applica-
tions such as cable TV apply 75 Q. The 9102 is designed with an input
impedance of 50 Q; it can, however, be used for testing a device with
an impedance of 75 Q by using the software impedance switch. The
measurement results from the 50 Q input are recalculated to fit the
different impedance.

On the 9102, simply select the correct impedance value so that the
9102 can translate the internal measurement values to the power
before the coupler.

1 To connect a 75 Q device, connect the device under test to the
9102 Handheld Spectrum Analyzer.

2 In the main menu, select Level.

3 In the vertical menu, select the impedance of the device, that
means select Impedance: 50 Q or Impedance: 75 Q, respectively.
New measurement results are presented with the new impedance
value taken into account. In addition, if the impedance is changed
to 75 Q and the power had been displayed in dBm, the new
measurements are shown in dBpuV. If the impedance is changed to
50 Q and the power had been displayed in dBuV, the new
measurements are shown in dBm.

NOTE

Signal reflections on the cable between the 50 Q and the 75 Q
device affect the measurement accuracy of the 9102 Handheld
Spectrum Analyzer. For more accurate results, Aeroflex recom-
mends using an impedance converter; such a converter will cause
attenuation affecting the results. This attenuation can be compen-
sated as explained in section “Compensating gains and losses” on
page 92.
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Setting up the trace
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Figure 25 Example of two traces in channel power mode

The trace functions provide different views of the measurements, for
example the actual measurement or an average over the last couple of
measurements. You can even select two different views of the
measurement. Another possibility is to compare the actual measure-
ment with an older measurement which has been stored in the 9102
and loaded to one of the trace views (see section “Storing and loading
traces” on page 99).

The 9102 samples many measurements for each frequency point. With
the detector functions, you can define the method to select which of
the samples is displayed.

Selecting the trace  The 9102 has five different modes to display a trace:
mode .
— In Actual mode, the 9102 shows a complete new measurement in
each trace. Subsequent traces are independent of each other.

— In hold mode, the last measurement is kept on the display;
measurements continue but are not displayed.

— In max hold mode, the 9102 takes new measurements and, for
each frequency point, compares the new measurement with the
previous result. If the new measurement value is higher than the
previous result, the new measurement value becomes the new
result value; otherwise the old result value is kept. This way, the
highest result since the start of the max hold measurement (or a
parameter change) is kept and displayed.

— Similarly, in min hold mode, the 9102 takes new measurements
and compares the new measurement with the previous result. If the
new measurement value is lower than the previous result, the new

94 9102 Handheld Spectrum Analyzer  Software version 5.31



Chapter 4 Channel Power Operation
Setting up the trace

measurement value becomes the new result value; otherwise the
old result value is kept. This way, the lowest result since the start of
the min hold measurement (or a parameter change) is kept and
displayed.

In average mode, the new measurement and previous ones are
averaged for each frequency point displayed. The 9102 uses a
recursive algorithm for averaging.

To select whether you want to view an actual measurement, stop and
hold the last measurement, see the lowest or highest data for each
frequency or an average value, proceed as follows:

1
2

In the main menu, select Trace.

Select the trace you want to modify (Trace A or Trace B) using the
horizontal softkeys.

Select the trace mode with the vertical softkeys (Actual, Hold, Max
hold, Min hold, Average).

The trace mode is shown at the left-hand side of the vertical axis,
e.g. A (ACT).

NOTE

For fastest valid results it is advisable to briefly activate the actual
mode before selecting any other mode.

NOTE

When the trace is on hold, the measurement and failure counters
continue counting. A second trace, if active, continues updating.
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Turning the second trace  You can define two different trace views, e.g. one with the actual values
on and off and one with the maximum values. While the first view (Trace A is
always active, the second can be switched off. The functions of turning

B Trace B on or off and selecting the trace mode are combined as
Actual follows:
Mode 1 From the main menu, select Trace > Trace B.
= 2 To turn trace B on, select the trace mode (Actual, Hold, Max hold,
Hold

Min hold, or Average). To turn trace B off, select Off.
If activated, the trace mode is displayed left to the vertical axis, e.g.

e

B
kin hold

Average

off

Subtracting trace B from  If you have used two different trace views as described above, you can
trace A  show the difference between trace A and trace B by subtracting trace
B from trace A as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Subtract A-B — A.

2 Select on to subtract trace B from trace A. On the left-hand side of
the result area the Term “Subtract” will now be displayed to indicate
that a mathematical function is being performed.

3 The result is displayed in trace A.

If trace A is on Hold, this function is not available and thus the
Subtract A - B — A softkey is greyed out.
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If you have used two different trace views, you can also show the sum
of trace A and trace B by adding the two traces as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Add A+B — A.

2 Select on to add B to trace A. On the left-hand side of the result
area the term “Add” will now be displayed to indicate that a mathe-
matical function is being performed. The result is displayed in trace
A.

When the trace mode is set to averaging, it may be useful to adjust the
number of measurements over which the 9102 averages the results.
The average count value that can be defined in the Trace menus
applies to both traces alike.

The 9102 uses a recursive algorithm in which a new result is added to
the older averages with a weighting factor; the description below indi-
cates how to change this weighting factor.

1 Enter the Trace menu (select Trace > Trace A or Trace B from the
main menu).

2 Push the Average Count softkey.
The Average input field opens.

3 Enter the number of measurements over which to average the
results, in the range from 2 to 128.

4 Press ENTER.

In channel power mode, the detection method is set to Sample by
default. If the 9132 RMS Detector Option is installed and activated on
your 9102, the root mean square detector showing the RMS-effective
level of the measured signal is also available. In order to set the detec-
tion method to RMS proceed as follows:

1 From the main menu, select Trace > Detect.

2 Select the RMS from the Detector section of the vertical softkeys.
The selected detection method is indicated at the left-hand side of
the display.

NOTE

If the 9132 RMS Detector Option is not installed on your 9102, the
RMS detector is greyed out.
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Channel: #0 ch
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Sample
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Figure 26 Detect menu with activated 9132 RMS Detector

Option

Copying traces inside  You can copy an actual measurement from trace A to trace B or vice
the 9102  versa; this way you can keep the last measurement results on the
screen and at the same time continue measuring or change the
settings of the 9102 Handheld Spectrum Analyzer. The previous results
in the target trace will be erased; the target trace will assume hold

mode.

To copy the measurement data from one trace to another, proceed as

follows:

1 From the main menu, select Trace > Trace Function.

2 To copy the measurement results from trace A to trace B, press

Copy A —» B.

To copy results from trace B to trace A, press Copy B — A.

If you first press Copy A — B, then Copy B — A (or vice versa), both
traces will display the same results and will be in hold mode.
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Storing and loading traces

Storing a trace

Channel: # 4

Channel A
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— Trace B Trace Trac_e Main Count
Memory Function a3

Figure 27 Trace A menu

The 9102 provides the capability to store up to 99 traces in the 9102
and load them again at random. The stored trace can then be exam-
ined or compared to a recent measurement. In addition, stored traces
can also be transferred to a PC using the 9100 Data Exchange Soft-
ware which is delivered with the 9102. For details on the software refer
to Chapter 15 “9100 Data Exchange Software”.

You can store either trace A and B. Any trace can be stored under a
name with up to 11 characters. The procedure to enter text in alphanu-
merical input fields is explained in section “Entering numbers and text”
on page 27. Note that along with the trace, the instrument settings
such as frequency range, level range and markers are stored.

1 Activate the trace you want to store by pushing Trace > Trace A or
Trace B.

2 From the main menu, select Trace > Trace Memory.

3 Push Store Trace.
An input field opens, allowing you to enter a name for the trace.
Below the input field, a list of existing traces is indicated.

4 Enter a name for the trace. To use a modified trace name, you can
move the cursor to a suitable trace name with the UP/DOWN cursor
keys. The selected trace name also appears in the input field; use
the LEFT/RIGHT cursor keys to move the cursor to the appropriate
position within the trace name to enter additional characters or
delete existing ones.
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5 Confirm your choice by pressing ENTER.
The input field closes and the trace is stored under the selected
name.

Reusing a trace name  You cannot overwrite an existing trace using the same trace name. If
you want to reuse a trace name, you will have to delete the old trace
first.

Reloading atrace 1 From the main menu, select Trace > Trace Memory.

2 Push Recall Trace.
An input field opens, allowing you to enter the trace name. Below
the input field, a list of existing traces is indicated.

3 Enter the name of the trace to load, or choose one with the Up/
DOWN cursor keys.

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is displayed.

Along with the trace, the 9102 also loads the settings that were used
when the trace was saved. These will overwrite the current settings
such as frequency range, reference level and markers.

Deleting a trace  Stored traces can be deleted. Note that there will be no warning; once
you have selected and requested a file to be deleted, this will occur
immediately.

1 From the main menu, select Trace > Trace Memory.

2 Push Delete Trace.
An input field for the name of the trace to be deleted appears,
together with a trace selection box.

3 Select the trace to be deleted using the UP/DOWN cursor keys.
Alternatively, enter the trace name with the numeric keys.

4 Confirm your choice by pressing ENTER.
The trace is deleted from the trace list.

5 Select another trace for deletion, or press ESCAPE to leave the
entry field and the trace selection box.

Deleting all traces Instead of deleting traces individually, all traces can be deleted in one
step. You will be asked to confirm this step.

1 From the main menu, select Trace > Trace Memory.
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2 Press Delete All.
A query appears, asking you to confirm your selection.

3 Press ENTER to have all traces deleted.
The query disappears. All traces are deleted.

Viewing the channel power mode parameters

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey.

Channel: #0 ch

N/A annel

RBW: 1 MHz SWT:1.45 ms Power
15:33:58 Parameter Window 06.06.2003
First Channel : 0 Last Channel : 100
Channel Width : 1.000000 MHz Channel Spacing : 1.000000 MHz
1st Ch. Center : 1.000000 GHz e OBW : a0 %
Ref. Level : 0.0 dBm
Attenuation : 30 dB
Impedance : a0 Ohm
RBW : 1 MHz Detector : RM3
VBW : 1 MHz
SWT: 1.45 ms
Press <Exit> to continue

Ch. System Level Marker Trace m Exit
Measure

Figure 28 Channel power mode parameters
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Power Sensor Operation

This chapter describes the instrument’s functions in power sensor
mode. Topics discussed in this chapter are as follows:

— “About the power sensor mode” on page 104
— “Connecting the 9162 Insertion Power Sensor” on page 105

— “Setting up the 9102 for insertion power measurements” on
page 106

— “Reading the power measurement” on page 107
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About the power sensor mode

104

A\

WARNING

The 9162 Insertion Power Sensor may be hot during and after oper-

ation.

The 9102 offers different measurement modes, e.g. spectrum analysis
and channel power measurements. The power sensor mode allows
you to perform a broadband measurement of the power of a radio
frequency signal. The mode uses the 9162 Insertion Power Sensor
which measures the power in both directions, i.e. the transmitted and
the reflected power on the way between the source and the sink. No
direct RF connection to the 9102 is required.

The power sensor mode further reduces the complexity of all the setup
possibilities; all you need to enter is the frequency, the expected signal
type and the desired measurement unit.

Frequency

Freq: 300 MHz

(=]

(=]

Forward
] 17.1 dBm
; 10 20 30 a0 slo

Reverse
_ 17.0 dBm
; 10 20 30 a0 slo
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Connecting the 9162 Insertion Power Sensor

The insertion power sensor takes measurements on RF signals in the
range from 70 to 2700 MHz at power levels from 1 mW to 50 W.
Proper measurements are achieved if the impedance at the input and
output power is 50 Q.

To perform measurements with the power sensor and read the results
on the 9102, the following connections need to be made:

1 Connect the cable from the 9162 Insertion Power Sensor to the
Multi Port connector of the 9102.

2 Connect the cable coming from the signal source to the RF In port
(N-type connector) of the power sensor.

3 Connect the cable going to the signal sink (e.g. an antenna) to the
RF Out port (N-type connector) of the power sensor. If you do not
have a sink, the RF Out connector should be terminated with 50 Q.

WARNING

Do not feed more than +47 dBm into the 9162 Insertion Power Sen-
sor, the device may be destroyed otherwise.
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Setting up the 9102 for insertion power measurements

Starting the insertion  To select the insertion power mode, proceed as follows:

power mode
1 Push the MoDE function key.

2 Select the Insertion Power softkey.
The insertion power menu appears. If you select a new mode, all
parameters are set to the values used when the mode was last
active. If, however, you resume the last active mode, the measure-
ments continue without any changes to the parameters.

Frequency

[300.0000 tHz

Signal

G3M
Freq: 300 MHz
Forward
TETRA
L ]
0 10 20 30 40 50
UMTS
Reverse
CDMA
L ]
0 10 20 30 40 50 o~
[
s
1 1
: S

Display
m D

Setting up the signal  The insertion power sensor is a broadband measuring device.
type and frequency  However, to ensure the best measurement accuracy, it is advisable to
provide information about the signal type and the frequency of the
signal:

1 Select one of the Signal function softkeys (CW, GSM, TETRA, UMTS,
CDMA or DVB-T).
The appropriate function softkey is highlighted, and the Frequency
input field opens.

2 Enter the center frequency of the signal to be measured (in the
range 70 to 2700 MHz) and conclude the entry by pushing an
enter key for the unit (GHz or MH2).

mmmy | Note

Although the frequency can be entered at a higher accuracy, it is
sufficient to supply it in full megahertz.
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The 9102 can display results either in Watts (linear unit) or in dBm (loga-
rithmic unib).

To select the desired unit, press the Display function softkey once or
twice until the desired display mode (log or lin) is highlighted.

Reading the power measurement

Forward power

Reverse power

The 9162 Insertion Power Sensor performs broadband measurements
of the forward and reverse power. The results are shown as follows:

The 9102 displays a bar indicating the power to the scale shown below
the bar, either in Watts (linear display) or in dBm (logarithmic display).
The numerical value is also shown on the right-hand side.

The forward power is the amount of power being transmitted into the
RF In port and further from the RF Out port to the signal sink, without
being reflected.

The 9102 displays a bar indicating the power to the scale shown below
the bar, either in Watts (linear display) or in dBm (logarithmic display).
The numerical value is also shown on the right-hand side.

The reverse power is the amount of power being transmitted (or

reflected by the sink) into the RF Out port and further from the RF Out
port to the signal sink, without being reflected.
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Signal Generator Operation

This chapter describes the instrument’s functions that are specific to
the signal generator mode. Topics discussed in this chapter are as
follows:

— “About the signal generator mode” on page 110

— “Switching the signal generator on and off” on page 110
— “Changing the frequency” on page 110

— “Setting the level” on page 113

— “Applying special functions on the signal” on page 113
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About the signal generator mode

In this mode the instrument can be used to generate a signal in order
to stimulate an electronic circuit with a set frequency and a set level.
As this mode is only used for sending out a signal and no actual
measurement takes place on the instrument there is no trace display.
Depending on the application of the signal the result of the process
could be for example the booting of a processor.

Selecting the measurement mode

To select signal generator mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears.

2 Select (VSWR/)Tracking ... > Signal Generator.
The Signal Generator main menu appears (see Figure 30 and
Figure 29).

Switching the signal generator on and off

When you select the signal generator mode as described above, the
signal generator is switched on by default. To switch it off press the
Output softkey until off is highlighted. If you switch the signal generator
off and select another mode, it will be automatically switched on again
as soon as you return to signal generator mode.

Changing the frequency

The main menu shows softkeys for the definition of the frequency
range on the display. The softkeys available for setting frequency
parameters depend on the frequency mode you select. The modes
available are: CW (Continuous Wave) and SWP (Sweep).

Selecting the frequency  To configure the softkeys available for setting the frequency you can
mode  choose between the two frequency modes CW and SWP. The CW
mode is active by default. To change between CW and SWP, press the
Mode softkey until the required option is highlighted. The main menu
display will change accordingly.
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Signal

Generator

Output

Frequency: 1.810000 GHz

Level: —10.0 dBm

Pt

¥
L
U =T

1 In the main menu, select the CW mode by pressing the Mode
softkey until CW is highlighted. The CW main menu as shown

above appears.

Figure 29 Signal Generator main menu in CW mode

FStep

10 MHz
man

Level

Mode
cw

Changing the frequency

2 Push the CENT function key (or the Frequency softkey in the main

menu).

An entry field appears, indicating the center frequency currently
set and the step size for the UP/DOWN cursor keys.

3 Enter a new frequency using the numeric keys, the cursor keys and

the BACKSPACE key.

Conclude the entry by pressing the appropriate enter key determining
the unit (GHz/DBM for gigahertz, MHz/DB/Ms for megahertz).
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Changing the frequency

Selecting the step size
for the frequency input
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Figure 30 Signal Generator main menu in SWP mode
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1 In the main menu select the SWP mode by pressing the Mode

softkey until SWP is highlighted. The SWP main menu as shown

above appears.

2 In the main menu, push the Start softkey.

An entry field appears, indicating the start frequency currently set

and the step size for the UpP/DOWN cursor keys.

3 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

4 Push the Stop softkey and enter the frequency.

The center, start and stop frequencies can either be set by entering a
new value with the numeric keys, or by using the arrow keys (UP,
DowN) to increase or decrease the current setting. The step size for an
arrow keypress can be either automatically selected by the 9102, or

manually adjusted.

Manually setting the frequency step size

1 In the Signal Generator main menu select the frequency mode (CW

or SWP) for which you want to set the frequency step size as
described in “Selecting the frequency mode” on page 110.

2 Push the FStep key.
The Freq Step entry field opens.

3 Enter a new frequency step value and close the entry field by
pressing Enter.

The auto/manual selection switches to manual and the selected

frequency step size is displayed on the softkey.
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Setting the frequency step size selection to automatic
1 In the Transmission main menu, select Freq.

2 Push the FStep softkey several times until the “auto” selection is
highlighted.

Setting the level

1 In the main menu, push the Level softkey.
The level input field opens.

2 Enter the new level either using the numeric keys, closing the input
field with the appropriate enter key, or with the UP/DOWN arrow
keys. The level can be entered in the range of —10 dBm and
—30 dBm in 1 dB steps.

Applying special functions on the signal

This section shows how the number of measurements can be limited.

Performing a limited  The 9102 can run measurements continuously or a defined number of
number of times. Limiting the number of measurements can be useful for statis-

measurements tical analyses.

1 In the main menu, select Sweep.
The Sweep menu appears.

2 Select the sweep mode: Push Cont. for continuous signal genera-

Sweep g .
tion or Single for a single sweep.
Si The selected sweep mode is highlighted.
ingle
SWT
Z24.0 ms
man
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Transmission Operation

This chapter describes the instrument’s functions that are specific to
the transmission mode. Topics discussed in this chapter are as follows:

— “About the transmission mode” on page 116

— “Selecting the measurement mode” on page 116

— “Switching the tracking generator on and off” on page 117
— “Normalizing the trace” on page 117

— “Setting the tracking output power” on page 118

— “Changing the frequency settings” on page 119

— “Selecting RBW, VBW and SWT"” on page 122

— “Setting up the level parameters” on page 122

— “Applying special functions on the signal” on page 125

— “Setting up the trace” on page 127

— “Storing and loading traces” on page 134

— "Viewing the transmission mode parameters” on page 136
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About the transmission mode

The transmission mode allows you to determine the frequency charac-
teristics of passive (e.g. bandpass filters) or active devices under test
(e.g. amplifiers). In this mode the 9102 Handheld Spectrum Analyzer
uses a tracking generator — a signal generator which is synchronous
with the receive frequency of the spectrum analyzer — to measure e.g.
reflection and the transmission characteristics of devices under test.
The tracking generator has an output frequency from 1 MHz to 4 GHz.
Its level is adjustable from —10 to —30 dBm which allows adaptation of
the output signal to the demands of devices under test. In the 9100
applications guide contained on the documentation CD delivered with
your instrument you will find an application example for this mode.

Trans— Tracking
mission on
Ref. 0.0 Tracking
Output
dB ' Power

Ref.

Hormalize

A
on

[ 1
¥
ol 100.0MHzfdiv Center: 500.0000MHz Span: 1.000000GHz

Freq Level Marker Trace Tracking Main

Generator

Figure 31 Example of a transmission measurement

Selecting the measurement mode

To select transmission mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears.

2 Select (VSWR/)Tracking ... > Transmission.
The Transmission main menu appears.
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Switching the tracking generator on and off

Normalizing the trace

When you select the transmission mode as described in “Selecting the
measurement mode”, the tracking generator is switched on by default.
To switch it off, proceed as follows:

1 In the Transmission main menu, press the Tracking Generator
softkey.

2 Press the Tracking softkey until “off” is highlighted.

If you switch the tracking generator off and select the spectrum anal-
ysis or channel power mode, it will be automatically switched on again
as soon as you return to transmission mode.

In order to eliminate slight ripples in the trace display the Normalize
function should be used before taking measurements. There are two
softkeys available for normalizing the display for trace A and trace B.
The following figure shows trace A with normalization deactivated (off).

Al -3.3dBm {1.000800GHz T
rans— Trackin
q

mission on

Ref. 20.0

Tracking
Level

Output
dBm ! ROy

0.0 4 : Ref.
Level

Count '

il ' Hormalize
-20.0 ! B

off

-60.0 !
ol 360.0MHzfdiv Center: 1.600000GHz Span: 3.600000GHz

Freq Level Marker Trace Tracking

Main
Generator

Figure 32 Normalize A off

In order to achieve a normalized trace proceed as follows:

1 Establish a cable connection between the RF IN and the RF out
connector.

2 In the Transmission main menu, press the Tracking Generator
softkey.

3 Press the Normalize A or B softkey until “on” is highlighted.
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NOTE

If trace B is not active, the Normalize B softkey will be greyed out.

The message “Normal.’d” on the left-hand side of the results area indi-
cates that the display is normalized. If you change measurement
parameters, €.g. tracking output, frequency settings or attenuation, it
may be necessary to repeat the normalizing procedure. If this is the
case, the message “Normalize” will be displayed against a red back-
ground on the left-hand side of the results area.

The following figure shows trace A after normalization has been acti-
vated.

Al -3.3dB f943.2000MHz

Da2 -0.6dB f-338.4003MHz T rans— Tracking
mission on
Ref. 20.0 Tracking
Output
dB E Powrer
0.0
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Count
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-20.0 A
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-40.0
Pos./Hey.
A (ACT ‘
-60.0 \
ol 360.0MHz/div Center: 1.800000GHz Span: 3.600000GHz

Freq Level Marker Trace Tracking

Main
Generator

Figure 33 Normalize A on

Setting the tracking output power

118

The tracking generator’s output power can be set in a range from —10
to

—30 dBm. In order to change the output power proceed as follows:

1 In the Transmission main menu, press the Tracking Generator
softkey.

2 Press the Tracking Output Power softkey. The Tracking Output
Power input field appears.

3 Use the UP/DOWN cursor keys to enter a new output power value in
1 dBm steps or enter the new value using the numeric keypad.

4 Press ENTER
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Changing the frequency settings

Trans—
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Figure 34 Frequency menu

There are different methods to set the frequency range to be
measured; the range can be expressed by either the start and stop
frequencies (i.e. first and last frequencies on the display), or by center
frequency and span (i.e. the center and the frequency range), or by
other combinations of center frequency, span, start and stop frequen-
cies.

All four parameters are accessible in the Freq menu. On the main
menu, however, only one of the combinations mentioned above is
shown, depending on the parameter last entered.

Changing a frequency parameter may affect an associated parame-
ter.

Example: If you change the span to the maximum of 4 GHz, the start
and stop frequencies are changed to O and 4 GHz, respectively.

Setting start and stop Push the CENT function key (or the Freq softkey in the Transmission

frequency mainmenu).
The vertical softkeys include Start and Stop softkeys.

RN

Start 2 Push the Start softkey.
An entry field appears, indicating the start frequency currently set
and the step size for the UP/DOWN cursor keys.

3 Enter a new frequency using the numeric keys, the cursor keys and

i the BACKSPACE key.
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Freq Mode

Startf
Stop

4 Conclude the entry by pushing an enter key for the unit (GHz/DBMm
for gigahertz, MHz/DB/Mms for megahertz).
If the start frequency entered is lower than the stop frequency, the
horizontal axis will display the range from the new start to the stop
frequency.
If the new start frequency is higher than or equal to the stop
frequency, the start frequency is used as the center frequency with
zero span, i.e. the signal at the selected frequency will be shown in
the time domain.

5 Push the Stop softkey and enter the frequency for the right end of
the display.

You can also place softkeys for the start and stop frequencies available
on the main menu by changing the frequency mode, see “Changing the
main menu for different frequency parameters”.

1 Push the CENT function key (or the Freq softkey in the Transmission
main menu).
The vertical softkeys include Center and Span. An entry field
appears, indicating the center frequency currently set and the step
size for the up/down cursor keys.

2 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

3 Conclude the entry by pushing an enter key for the unit (GHz/DBMm
for gigahertz, MHz/DB/ms for megahertz, KHz/DBmV/Ms for kilo-
hertz, or ENTER for hertz).

4 Push the Span softkey and enter the frequency for the range from
the left to the right end of the display.

You can also place softkeys for the center frequency and the span
available on the main menu by changing the frequency mode, see
section “Changing the main menu for different frequency parameters”
below.

The Transmission main menu shows two softkeys for the definition of
the frequency range on the display. Different methods exist to define
the range as depicted above; you can configure these softkeys to one
of the two allowable combinations as follows:

1 From the Transmission main menu, select Freq > Freq Mode.

2 Select the combination of softkeys that you want to see in the main
menu (Start/Stop or Center/Span).

3 Return to the main menu by pushing the Main ... softkey.
The main menu appears and displays the selected combination of
keys.

Note that the description of the horizontal frequency axis changes with
the selected parameter set.
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Changing the frequency settings

To change the frequency range to the full bandwidth supported by the
9102 for transmission measurements, proceed as follows:

1 From the Transmission main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Full Span softkey.
The leftmost frequency changes to 0 Hz and the rightmost
frequency to 4 GHz.

Measurements on a selected center frequency can also be displayed
in the time domain.

1 From the Transmission main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Center softkey and enter the desired center frequency;
close the input field by selecting the appropriate unit with one of
the enter keys.

3 Push the Zero Span softkey.
The horizontal axis becomes the time axis. The scale width is iden-
tical to the sweep time. See Figure 35 on page 126 for an example.

The center, start and stop frequencies can be set either by entering a
new value with the numeric keys, or by using the arrow keys (UP,
DoWwN) to increase or decrease the current setting. The step size for an
arrow keypress can either be selected automatically by the 9102, or
manually adjusted.

Manually setting the frequency step size

1 From the Transmission main menu, select Freq.

2 Push the FStep softkey.
The Freq Step entry field opens.

3 Enter a new frequency step value and close the entry field by
pressing Enter.

Setting the frequency step size selection to automatic

1 From the Transmission main menu, select Freq.

2 Push the FStep softkey several times until the “auto” selection is
highlighted.
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Selecting RBW, VBW and SWT
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The resolution bandwidth (RBW) is the 3 dB bandwidth of the IF filter
for selecting the signal to be measured. The resolution bandwidth
describes the ability of the spectrum analyzer to discriminate between
adjacent signals of similar amplitude. Only signals spaced at a
frequency of more than the RBW can be discriminated from one
another.

The 9102 can be set to automatically select the resolution bandwidth,
depending on the frequency span.

The video bandwidth (VBW) is the lowpass filter over which several
results for one frequency point are smoothened. The lower the video
bandwidth, the smoother the signal curve and the less variations there
are.

The 9102 can be set to select the video bandwidth automatically as a
function of the resolution bandwidth. A typical value for the video band-
width should be equal or 10 times lower than the radio bandwidth
value.

The sweep time (SWT) determines how long it takes for a complete
sweep over the measured frequency range (span).

The 9102 can be set to automatically select the sweep time, depending
on RBW and VBW. If manually set, the sweep time should be selected
long enough for the filtered signal to reach steady state. The 9102 will
output an “UNCALibrated” warning if the sweep time is too low.

To set the resolution bandwidth, the video bandwidth or the sweep
time, proceed as follows:

1 In the main menu, select the appropriate softkey (RBW, VBW, or
SWT).

2 Enter the value and complete the entry with the appropriate enter
key for the unit, select a new value with the help of the UP/DOWN
cursor keys, or switch to auto to leave the setting to the 9102.

Changing between automatic and manual mode

Push the appropriate softkey (RBW, VBW, or SWT) until the desired
selection (auto or manual) is highlighted.

Setting up the level parameters

122

The dynamic range between the measured signal and the noise floor
depend on the proper setting of the level settings. These consist of the
reference level and the attenuation.

The reference level basically determines the level at the top of the

display. The vertical axis is divided into eight horizontal rows. You can
adjust the scale (which defaults to 10 dB per line) to your preferences.
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The attenuation setting can be coupled to automatically follow the
reference level setting. For reference levels of —20 dBm and lower, the
attenuation is set to 10 dB; the maximum attenuation is 50 dB.

Attenuation or gain due to external coupling can be compensated by
frequency-dependent coupling factors, so that the displayed measure-
ment values reflect the power at the device under test.

WARNING

The maximum input power level at the RF IN connector is 30 dBm
(1 W). Higher input levels may result in serious damage of the instru-
ment.

You can switch the display between absolute and relative as follows:

1 In the main menu select Level. The Level menu is displayed.

2 Toggle the display to absolute or relative by pressing the Display
softkey until the required display option is highlighted. If you select
abs, reference level and the unit dBm will be shown in the results
display. If you select rel, reference and the unit dB will be shown.

1 In the main menu, push the Ref. softkey or select Level followed by
Ref. Alternatively, push the REF function key.
The Reference Level input field opens.

2 Enter the new reference level either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actual set output power.

1 In the main menu, push the ATTN. softkey.
The Attenuation input field opens.

2 Enter a new attenuation value in the range from 0 to 50 dB (in
10 dB steps) and close the input field with one of the enter keys, or
use the UP/DOWN arrow keys to select the attenuation value in the
range from 10 to 50 dB.

NOTE

The attenuation value of O dB can be set only with the numeric keys
to avoid accidental deactivation. The O dB setting should be selected
carefully because too high input levels may damage the instrument.

NOTE

For precision measurements, the input power level subtracted by
the attenuation should not exceed —23 dBm.
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losses

Enabling external device
compensation

Turning external device
compensation off

The scale for the vertical axis (power) can be changed in the range
from 1 to 20 dB per division (vertical line in the displayed grid) in 1-3-
5 steps as follows:

1 In the main menu, select Level.

2 Push the Scale softkey.
The Scale input field opens.

3 Select a new scale by entering a new number of dB per division
numerically and pressing the ENTER or MHz/DB/MS key, or by
pushing the UP/DOWN cursor keys.

If the device under test is connected to the 9102 Handheld Spectrum
Analyzer via an amplifier or a device attenuating the signal, such as an
antenna or a long cable, the measurement results are wrong by the
gain or loss factor. This factor may be a constant or even frequency-
dependent.

To view the correct measurement results, the gain or loss can be
compensated. The 9102 can even compensate a frequency-depen-
dent factor; a correction curve or table can be entered on an external
PC using the 9100 Data Exchange Software and loaded to the 9102.
The section “Defining and loading external coupling parameters” on
page 243 explains this part in more detail.

Once correction values are stored in the 9102, these can be selected
and activated as follows:

1 In the main menu, select Level > Ext. Dev. Memory.

2 Press Recall Ext. Dev. Comp.
A pull-down menu appears with a list of names for the compensa-
tion tables available in the 9102.

3 Select a compensation table using the UP/DOWN cursor keys and
confirm your choice by pressing ENTER.
Compensation is still off, but the 9102 changes automatically to the
Level menu.

4 Push the Ext. Dev. Comp. softkey until “on” is highlighted.
The text “Ext. Dev.”, together with the name of the file loaded,
appears on the upper left-hand corner of the results display.

NOTE

Steps 1 thru 3 may be omitted if a file had been previously selected.
In this case, select the Level menu and continue with step 4.

1 In the main menu, select the Level menu.

2 Press Ext. Dev. Comp. until “off” is highlighted.
The text “Ext. Dev.” to the left of the results display disappears.
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Deleting files for external ~ You can delete files containing compensation parameters as follows:

device compensation
1 From the main menu, select Level > Ext. Dev. Memory.

2 a.To delete an individual compensation file from the 9102 memory,
push Delete Ext. Dev. Comp. Select a file name and press ENTER.
The compensation file is deleted from the list. Note that there will
be no warning; once you have selected and requested a file to be
deleted, this will occur immediately.

b. To delete all the compensation files from the 9102, push Delete
All and confirm by pressing ENTER.
All compensation files are deleted.

Applying special functions on the signal

This section shows how the measurement can be triggered and how
the number of measurements can be limited.

Using a trigger  The 9102 can either start signal analysis at a random point in time, or
start the measurement when a given signal threshold is passed.
Starting measurements depending on the actual signal level is only
supported in zero span mode.

Free Run

Trigger
Selecting untriggered signal analysis

1 In the the main menu push Freq > Trigger.
The Trigger menu appears.

2 Push the Free Run softkey.
m The softkey is highlighted and the 9102 is ready for measurements

at random times.

Selecting a trigger threshold in the RF signal
Slope
1 In the main menu push Freq > Trigger.

. The Trigger menu appears.

2 Push the Video softkey.
The Video softkey is highlighted and an input field for the trigger
level appears.

The Video trigger is available in zero span mode only, otherwise the
softkey description is grayed out.

3 Enter the trigger level (in dBm) and complete the entry by pushing
either the GHz/pDBM or the ENTER key.
The trigger threshold is displayed at the power axis; the symbol
also indicates the slope (direction in which the signal passes the
threshold to start the measurement.
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4 If necessary, change the slope between positive and negative
direction by pushing the Slope softkey.
The active slope is indicated at the power axis by the following
symbol (see also Figure 35): [

Trigger Level

m dBm Free Run

Trigger

Ref. 0.0

dB

-20.0
Extern

Count
39 Slope
-40.0

-60.0 !
ol 70.0psfdiv Center: 947 G000MHz Span: 0.000000Hz

Freq . Main '
e L3 Sweep shan

Figure 35 Triggered measurement (in the time domain)

Using an external trigger

In order to use a trigger signal generated by an external device,
proceed as follows:

1 Connect the external device to the EXT. TRIG. connector on the top
of the instrument (see “EXT. REF. IN/ EXT. TRIG. connector” on
page 15).

2 In the the main menu, enter the Sweep menu by pushing Freq >
Trigger.
The Trigger menu appears.

3 Push the Extern softkey.
The softkey is highlighted.
After activating the external trigger the instrument waits to receive
an impulse. When an impulse is detected on the external trigger
entrance one sweep is performed. Afterwards the instrument waits
for the next trigger event.
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The 9102 can run measurements continuously or a defined number of
times. Limiting the number of measurements can be useful for statis-
tical analyses.

1 In the main menu, select Freq > Sweep.
The Sweep menu appears.

2 Select the trigger mode: Push Cont. for continuous measurements
or Single for a limited number of measurements.
The selected trigger mode is highlighted.

3 To enter the number of measurements, push the Single Count
softkey, enter a number in the range from 1 to 1000 and press
ENTER
If Trigger Mode is set to Single, the 9102 performs the defined
number of measurements and enters hold mode.

— To restart single-mode measurements, push the HOLD/RUN func-
tion key or the Single softkey.

— To stop a continuous measurement, push the HOLD/RUN function
key. Push it again to resume measurements.

Trans— B
mission

Ref. -50.0

dB

-70.0
-90.0| ]

-110.0

| B (MAX) |

-130.0 : : : : ' : : : :
ol 1.400MHz/div Start: 88.00000MHz Stop: 102.0000MHz

Il
Trace A Trace B Detect LS Trac_e B cont
Memory Function 5

Figure 36 Example of two traces

The trace functions provide different views of the measurements, for
example the actual measurement or an average over the last couple of
measurements. You can even select two different views of the
measurement. Another possibility is to compare the actual measure-
ment with an older measurement which has been stored in the 9102
and loaded to one of the trace views (see section “Storing and loading
traces” on page 134).
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The 9102 samples many measurements for each frequency point. With
the detector functions, you can define the method to select which of
the samples is displayed.
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The 9102 has five different modes to display a trace:

— In actual mode, the 9102 shows a complete new measurement in
each trace. Subsequent traces are independent of each other.

— In hold mode, the last measurement is kept on the display;
measurements continue but are not displayed.

— In max hold mode, the 9102 takes new measurements and, for
each frequency point, compares the new measurement with the
previous result. If the new measurement value is higher than the
previous result, the new measurement value becomes the new
result value; otherwise the old result value is kept. This way, the
highest result since the start of the Max hold measurement (or a
parameter change) is kept and displayed.

— Similarly, in min hold mode, the 9102 takes new measurements
and compares the new measurement with the previous result. If the
new measurement value is lower than the previous result, the new
measurement value becomes the new result value; otherwise the
old result value is kept. This way, the lowest result since the start of
the Min hold measurement (or a parameter change) is kept and
displayed.

— In average mode, the new measurement and previous ones are
averaged for each frequency point displayed. The 9102 uses a
recursive algorithm for averaging.

To select whether you want to view an actual measurement, stop and
hold the last measurement, see the lowest or highest data for each
frequency or an average value, proceed as follows:

1 In the main menu, select Trace.

2 Select the trace you want to modify (Trace A or Trace B) using the
horizontal softkeys.

3 Select the trace mode with the vertical softkeys (Actual, Hold, Max
hold, Min hold, Average).
The trace mode is shown at the left-hand side of the vertical axis,
e.g. A (ACT).

NOTE

For fastest valid results it is advisable to briefly activate the actual
mode before selecting any other mode.

NOTE

When the trace is on hold, the measurement and failure counters
continue counting. A second trace, if active, continues updating.
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You can define two different trace views, e.g. one with the actual values
and one with the maximum values. While the first view (Trace A) is
always active, the second can be switched off. The functions of turning
Trace B on or off and selecting the trace mode are combined as
follows:

1 In the main menu, select Trace > Trace B.

2 To turn trace B on, select the trace mode (Actual, Hold, Max hold,
Min hold, or Average). To turn trace B off, select Off.
If activated, the trace mode is displayed left to the vertical axis, e.g.
B (MAX).

If you have used two different trace views as described above, you can
show the difference between trace A and trace B by subtracting trace
B from trace A as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Subtract A—B —> A.

2 Select on to subtract trace B from trace A. On the left-hand side of
the result area the Term “Subtract” will now be displayed to indicate
that a mathematical function is being performed.

3 The result is displayed in trace A.

NOTE

If trace A is on Hold, this function is not available and thus the
Subtract A — B —> A softkey is greyed out.
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If you have used two different trace views, you can also show the sum
of
trace A and trace B by adding the two traces as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Add A+B —> A,

2 Select on to add B to trace A. On the left-hand side of the result
area the term “Add” will now be displayed to indicate that a mathe-
matical function is being performed.

3 The result is displayed in trace A.

As soon as you use one of the two mathematical functions, Subtract
A+ B - AorAddA + B — A, the Trace Offset function is activated.
You can use this function to adjust the trace display, if the mathematical
calculation performed causes the resulting trace to move outside the
display area. In order to bring the trace back into view, use the Trace
Offset softkey to modify the offset value until the trace moves back into
the display area.

When the trace mode is set to averaging, it may be useful to adjust the
number of measurements over which the 9102 averages the results.
The average count value that can be defined in the Trace menus
applies to both traces alike.

The 9102 uses a recursive algorithm in which a new result is added to
the older averages with a weighting factor; the description below indi-
cates how to change this weighting factor.

1 Select the Trace menu (select Trace > Trace A or Trace B from the
main menu).

2 Push the Average Count softkey.
The Average input field opens.

3 Enter the number of measurements over which to average the
results, in the range from 2 to 128.

4 Press ENTER
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For each new measurement, the 9102 selects one or two values from
a number of measurements for each frequency value. The method is
user-definable; the following methods are available (see also

Figure 37):

— Positive/negative peak: Both the largest and smallest values are
taken and displayed as a vertical bar.

— Positive peak: Only the largest value is displayed.
— Negative peak: The smallest value is shown.
— Sample: A sample measurement value is picked.

— If the 9132 RMS Detector Option is installed and activated on your
9102, the root mean square detector showing the RMS-effective
level of the measured signal is also available. If the 9132 RMS
Detector Option is not installed on your instrument the RMS
detector will be greyed out.

Pos. Peak  Pos.fNeq. Peak

LA
&
3
=
o
®

D e T

Figure 37 Trace detectors

The detection method applies to both traces. Select the detection
method as follows:

1 From the main menu, select Trace > Detect.

2 Select the trace method from the Detector section of the vertical
softkeys.
The selected detection method is indicated at the left-hand side of
the display.

You can copy an actual measurement from trace A to trace B or vice
versa; this way you can keep the last measurement results on the
screen and at the same time continue measuring or change the
settings of the 9102 Handheld Spectrum Analyzer. The previous results
in the target trace will be erased; the target trace will assume hold
mode.

To copy the measurement data from one trace to another, proceed as
follows:
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1 From the main menu, select Trace > Trace Function.

2 To copy the measurement results from trace A to trace B, press
Copy A —» B.
To copy results from trace B to trace A, press Copy B — A.
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Figure 38 Trace function menu
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NOTE

If you first press Copy A — B, then Copy B — A (or vice versa), both
traces will display the same results and will be in hold mode.
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Storing and loading traces
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Storing a trace
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Figure 39 Trace A menu

The 9102 provides the capability to store up to 99 traces in the 9102
and load them again at random. The stored trace can then be exam-
ined or compared to a recent measurement. In addition, stored traces
can also be transferred to a PC using the 9100 Data Exchange Soft-
ware which is being delivered with the 9102. For details on the soft-
ware refer to Chapter 15 “9100 Data Exchange Software”.

You can store either trace A or B. Any trace can be stored under a
name with up to 11 characters. The procedure to enter text in alphanu-
merical input fields is explained in section “Entering numbers and text”
on page 27. Note that along with the trace, the instrument settings
such as frequency range, level range and markers are stored.

1 In the main menu, select Trace > Trace Memory.

2 Press either Store Trace
An input field opens, allowing you to enter a name for the trace.
Below the input field, a list of existing traces is indicated.

3 Enter a name for the trace. To use a modified trace name, you can
move the cursor to a suitable trace name with the UP/DOWN cursor
keys. The selected trace name also appears in the input field; use
the LEFT/RIGHT cursor keys to move the cursor to the appropriate
position within the trace name to enter additional characters or
delete existing ones.

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is stored under the selected
name.
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You cannot overwrite an existing trace using the same trace name. If
you want to reuse a trace name, you will have to delete the old trace
first.

1 In the main menu, select Trace > Trace Memory.

2 Push either Recall Trace.
An input field opens, allowing you to enter the trace name. Below
the input field, a list of existing traces is indicated.

3 Enter the name of the trace to load, or choose one with the Up/
DOWN cursor keys.

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is displayed.

NOTE

Along with the trace, the 9102 also loads the settings that were used
when the trace was saved. These will overwrite the current settings
such as frequency range, reference level and markers.

Stored traces can be deleted. Note that there will be no warning; once
you have selected and requested a file to be deleted, this will occur
immediately.

1 In the main menu, select Trace > Trace Memory.

2 Press Delete Trace.
An input field for the name of the trace to be deleted appears,
together with a trace selection box.

3 Select the trace to be deleted using the UP/DOWN cursor keys.
Alternatively, enter the trace name with the numeric keys.

4 Confirm your choice by pressing ENTER.
The trace is deleted from the trace list.

5 Select another trace for deletion, or press ESCAPE to leave the
input field and the trace selection box.

Instead of deleting traces individually, all traces can be deleted in one
step. You will be asked to confirm this step.
1 In the main menu, select Trace > Trace Memory.

2 Press Delete All.
A query appears, asking you to confirm your selection.

3 Press ENTER to have all traces deleted.
The query disappears. All traces are deleted.
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Viewing the transmission mode parameters

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey

Trans-—
mission
15:44:46 Parameter Window 06.06.2003
Center : 1.800000 GHz Start : 0.000000 Hz
Span : 3.600000 GHz Stop : 3.600000 GHz
Reference 0.0 dB Trigger Mode : Free Run
Attenuation : 30 dB Trigger Level : -40.0 dBm
Impedance : a0 Ohm Sweep : Continuous
TG Output Power : -10.0 dBm Single Count : 1
RBW : 1 MHz Detector : Pos.fHeq.
VBW : 1 MHz
SWT: 43.2 ms
Press <Exit> to continue

Freq Level Marker Trace Tracking . Exit
Main
o Generator

Figure 40 Transmission mode parameters
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Measurement Option

This chapter gives a general overview on the 9130 VSWR/DTF Reflec-
tion Measurement Option. Topics discussed in this chapter are as
follows:

“About the 9130 VSWR/DTF Reflection Measurement Option” on
page 138

— “Specifications” on page 138

— “Measurement modes” on page 139

— “Hardware requirements” on page 140

— “Connecting the 9160 VSWR/DTF Bridge” on page 140
— “Calibration” on page 142
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About the 9130 VSWR/DTF Reflection Measurement Option

Specifications

138

The 9130 VSWR/DTF Reflection Measurement Option, in conjunction
with the 9160 VSWR/DTF Bridge, turns the 9102 into a full-featured
reflection test set. The functionality of the 9130 VSWR/DTF Reflection
Measurement Option is tailored to the testing requirements involved in
the acceptance and maintenance of professional antenna systems, e.g.
cellular base stations. This measurement option is especially suitable
for field applications. However, it also offers lab and service applica-
tions, e.g. reflection measurements at passive RF devices (such as
attenuators, matching pads and filters) are possible.

During reflection measurements the 9102’s tracking generator works
as a test signal generator while the sprectrum analyzer measures the
level of the reflected signal. In the 9100 applications guide contained
on the documentation CD delivered in your instrument you will find
detailed application examples for the 9130 VSWR/DTF Reflection
Measurement Option.

Table 13 9130 VSWR/DTF Reflection Measurement Option

specifications
Measurement range >70 dB
Measurement units dB, VSWR, mRho
Measurement sample 501
points
Cable parameter edit Auto or manual
Measurement method Vector or scalar

Table 14 9160 VSWR/DTF Bridge specifications

Frequency range 1 MHz to 4 GHz
Directivity (10 MHz to 3 Typ. 30 dB

GH2)

Insertion Loss <2x 10 dB
Impedance 50 Ohm

DUT port return loss > 18 dB
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Measurement modes

The 9130 VSWR/DTF Reflection Measurement Option offers three
additional measurement modes: reflection, distance to fault and cable
loss. If the 9130 VSWR/DTF Reflection Measurement Option is installed
and activated on your 9102, three additional submenus besides signal
generator and transmission are available in the VSWR/Tracking...
submenu:

— Reflection
This mode enables you to test performance and match of antenna
systems over the desired frequency range in one view.
For a description of measurements using the reflection mode refer
to “Reflection Operation” on page 143.

— Distance to Fault
This mode puts the attention on the cable and offers a detailed
analysis of feeder cables. Cable-related problems can be easily
detected and located.
For a description of measurements using the distance to fault
mode refer to “Distance to Fault Operation” on page 163.

— Cable Loss
The cable loss mode allows you to determine the average cable
loss.
For a description of measurements using the distance to fault
mode refer to “Cable Loss Operation” on page 173.

9100 Handheld Spectrum Analyzer past

Mode

Signal Generator
Transmission
Reflection
Distance to Fault
Cable Loss
System Calibration Extemal Factory m
Information Device Settings

Figure 41 VSWR/Tracking menu

For details on selecting a measurement mode refer to “Selecting the
measurement mode” on page 29.
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Hardware requirements

Hardware requirements

Following are the hardware requirements and recommendations for
performing measurements using the 9130 VSWR/DTF Reflection
Measurement Option:

— 9160 VSWR/DTF Bridge

— 9150 Tracking Generator

— Calibration set for N or 7/16"

— Test port extension cable N or 7/16".

NOTE

The test port extenstion cable is especially recommended for reflec-
tion measurements. A direct connection to antenna feeder cables is
in this case often not practicable as these cables are usually very
rigid. The test port extension cable can have a minimal influence on
measurement results. However, test results are not influenced in a
decisive way, so this effect can be disregarded.

For details on options and accessories for the 9102 please refer to
“Options and accessories” on page 5

Connecting the 9160 VSWR/DTF Bridge

140

For reflection measurements a measurement bridge is necessary. The
9160 VSWR/DTF Bridge is used to measure the load impedance of an
antenna or another device very precisely. It covers the full operational
frequency range of the 9102.

In order to set up the 9102 for VSWR/DTF reflection measurements
simply connect the 9160 VSWR/DTF Bridge to the RF in and RF out
connectors as well as to the Multi Port connector on the top of the
instrument.
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Connecting the 9160 VSWR/DTF Bridge

For details on the 9102's connectors refer to “Connecting the 9102
Handheld Spectrum Analyzer” on page 14.
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Calibration

Calibration

142

Before starting VSWR/DTF measurement the instrument needs to be
calibrated. For reference calibration a calibration standard with an
open, short and load reference connector has to be connected. Aero-
flex offers calibration sets Open/Short/Load Type 7/16“ male and Type
N male as well as test port extension cables with different connector
standards (N and 7/16” DIN). For ordering information refer to
“Options and accessories” on page 5. For a description of the calibra-
tion procedure within the measurement modes reflection, distance to
fault and cable loss refer to Chapter 9, Chapter 10 and Chapter 11.
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Reflection Operation

This chapter describes the instrument’s functions that are specific to
the
reflection mode. Topics discussed in this chapter are as follows:

— “About the reflection mode” on page 144

— “Selecting the measurement mode” on page 145

— “Preparative steps” on page 145

— “Changing the frequency settings” on page 146

— “Reflection calibration” on page 149

— “Changing the units settings” on page 150

— “Setting up the level parameters” on page 151

— “Performing a limited number of measurements” on page 154
— “Setting up the trace” on page 154

— “Storing and loading traces” on page 158

— “Using limits” on page 159

— “Viewing the reflection mode parameters” on page 160

9102 Handheld Spectrum Analyzer  Software version 5.31 143



Chapter 9 Reflection Operation
About the reflection mode

About the reflection mode

144

Modern antenna systems for professional applications are character-
ised by a low reflection and a good match. All components of the
antenna system should be matched to 50 Ohm, the standard imped-
ance for professional wireless equipment. If all components are
matched, the system'’s efficiency is at its maximum level. The better the
match the better the ratio between radiated and lost RF energy.

The reflection mode enables you to test performance and match of
antenna systems over the desired frequency range in one view and to
validate performance for acceptance and maintenance.

During reflection measurements the 9102’s tracking generator gener-
ates a test signal. The 9102 measures the signal level reflected by the
antenna. For measuring the load impedance of an antenna very
precisely with a linear behavior over 4 GHz, the 9160 VSWR DTF
bridge is used. The reflection measurement modes offers scalar and
vector reflection measurements and displays all common reflection
measurement units such as return loss, rho, VSWR and the reflected
power ratio.

Figure 42 shows an example for a return loss measurement results
display.

Al -24.1dB f1.920000GHz -
zr.aue rza1s0mwer: Reflection

Ab
AS -24.9dB f2.117680GHz
Ad -2a.7dB f2.075120GHz

Ret. 0.0
Loss Stop
dB

-10.0
Ref.

Scale

k Filter

‘ 1 MHz
auto

-30.0

| Calibd_|

-40.0 !
ol 28.00MHzfdiv Start: 1.920000GHz Stop: 2.200000GHz SWT

Freq Level Marker Trace Reflection 2.80 ms
Cal. auto

Figure 42 Example of a return loss measurement

On the measurement results screen markers are usually set on the
limits of the uplink and downlink band. These are the ranges which are
the interesting parts of the spectrum displayed. Two further markers
are set on the maximum reflection within those bands to indicate
whether the antenna system under test performs within the usual
reflection limits of 17 to 20 dB return loss. For a detailed application
example for the reflection measurement mode refer to the applications
guide contained on the documentation CD delivered with your instru-
ment.
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Selecting the measurement mode

Preparative steps

To select the reflection mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears.

2 Select VSWR/Tracking ... > Reflection.
The reflection main menu appears.

NOTE

This mode is available for selection, if the 9130 VSWR/DTF Reflec-
tion Measurement Option is installed and acitivated on your instru-
ment.

Before starting the measurement the following preparative steps are
necessary:

— Connecting the 9160 VSWR/DTF Bridge
For details on this procedure refer to “Connecting the 9160 VSWR/
DTF Bridge” on page 140.

— Selecting the desired frequency band
— Calibration

The next section section shows how to change the frequency settings
on the 9102. This section is followed by a description of the calibration
process.
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Changing the frequency settings

Reflection
Center
Ret. 0.0
Loss Span
dB
-20.0
Start
Count
399
Stop
FStep
360 MHz
-60.0 auto
T (T Full
A (ACT
1 Span !
-60.0 !
. ="="="= 360.0MHz/div Center: 1.500000GHz Span: 3.600000GHz -
ro
Freq et Sweep LD Span !

Mode

Figure 43 Frequency menu

There are different methods to set the frequency range to be
measured; the range can be expressed by either the start and stop
frequencies (i.e. first and last frequencies on the display), or by center
frequency and span (i.e. the center and the frequency range), or by
other combinations of center frequency, span, start and stop frequen-
cies.

All four parameters are accessible in the Freq menu. On the main
menu, however, only one of the combinations mentioned above is
shown, depending on the parameter last entered.

NOTE

Changing a frequency parameter may affect an associated parame-
ter.

Example: If you change the span to the maximum of 4 GHz, the start
and stop frequencies are changed to O and 4 GHz, respectively.

Setting start and stop 1 Push the CENT function key (or the Freq softkey in the Reflection

frequency main menu).
The vertical softkeys include Start and Stop softkeys.
Start 2 Push the Start softkey.
An entry field appears, indicating the start frequency currently set
and the step size for the UP/DOWN cursor keys.
Sto 3 Enter a new frequency using the numeric keys, the cursor keys and
P

the BACKSPACE key.
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4 Conclude the entry by pushing an enter key for the unit (GHz/DBMm
for gigahertz, MHz/DB/ms for megahertz).
If the start frequency entered is lower than the stop frequency, the
horizontal axis will display the range from the new start to the stop
frequency.
If the new start frequency is higher than or equal to the stop
frequency, the start frequency is used as the center frequency with
zero span, i.e. the signal at the selected frequency will be shown in
the time domain.

5 Push the Stop softkey and enter the frequency for the right end of
the display.

You can also place softkeys for the start and stop frequencies available
on the main menu by changing the frequency mode, see “Changing the
main menu for different frequency parameters”.

1 Push the CENT function key (or the Freq softkey in the Reflection
main menu).
The vertical softkeys include Center and Span. An entry field
appears, indicating the center frequency currently set and the step
size for the up/down cursor keys.

2 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

3 Conclude the entry by pushing an enter key for the unit (GHz/DBMm
for gigahertz, MHz/DB/ms for megahertz, KHz/DBmV/Ms for kilo-
hertz, or ENTER for hertz).

4 Push the Span softkey and enter the frequency for the range from
the left to the right end of the display.

You can also place softkeys for the center frequency and the span
available on the main menu by changing the frequency mode, see
section “Changing the main menu for different frequency parameters”
below.

The Reflection main menu shows two softkeys for the definition of the
frequency range on the display. Different methods exist to define the
range as depicted above; you can configure these softkeys to one of
the two allowable combinations as follows:

1 From the Reflection main menu, select Freq > Freq Mode.

2 Select the combination of softkeys that you want to see in the main
menu (Start/Stop or Center/Span).

3 Return to the main menu by pushing the Main ... softkey.
The main menu appears and displays the selected combination of
keys.

Note that the description of the horizontal frequency axis changes with
the selected parameter set.

9102 Handheld Spectrum Analyzer  Software version 5.31 147



Chapter 9 Reflection Operation
Changing the frequency settings

Viewing the complete
frequency band

Full
Span !

Performing
measurements in the
time domain

fero
Span !

Selecting the step size
for the frequency input

FStep
100 kHz
aunko

148

To change the frequency range to the full bandwidth supported by the
9102 for reflection measurements, proceed as follows:

1 From the Reflection main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Full Span softkey.
The leftmost frequency changes to O Hz and the rightmost
frequency to 4 GHz.

Measurements on a selected center frequency can also be displayed
in the time domain.

1 From the Reflection main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Center softkey and enter the desired center frequency;
close the input field by selecting the appropriate unit with one of
the enter keys.

3 Push the Zero Span softkey.
The horizontal axis becomes the time axis. The scale width is iden-
tical to the sweep time.

The center, start and stop frequencies can be set either by entering a
new value with the numeric keys, or by using the arrow keys (UP,
DoWwN) to increase or decrease the current setting. The step size for an
arrow keypress can either be selected automatically by the 9102, or
manually adjusted.

Manually setting the frequency step size

1 From the Reflection main menu, select Freq.

2 Push the FStep softkey.
The Freq Step entry field opens.

3 Enter a new frequency step value and close the entry field by
pressing Enter. The auto/manual selection switches to manual and
the selected frequency step size is displayed on the softkey.

Setting the frequency step size selection to automatic

1 From the Reflection main menu, select Freq.

2 Push the FStep softkey several times until the “auto” selection is
highlighted.
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Before starting the measurement the instrument needs to be calibrated
with a reference match resistor. For details on available calibration sets
refer to “Options and accessories” on page 5 and “Calibration” on
page 142. On the left handside of the results display a red icon reading
“Calibrate” informs you that a calibration needs to be performed. You
can perform a vector or scalar calibration for your measurement. In
order to calibrate the instrument for your reflection measurement
proceed as follows:

1 Connect the test port extension cable to the 9160 VSWR/DTF
Bridge.

2 In the Reflection main menu press Reflection Cal. softkey. the
Reflection Calibration menu is displayed.

Reflection

Mode
Reflection Calibration Vector

Connect SHORT to measurement port, then press <Continue:=

Continue !

Cancel !

Ey

H
. -
U =T

Reflection Main

Figure 44 Reflection Calibration menu

3 In this menu you can select the mode to be used for your measure-
ment by pressing the Scalar or Vector softkey. The scalar measure-
ment measures the level of the reflected signal. The vector
measurement is even more precise and also measures the phase
of the reflected signal. It increases measurement accuracy as well
as the return loss measurement range.

The 9102 will guide you through the calibration process by
onscreen messages as shown in Figure 44. When prompted as
shown connect the calibration set to the test port extension cable
and press Continue. You can abort the calibration process by
pressing the Cancel ! softkey.

4 When calibration is completed the Reflection main menu will be
displayed again. On the left handside of the results display the cali-
bration icon will now be displayed in green and read “Calib’d” (Cali-
brated).
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The measurement graph shows full reflection (O dB return loss) as soon
as the calibration set is removed. The instrument is now ready for
starting the reflection measurement.

NOTE

When performing a number of measurements it can be necessary to
repeat the calibration process due to temperature changes etc. This
is regular behaviour. Furthermore if you change the frequency band,
calibration has to be repeated. As soon as calibration is necessary
the 9102 will inform you by displaying the red “Calibrate” icon.

Changing the units settings

The reflection mode supports all common reflection measurement
units:

150

Unit

VSWR

Refl.
Factor

Refl.
Power

— Return loss

The most common reflection measurement unit. Using this unit the
attenuation of the reflected signal against the test signal power is
measured. Due to the fact that the return loss is linked to the signal
power this measurement unit is very easy to handle. A return loss
of 20 dB for example, means that

1/100 of the transmitted power is reflected back to the radio.
Usually a return loss of around 17 dB is required to accept an
antenna as functional.

VSWR

This unit is based on the RF signal voltage. It represents a ratio of
transmitted and received voltage. Using special alignment charts all
units can be easily compared to each other. A return loss of 20 dB
for example is equivalent to a VSWR of 1.22.

Reflection factor
This unit is also based on the RF signal voltage and shows the
reflection in mRho.

Reflection power
This unit shows the reflected power ratio as a percentage.

In order to select the measurement unit for your reflection measure-
ment proceed as follows:

1

In the Reflection main menu select Level > Units. The Unit menu is
displayed on the right-hand side of the screen.

2 Select Return Loss, VSWR, Refl. Factor or Refl. Power by pressing

the respective softkey followed by ENTER. The selected unit will be
displayed on the left-hand side of the results display.
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Setting up the level parameters

Setting the reference
level for return loss

Changing the vertical
scale for return loss

Setting the maximum for
VSWR

Changing the scale for
VSWR

After specifying the unit for your reflection measurement you can
adjust the level parameters. Depending on the unit you specified via
the Units menu the display of the Level menu changes to enable you
to set the level parameters for the individual units as follows:

1 In the main menu, push the Ref. softkey or select Level followed by
Ref. Alternatively, push the REF function key.
The Reference Level input field opens.

2 Enter the new reference level either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actual set output power.

The scale for the vertical axis (power) can be changed in the range
from 1 to 20 dB per division (vertical line in the displayed grid) in 1-3-
5 steps as follows:

1 In the main menu, select Level.

2 Push the Scale softkey.
The Scale input field opens.

3 Select a new scale by entering a new number of dB per division
numerically and pressing the ENTER or MHz/DB/Ms key, or by
pushing the UP/DOWN cursor keys.

1 In the main menu, push the Max VSWR softkey or select Level
followed by Ref. Alternatively, push the REF function key.
The Reference Level input field opens.

2 Enter the new maximum VSWR either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new maximum level appears at the top of the vertical axis.

The scale for the vertical axis (power) can be changed in the range
from 1 to 1000 per division (vertical line in the displayed grid) as
follows:

1 In the main menu, select Level.

2 Push the VSWR Scale softkey.
The VSWR Scale input field opens.
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Setting the maximum for

reflection factor
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reflection power

3

Select a new scale by entering a new number per division numeri-
cally and pressing the ENTER or MHz/DB/Ms key, or by pushing the
UP/DOWN cursor keys.

In the main menu, push the Max Refl Factor softkey or select Level
followed by Max Refl Factor. Alternatively, push the REF function
key.

The Reference Level input field opens.

Enter the new maximum reflection factor either using the numeric
keys, closing the input field with the appropriate enter key, or with
the UP/DOWN arrow keys.

The new maximum reflection factor appears at the top of the
vertical axis.

The scale for the vertical axis (power) can be changed in the range
from 0 to 2000 mRho per division (vertical line in the displayed grid) as
follows:

1
2

In the main menu, select Level.

Push the Refl. Factor Scale softkey.
The Refl. Factor Scale input field opens.

Select a new scale by entering a new number per division numeri-
cally and pressing the ENTER or MHz/DB/Ms key, or by pushing the
UP/DOWN cursor keys.

In the main menu, push the Max Refl Power softkey or select Level
followed by Max Refl Power. Alternatively, push the REF function
key.

The Reference Level input field opens.

Enter the new maximum reflection factor either using the numeric
keys, closing the input field with the appropriate enter key, or with
the UP/DOWN arrow keys.

The new maximum reflection factor appears at the top of the
vertical axis.

The scale for the vertical axis (power) can be changed in the range
from 1 to
200 % per division (vertical line in the displayed grid) as follows:

1

In the main menu, select Level.

2 Push the Refl. Power Scale softkey.

The Refl. Power Scale input field opens.
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3 Select a new scale by entering a new number per division numeri-
cally and pressing the ENTER or MHz/DB/Ms key, or by pushing the
UP/DOWN cursor keys.
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Performing a limited number of measurements

Setting up the trace

154

Selecting the trace
mode

The 9102 can run measurements continuously or a defined number of
times. Limiting the number of measurements can be useful for statis-
tical analyses.

1 In the main menu, select Freq > Sweep.
The Sweep menu appears.

2 Select the trigger mode: Push Cont. for continuous measurements
or Single for a limited number of measurements.
The selected trigger mode is highlighted.

3 To enter the number of measurements, push the Single Count
softkey, enter a number in the range from 1 to 1000 and press
ENTER.

If Trigger Mode is set to Single, the 9102 performs the defined
number of measurements and enters hold mode.

— To restart single-mode measurements, push the HOLD/RUN func-
tion key or the Single softkey.

— To stop a continuous measurement, push the HOLD/RUN function
key. Push it again to resume measurements.

The trace functions provide different views of the measurements, for
example the actual measurement or an average over the last couple of
measurements. You can even select two different views of the
measurement. Another possibility is to compare the actual measure-
ment with an older measurement which has been stored in the 9102
and loaded to one of the trace views (see section “Storing and loading
traces” on page 158).

The 9102 has five different modes to display a trace:

— In actual mode, the 9102 shows a complete new measurement in
each trace. Subsequent traces are independent of each other.

— In hold mode, the last measurement is kept on the display;
measurements continue but are not displayed.

— In max hold mode, the 9102 takes new measurements and, for
each frequency point, compares the new measurement with the
previous result. If the new measurement value is higher than the
previous result, the new measurement value becomes the new
result value; otherwise the old result value is kept. This way, the
highest result since the start of the Max hold measurement (or a
parameter change) is kept and displayed.

— Similarly, in min hold mode, the 9102 takes new measurements
and compares the new measurement with the previous result. If the
new measurement value is lower than the previous result, the new
measurement value becomes the new result value; otherwise the
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old result value is kept. This way, the lowest result since the start of
the Min hold measurement (or a parameter change) is kept and
displayed.

In average mode, the new measurement and previous ones are
averaged for each frequency point displayed. The 9102 uses a
recursive algorithm for averaging.

To select whether you want to view an actual measurement, stop and
hold the last measurement, see the lowest or highest data for each
frequency or an average value, proceed as follows:

1
2

In the main menu, select Trace.

Select the trace you want to modify (Trace A or Trace B) using the
horizontal softkeys.

Select the trace mode with the vertical softkeys (Actual, Hold, Max
hold, Min hold, Average).

The trace mode is shown at the left-hand side of the vertical axis,
e.g. A (ACT).

NOTE

For fastest valid results it is advisable to briefly activate the actual
mode before selecting any other mode.

NOTE

When the trace is on hold, the measurement and failure counters
continue counting. A second trace, if active, continues updating.
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You can define two different trace views, e.g. one with the actual values
and one with the maximum values. While the first view (Trace A) is
always active, the second can be switched off. The functions of turning
Trace B on or off and selecting the trace mode are combined as
follows:

1 In the main menu, select Trace > Trace B.

2 To turn trace B on, select the trace mode (Actual, Hold, Max hold,
Min hold, or Average). To turn trace B off, select Off.
If activated, the trace mode is displayed left to the vertical axis, e.g.
B (MAX).

If you have used two different trace views as described above, you can
show the difference between trace A and trace B by subtracting trace
B from trace A as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Subtract A—B —> A.

2 Select on to subtract trace B from trace A. On the left-hand side of
the result area the Term “Subtract” will now be displayed to indicate
that a mathematical function is being performed.

3 The result is displayed in trace A.

NOTE

If trace A is on Hold, this function is not available and thus the
Subtract A — B —> A softkey is greyed out.

If you have used two different trace views, you can also show the sum
of
trace A and trace B by adding the two traces as follows:

1 Inthe Trace menu select the softkey Trace Function followed by the
softkey Add A+ B —> A,
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2 Select on to add B to trace A. On the left-hand side of the result
area the term “Add” will now be displayed to indicate that a mathe-
matical function is being performed.

3 The result is displayed in trace A.

As soon as you use one of the two mathematical functions, Subtract
A+ B—> Aor Add A + B — A, the Trace Offset function is activated.
You can use this function to adjust the trace display, if the mathematical
calculation performed causes the resulting trace to move outside the
display area. In order to bring the trace back into view, use the Trace
Offset softkey to modify the offset value until the trace moves back into
the display area.

When the trace mode is set to averaging, it may be useful to adjust the
number of measurements over which the 9102 averages the results.
The average count value that can be defined in the Trace menus
applies to both traces alike.

The 9102 uses a recursive algorithm in which a new result is added to
the older averages with a weighting factor; the description below indi-
cates how to change this weighting factor.

1 Select the Trace menu (select Trace > Trace A or Trace B from the
main menu).

2 Push the Average Count softkey.
The Average input field opens.

3 Enter the number of measurements over which to average the
results, in the range from 2 to 128.

4 Press ENTER.

You can copy an actual measurement from trace A to trace B or vice
versa; this way you can keep the last measurement results on the
screen and at the same time continue measuring or change the
settings of the 9102 Handheld Spectrum Analyzer. The previous results
in the target trace will be erased; the target trace will assume hold
mode.

To copy the measurement data from one trace to another, proceed as
follows:
1 From the main menu, select Trace > Trace Function.

2 To copy the measurement results from trace A to trace B, press
Copy A —» B.
To copy results from trace B to trace A, press Copy B — A.
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NOTE

If you first press Copy A — B, then Copy B — A (or vice versa), both
traces will display the same results and will be in hold mode.

Storing and loading traces

158

Storing a trace

Reusing a trace name

Reloading a trace

The 9102 provides the capability to store up to 99 traces in the 9102
and load them again at random. The stored trace can then be exam-
ined or compared to a recent measurement. In addition, stored traces
can also be transferred to a PC using the 9100 Data Exchange Soft-
ware which is being delivered with the 9102. For details on the soft-
ware refer to Chapter 15 “9100 Data Exchange Software”.

You can store trace A and trace B. Any trace can be stored under a
name with up to 11 characters. The procedure to enter text in alphanu-
merical input fields is explained in section “Entering numbers and text”
on page 27. Note that along with the trace, the instrument settings
such as frequency range, level range and markers are stored.

1 In the main menu, select Trace > Trace Memory.

2 Press either Store Trace..
An input field opens, allowing you to enter a name for the trace.
Below the input field, a list of existing traces is indicated.

3 Enter a name for the trace. To use a modified trace name, you can
move the cursor to a suitable trace name with the UP/DOWN cursor
keys. The selected trace name also appears in the input field; use
the LEFT/RIGHT cursor keys to move the cursor to the appropriate
position within the trace name to enter additional characters or
delete existing ones.

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is stored under the selected
name.

You cannot overwrite an existing trace using the same trace name. If
you want to reuse a trace name, you will have to delete the old trace
first.

1 In the main menu, select Trace > Trace Memory.

2 Push either Recall Trace.
An input field opens, allowing you to enter the trace name. Below
the input field, a list of existing traces is indicated.

3 Enter the name of the trace to load, or choose one with the Up/
DOWN cursor keys.
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Deleting all traces

Using limits

Chapter 9 Reflection Operation
Using limits

4 Confirm your choice by pressing ENTER.
The input field closes and the trace is displayed.

NOTE

Along with the trace, the 9102 also loads the settings that were used
when the trace was saved. These will overwrite the current settings
such as frequency range, reference level and markers.

Stored traces can be deleted. Note that there will be no warning; once
you have selected and requested a file to be deleted, this will occur
immediately.

1 In the main menu, select Trace > Trace Memory.

2 Press Delete Trace.
An input field for the name of the trace to be deleted appears,
together with a trace selection box.

3 Select the trace to be deleted using the UP/DOWN cursor keys.
Alternatively, enter the trace name with the numeric keys.

4 Confirm your choice by pressing ENTER.
The trace is deleted from the trace list.

5 Select another trace for deletion, or press ESCAPE to leave the
input field and the trace selection box.

Instead of deleting traces individually, all traces can be deleted in one
step. You will be asked to confirm this step.

1 In the main menu, select Trace > Trace Memory.

2 Press Delete All.
A query appears, asking you to confirm your selection.

3 Press ENTER to have all traces deleted.
The query disappears. All traces are deleted.

When activating limit lines prepared for the band to be measured, the
band’s ends as well as the reflection limit can be identified in on view:
the 9102 provides a simple Pass/Fail verdict and displays the limit lines
on screen:
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Limits: V3WR_TEST Al -21.9dB f1.920000GHz
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Figure 45 Example of a results display

If the reflection is higher than the limit, the test result is displayed as
“Fail”. For details on defining and using limit lines refer to “Using limit
lines” on page 34.

Viewing the reflection mode parameters

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
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opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey

s 2smnzesooomn:  Reflection

Al 2.5dB f129.6000MHz
A3 2.50B /129.6000MHz
16:28:44 Parameter Window 06.06.2003
Center : 1.800000 GHz Start : 0.000000 Hz
Span : 3.600000 GHz Stop : 3.600000 GHz
Reference 0.0 dB Trigger Mode : Free Run
Attenuation : 0dB Trigger Level : -40.0 dBm
Impedance : a0 Ohm Sweep : Continuous
Single Count : 1
Filter : 1 MHz Mode : Scalar
SWT: 36.0 ms
Press <Exit> to continue
Mkr Mkr Mkr Main
Peak. Transfer More
Figure 46 Reflection mode parameters
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Distance to Fault Operation

This chapter describes the instrument’s functions that are specific to
the reflection mode. Topics discussed in this chapter are as follows:

— “About the distance to fault mode” on page 164
— “Selecting the measurement mode” on page 165
— “Preparative steps” on page 165

— “Selecting the measurement unit” on page 165

— “Specifying the cable length” on page 166

— “Specifying cable settings” on page 166

— “Setting center frequency and span” on page 167
— “Distance to fault calibration” on page 168

— “Specifying the level parameters” on page 170

— “Setting up the trace” on page 171

— “Using limits” on page 171

— “Viewing the distance to fault parameters” on page 171
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About the distance to fault mode

The distance-to-fault measurement is essential for antenna installa-
tions. It focuses on the cable measuring the reflection arising along it
in order to detect and locate weak connectors, cable kinks, water
ingress and other cable-related problems. This measurement is also
called structural return loss and it displays reflection arising at a certain
cable position precisely in the location domain. Thereby cable prob-
lems can be easily identified. The 9102 supports a detailed analysis of
the antenna feeder cable with a total length of up to 2000 m. The high
501 points measurement resolution ensures quick and efficient trou-
bleshooting by detecting even small reflections which result in a
displayed distance to fault.

Al 40.32mRBhof 4.70m

A3 373mRhof 41.10m D 1 Sta nce Center
A2 29.8mRhof 20.50m to Fa u I t
Refl. 400 :
factor : £ Span
man
mRho
300 Max Refl
Factor
Count '
146 | Refl.
200 ! Factor
. Scale
Cable
100 E Length
| RMS | :
A (ACT b '
0 Mﬂ. e P - JK.‘..J”
[yl 5.00mfdiv Cable Type: user-defined  Cable Length: 50.0m .
v ¥p 9 Distance

Cahle Level Marker Trace DTF Unit
Calibration m

Figure 47 Example of a distance-to-fault measurement

Figure 47 shows an example of a distance-to-fault results display. As in
the other measurement modes you can use markers to label all peaks.
In the distance to fault mode the markers appear in line style. For a
detailed application example for the distance to fault measurement
mode refer to the applications guide contained on the documentation
CD delivered with your instrument.
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Selecting the measurement mode

Preparative steps

To select distance to fault mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears.

2 Select VSWR/Tracking ... > Distance to Fault.
The Distance to Fault main menu appears.

NOTE

This mode is available for selection, if the 9130 VSWR/DTF Reflec-
tion Measurement Option is installed and acitivated on your instru-
ment.

Before starting the measurement the following preparative steps are
necessary:

— Connecting the 9160 VSWR/DTF Bridge
For details on this procedure refer to “Connecting the 9160 VSWR/
DTF Bridge” on page 140.

— Selecting the unit for reflection

— Specifying the cable settings, e.g. cable length
— Setting center frequency and span

— Calibration

The following sections describe unit selection, cable setting specifica-
tion, frequency selection and calibration.

Selecting the measurement unit

Unit

mRho

dB

The first preparative step for your distance-to-fault measurement is
selecting the unit. The distance to fault mode offers the units dB, mRho
and VSWR (voltage standing wave ratio, the ratio does not have a unit
and the results are higher than or equal to 1). For DTF measurements
a linear scale unit like the reflection factor Rho is of advantage. There-
fore the unit mRho is the default setting.

In order to select the measurement unit for your distance-to-fault
measurement proceed as follows:

1 In the Distance to Fault main menu select Level > Units. The Unit
menu is displayed on the right handside of the screen.

2 Select dB or mRho or VSWR by pressing the respective softkey
followed by ENTER.
The selected unit will be displayed on the left-hand side of the
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Specifying the cable length

results display: “Ref.” and “dB”, if you select dB. “Refl. factor” and
“mRho”, if you select Rho. “VSWR” without a unit if you select
VSWR.

Specifying the cable length

Selecting the distance
unit
Distance

Unit
m

Setting the length

One of the most important DTF measurement parameters is the cable
length. In order to achieve a practical results display it is recommended
to set the cable length to a value approximately 10 % higher than the
actual cable length. The cable length can be specified in metres or feet.

To select the distance unit proceed as follows:

1 In the Distance to Fault main menu press the Distance Unit Softkey.

2 Toggle the softkey to the required unit, metre or feet, and press
ENTER. The unit will be displayed in the cable length field of the
results display as well as on the Cable Length input field.

In order to set the cable length proceed as follows:

1 In the Distance to Fault main menu press the Cable Length softkey.
The Cable Length input field is displayed.

2 Enter the cable length in the unit specified and press ENTER.

Specifying cable settings

166

Using predefined
parameter files

Aeroflex provides predefined cable parameter files for most known
coaxial cables used for antenna installations whithin the 9100 Data
Exchange Software. These parameter files can easily be uploaded to
the 9102. However, the parameters for rare cable types can be set step
by step on the instrument.

You can upload files containing predefined cable types via the 9100
Data Exchange Software. For details on the upload procedure refer to
“9100 Data Exchange Software” on page 223. For a complete listing of
the predefined cable types available in the 9100 Data Exchange Soft-
ware refer to “Predefined cable types” on page 363. After uploading
the files the cable types are stored on your 9102 and available for
selection.

To select a cable type for a DTF measurement proceed as follows:

1 In the Distance to Fault main menu select Cable > Cable Memory.
The Cable Memory menu is displayed
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Setting center frequency and span

Press the Recall Cable Type softkey. A dropdown list containing all
cable types stored on the system is displayed.

Select the required cable type using the UP/DOWN arrow keys and
press ENTER. The settings of the selected cable type are now auto-
matically used for the DTF measurement.

For measurements on rare cable types the parameters can be set up
via the Cable Setting menu. For the values to be entered refer to the
manufactuer’s information for the cable to be measured. In order to
manually specify the cable parameters proceed as follows:

1

In the Distance to Fault main menu select Cable > Cable Setting.
The Cable Setting menu is displayed.

To specify the dielectric of the cable to be measured, which is
linked to the velocity factor, press the Cable Dielec. softkey. The
Cable Dielectric input field is displayed. Enter the cable dielectric
and press ENTER.

To specify the propagation velocity of the cable to be measured,
which is in turn linked to the dielectric, press the Cable Velocity
Factor softkey. The Cable Velocity Factor input field is displayed.
Enter the velocity factor and press ENTER.

To specify the cable’s cut off frequency in GHz, which is the
maximum frequency up to which the cable transmitts, press the
Cut Off Freq. softkey. The Cut Off Frequency input field is displayed.
Enter the frequency and press ENTER.

To specify the cable attenuation in dBm per 100m or dBm per 100
ft at

1 GHz of the cable to be measured press the Cable Attn. softkey.
This softkey can be toggled between dB/100m and dB/100 ft.
After pressing the softkey the Cable Attenuation input field will be
displayed accordingly. Enter the attenuation and press Enter.

Setting center frequency and span

Center

Sphan

aukto

1 Push the CENT function key or the Center softkey in the Distance to

Fault main menu.

The vertical softkeys include Center and Span. An entry field
appears, indicating the center frequency currently set and the step
size for the up/down cursor keys.

Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

Conclude the entry by pushing an enter key for the unit (GHz/DBm
for gigahertz, MHz/DB/ms for megahertz, KHz/DBmV/Ms for kilo-
hertz, or ENTER for hertz).
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4 Push the Span softkey. If you intend to set the span manually, enter
the frequency for the range from the left to the right end of the
display. If you want the span to be set automatically, toggle the
Span softkey to auto.

If you specify the same value for the center frequency as for the
cable cutoff frequency, your measurement becomes invalid as the
cutoff frequency is the maximum frequency up to which the cable
transmitts signals. In this case the measurement would not make any
sense. For details on specifying the cable cutoff frequency refer to
“Specifying cable settings” on page 166.

Distance to fault calibration

Before starting the measurement the instrument needs to be calibrated
with a reference match resistor. For details on available calibration sets
refer to “Options and accessories” on page 5 and “Calibration” on
page 142. On the left-hand side of the results display a red icon
reading “Calibrate” informs you that a calibration needs to be
performed.

To ensure that the calibration results in better rather than worse
measurement accuracy, it is important that you know and enter the
correct cable parameters for the cable between the instrument and
the calibration set. See Table 15 for the parameters of cables deliv-
ered by Aeroflex for this purpose.

In order to calibrate the instrument for your distance-to-fault measure-
ment proceed as follows:

1 Connect the test port extension cable to the 9160 VSWR/DTF
Bridge.

2 In the Distance to Fault main menu press DTF Cal. softkey. The
distance to fault Calibration menu is displayed.
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Distance

to Fault
Cal. Cah.
Dielec.
Cal. Cah.
Length

DTF Calibration

Connect SHORT to end of RF cable,

. il )
then press <Continue> @S |

[
Y
_II_ .
U =T
DTF Main Cancel !
Calibration

Figure 48 Distance to fault Calibration menu

3 Push the Cal. Cab. Dielec. key to enter the dielectric constant, «,.
See Table 15 for the dielectric of cables delivered by Aeroflex for
this purpose.

4 Push the Cal. Cab. Length key to enter the length of the calibration
cable. See Table 15 for the length of cables delivered by Aeroflex
for this purpose.

5 The 9102 will guide you through the calibration process by
onscreen messages as shown in Figure 48. When prompted as
shown connect the calibration set to the test port extension cable
and press Continue. You can abort the calibration process by
pressing the Cancel ! softkey.

6 When calibration is completed the Distance to Fault main menu will
be displayed again. On the left handside of the results display the
calibration icon will now be displayed in green and read “Calib’d”
(Calibrated).

NOTE

When performing a number of measurements it can be necessary to
repeat the calibration process due to temperature changes etc. This
is a regular behaviour. Furthermore, if you change the frequency
band, calibration has to be repeated. As soon as calibration is nec-
essary the 9102 will inform you by displaying the red “Calibrate”
icon.

Table 15 Parameters for Aeroflex-supplied cables

Dielectric

constant g, Length

Cable description

Test port extension cable 23 1.0 m (3.3 ft)
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Table 15 Parameters for Aeroflex-supplied cables

Cable description Dielectric Length
constant ¢,
SilverLine-TG™ TuffGrip™ 2.04 1.5 m (4.9 ft)

cable

Specifying the level parameters

After specifying the unit for your reflection meausrement you can
adjust the level parameters. Depending on the unit you specified via
the Units menu the display of the Level menu changes to enable you
to set the level parameters for the individual units as follows:

Setting the reference 1 In the main menu, push the Ref. softkey or select Level followed by
level for dB Ref. Alternatively, push the REF function key.
The Reference Level input field opens.

2 Enter the new reference level either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actual set output power.

Changing the vertical  The scale for the vertical axis (powen can be changed in the range
scale for dB8  from 1 to 20 dB per division (vertical line in the displayed grid) in 1-3-
5 steps as follows:

1 In the main menu, select Level.

2 Push the Scale softkey.
The Scale input field opens.

3 Select a new scale by entering a new number of dB per division
numerically and pressing the ENTER or MHz/DB/MS key, or by
pushing the UP/DOWN cursor keys.

Setting the maximum for 1 In the main menu, push the Max Refl Factor softkey or select Level
reflection factor followed by Max Refl Factor. Alternatively, push the REF function
key.
The Reference Level input field opens.

2 Enter the new maximum reflection factor either using the numeric
keys, closing the input field with the appropriate enter key, or with
the UP/DOWN arrow keys.

The new maximum reflection factor appears at the top of the
vertical axis.
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Changing the scale for  The scale for the vertical axis (power) can be changed in the range
reflection factor  from O to 2000 mRho per division (vertical line in the displayed grid) as
follows:

1 In the main menu, select Level.

2 Push the Refl. Factor Scale softkey.
The Refl. Factor Scale input field opens.

3 Select a new scale by entering a new number per division numeri-
cally and pressing the ENTER or MHz/DB/mS key, or by pushing the
UP/DOWN cursor keys.

Setting up the trace

The trace functions provide different views of the measurements, for
example the actual measurement or an average over the last couple of
measurements. You can even select two different views of the
measurement. Another possibility is to compare the actual measure-
ment with an older measurement which has been stored in the 9102
and loaded to one of the trace views. For details on setting up traces
refer to “Setting up the trace” on page 154 in Chapter 9 “Reflection
Operation”.

Using limits

As in the reflection mode you can also use limit lines for distance to
fault measurements. For details on the usage of limits refer to “Using
limit lines” on page 34 in Chapter 2 “General Operation”.

Viewing the distance to fault parameters

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
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opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey

Distance
to Fault
11:02:52 Parameter Window 22.08.2006
Center : 1.800000 GHz Cut Off Freq. : 4.000000 GHz
Span : 1.923148 GHz
Cable Memory : user-defined
Refl. Factor : 400 mRho Cable Length : 10.0 m
Attenuation : 0dB Cable Dielectric : 3.0
Impedance : a0 Ohm Cable Velocity F.: 0.58
Cable Attenuation : 0.500 dBf100Dm
RBW : 30 kHz Detector : Pos.fHeq.
VBW : 1 MHz
SWT: 300 ms
Press <Exit> to continue

Cahle Level Marker Trace DTF Exit
Calibration

Figure 49 Distance to fault parameters
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This chapter describes the instrument’s functions that are specific to
the reflection mode. Topics discussed in this chapter are as follows:

— “About the cable loss mode” on page 174

— “Selecting the measurement mode” on page 174

— “Preparative steps” on page 175

— “Changing the frequency settings” on page 175

— “Cable loss calibration” on page 178

— “Performing a limited number of measurements” on page 180
— “Using limits” on page 180

— “Viewing the cable loss parameters” on page 180
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About the cable loss mode

The cable loss mode is an additional measurement mode for deter-
mining the transmission quality of cables. It displays the average cable
loss in dB. For measurement similar parameters and procedures as for
the other VSWR/DTF measurement modes as well as cable calibration
are necessary.

Average Cable Loss

08 T Cable Loss conter

Ref. 10.0
_/xnh_,____,__,ﬁ_f—"m\f\ﬂ_ﬂ:,_n—____,_/x/—w—"\,__ﬁ_‘ Eian
-10.0
Ref.

Count
69

-30.0 E Scale
Filter
1 MHz
-350.0 auto
|_Scalar |
A (ACT
-70.0 !
. dgdh 360.0MHz/div Center: 1.800000GHz Span: 3.600000GHz SWT

=
Freq Level Marker Trace Cahle Loss 43.2 ms
Cal. anto

Figure 50 Cable loss measurement screen

Selecting the measurement mode

To select the cable loss mode, proceed as follows:

1 Push the MoDE function key.
The Mode menu appears.

2 Select VSWR/Tracking ... > Cable Loss.
The Cable Loss main menu appears.

This mode is available for selection, if the 9130 VSWR/DTF Reflec-
tion Measurement Option is installed and acitivated on your instru-
ment.
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Preparative steps

Before starting the measurement the following preparative steps are
necessary:

— Connecting the 9160 VSWR/DTF Bridge
For details on this procedure refer to “Connecting the 9160 VSWR/
DTF Bridge” on page 140.

— Selecting the desired frequency band
— Calibration

The next section section shows how to change the frequency settings
on the 9102. It is followed by a description of the calibration process.

Changing the frequency settings

Average Cable Loss

Cable Loss
0.3 dB Center
Ref. 10.0
_/\d\_,___‘_,__m.i__n—__,__mf—”\_.__._ Sha
dB :
-10.0
Start
Count
32 !
-30.0 : Eion
FStep
' 360 MHz
-50.0 ! auto
EETE : Full
A (ACT '
! Span !
-70.0 !
. ="="="= 360.0MHzfdiv Center: 1.600000GHz Span: 3.600000GHz
Zero
Freq L) Sweep Main Span !

Mode

Figure 51 Frequency menu

There are different methods to set the frequency range to be
measured; the range can be expressed by either the start and stop
frequencies (i.e. first and last frequency on the display), or by center
frequency and span (i.e. the center and the frequency range), or by
other combinations of center frequency, span, start and stop frequen-
cies.

All four parameters are accessible in the Freq menu. On the main

menu, however, only one of the combinations mentioned above is
shown, depending on the previously entered parameter.
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Setting center frequency

176

Setting start and stop
frequency

Start

Stop

and span

Center

Span

NOTE

Changing a frequency parameter may affect an associated parame-
ter.

Example: If you change the span to the maximum of 4 GHz, the start
and stop frequencies are changed to 0 and 4 GHz, respectively.

1 Push the CENT function key (or the Freq softkey in the Reflection
main menu).
The vertical softkeys include Start and Stop softkeys.

2 Push the Start softkey.
An entry field appears, indicating the start frequency currently set
and the step size for the UpP/DOWN cursor keys.

3 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

4 Conclude the entry by pushing an enter key for the unit (GHz/DBm
for gigahertz, MHz/pB/ms for megahertz).
If the start frequency entered is lower than the stop frequency, the
horizontal axis will display the range from the new start to the stop
frequency.
If the new start frequency is higher than or equal to the stop
frequency, the start frequency is used as the center frequency with
zero span, i.e. the signal at the selected frequency will be shown in
the time domain.

5 Push the Stop softkey and enter the frequency for the right end of
the display.

You can also place softkeys for the start and stop frequencies available
on the main menu by changing the frequency mode, see “Changing the
main menu for different frequency parameters”.

1 Push the CENT function key (or the Freq softkey in the Reflection
main menu).
The vertical softkeys include Center and Span. An entry field
appears, indicating the center frequency currently set and the step
size for the up/down cursor keys.

2 Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

3 Conclude the entry by pushing an enter key for the unit (GHz/DBMm
for Giga Hertz, MHz/pDB/Ms for Mega Hertz, KHz/DBMV/Ms for Kilo
Hertz, or ENTER for Hertz).

4 Push the Span softkey and enter the frequency for the range from
the left to the right end of the display.

You can also place softkeys for the center frequency and the span
available on the main menu by changing the frequency mode, see
section “Changing the main menu for different frequency parameters”
below.
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The Reflection main menu shows two softkeys for the definition of the
frequency range on the display. Different methods exist to define the
range as depicted above; you can configure these softkeys to one of
the two allowable combinations as follows:

1 From the Reflection main menu, select Freq > Freq Mode.

2 Select the combination of softkeys that you want to see in the main
menu (Start/Stop or Center/Span).

3 Return to the main menu by pushing the Main ... softkey.
The main menu appears and displays the selected combination of
keys.

Note that the description of the horizontal frequency axis changes with
the selected parameter set.

To change the frequency range to the full bandwidth supported by the
9102 for cable loss measurements, proceed as follows:

1 From the Reflection main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Full Span softkey.
The leftmost frequency changes to O Hz and the rightmost
frequency to 4 GHz.

Measurements on a selected center frequency can also be displayed
in the time domain.

1 From the Reflection main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Center softkey and enter the desired center frequency;
close the input field by selecting the appropriate unit with one of
the enter keys.

3 Push the Zero Span softkey.
The horizontal axis becomes the time axis. The scale width is iden-
tical to the sweep time.

The center, start and stop frequencies can be set either by entering a
new value with the numeric keys, or by using the arrow keys (UP,
DoOwN) to increase or decrease the current setting. The step size for an
arrow keypress can either be selected automatically by the 9102, or
manually adjusted.

Manually setting the frequency step size
1 From the Reflection main menu, select Freq.

2 Push the FStep softkey.
The Freq Step entry field opens.
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Cable loss calibration

178

3 Enter a new frequency step value and close the entry field by
pressing Enter. The auto/manual selection switches to manual and
the selected frequency step size is displayed on the softkey.

Setting the frequency step size selection to automatic
1 From the Reflection main menu, select Freq.

2 Push the FStep softkey several times until the “auto” selection is
highlighted.

Before starting the measurement the instrument needs to be calibrated
with a reference match resistor. For details on available calibration sets
refer to “Options and accessories” on page 5 and “Calibration” on
page 142. On the lefthand side of the results display a red icon reading
“Calibrate” informs you that a calibration needs to be performed. In
order to calibrate the instrument for your cable loss measurement
proceed as follows:

1 Connect the test port extension cable to the 9160 VSWR/DTF
Bridge.

2 In the reflection main menu press Cable Loss Cal. softkey. The
cable loss Calibration menu is displayed.

Average Cable Loss
P Cable Loss cal

Cable Loss Calibration

Connect OPEN to measurement port,

. il )
then press <Continue> (S |

Ey

H
. -
U =T
Cable Loss Main Cancel !

Figure 52 Cable Loss Calibration menu

3 The 9102 will guide you through the calibration process by
onscreen messages as shown in Figure 52. When prompted as
shown connect the calibration set to the test port extension cable
and press Continue. You can abort the calibration process by
pressing the Cancel ! softkey.
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4 When calibration is completed the Reflection main menu will be
displayed again. On the lefthand side of the results display the cali-
bration icon will now be displayed in green and read “Calib’d” (Cali-
brated).

The measurement graph shows full reflection (O dB cable loss) as soon
as the calibration set is removed. The instrument is now ready for
starting the cable loss measurement.

NOTE

When performing a number of measurements it can be necessary to
repeat the calibration process due to temperature changes etc. This
is a regular behaviour. Furthermore, if you change the frequency
band, calibration has to be repeated. As soon as calibration is nec-
essary the 9102 will inform you by displaying the red “Calibrate”
icon.

Setting up the level parameters

Setting the reference
level

Changing the vertical
scale

1 In the main menu, push the Ref. softkey or select Level followed by
Ref. Alternatively, push the REF function key.
The Reference Level input field opens.

2 Enter the new reference level either using the numeric keys,
closing the input field with the appropriate enter key, or with the
UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actual set output power.

The scale for the vertical axis (power) can be changed in the range
from 1 to 20 dB per division (vertical line in the displayed grid) in 1-3-
5 steps as follows:

1 In the main menu, select Level.

2 Push the Scale softkey.
The Scale input field opens.

3 Select a new scale by entering a new number of dB per division
numerically and pressing the ENTER or MHz/DB/MS key, or by
pushing the UP/DOWN cursor keys.
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Performing a limited number of measurements

The 9102 can run measurements continuously or a defined number of
times. Limiting the number of measurements can be useful for statis-
tical analyses. For details on limiting the number of measurements refer
to “Performing a limited number of measurements” on page 154 in
Chapter 9 “Reflection Operation”.

Using limits

As in the reflection mode you can also use limit lines for distance to
fault measurements. For details on the usage of limits refer to “Using
limit lines” on page 34 in Chapter 2 “General Operation”.

Viewing the cable loss parameters

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey

Average Cable Loss

Cable Loss
0.0 dB
09:14:50 Parameter Window 07.06.2003
Center : 1.800000 GHz Start : 0.000000 Hz
Span : 3.600000 GHz Stop : 3.600000 GHz
Reference 10.0 dB Trigger Mode : Free Run
Attenuation : 0dB Trigger Level : -40.0 dBm
Impedance : a0 Ohm Sweep : Continuous
Single Count : 1
Filter : 1 MHz Mode : Scalar
SWT: 43.2 ms
Press <Exit> to continue

Freq Level Marker Trace Cable Loss m Exit

Figure 53 Cable loss parameters
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This chapter describes the instrument’s functions that are specific to
the EMF (EMI) mode. Topics discussed in this chapter are as follows:

— “EMF measurements” on page 183

— “Measurement methods” on page 185

— “Measurement antennas” on page 188

— “EMF measurements with the 9102” on page 194

— “Connecting the antenna” on page 196

— “Selecting the measurement mode” on page 197

— “Selecting the unit” on page 197

— “Selecting the frequency range” on page 198

— “Selecting RBW, VBW and SWT” on page 201

— “Specifying the display calculation” on page 202

— “Specifying level settings” on page 202

— “Performing automatic measurements” on page 203
— “Performing manual measurements” on page 207

— “Using limits” on page 210

— “Using Markers” on page 210

— “Viewing the EMF (EMI) mode parameters” on page 210
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More and more sources of electromagnetic fields, mostly transmitters
for mobile radio, broadcasting and other radio services, are being
created and installed. Equipment for home and office communication
and other technical devices also contribute to the exposure to electro-
magnetic fields in the working environment and at home. For health
protection regulatory bodies have implemented limit recommenda-
tions which were turned into national laws. Network operators, compa-
nies installing transmitters for broadcasting and regulatory bodies are
faced by the challenge of verifying that limits specified for electromag-
netic fields are observed by the sources at hand.

The 9102 in conjunction with the 9131 EMF Measurement Option
offers the EMF (EMI) measurement mode allowing you to perform radi-
ation measurements easily and efficiently. All you need to effectively
record electromagnetic fields is the 9102 with the 9131 EMF Measure-
ment Option installed and the appropriate antenna for your measure-
ment method. Aeroflex offers a range of antennas for different
purposes. For further details on different measurement antenna types
refer to “Measurement antennas” on page 188. The following picture
shows a typical application example, an EMF measurement performed
using the 9102 in conjunction with an isotropic antenna, the Aeroflex
9171 Isotropic Antenna, mounted on a tripod.

The EMF (EMI) measurement mode enables you to perform automatic
EMF measurements upon the press of a button. In this mode, the 9102
measures the electromagnetic field over a user-definable frequency

range and displays the field strength in V/m or the power density in W/
mZ2. Al necessary functions, e.g. detecting the peak value over a given
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time period or integrating the broadband signal power over a given
frequency range, are available. You can compare the recorded
measurement values with the relevant threshold values.

Results can be displayed in logarithmic or linear format, the displayed
range quickly and easily being adapted to the measured signal. The
measured signals can be displayed both graphically and numerically in
logarithmic or linear terms as shown in the following example.

Electrical field strength Al 88.5dBpVim f948.20MHz

0.143426 Vim A4 79.6dBpVim f935.60MHz EM F (EM I) dBmim?
Ant. Factor: AT3000_X A3 84.3dBpVim f1.0002 GHz
A2  87.1dBpVim f956.20MHz

Unit

Ref. 117.0
Level
dBpPVim

dBmV/m

dBVim

370 !
="="="= 10.00MHz/div Center: 975.0000MHz Span: 100.0000MHz
Unit
izl Limits Limit Ant. Factor Main
Evaluation Memory Memory log

Figure 54 EMF (EMD measurement

Electromagnetic fields are usually measured over a defined frequency
range to determine the amount of radiation emitted by certain sources,
such as broadcast stations or mobile phone base stations. Thus,
measurements should be performed on a frequency where radiation is
expected, e.g. on a broadcast or cellular radio frequency. For precise
measurements a frequency-selective receiver with high sensitivity, a
large dynamic range and precise measurements of the field strength is
required. These are the prerequisites for accurate and reproducible
measurement results.

Basically, there are two different measurement approaches in EMF veri-
fication:

— Radiation emission and
— radiation immission
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Radiation emission

Measurement setup for
emission measurements

Radiation immission

The equipment and the methods used vary according to measurement
type. With the 9102 Handheld Spectrum Analyzer in conjunction with
the 9131 EMF Measurement Option and the appropriate accessories,
i.e. antennas, Aeroflex offers a measurement solution covering the
different approaches and requirements.

In the following two sections the radiation emission and immission
concepts are explained. Furthermore these sections provide you with
an overview on the equipment needed in order to perform EMF
measurements depending on the measurement approach.

Using this measurement type operators of cellular networks and
broadcast stations verify that the radiation of a particular transmitter
installed is within the limits specified by law and regulatory bodies. In
many countries worldwide regulatory bodies stipulate a proof of regu-
lation adherence. The radiation emission measurement is a directional
measurement determining the electromagnetic field emitted by a
transmitter. Within the measurement setup a directional antenna helps
to measure the emitted radiation.

For performing emission measurements according to ICNIRP (Interna-
tional Commission on Non-lonizing Radiation Protection) standard with
the 9102 you just need the following two pieces of equipment:

— 9102 Handheld Spectrum Analyzer equipped with the
9131 EMF Measurement Option and the 9132 RMS Detector
Option

— A directional antenna

Aeroflex offers two different directional antennas for performing radia-
tion emission measurements. For a detailed description of these two
antennas refer to “Directional antennas” on page 193.

This measurement setup consisting of the 9102 and the directional
antenna provides a handheld solution for performing radiation emis-
sion measurements easily and efficiently.

For engineering offices and regulatory bodies the specific radiation
exposure caused by all radiation sources in a particular place is of
special interest. During an immission measurement the electromag-
netic field exposure is measured at different locations within a desig-
nated area to identify minimum and/or maximum radiation. Typical
applications for this kind of measurement are for example:

— Measurements for defining security zones in close proximity of
transmitter sites
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— Measurements for determining radiation exposure of
representative and especially sensitive facilities, e.g. schools,
nursery schools and hospitals situated in proximity of transmitter
sites

— Long-term measurements for determining immission fluctuations

As for emission measurements you just need two pieces of equipment
for performing immission measurements with the 9102:

— 9102 Handheld Spectrum Analyzer equipped with the
9131 EMF Measurement Option and the 9132 RMS Detector
Option

— 9170 Biconical Antenna (for a detailed description refer to “9170
Biconical Antenna” on page 189)
or

— 9171 Isotropic Antenna (for a detailed description refer to “9171
Isotropic Antenna” on page 191)

The type of antenna you use depends on your measurement require-
ments. The detailed descriptions of the two different antenna types in
“Measurement antennas” on page 188 provide you with useful infor-
mation for selecting the appropriate measurement antenna for your
EMF measurement.

In this measurement setup the 9102 captures the electromagnetic
waves from all directions and displays the overall field strength in the
desired frequency range.

The location for performing EMF measurements is usually predefined.
A main goal of performing EMF measurements is determining the radi-
ation people are exposed to in their everyday life, so the measure-
ments are usually done at locations where people stay for a while, e.qg.
their work place, home, but also restaurants or sidewalks etc. At the
measurement locations a search for the maximum field strength has to
be performed in order to determine the radiation exposure caused for
example by mobile network base stations. For longterm EMF measure-
ments first the maximum field strength is determined and then the
antenna is placed on the location of maximum exposure. Basically
there are two methods for determining the maximum field strength
within a designated measurement area:

— The stirring method or

— the multipoint method
Using each of the two methods the user will move with the antenna
within the area to be measured as shown in the following graphic

depicting a user determining the maximum field strength using a
measurement setup involving an isotropic antenna.
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Using the stirring method the user sets the measurement instrument to
maximum hold and moves the antenna within the designated measure-
ment area. Depending on the antenna used the user has to be very
thorough in covering the designated measurement area in order to
capture the different locations, directions of incidence, and polarisa-
tions equally. Using an isotropic antenna directions of incidence and
polarisations can be neglected, thus an isotropic antenna provides a
more comfortable solution for using the stirring method. For further
details on the characteristics of different antennas refer to “Measure-
ment antennas” on page 188. After completing the coverage of the
designated measurement area the measurement instrument provides
the maximum field strength value.

The multipoint approach involves a predefined multipoint matrix
providing the user with designated measurement points. For this
purpose the dimensions of the measurement area first have to be
determined and the measurement points have to be specified. At each
measurement point a measurement has to be taken. As three measure-
ments are required at each point (one for each direction, xy, 2), it is
recommended to use an isotropic antenna for performing measure-
ments using the multipoint method. For further details on the charac-
teristics of different antennas refer to “Measurement antennas” on
page 188. The user performs the measurement at each of the
measurement points and documents the individual measurement
results.

Another possibility is to use a simplified approach to the multipoint
method. As for the stirring method the user sets the measurement
instrument to maximum hold and moves within the designated
measurement area covering all predefined measurement points using
an isotropic antenna.

Compared to the stirring method the multipoint method, whether in its
pure or in its simplified form, has the advantage of offering a guideline
to the user performing the measurements and thus constitutes a more
structured approach.

9102 Handheld Spectrum Analyzer  Software version 5.31 187



Chapter 12 EMF (EMI) Operation
Measurement antennas

Measurement antennas
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The antenna is one of the most important factors in EMF measure-
ments. There are different types of antennas which can be used for
measuring field strength depending on your measurement require-
ments. Aeroflex offers a range of antennas for different measurement
requirements:

— The 9170 Biconical Antenna with a frequency range from 60 to
2500 MHz for immission measurements

— The 9171 Isotropic Antenna with a frequency range from 50 to
3000 MHz for immission measurements

— The 9172 and 9173 Directional Antennas, two antennas with a
frequency range of 80 to 1000 MHz and 300 to 3000 MHz
respectively for emission measurements

For ordering details for Aeroflex antennas and antenna accessories
refer to “Options and accessories” on page 5.

During measurements the antenna converts the free progressive wave
into a line wave. For antenna calibration a correction table containing
k factors is required. These factors are proportionality factors which
correct the antenna'’s frequency response and help to convert the
measured power or voltage to field strength or power density. Using
the k factor table the measured level is converted into the relevant
quantities, the field strength measured in V/m and the power density
measured in W/mZ2.

Aeroflex delivers its measurement antennas in conjunction with the
appropriate correction factor tables. Using the 9100 Data Exchange
Software you can transfer the k factor tables delivered to your instru-
ment. With the 9171 Isotropic antenna this step is not neccessary as
the factors are stored in a memory inside the antenna interface. You
can also use the 9100 Data Exchange Software to collect the correc-
tion data for antennas from other vendors and transfer them to your
9102. For further details on using the 9100 Data Exchange Software
refer to Chapter 15 “9100 Data Exchange Software”. After transferring
the correction tables to the instrument they will be available for selec-
tion for EMF measurements.

Aeroflex also offers antenna accessories like a tripod as well as cali-
brated cables. Thus you will be able to master any situation in the field
using the 9102 and its accessories. If you use a tripod and cable setup
for your measurements, cable attenuation is taken into account by acti-
vating the appropriate cable factor on the instrument.

Following is a general technical description of the different measure-
ment antenna types providing information on the relevant measure-
ment purpose as well as technical details. For a detailed description of
all individual steps to be taken during EMF measurements using the
different measurement antenna types refer to “Performing automatic
measurements” on page 203 and “Performing manual measurements”
on page 207.
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9170 Biconical Antenna

Biconical antennas are characterised by their dipole-like structure. The
two reception lobes are highly symmetrical and provide the biconical
antenna with two main reception directions with an opening angle of
120° each.

When manually turning the biconical antenna during measurements
into three main panes (x, y, z) the same antenna element is used for the
measurements in each of the different directions. This leads to an
unmatched isotropy and thus makes biconical antennas most suitable
for high-precision measurements. Mounting the antenna on a turning
device you can easily turn the antenna in the directions indicated on
the device and perform the measurements for each pane. Thereby a
globe-like coverage for the measurement, comparable to the one using
an isotropic antenna, is achieved as shown in the following graphic.

The 9102 supports consecutive measurements in three axes and auto-
matically calculates the resulting field strength.

Aeroflex offers the 9170 Biconical Antenna for EMF immission
measurements with the 9102 and the 9131 EMF Measurement Option.
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The delivery includes:

Antenna

steps

Clip with a 1/4 inch thread for an optional tripod and stops in 120°

— 10 m calibrated ferrite beaded coaxial cable
— Calibration certificate and k factor table

Following are the 9170 Biconical Antenna’s technical specifications:

Antenna type

Frequency range
Sensitivity

Maximum applicable field
strength

Dipole balun symmetry
60 to 80 MHz
80 MHz to 3 GHz

Isotropy error
up to 1.5 GHz
1510 2.2 GHz
2.2t0 3 GHz

Dimensions
Width
Length
Weight

RF connector

Operational temperature
range

Environmental protection
class

RoHS-compliant

Biconical (linear passive
device)

60 MHz to 2.5 GHz
> 0.5 mV/m
> 300 V/m

+0.6 dB
+0.2 dB

<0.5dB
<0.9 dB
<12dB

200 mm
250 mm
2.4 kg

N type
-30°C to +55°C

IP44
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9171 Isotropic Antenna

e

The most comfortable and fastest solution for performing EMF immis-
sion measurements comprises using an isotropic antenna. In an
isotropic antenna three antennas or dipole elements, one for each
direction (x, y and 2), are arranged orthonogally and combined by inter-
connection as shown in the following graphic.

Aeroflex offers the 9171 Isotropic Antenna for EMF immission
measurements with the 9102 equipped with the 9131 EMF Measure-
ment Option. The 9171 Isotropic Antenna is controlled by the 9102
Handheld Spectrum Analyzer, rendering manual rotation of the
antenna during measurements unnecessary. This antenna enables you
to perform fast automatic measurements. Remote control is achieved
by way of a circuit integrated into the antenna. The circuit is connected
to the 9102’s Multi Port connector via an additional shielded cable with
a high-precision connector. Via this connection the 9102 also reads the
calibration data, i.e. the k factor correction information, automatically
from the EPROM within the circuit.

9102 Handheld Spectrum Analyzer  Software version 5.31 191



Chapter 12 EMF (EMI) Operation
Measurement antennas

192

As soon as you connect the cable to the 9102's Multiport the instru-
ment automatically detects the antenna and loads a set of individual
calibration values from the antenna. On starting the measurement the
instrument automatically controls the antenna'’s receiving direction,

performs the measurements in each direction and calculates the

isotropic total value from the three individual measurement values.

The delivery includes:

— Antenna

— Clip with 1/4 inch thead for an optional tripod

— 6 m combined remote control cable and a calibrated ferrite-

beaded coaxial cable

— Antenna interface (control and calibration data)
— Calibration certificate and k factor table

NOTE

The 9171 Isotropic Antenna is delivered in a case. Please retain this
case for proper packing in case you want to dispatch the antenna to

Aeroflex for calibration.

Following are the 9171 Isotropic Antenna'’s technical specifications:

Antenna type

Frequency range
Sensitivity

Maximum applicable field
strength

Dipole balun symmetry
50 to 80 MHz
80 MHz to 3 GHz

Isotropy error vertical polariza-
tion

up to 1.7 GHz

1.7 to 2.1 GHz

2.1 to 3 GHz

Isotropy error horizontal
polarization

up to 1.2 GHz

1.2to 1.7 GHz

1.7 t0 2.1 GHz

2.11to 3 GHz

Dimensions
Radome diameter
Length

Weight

Isotropic transducer with 3
orthogonal dipole antennas

30 MHz to 3 GHz
<5 mV/m
< 300 V/m

+0.6 dB
+0.2 dB

+0.5 dB
+1.0 dB
+0.5 dB

+0.5 dB
+1.0dB
+0.5 dB
+1.0dB

200 mm
520 mm
0.5 kg
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Measurement antennas
RF connector N type
Operational temperature -20°C to +60°C
range
Environmental protection IP 54
class
RoHS-compliant
Ll I ] I I ’ ' \

mHl]ll’ l -

Directional antennas are log-periodic broadband antennas covering a
wide spectrum of applications. They are typically used for measuring
the emission from a specific antenna site.

Aeroflex offers two different directional antennas of 1 m length each
accommodating different frequency ranges:

— 9172 Directional Antenna - 80 to 100 MHz
— 9173 Directional Antenna - 300 to 3000 MHz

Thanks to their small angle of beam and their excellent frequency
response, these two directional antennas can also be used for EMF
prequalification and for finding interferers. With these two antenna
types and their overlapping frequency ranges, the whole range of
commercial range of radio services is covered.

The delivery includes:

— Antenna
— Clip with 5/8 thread for an optional tripod

Following are the 9172 and 9173 Directional Antenna’s technical spec-
ifications:

Frequency range 80 to 100 MHz and
300 MHz to 3000 MHz

Maximum transmission power > 0.5 mV/m

(CW)

Maximum applicable field >300 V/m

strengh
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Nominal impedance 50 Q

VSWR (typically) <20

RF connector N female

Polarisation Linear (vertical/horizontal)

Calibration CISPR

Pole clamp 5/8“ UNC thread 37 mm
round flange

Size (length x width) 1mx0.55m

Weight 2.4 kg

EMF measurements with the 9102

194

As explained the 9102 in conjunction with the 9131 EMF Measurement
Option and it's antenna acessory range provides you with a measure-
ment solution suitable for performing EMF measurements according to
your specific measurement requirements.

In EMF (EMD mode the 9102 measures the electrical field strength (E)
as well as the power density (S) to enable you to compare the
measured EMF with the binding limits specified by the responsible
regulatory bodies. You can specify which result should be displayed.
For further details on specifying the value to be displayed in your EMF
measurement refer to “Specifying the display calculation” on

page 202.

The display unit for the electrical field strength is V/m.

The electrical field strength is calculated as the square root taken from
S x R, with R being the air wave resistance of 377 Q.

The 9102 displays the total electrical field strength by adding all mea-
surement values measured for the three directions x, y, z.

Eresult is Calculated as the square root taken from Eyesuir®+ Eyresutt®+

Ezresult :

The display unit for the power density is W/m?2.
It is calculated as S = E,? + Rg. Ry again being the air wave resistance
of 377 Q.

The following sections explain how to perform EMF measurements
with the 9102 differentiating between auto and quick mode used for
automatic measurements involving the 9171 Isotropic Antenna and
manual mode used for manual measurements involving the 9170
Biconical Antenna. The preparative steps which have to be performed
before starting the actual measurement, e.g. selecting the EMF (EMI)
measurement mode, setting the required frequency range, selecting
the measurement unit and specifying the measurement result to be
displayed (power density or field strength) are identical for both
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measurements with the exception of connecting the antennas to the
9102. The steps involved in this procedure depend on the antenna
used.

NOTE

Due to the physical nature of EMF measurements the following has
to be taken into account.

When performing measurements on broadband signals the
electrical field strength or the power density displayed may show
deviations. In this case the measurement has to be performed via a
channel power measurement. Furthermore a very big or very small
relation between span and RBW may lead to false measurements or
invalid measurement results.
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Connecting the antenna

As afirst step you establish the appropriate hardware setup for the EMF
measurement according to measurement type. As explained before
the type of antenna you use depends on measurement type and
measurement method. For further details on which antenna to use
refer to “EMF measurements” on page 183 and “Measurement
antennas” on page 188.

Connecting the 9170  To establish a connection between the 9102 and the 9170 Biconical
Biconical Antenna  Antenna simply connect the antenna via an RF cable to the 9102's RF
in connector.

Connecting the 9171  To establish a connection between the 9102 and the 9171 Isotropic
Isotropic Antenna  Antenna connect the antenna directly to the 9102’s RF in connector
and connect the controller cable to the 9102’s Multi Port connector. As
soon as you have connected the antenna to both connectors the 9102
automatically detects the antenna and loads the correction data.

If you connect the antenna controller to the instrument with the EMF
(EMD mode already running, it takes about 10 seconds for the 9102
to detect the antenna. In order to avoid any disturbance of the pro-
cess do not press any buttons on the instrument during this time.

After the antenna is detected and the correction data are loaded the
9102 switches to the Level menu and the Antenna Factor softkey is
highlighted. To activate the antenna factor press the Antenna Factor
softkey until on is highlighted.

Connecting a directional  To establish a connection between the 9102 and one of the two direc-
antenna tional antennas, the 9172 or 9173 Directional Antenna, simply connect
the antenna via an RF cable to the RF 9102’s RF in connector.

Using a tripod  As a measurement antenna accessory Aeroflex offers a wooden tripod.
For ordering details refer to “Options and accessories” on page 5.
Using this tripod you can for example set the 9170 Biconical Antenna
up for turning. For setting up the appropriate antenna on the tripod, first
fix the appropriate adapter on the tripod and then fix the antenna to the
adapter. Then you can use the appropriate extension cable to connect
the antennato the 9102. In case of the 9171 Isotropic Antenna you also
have to connect the controller cable to the 9102's Multi Port as
described in “Connecting the 9171 Isotropic Antenna” on page 196.
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Selecting the measurement mode

To select the EMF (EMD mode, proceed as follows:
1 Push the MoDE function key.
The Mode menu appears.

2 Select EMF (EMI).
The EMF (EMI) main menu appears.

This mode is available for selection, if the 9130 EMF Measurement
Option is installed and activated on your instrument.

Selecting the unit

After selecting the EMF (EMD measurement mode the next step is to
select the unit.

1 In the main menu, select Level > Units.

2 You can use logarithmic or linear units. In order to toggle the
display between logarithmic and linear units press the Unit softkey
in the lower right corner of the display and select log or lin.

3 You can now choose between the following units via the Unit
softkey in the upper right corner of the display.
Logarithmic units: dBpV/m, dBmV/m and dBV/m
Linear units: V/m, mW/m?
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Selecting the frequency range
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Figure 55 Frequency menu

There are different methods to set the frequency range to be
measured; the range can be expressed by either the start and stop
frequencies (i.e. first and last frequencies on the display), or by center
frequency and span (i.e. the center and the frequency range), or by
other combinations of center frequency, span, start and stop frequen-
cies.

All four parameters are accessible in the Freq menu. On the main
menu, however, only one of the combinations mentioned above is
shown, depending on the parameter last entered.

NOTE

Changing a frequency parameter may affect an associated parame-
ter.

Example: In a unit without the frequency extension option installed, if
you change the span to the maximum of 4 GHz, the start and stop
frequencies are changed to 0 and 4 GHz, respectively.

The following section concentrate on the different methods of setting
the frequency, which is one of the preparative steps for EMF measure-
ments. For descriptions of further Frequency menu functions (e.g.
Trigger) refer to Chapter 3 “Spectrum Analysis Operation”.
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Push the CENT function key (or the Freq softkey in the Reflection
main menu).
The vertical softkeys include Start and Stop softkeys.

Push the Start softkey.
An entry field appears, indicating the start frequency currently set
and the step size for the UP/DOWN cursor keys.

Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

Conclude the entry by pushing an enter key for the unit (GHz/DBM
for gigahertz, MHz/DB/ms for megahertz).

If the start frequency entered is lower than the stop frequency, the
horizontal axis will display the range from the new start to the stop
frequency.

If the new start frequency is higher than or equal to the stop
frequency, the start frequency is used as the center frequency with
zero span, i.e. the signal at the selected frequency will be shown in
the time domain.

Push the Stop softkey and enter the frequency for the right end of
the display.

You can also place softkeys for the start and stop frequencies available
on the main menu by changing the frequency mode, see “Changing the
main menu for different frequency parameters”.

-_

Push the CENT function key (or the Freq softkey in the Reflection
main menu).

The vertical softkeys include Center and Span. An entry field
appears, indicating the center frequency currently set and the step
size for the up/down cursor keys.

Enter a new frequency using the numeric keys, the cursor keys and
the BACKSPACE key.

Conclude the entry by pushing an enter key for the unit (GHz/DBM
for gigahertz, MHz/pB/ms for megahertz, KHz/bBmV/Ms for kilo-
hertz, or ENTER for hertz).

Push the Span softkey and enter the frequency for the range from
the left to the right end of the display.

You can also place softkeys for the center frequency and the span
available on the main menu by changing the frequency mode, see
section “Changing the main menu for different frequency parameters”
below.
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Changing the main
menu for different
frequency parameters

Freq Mode

Startf
Stop

Viewing the complete
frequency band

Full
Span !

Performing
measurements in the
time domain

fero
Span !

Selecting the step size
for the frequency input

Fstep
100 kHz
aunkto
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The Reflection main menu shows two softkeys for the definition of the
frequency range on the display. Different methods exist to define the
range as depicted above; you can configure these softkeys to one of
the two allowable combinations as follows:

1 From the Reflection main menu, select Freq > Freq Mode.

2 Select the combination of softkeys that you want to see in the main
menu (Start/Stop or Center/Span).

3 Return to the main menu by pushing the Main ... softkey.
The main menu appears and displays the selected combination of
keys.

Note that the description of the horizontal frequency axis changes with
the selected parameter set.

To change the frequency range to the full bandwidth supported by the
9102, proceed as follows:

1 From the Reflection main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Full Span softkey.
The leftmost frequency changes to O Hz and the rightmost
frequency to 4 GHz, or 7.5 GHz if the frequency extension option is
installed

Measurements on a selected center frequency can also be displayed
in the time domain.

1 From the Reflection main menu, push the Freq softkey.
The Frequency menu is displayed.

2 Push the Center softkey and enter the desired center frequency;
close the input field by selecting the appropriate unit with one of
the enter keys.

3 Push the Zero Span softkey.
The horizontal axis becomes the time axis. The scale width is iden-
tical to the sweep time.

The center, start and stop frequencies can be set either by entering a
new value with the numeric keys, or by using the arrow keys (Up,
DownN) to increase or decrease the current setting. The step size for an
arrow keypress can either be selected automatically by the 9102, or
manually adjusted.

Manually setting the frequency step size

1 From the Reflection main menu, select Freq.
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2 Push the FStep softkey.
The Freq Step entry field opens.

3 Enter a new frequency step value and close the entry field by
pressing Enter. The auto/manual selection switches to manual and
the selected frequency step size is displayed on the softkey.

Setting the frequency step size selection to automatic
1 From the Reflection main menu, select Fregq.

2 Push the FStep softkey several times until the “auto” selection is
highlighted.

Selecting RBW, VBW and SWT

RBYW
1 MHz
auko

B
1 MHz
aukto

SWT
43.2 ms

aukto

The resolution bandwidth (RBW) is the 3 dB bandwidth of the IF filter
for selecting the signal to be measured. The resolution bandwidth
describes the ability of the spectrum analyzer to discriminate between
adjacent signals of similar amplitude. Only signals spaced at a
frequency of more than the RBW can be discriminated from one
another.

The 9102 can be set to automatically select the resolution bandwidth,
depending on the frequency span. The EMF (EMD measurement mode
offers two special RBW filters requried for EMC prequalification tests:
120 kHz and 9 kHz at 6 dB.

The video bandwidth (VBW) is the lowpass bandwidth over which
several results for one frequency point are smoothened. The lower the
video bandwidth, the smoother the signal curve and the less variations
there are.

The 9102 can be set to select the video bandwidth automatically as a
function of the resolution bandwidth.

The sweep time (SWT) determines how long it takes for a complete
sweep over the measured frequency range (span).

The 9102 can be set to automatically select the sweep time, depending
on RBW and VBW. If manually set, the sweep time should be selected
long enough for the filtered signal to reach steady state. The 9102 will
output an “UNCALibrated” warning if the sweep time is too low.

To set the resolution bandwidth, the video bandwidth or the sweep
time, proceed as follows:

1 In the main menu, select the appropriate softkey (RBW, VBW, or
SWT).

2 Enter the value and complete the entry with the appropriate enter
key for the unit, select a new value with the help of the UP/DOWN
cursor keys, or switch to auto to leave the setting to the 9102.

Changing between automatic and manual mode

Push the appropriate softkey (RBW, VBW, or SWT) several times until
the desired selection (auto or manual) is highlighted.
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Specifying the display calculation

The 9102 measures electrical field strength (B) in V/m as well as the
power density (S) in W/m?. For further information about these two
values and their interdependence refer to “EMF measurements with
the 9102" on page 194. You can switch the display between these two
results values.

This step is preparative and has to be taken before you start your
actual measurement in automatic or manual mode.

To switch the display between electrical field strength and power

s density proceed as follows:
[vim]
Display 1 In the EMF (EMI) main menu select Measure > Display Calculation.

2 Toggle the Display softkey until the required option, E for electrical
field strength and S for power density, is highlighted. In the upper
left corner of the display the appropriate value will be displayed
during your measurement in the relevant unit: electrical field
strength in V/m and power density in
W/m?.

Specifying level settings

The accuracy and the dynamic range between the measured signal
and the noise floor depend on the proper setting of the level settings.
These consist of the reference level and the attenuation.

The reference level basically determines the level at the top of the
display. The vertical axis is divided into eight horizontal lines; you can
adjust the scale (which defaults to 10 dB per line) to your preferences.

Attenuation or gain due to external coupling can be compensated by
frequency-dependent coupling factors, so that the displayed measure-
ment values reflect the power at the device under test.

Setting the reference 1 In the main menu, push the Ref. Level softkey. You can also select
level Level followed by Ref. Level Alternatively, push the REF function
key.
The reference level input field opens.
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NOTE

Depending on the unit you use and the specified display calculation
the Ref. Level softkey changes to Ref. Power or Ref. Voltage. Further-
more the input field name and the display on the left-hand side of
the screen changes accordingly.

2 Enter the new reference power or voltage either using the numeric
keys, closing the input field with the appropriate enter key, or with
the UP/DOWN arrow keys.

The new reference level appears at the top of the vertical axis. The
reference is based on the actually set output power.

1 In the main menu, push the Attenuation softkey.
The Attenuation input field opens.

2 Enter a new attenuation value in the range from 0 to 50 dB (in
10 dB steps) and close the input field with one of the enter keys, or
use the UP/DOWN arrow keys to select the attenuation value in the
range 10 to 50 dB.
If the attenuation value is changed, the attenuation option will
change to “manual”.

Performing automatic measurements

When using the 9171 Isotropic Antenna you can perform measure-
ments in automatic mode. A prerequisite for performing automatic
measurements is that the 9171 Isotropic Antenna’s controller cable is
connected to the 9102’s multiport. Via this connection the 9102 reads
the relevant correction data from the antenna and controls the
measurement. However, if you use a tripod measurement setup in
conjunction with an extension cable, the cable attenuation also has to
be taken into account by using cable correction data.

There are two different options selectable from the Measure menu for
performing automatic measurements: Auto and Quick. The two
different modes are described in “Auto measurements” on page 205
and “Quick measurements” on page 207.

NOTE

If the 9171 Isotropic Antenna is not connected via its controller cable
to the 9102's Multi Port, the two softkeys Auto and Quick will be
greyed out in the EMF (EMID Measure menu.
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Activating the antenna  Assoon as you have connected the antenna to the RF In connector and
factor settings  the antenna controller to the Multi Port connector of the 9102, the
instrument automatically detects the antenna and loads the correction
data.

If you connect the antenna controller to the instrument with the EMF
(EMD mode already running, it takes about 10 seconds for the 9102
to detect the antenna. In order to avoid any disturbance of the pro-
cess do not press any buttons on the instrument during this time.

After the antenna is detected and the correction data are loaded the
9102 switches to the Level menu and the Antenna Factor softkey is
highlighted. To activate the antenna factor press the Antenna Factor
softkey until on is highlighted.

Specifying cable factor If you are using an extension cable to connect the 9171 Isotropic
settings for extension ~ Antenna to your 9102, for example for mounting it on a tripod, cable
cables attenuation has to be taken into account by activating the appropriate
cable correction factor. Cable factors are maintained and edited within
the 9100 Data Exchange Software. You can transfer them to your 9102
for usage within EMF measurements. For further details refer to
“Managing cable factors for EMF measurements” on page 250 in
Chapter 15 “9100 Data Exchange Software”.

In order to employ cable correction data for your measurement
proceed as follows:

1 Inthe EMF (EMD main menu select Level > Ant. Factor Memory. The
Antenna Factor Memory is displayed.

Power density Recall
0.000004 W/m2 EMF (EM I) enna
Ant. Factor: not loaded Factor
Ref. 20.4 Recall
Level Cable
dBmim? : [REIET?
0.4 Delete
. Antenna
Factor
Count '
952 ' Delete
-19.6 ! Cahle
X--= . Factor
-39.6
| RMS | : Delete
A (MAX) | : Al
Ant. Fac.
-39.6 !
260.0MHz/div Start: 1.000000GHz Stop: 3.600000GHz Delete

Level Units Limits Limit ant. Factor Main All
Evaluation Memory Memory Cah. Fac.

Figure 56 Antenna Factor menu
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2 Press the Recall Cable Factor softkey. A dropdown list showing all
cable factors stored on the system is displayed.

3 Select the cable factor you intend to use and press ENTER. Now the
Level menu is displayed again with the Cable Factor softkey high-
lighted.

4 To activate the cable factor selected toggle the Cable Factor softkey
until on is highlighted.

Auto measurements provide you with the comfort of the 9102 control-
ling the measurement process for all three measurement panes. Once
you start your Auto measurement the 9102 will run automatically
through all measurements and calculate and display the overall
measurement result from the individual results for x, y and z. However,
you can specify the measurement time.

To start an Auto measurement proceed as follows:

1 In the EMF (EMI) main menu select Measure. The EMF (EMI)
Measure menu is displayed.

Electrical field strength

0.163452 V/m EMF (EM I) off
Ant. Factor: AT3000_X

Ref. 117.0 "

Level Manual
dBpPVim
97.0

| uto |
Quick

Continue !

37.0 !
ol 10.00MHz{div Center: 975.0000MHz Span: 100.0000MHz

Display Main Cancel !
Calculation

Figure 57 Measure menu

N

In the Measure menu select Meas. Time. An input field for the
measurement time will be displayed.

w

Enter the time intervall to be used for measuring on each of the
measurement panes. The default is 360 seconds, the maximum
value is 600 seconds. Press ENTER to set the measurement time.

1N

Now select the Auto softkey and press Continue ! to start the Auto
measurement.
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5 On the right-hand side of the display the red Measure indicator
shows that a measurement is in progress: [IEEaa-
Above this indicator the direction measured is shown (x as the first

one): IEEETE.

You can abort the measurement by pressing the Cancel ! softkey.

6 On completing the measurement for the x measurement pane the
Measure indicator disappears and the 9102 automatically switches
to y followed by z.
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7 On completion of the measurement the measurement result is
displayed with the graph automatically put on hold and the overall
calculated electrical field strength or power density, depending on
the selection you have made via Measure > Display Calculation (see
“Specifying the display calculation” on page 202) is displayed. You
can now save your results trace on the instrument.

To clear the trace and start a new measurement press the HOLD/RUN
function key or the Auto softkey. You can also press the Quick or
Manual softkey, if you intend to perform a measurement of one of these
types.

Quick measurements  Quick measurements are a convenient way of quickly determining the
maximum field strength by fast measurements with a predefined
measurement duration of one single sweep per measurement pane (x,
y, 2). Apart from the predefined measurement duration the measure-
ment process is identical.

To start a quick measurement proceed as follows:

1 In the EMF (EMI main menu select Measure. Now, the EMF (EMI)
Measure menu is displayed.

2 Select the Quick softkey and press Continue ! to start the quick
measurement. You can abort the measurement by pressing Cancel
1. From now on the measurement process is identical with the
process described for Auto measurements.

Performing manual measurements

The manual measurement mode provides you with a comfortable way
of performing EMF measurements using the 9170 Biconical Antenna.
For this type of EMF measurement the 9170 Biconical Antenna is
turned manually in each of the measurement directions (x, y and 2),
usually mounted on a turning device. For each direction the 9102
performs the measurement of electrical field strength or power density
depending on the selection you have made via Measure > Display
Calculation (see “Specifying the display calculation” on page 202). You
start the individual measurements manually after turning the antenna
in the relevant direction. As for automatic measurements you can also
specify the measurement time for each direction. On completing all
three measurements the 9102 calculates the total result value.

As the k factor correction data are not automatically loaded and acti-
vated when using a biconical antenna you have to activate the appro-
priate correction table manually on your instrument. Also, as the
biconical antenna will often be mounted on a tripod and connected to
the 9102 via an extension cable, the cable factor has to be activated
manually.
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Specifying antenna
factor settings

Specifying cable factor

208

settings for extension
cables

Performing the
measurement

The following sections describe all steps which are specific to manual
measurements. The preparative steps which have to be performed
before starting the actual measurement, e.g. selecting the EMF (EMI)
measurement mode, setting the required frequency range, selecting
the measurement unit and specifying the measurement result to be
displayed (power density or field strength) are identical for both manual
and automatic measurements.

The scope of delivery of the 9170 Biconical Antenna includes the
appropriate

k factor correction table. The data are available within the 9100 Data
Exchange Software. For details on downloading the data to the 9102
and managing antenna factors within the 9100 Data Exchange Soft-
ware refer to “Managing antenna factors for EMF measurements” on
page 248 in Chapter 15 “9100 Data Exchange Software”.

To activate the appropriate antenna factor for your EMF measurement
proceed as follows:

1 In the EMF (EMI) main menu select Level > Ant. Factor Memory. The
Antenna Factor Memory is displayed (see Figure 56 on page 204).

2 Press the Recall Antenna Factor softkey. A dropdown list showing
all antenna factors stored on the system is displayed.

3 Select the appropriate antenna factor and press ENTER. Now the
Level menu is displayed again.

To activate the antenna factor selected toggle the Antenna Factor
softkey until on is highlighted.

If you are using an extension cable to connect the 9172 Biconic
Antenna to your 9102, for example for mounting it on a tripod, cable
attenuation has to be taken into account by activating the appropriate
cable correction factor. Cable factors are maintained and edited within
the 9100 Data Exchange Software. You can transfer them to your 9102
for usage within EMF measurements. For further details refer to
“Managing cable factors for EMF measurements” on page 250 in
Chapter 15 “9100 Data Exchange Software”. The procedure of speci-
fying cable factor settings for manual measurements is identical to the
one described for automatic measurements. For details refer to
“Performing manual measurements” on page 207.

To perform a manual measurement proceed as follows:
1 In the Measure menu select Meas. Time. An input field for the
measurement time will be displayed.

2 Enter the time interval to be used for measuring on each of the
measurement panes. The default is 360 seconds, the maximum
value is 600 seconds. Press ENTER to set the measurement time.
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3 Now select the Manual softkey. The softkeys for the three different
measurement directions (x, y and z) are available on the right-hand
side with x highlighted as the first measurement direction and the x
direction indicator displayed on the left-hand side as shown in the
following picture.

Power density
0.000003 W/m? EMF (EM I)

Ant. Factor: not loaded

off

Continue !

-59.6 !
260.0MHzfdiv Start: 1.000000GHz Stop: 3.600000GHz
Display Main Cancel !
Calculation

Figure 58 Softkeys for manual measurements

H

Press Continue ! to start the first measurement. On the right-hand
side of the display the red Measure indicator shows that a
measurement is in progress: |[FEEE

You can abort the measurement by pressing the Cancel ! softkey.
After completion of the measurement the Measure indicator disap-
pears.

a

Now press the Y softkey followed by Continue ! to start the
measurement for the y direction. The procedure is identical to the
one described for the x direction above.

6 After completion of the y measurement press the Z softkey
followed by Continue !. The procedure is identical to the one
described for the x direction above.

7 On completion of the measurement the measurement result is
displayed with the graph automatically put on hold and the overall
calculated electrical field strength or power density, depending on
the selection you have made via Measure > Display Calculation (see
“Specifying the display calculation” on page 202) is displayed. You
can now save your results trace on the instrument.

To clear the trace and start a new measurement press the HOLD/RUN
function key or the Manual softkey.
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Setting up the trace

Using limits

Using Markers

The trace functions provide different views of the measurements, for
example the actual measurement or an average over the last couple of
measurements. You can even select two different views of the
measurement. Another possibility is to compare the actual measure-
ment with an older measurement which has been stored in the 9102
and loaded to one of the trace views. For details on setting up traces
refer to “Setting up the trace” on page 67 in Chapter 3 “Spectrum
Analysis Operation”.

As in the reflection mode you can also use limit lines for distance to
fault measurements. For details on the usage of limits refer to “Using
limit lines” on page 34 in Chapter 2 “General Operation”.

The 9102 includes powerful and easy-to-use marker functions. To
further analyze your measurement result display you can employ up to
six markers. For a detailed description of the usage of markers refer to
“Working with the markers” on page 31.

Viewing the EMF (EMI) mode parameters

210

You can get an overview of all parameters set for this mode in the
Parameter Window. To view the parameters, press the PARAM function
key. To close the Parameter Window and return to the menu you
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opened it from, press the ESCAPE function key, the Exit softkey or the
PARAM function key. To close the parameter page and change to the
relevant main menu press the Main softkey

Electrical field strength
0.034863 V/m EMF (EM I)

Ant. Factor: not loaded

11:06:43 Parameter Window 03.11.2003
Center : 1.800000 GHz Start : 0.000000 Hz
Span : 3.600000 GHz Stop : 3.600000 GHz
Ref. Level : 107.0 dBpvim Trigger Mode : Free Run
Attenuation : 30 dB Trigger Level : 67.0 dBpVim
Impedance : a0 Ohm Sweep : Continuous

Single Count : 1
RBW : 1 MHz Detector : RM3
VBW : 1 MHz
SWT: 43.2 ms
Press <Exit> to continue

Freq Level Marker Trace Measure m Exit

Figure 59 EMF (EMD parameters
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Troubleshooting

This chapter provides information on handling errors and problems
related to the 9102 Handheld Spectrum Analyzer.
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Recharging problems with the 9102B

If a 9102B (serial number 0604001 and higher) is completely
discharged then it may happen that the 9102B does not automatically
re-charge the battery while connected to an external power supply.

In such a case, to reset the "safety power-off switch", please carry out
the following steps:

1 Switch off the 9102B.

Remove the power connector from the 9102B.
Remove the battery.

Wait a few seconds.

Insert the battery again.

o G b~ WN

Re-connect the power connector and provide external power.
The LED on the front will show that the battery is charged again.
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Handling system errors

Should an error or problem occur that prevents you from controlling
the instrument and thus requires the instrument software to be set up
again, the 9102 offers the Setup Application Software menu. This menu
provides you with access to the instrument without starting the instru-
ment software and enables you to perform a software update.

Chapter 14 “Updating the Instrument Software” contains a detailed

description of the processes involved in updating the instrument’s soft-
ware via the Setup Application Software menu.
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Updating the Instrument
Software

This chapter describes how to perform an update of the instrument’s
software via the 9102 Handheld Spectrum Analyzer's Setup Applica-
tion Software menu. Topics discussed in this chapter include the
following:

— “Entering the Setup Application Software menu” on page 218
— “Setting a password” on page 218

— “Performing a serial update” on page 219

— “Performing a LAN update” on page 221

— “Determining the Host IP address” on page 222
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Entering the Setup Application Software menu

Setting a password

218

The 9102 Handheld Spectrum Analyzer's Setup Application Software
menu can be entered instead of automatically loading the instrument
software. This menu provides you with access to the instrument in case
an error or problem should occur that prevents you from controlling it
and requires the instrument software to be set up again. The menu
offers two options for the update process: Serial update and LAN
update. To enter the Setup Application Software menu, proceed as
follows:

1 Turn on the 9102 Handheld Spectrum Analyzer.
The boot-up screen appears.

2 When the message “Press O to enter Setup” appears, press the
numeric key 0.
The Setup Application Software menu appears.

In order to ensure that software updates are only performed by autho-
rized users you can set a password to protect the software update
option. If a password is set, the user performing the software update
via the Setup Application Software menu will be asked to enter it before
data are loaded.

NOTE

This password only affects the software update options available on
the Setup Application Software menu. It does not affect the usage of
the instrument’s application software.

In order to set a password proceed as follows:

1 Switch on the 9102. In order to enter the Setup Application Soft-
ware menu press the numeric key 0 when the input request
message is displayed on the boot-up screen. Now the Setup Appli-
cation Software menu is displayed.

2 Press the numeric key 3 to open a password input field.

3 Enter a 6-digit numeric string as your password. For each digit you
enter an asterisk (*) will be displayed in the input field.

4 Press ENTER to submit your input. You will now be asked to reenter
your passwort for confirmation.

5 Press ENTER to submit your input. If your input is not identical to
the password entered in the first input field, an error message will
be displayed and you can enter the password again. Otherwise
your new password will be saved.

You can also change a previously defined password. In order to do so
proceed as described above. If a password has already been defined,
you will be asked automatically to enter the old password before you
can enter a new one.
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If you have forgotten your password, please contact one of Aero-
flex’s Technical Assistance Centers. For contact information please
refer to section “Technical assistance” on page xvi.

Performing a serial update

The software update requires a 9100 software update file, which is an
executable file running on a Windows PC that also includes the soft-
ware update for your 9102 Handheld Spectrum Analyzer. Such a file
can be downloaded from Aeroflex’'s website, e.g. the file
9100Setup_4_50.exe.

Take the following steps to perform a serial update of the instrument
software via the Setup Application Software menu:

1 Connect the 9102 to an external power supply.

2 Connect the 9102 to the PC. See section “Connecting the 9102
Handheld Spectrum Analyzer” on page 14 for further details.

3 Switch on the 9102.
The boot-up screen is displayed.

Aeroflex 9100 Handheld Spectrum Analyzer
© Copyright 2010 Aeroflex GmbH

All rights reserved.

U.S. patent pending

Press “0” to enter Setup...

4 In order to enter the Setup Application Software menu press the
numeric key 0 when the input request message is displayed on the
boot-up screen.

Now the Setup Application Software menu is displayed.
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Setup Application Software:

See chapter Troubleshooting in user’s guide first!
Press “1” for serial update...

Press “2” for LAN update...

Press “3” to set Password

Press “ESC” to exat

5 Press numeric key 1 to open the Serial Update menu.

6 In order to upload the application files from the PC to the instru-
ment start the installation program on your PC. This will open the
Update window as shown below.

9200 Update = T

Yersion: 3.00.0150 21.02.2005%

Select connection and start update

v Serial " LAN

— Connection

Baud R ate |F Address [S1074]

57600 R

& COM1 ¢ COM2

Fart
© coMa ¢ coms | | 49200
— Progresz
File
| 025
E ntire update
| 0%

Start I Cloze

7 In the Connection section, select Serial.

8 To start the serial update press the numeric key 1 on the instru-
ment.
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You do not have to click on Start in the Update window on your PC.
The update process will be started without any further input on the
PC.

Performing a LAN update

The software update requires a 9100 software update file, which is an
executable file running on a Windows PC that also includes the soft-
ware update for your 9102 Handheld Spectrum Analyzer. Such a file
can be downloaded from Aeroflex’'s website, e.g. the file
9100Setup_4_50.exe.

Take the following steps to perform a LAN update of the instrument’s
software via the Setup Application Software menu:

1 Connect the 9102 to an external power supply.

2 Connect the 9102 to the PC. See section “Connecting the 9102
Handheld Spectrum Analyzer” on page 14 for further details.

3 Switch on the 9102. In order to enter the Setup Application Soft-
ware menu press the numeric key 0 when the input request
message is displayed on the boot-up screen. Now the Setup Appli-
cation Software menu is displayed.

4 Press the numeric key 2 to open the LAN Update menu.

5 Here the IP adresses of the instrument (Target IP) and the PC (Host
IP) are displayed. Press the numeric key 1 to change or enter the
Host IP and 2 to change the Target IP. See section “Determining the
Host IP address” on page 222 for information on determining the
Host PC's IP address.

6 In order to upload the application files from the PC to the instru-
ment start the installation program on your PC. This will open the
Update window (see “Performing a serial update” on page 219).

You do not have to click on Start in the Update window on your PC.
The update process will be started without any further input on the
PC.

7 In the Connection section, select LAN.

8 In order to start the update press the numeric key 6 on the instru-
ment.
A message prompts you to press any key to start the update or to
hit the ESC key to abort the update.

9 Press the ENTER key to start the update.
Both the instrument and the installation program on the PC display
the progress of the software update.
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Determining the Host IP address

In order to determine your host PC’s IP address proceed as follows:

1 On the status bar, click Start and select Run to open an input
window.

2 On the input line, type cmd to open a command prompt.

3 Type IPconfig -all to display the network settings for the PC. In
this list you will find its IP address. To close the command prompt
type exit.

INNT\System32\command. com
snripeonfig
Windows NT4 IP Configuration

Ethernet adapter Local Area Connection:

Connection—specific DHNE Suffix . =

IP fiddress. . . . . . o o o o = . :134.114.78.143
Subnet Mask : 255.255.255.8
Default Gateway $0134.114.78.1
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This chapter describes how to install and use the 9100 Data Exchange
Software. The topics discussed in this chapter are as follows:

— “About the 9100 Data Exchange Software” on page 224

— “Installation requirements” on page 224

— “Understanding the license conditions” on page 224

— “Installing the software” on page 224

— “Starting the software” on page 225

— “Connecting the PC to the 9102” on page 226

— “Loading measurement results from the 9102” on page 227
— “Saving, loading and printing results on the PC” on page 231
— “Creating screen shots” on page 235

— “Working with measurement results” on page 236

— “Defining and loading limit templates” on page 239

— “Defining and loading external coupling parameters” on page 243

— “Managing communication systems for channel power measure-
ments” on page 245

— “Managing cable types for distance-to-fault measurements” on
page 246

— “Managing antenna factors for EMF measurements” on page 248
— “Managing cable factors for EMF measurements” on page 250

— “Working with settings” on page 251

— “Managing files on the PC and on the 9102"” on page 252

— “Including the GPS position in the trace” on page 255
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About the 9100 Data Exchange Software

The 9102 is delivered with a software product, the 9100 Data
Exchange Software. This is a tool to load and display measurements
from the 9102 to the PC and to install software updates on the 9102.

Installation requirements

To install the 9100 Data Exchange Software, you need

— a PC with Pentium processor or equivalent

— Windows 98SE, Windows NT or later versions
— a minimum of 32 megabytes of RAM

— 50 megabytes of free space on the hard disk
— a free serial interface or a LAN connection

Understanding the license conditions

Before installing the 9100 Data Exchange Software, ensure that you
understand the license terms which can be found in the appendix
“Software License” on page 379. The software may only be installed on
one computer at any one time!

Installing the software

If you received the software on a CD, just insert the CD in the CD drive
of your PC.

Run 9100DataExchange.exe.
This will start the install wizard which will copy the required files onto
your PC.

Follow the instructions given by the install wizard.

By default, the install wizard will store the program files in the following
directory (assuming an English Windows installation):

C:\Program files\Aeroflex\9100 Data Exchange.
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Starting the software

Click Start > Programs > Aeroflex > 9100 Data Exchange to run the 9100
Data Exchange Software.

The following box appears:

x

Welcome to Aeroflex
9100 Data Exchange Software

— Connect ko 3100

" Serial Connection
[ CORI - full modem cable |

™ LM Connection _
[IP 0000 k.

" Open existing Trace Cancel

To connect to the 9102 via serial connection (RS-232 interface on a
COM port of the PC), select Serial Connection.

To connect to the 9102 via a local area network (LAN) over TCP/IP,
select LAN Connection.

If you do not want to connect to the 9102 but rather open a measure-

ment trace file that has been previously stored on the PC, select Open
existing Trace or Cancel.
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Connecting the PC to the 9102

In order to connect the PC to the 9102, you need to configure the 9100
Data Exchange Software first.

From the menu bar, select Connection Settings > Serial / LAN for 9100...
This will open the Connect pull-up menu as shown below:

x

I j " Serial o Lap

— Inf
Stare | Delete | |

= Senal — LAk

COM Port IEEIM1 vI IF'ﬁddr,I 172 .16 . 17 . 140
Baud Rate |5:-'snn "I Pait |4aznn

Check Connection | k. I Cancel |

Using a predefined  If you have previously stored configuration data for a successful
configuration for the  connection with the 9102, you can proceed as follows:

connection 1 Connect the 9102 with the PC using a serial interface cable or the

LAN, depending on the configuration you want to use.

2 In the Connect dialog box of the 9100 Data Exchange Software
(see above), load the configuration by selecting a name from the
drop-down list box or in the upper left-hand corner of the Connect
menu. Click on OK to load this configuration.

The PC will now attempt to exchange messages with the 9102 over
the interface defined in the configuration file. The Connect dialog
box will disappear and if a connection has been set up successfully,
the status bar of the PC software will indicate CONNECTED.

Serial interface 1 Select the Serial radio button.
CoNNEClion 5 geject the baudrate (bit rate) that is set up in the 9102 as well.
3 Select a serial port (e.g. COM1).

4 Switch on the 9102 and connect it to the PC using a null modem
cable as specified in “Connecting the PC to the 9102” on
page 226.
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LAN (TCP/IP) connection

Saving the configuration
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5 Click on Check Connection to verify that the connection is working
over the selected COM port.
The PC will now attempt to exchange messages with the 9102 over
the cable attached to the selected serial port. The Connect dialog
box will disappear and if a connection has been set up successfully,
the status bar of the PC software will indicate CONNECTED.

1 In the Connect pull-up menu, select the LAN radio button.

2 Enter the IP address of the 9102. The IP address of the 9102 can
be read and modified over an RS-232 link using the SCPI
command; see “Changing the IP address of the 9102" on page 47
for information on changing the IP address of the 9102.

3 Enter the IP port number in the Port input field. Valid entries are in
the range from 1024 to 65535; the default is 49200.

4 Switch on the 9102 and connect both 9102 and PC to the
computer network with a normal patch cable, or connect them
directly with each other using a cross patch cable.

5 Click on Check Connection to verify that the connection is working
over the selected LAN connection.
The PC will now attempt to exchange messages with the 9102 over
the network. The Connect dialog box will disappear and if a
connection has been set up successfully, the status bar of the PC
software will indicate CONNECTED.

You can save the configuration in a file for later use so that you do not
have to reenter the configuration each time you are using 9100 Data
Exchange Software.

1 In the entry field at the upper left-hand corner, enter a configura-
tion name that allows you to identify the configuration that you
have made. Several configurations can be stored under individual
names.

2 Press Store to save the current configuration.

Loading measurement results from the 9102

The 9100 Data Exchange Software can load and display a measure-
ment (trace) from the 9102 in two different ways. The software can load
either the trace currently displayed or a trace that is saved in the 9102
memory. Using the Live Trace command available in the Instrument
menu you can also display a live trace in real mode with updates
continuously performed. Note that the 9100 Data Exchange Software
can hold multiple windows, each with a trace.
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Viewing the actual trace
on the PC

Toggling the view mode

228

1 Connect the PC to the 9102 as described on page 226.

2 In the 9100 Data Exchange Software, select Instrument > Display

Trace, or press Ctrl+T, or click on the icon: L |

The trace is displayed in the program window (see example below).
You can resize or maximize the trace within the program window.

3 To store the results on a local PC drive, select File > Save or File >
Save as and choose a directory and file name.
The trace file is stored on your PC.

| - 9100 Data Exchange Software - [desd.9tr] =] 1]
@ File Instrument Tools Wiew Connection Settings  Window Help =
- £Le | el es| 410 Y [ :
ez EE 0 E EYERDMRDE b @) &) 2
Spectrum Analyzer 3101 Deuke Name: ksa 9101 41540 dBm /9344572 MHZ 25030004 1530
[ D2: 15006 / 1077600 MHZ
BV 10KHT
VB 10kHZ
ST 1L NS
-s00 | [IELETY =11
Ret : Ext Deukce Somp. -
Lewel !
dEm 1 Ret Lewe| : -Eodim
T ETE : o 1odp
Scak ]
Mode: Chanke | Pawer
700 ; Chane|Sgem : estagkm
) T FulSEEm
Chane| : o2
Power Res it
Dekct T smpk
Tracs & HUT
800 Trace B : EFR
fuerage Cont : 5
Trigger T OFF
TrHger Level :
Trigger Mok
Triger e
Shgk cont
-1 =
ENTTT 3000.0200
Boaters kon -
emsle) ; Serlal Humber T DooMER
aman . Caltato Dat F- -
! Lartc heck FTT 2
Cl=Az) : Nertc beck D 240G
-120.0
120000 FHZD b TN 19350000 MHZ Spai: 1200000 MHz
Comme 1t
Ready IP: 172.16.17.162 MM v

NOTE

The trace will also display any active limits. When working in channel
power mode, the trace will include the communication system
name.

NOTE

In signal generator mode you cannot load a trace via Display Trace
as there are no suitable data available. If you select Display Trace in
the signal generator mode a dialog will be displayed informing you
that no data are available and asking you to select a different mode.

You can switch the trace display from landscape to portrait and vice
versa. In order to toggle the view mode proceed as follows:

1 Select View > View Mode. You can also right-click on the screen to
open a right-click menu and select View Mode.
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Showing and hiding
parameters

Showing and hiding
markers

Continually loading live
traces
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2 Select the view mode Landscape or Portrait. The display changes
accordingly.

You can display and hide trace parameters by selecting View > Show
All Parameters or View > Hide All Parameters.

You can display and hide markers by selecting and deselecting View >
Markers Trace A or View > Markers Trace B. On selecting to show the
markers a tick is displayed next to Markers Trace A or Markers Trace B.

You can also continually load live traces from the instrument in real-
time mode which is particulary useful for monitoring ongoing measure-
ments on your PC. To continuosly download traces displayed on the
9102’s screen proceed as follows:

1 Select Instrument > Live Trace, press Ctrl+L, or click on the icon in
the menu bar: % The Live Trace Screen is displayed. On this
screen you can specify several settings for the live trace process.

5I

— Updates

& Continuous mods
[ I‘I Lpdatels]

Time between updates ID seconds

~Wie
' Open new ace window

" Ovenwite active trace window

—Save

[~ Save as

Select path:
IE:\Dokumente und Einstellungenhweizsbro\Eigene | |

File name: ITrace

File tppe: IMDdified Trace Document [ Stm) j

Start I Cancel |

2 In the Updates frame select Continuous mode, if you want the live
trace to be updated continuously until you stop the process manu-
ally. If you want to specify a fixed number of update cycles after
which the process will be stopped automatically, select the second
control box and enter the number of updates to be performed. In
the Time between updates field, enter the number of seconds
between each update cycle.
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Transferring a saved
trace to the PC

3 In the View frame select Open new trace window, if you want to

display the live trace in a separate new window. If you want to over-

write the active trace, select Overwrite active trace window.

4 If you intend to save the live trace in a file on completion of the live
trace update process, select Save as in the Save frame. Now the
Save fields are activated enabling you to select a directory, a file
name and the file type for saving your trace on your PC. You can
save the traces as *.9tm or graphic files (e.g. *.bmp, *.jpg etc.). For
further details on saving traces on your PC refer to “Saving, loading
and printing results on the PC” on page 231.

To load the data saved in the 9102 proceed as follows:

1 On the 9102, save the desired measurements in trace files.
2 Connect the PC to the 9102 as described on page 226.

x

3 In the 9100 Data Exchange Software, select Instrument > Get Trace,

or press Ctrl+G, or click on the icon: E3|

This will load and display a list of trace files that reside on the 9102
(see example below).

80211G

&1

a2

&CH

DESD

Fd1

EGOY
PHASEMOI

Cancel |

4 Select the desired trace file(s) and click View.

The trace is displayed in the program window. You can resize or
maximize the trace within the program window.

To store the results on a local PC drive, select the window with the
trace to be stored, select File > Save or File > Save as and choose a
directory and file name. The default directory is Traces inside your
9100 Data Exchange installation directory.

The trace file is stored on your PC with the extension *.9tm differ-
entiating it from the original trace saved on the 9102 and obtained
by the Get Trace procedure. These trace files have the extension

* otr.
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NOTE
*Otr trace files can also be transferred in both directions using the

Traces tab in the Instrument > Data Transfer... menu.

Saving, loading and printing results on the PC

Storing results on the PC

Loading a trace file on
the PC

Printing measurement
results

Affecting the layout

Once a measurement trace has been transferred to the PC, it can be
stored on the hard disk, printed or exported to a graphics or text file.

The trace, along with the 9102 settings and markers, can be saved in a
file and loaded again in a trace file. This way, information about settings
and individual result values will not be lost.

1

Select File > Save or File > Save As ....
A window with a file selection box appears.

Select a directory and a file name to save the trace data, and
confirm by pressing ENTER.
The trace data are saved in a file.

Results previously stored on the PC can be retrieved and displayed in
the 9100 Data Exchange Software.

1

Select File > Open.
A window with a file selection box appears.

Select the directory and the file name containing the trace data,
and confirm by pressing ENTER.
The trace data are loaded to the 9100 Data Exchange Software.

The following steps help you to choose the best format for your print-
out:

1

Select File > Print Setup... and set up the correct printer, the paper
orientation and printer-dependent settings. Confirm the changes
made by pressing ENTER.

Select Edit > Additional Information... to enter text for two columns
of header information that is to be printed with the trace. The trace
is printed with the filename; use the check box “Show File Path” to
include complete information about the folder where the trace file
is located.
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Printing a trace

Printing several traces

Additional Information x|

i~ Print Head
iThis field can be edited. You cah use it to iThis field is edicable as well. Print project
print your company name and address with the or customer-related information here)
tracs) .

3 You can check the layout before printing by selecting File > Print
Preview.

{Thix field can be eited. Yeu cen we it to (Thin 1810 n aditabil ax Wil Frint prayect
Brint yuw Company nane and addreas with the ar curtenar-ralated intematisn hereh
p—
c nata asazsz. san
Spoctnm Anahyzer §1028  oewe e i o [EFEEN 12123008 113008
REWY. 30 kHx
VI 304
AT 667 s
- e |
Impedarde 50 Ohm
- . Davice Corre. © -
= Rl Lewed ~300 dBm
- Ataruabion )
Gcaie 10,0 clv
.
wade Spctum Anslvsis
“ Canter 9000000 M-z
o 5000000
s 17,5000 iz
Blap 92 50000 M-z
Maasure Mode:
Trigger OFF
Bngle Count 1
froceraeac__J
Datect PasMeg
n. Trace A L]
Trace (0FF)
Mwerage Court = 5
BW Varsion S5e00.0000
3 Boal Version - 400
)
Cal Datw 1311 3006
Last Chack 03052006
. by Wik
Nt Chack - 03052007
fors poworw __}
e 00 Q000N
o Langtude 000° 0,000 W
Ao 0N
CITTT .
Mo LTI dEm | 9001000 M-z
WD TTgdkm | BRAD0 G
e Wi AT | 91310
500000 kHzOw Canter 30 00000 Wz Bpar 5 000000 M-z

setnl wmmus [ MM

Go to the File > Print menu to select the pages to print, and start
printing by pressing ENTER.

If you have opened several documents and you intend to print them in
one go, select File > Print Open Documents....
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If you save the results in a graphics file, you can load them in other
applications such as a word processor and include them in your docu-
mentation in graphical format. File formats supported are:

— Windows Bitmap (BMP)

— JPEG UPG/JPEG)

— JPEG2000 (2K/JP2)

— Tagged Image File Format (TIF/TIFF)
— Zsoft Paintbrush (PCX)

— Portable Network Graphics (PNG)

— Sun Raster (RAS)

— Truevision Targa (TGA)

— Portable Bitmaps (PPM/PGM)

1 Select File > Export > Image.
A file selection box appears (“Save image file”).

2 Select a directory, a file name to save the measurement trace and a
file format, and confirm by pressing ENTER.
The trace data are stored as a graphics file in the selected location.

You can use the numerical results and include them in other applica-
tions for postprocessing, e.g. in Microsoft Excel.

1 Select File > Export > ASCII file.
A file selection box appears (“Save Trace as ASCII File...").

2 Select a directory and a file name to save the measurement data,
and confirm by pressing ENTER.
The data are stored in a text file (*. TXT) in the selected location.

Each line in the resulting text file contains a parameter from the
settings; the parameter name is separated from its value by a semi-
colon.

The 9100 Data Exchange Software offers two different methods to
copy the trace into a document. The best method depends on how you
intend to process the trace in that document.

This method is appropriate if you want to use the graphic image as is,
e.g. in a document.

1 Select the trace you want to copy by selecting the apppopriate
number in the Window menu.

2 Select Edit > Copy Graph.
The displayed window is copied into the Windows clipboard.

3 Press Alt+Tab or the mouse to change to the application where you
want to insert the graph (e.g. Microsoft Word).
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Data copy and paste

234

4 Move the cursor to the position where to insert the graph.

5 Press Ctrl+V or select Edit > Paste to insert the graph.

Note

If you want to resize the graph in Microsoft Word, select Format >
Picture and change to the Size tab to resize it.

Note

The 9100 Data Exchange Software copies the window in the size it
currently has on the screen. You can resize the window to copy the
graph in a different size or aspect ratio.

You will want to copy the data rather than the graphics if you want to
post-process the data, e.g. in a spreadsheet.

1 Select the trace you want to copy by selecting the apppopriate
number in the Window menu.

2 Select Edit > Copy Data.
All the relevant measurement data and instrument settings are
copied as text into the Windows clipboard.

w

Press Alt+Tab or the mouse to change to the application where you
want to insert the data (e.g. Microsoft Excel).

4 Move the cursor to the position where to insert the data.

a

Press Ctrl+V or select Edit > Paste to insert the data.

The data is copied into the document. Measurement data and
instrument settings are separated by a comma, so most spread-
sheet programs will nicely place the data in individual columns.

Marker Trace A Frequency[Hz] Level[dBm]
M1 90010000 939
2 88400000 786
W3 91310000 87
hid OFF
1] OFF
OFF
W7 OFF
Ma OFF
] OFF
W10 OFF

@/ oo ;@ o] ]| ;]| o | o e [ |
Ol |~ o @ o2 S| @
=
o

=

Trace A
Frequency[Hz] Min Level[dBm] Max Level[dBm]
87500000 97 4

@
[

B3
| B4 | 87510000 978 978
| BS | 87520000 G975 a7 g
| BB | 87530000 983 985
E7 87540000 98 97 E
| B | 87550000 975 975
| B9 | 87560000 G971 G975
| 70 | 87570000 935 985
[ 71] 87580000 77 a7 g
|72 87590000 976 975
| 73| 87600000 988 93,3
| 74 | 87610000 973 95
| 75 | 87620000 987 988
| 76 | 87630000 976 978
77 87640000 93,3 93 4
ED)

o7EEARAR An no A

Note

You can even have Microsoft Excel (or another spreadsheet pro-
gram) draw the trace: Mark the table containing the measurement
data (e.g. frequency and level points) and call up the Chart Wizard.
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Creating screen shots

The 9100 Data Exchange Software also offers a Tool for directly
producing screen shots of the software screen displayed on the 9102.
Using the Screen Dump tool you can easily create screen shots, save
them as image files, copy them to the clipboard as well as print them
directly.

In order to create screen shots proceed as follows:

1 Select Instrument > Screen Dump, or press Ctrl+N, or click on the
icon in the menu bar: ﬁ . The Screen Dump window is displayed.

2 In order to display the screen currently shown on the 9102 in the
Screen Dump window click on Read Screen. The screen originating
from the 9102 will be displayed in the Screen Dump window as

follows.
s E
Al 405.0pV f 21.60000MHz
Dad  -121.2pY £720.0000MHz SPECtru m Read Screen
A3 318.0pV 71.965600GHz H
AZ 283.8pV /2 .628000GHz A“aIYSIs
12:29:12 Parameter Window 28.06.2005
Clear Display
Center : 1.800000 GHz Start : 0.000000 Hz
Span : 3.600000 GHz Stop : 3.600000 GHz
Ref. Level 0.2y Trigger Mode : Free Run
Attenuation : 30 dB Trigger Level : 0.0 ¥ Save as Image
Impedance : a0 Ohm Sweep : Continuous
Single Count : 1 Copy to Clipboard
RBW : 1 MHz Detector : Pos./Heq. Print |
VBW : 1 MHz
SWT 43.2 ms
Press <Exit= to continue
Freq Level Marker Trace Measure m Exit
Exxit |

3 In order to save the screen shot as an image file click on Save as

Image. A file selection box appears (“Save image file").

4 Select a directory, a file name to save the measurement trace and a

file format, and confirm by pressing ENTER.
The trace data are stored as a graphics file in the selected location.

5 In order to copy the screen shot for further usage in other applica-

tions click on Copy to Clipboard.

6 In order to print the screen shot directly from the Screen Dump

tool click on Print.

NOTE
For best results it is recommended to use a local printer as opposed

to a printer connected to a network.
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7 If you intend to create another screen shot, click on Clear Display
and proceed as described.

8 To close the Screen Dump tool click on Exit.

Working with measurement results

236

Adding markers

To open a measurement trace that has been previously loaded from
the PC, select File > Open.

This will open a file selector box from which you can select a directory
and a trace file.

The 9102 already provides up to six markers; the marker positions are
stored and transferred together with the trace. You can use markers on
trace A and trace B.

In addition to these static markers, you can use additional dynamic
markers on the PC to read out the level values at any displayed
frequency. Up to ten markers per trace are possible.

In order to enable or disable markers on the PC proceed as follows:

1 Select View > Select Trace Markers. You can also right-click on the
screen to open a right-click menu and choose Select Trace
Markers.

The Select Trace Marker window is displayed.

x
I Trace & Max Peak |
~ Markers ~ Delta Markers — Meut Peak |

v a1
v i3  Da2 Label &l Peaks |
V' A3 ™ Da3 Set Thieshold |
[ a4 [~ Dag
| &0 i’
[~ &5 [~ Das
I~ &5 [~ D&E Sort by Lewvel |
[~ a7 I~ Da7?
Sart by Freguency |
I~ a8 [~ Dag
I I~ Da3 Restore Device
b ark:
I~ al0 I~ D&l AREE
bd ark.er
Clear Al | Clear Al | Description
k. Cancel
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Carry out one or several of the following steps:

To enable a marker select the required marker by checking the
relevant control box in the Marker area (A1 to A10 or B1 to
B10). To enable a delta marker check the relevant control box in
the Delta Marker area (DA2 to DA10 or DB2 to DB10).

To put a marker on the maximum peak click on Max Peak.
To put a marker on the next peak click on Next Peak.

To put a marker on all peaks (up to the 10 supported markers)
click on Label All Peaks.

To set a threshold for the Label All Peaks function click on Set
Threshold. The button label changes to Clear Threshold.
Specify your threshold in the field below by clicking on the up
and down arrows. the threshold will be displayed as a read line.
If you want to remove the limit, click on Clear Threshold. After
specifying the threshold only peaks above the threshold will be
labeled.

To enter descriptions for the markers click on Marker Descrip-
tion. A Marker Description window is displayed. Enter the
descriptions for the markers set and click on OK. Deselect the
text in the Show in Trace box on the right-hand side if you do not
want the text to appear in the graph.

The descriptions will be displayed in the graph with a line
connecting the text with the appropriate marker position.

r~ Show in Trace

I

IThis was the maximum peak. originally.

K I S S K K K

T T e (T L |

()8 I Cancel
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REW: 30 kHz
WEW: 30 kHz
SWT: B6.7 ms

This was the maximum peak ariginally.

— To move the marker to another frequency, drag it with the mouse.
Alternatively, use the LEFT/RIGHT (slow movement) or UP/DOWN
(larger steps) cursor keys on the keyboard.

Change the reference In order to change the reference level and scale proceed as follows:

level and scale ‘ o
1 Select View > Level. The Level window is displayed.

2 Use the up and down arrows of the Ref. field to specify the refer-
ence level.

3 Specify the scale in the Scale field

4 In the Level Unit field you can select a unit from the dropdown list.
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Device Name: HSA 8101 06.04.2004 16:18:51

REW: 30 kHz
WEW: 30 kHz
SWT: B6.7 ms

Spectrum Analyzer 9101

-10.0
Roef

Impedance 50 Ohm

Level Ext. Device Comp. : -

aBm

Ref. Level : -10.0dBm
Attenuation : 10dB

Seale 10

Mode: Spectrum Analysis
Center 9026000 WHz
Span 5.000000 WMHz
Start © 9001000 MHz
Stop 9051000 WHz
Ieasure hode

Detect : Pos./Neg
Trace A D (MAY

...... Trace B . (OFF)
Average Count 5

Trigger ;. OFF

Trigger Level -

Trigger Edge =

Single Count |

5000.0200

-30.0

-50.0

: SW Version
-70.0 3 Boot Version
: Serial Number 9939559
: Calibration Date  :  24.05.2003
Fostes: | Last Check 24062003
A (MK by Willtek

| Mext Check 24.06.2004
B(OFF)

-80.0

500.000 kHz/Div Center. 902 6000 MHz

Comrnents:

Span: 65000000 MHz

The grid of vertical and horizontal lines can be switched on and off with
View > Grid. You can also right-click on the screen to open a right-click
menu and select Grid. The grid is the same as on the 9102, i.e. it
consists of eight horizontal and ten vertical rows.

You can add text to the trace and store it with the measurement. This
way, you can add valuable information about the conditions of the
measurement. The comment text will be printed and saved with the
graph but not exported to a graphics or text file.

1 Select View > Comment.
A “Comment” window opens, allowing you to enter text.

2 Enter your text (three lines maximum), then click on Save to have
the 9100 Data Exchange Software store the text along with the
measurements.

Defining and loading limit templates

One of the powerful features of the 9102 is its capability to compare
the measurements with predefined limits. The limits are set in the form
of a template that the actual measurement passes or fails. The template
can be defined on the PC using the 9100 Data Exchange Software and
then loaded to the 9102; the 9102 can hold up to 99 templates.

Editing a template may be easier when an example of a typical result
trace is available. The Limits Editing menu of the 9100 Data Exchange
Software cannot only show the actual limit curve (template) but also an
example trace that is stored on the PC.

Templates can be applied to measurements in both the spectrum and
the time domain. An example of a limit template in the time domain is
the power/time template for GSM phones.

9102 Handheld Spectrum Analyzer  Software version 5.31 239



Chapter 15 9100 Data Exchange Software
Defining and loading limit templates

240

Defining limits

The limits are expressed relative to the grid on the 9102 display, not as
absolute values in terms of frequency (or time) and power. This way,
you can apply the same template to different power levels and frequen-
cies provided that the scales are as intended.

x
Wl [ w1 [ w2 [ w2 [ Level | f— | y Limit Lines
0o 1.0 15 a0 lcwer
15 30 40 a0 lowaer i
it
4.0 30 85 25 lwrer ;
28 25 100 10 lower b —
00 70 35 70 upper Delete
35 170 |50 65 [upper | !
5.0 %] mo 7o upper Delete Al
5
D ata Transfer
Overlap Trace
3
Open 2
Save ir
Cancel |
0 1 F 3 4 5 [ T E 9 10 ¥

Limits can be defined as a template with an upper and and a lower limit
curve. Each curve consists of a number of straight lines between
points. The Limits menu of the 9100 Data Exchange Software allows
you to enter and display such lines.

The limits are expressed relative to the grid on the screen, with eight
horizontal and ten vertical lines. The coordinates of each point (in x/y
coordinates) correspond to these lines.

To define a new template, proceed as follows:

1 Inthe 9100 Data Exchange Software, select Tools > Limit Editor...
or click on the icon in the menu bar: )
The Limit Lines window is displayed, with a limits coordinates table
on the left and the limit lines on the right-hand side.

2 To enter a new limit line, press Insert.
A window appears, allowing you to enter the x/y coordinates for
two points.

Limit Points =
& UpperLevel ¢ Lower Level
Limit Line

y1?
e

1
w2 |0 y2 |0

()8 I Cancel |

3 Select whether you wish to define an upper or lower limit by
selecting one of the Upper Level and Lower Level radio buttons.

4 Enter the coordinates for the first point of the limit line (x1, y1).
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5 Enter the coordinates for the second point determining the limit
line (x2, y2). You can also move the limit lines afterwards by drag-
ging them with your mouse.

6 Confirm your choice and close the window by selecting OK.
The window disappears. The values are entered in the limits table
on the left and the limit line is shown in the limit lines graph on the
right.

7 Enter more limit lines as described above to complete the template
according to your requirements.

You can change the template by modifying or deleting individual limit
lines:

1 In the table within the Limit Lines window, click on the line that you
want to modify or delete.
The line within the table is highlighted and the corresponding limit
line in the graph is shown in red.

2 To modify the limits, click on Edit or double-click on the row. A
dialog box appears, allowing you to change the limits.
To delete a limit line, click on Delete.

Alternatively, to change the starting or ending point for an existing limit
line, proceed as follows:

1 In the graph within the Limit Lines window, click on the starting
point of a limit line that you want to modify.

2 Point the mouse to the starting or ending point of the limit line,
keep the left mouse button pressed and drag the point to its new
position and release it there.

1 In the Limit Lines window, select Overlay Trace.
A file selection box appears.

2 Select a trace file from the default or any other directory, and click
on Open.
The file selection box disappears and the trace data is displayed in
the limit lines box on the right-hand side of the Limit Lines window.

A template can be stored on the PC, e.g. to allow modifications later or
to download it to different 9102 analyzers at any time.

1 In the Limit Lines window, select Save.
A window opens (“Save Limit Lines”).

2 Choose a directory and enter a file name to save your limits
template.
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3 Confirm your choice by pressing ENTER.
The limits are saved in a file.

Loading a template from  To modify or to load a template to a 9102 that has previously been
the PC  stored on the PC, proceed as follows:

1 In the Limit Lines window, select Open.
A file selection window appears (“Open Limits File...").

2 Select the directory and the file containing a template file previ-
ously stored with the 9100 Data Exchange Software.

3 Confirm your choice by pressing ENTER.
The limits are loaded to the limits table and the graph. You can now
modify the limits (see section “Changing limit lines” above), or
download the limits to the 9102.

RN

Transferring a template Define a template or load it from the PC's hard disk as described
to the 9102 above.

2 Ensure that the PC is connected to the 9102 either via RS-232 or
LAN.

3 Select Data Transfer.
If the template (characterized by its limit lines) is not yet stored you
will be asked if you want to save it on the PC harddisk. If you
choose not to store the template, your changes will be lost.
The Data Transfer window is displayed with the Limits tab active.

-\ Program Files',Aeroflex',9100 Data Exchange\Limits x|
Traces | Settings Limits |Ehannel Systems | Extemal Devices | DTF Cable Types | EMF Antenna Factors | EMF Cabls Factors |
i Instrument ~PC
@] & o x|
Name [Date [Tme | [T timie =
EXAMPLE 20055EP08  16:2314
Matne [ Date [Time [
488 test. 3m 03112005 175224
< copy
oy >
Select al Select al |
ﬂ ﬂ Cloze

4 Choose a limits file (or multiple files) on the PC side (right-hand
side) of the Data Transfer window, and click on < copy.
The 9102 will, if not done so previously, ask whether to connect to
the 9102. In that case, follow the instructions in section
“Connecting the PC to the 9102" on page 226.

The file name on the 9102 will only carry the first 11 characters of
the file name that was used on the PC.
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If a limits file on the PC has been selected for transfer and a limits
file with the same name already exists on the 9102, the 9100 Data
Exchange Software will display a pop-up box with the file name in
question in the header bar, and offer several possibilities:

— Click on Yes if you want to overwrite the file in question.
— Click on No to cancel transmission of the file in question.

— Click on Yes to All to copy all files to the 9102, irrespective of
duplicate file names.

— Click on No to All to prevent overwriting of all files with duplicate
file names.

— Click on Rename to enter a new file name applying to that file
when downloaded to the 9102.

— Click on Cancel to cancel transmission of all files, no matter
whether file names already exist on the 9102 or not.

The 9100 Data Exchange Software will indicate when the down-
load has been completed successfully.

5 On the 9102, press ESCAPE to return to local mode. You can then
start using the limits template.

Defining and loading external coupling parameters

The 9102 Handheld Spectrum Analyzer can compensate a defined
gain or attenuation introduced by external equipment between the
device under test and the 9102. The coupling can be specified in the
9100 Data Exchange Software; several files for different devices can be
defined, stored and downloaded to the 9102. Furthermore, on
installing the 9100 Data Exchange Software two files with external
coupling parameters are automatically saved to the Extdev directory of
your 9100 Data Exchange directory on the PC. Once downloaded, the
compensation of effects from external devices can be switched on and
off at any time. The 9102 takes the coupling factor into account before
presenting the measurement result.

Gain and attenuation are frequency-dependent in most cases; there-
fore the 9100 Data Exchange Software allows you to enter interpola-
tion points to cover the frequency-dependent coupling factor over the
whole frequency range of interest.
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9102
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Open the External Device Compensation menu by selecting Tools >
External Device Editor... or by pressing Alt+E or by clicking on the

icon: @
To enter an interpolation point, select Insert.
A dialog box appears, allowing you to enter frequency and level.

Enter the frequency, select a unit (from hertz to gigahertz) and
enter the coupling factor (in dB). Positive factors indicate signal
attenuation, negative factors indicate gain in the signal line.

Close the box by pressing OK and repeat the last two steps with as
many interpolation points as available.

The frequency-dependent compensation curve appears on the
right-hand side as values are entered.

If you want to change a factor, either select a line from the table on
the left-hand side and click on Edit to change the values numeri-
cally, or point with the mouse to an interpolation point in the graph
on the right and drag it to a new position.

To move the whole interpolation curve up or down in steps of 1 dB,
click on the Level Offset arrow buttons.

When completed, save the device compensation values in a file on
the PC: Click on Save, enter a file name and confirm by clicking on
Save.

Press Cancel to close the External Device Compensation window.

One or more files with external coupling loss data can be transferred
to the 9102 and reside in the internal memory of the 9102. They will

not be taken into account until they are activated (see “Compensating
gains and losses”).

1 Select Instrument > Data Transfer (Ctrl-D), or in the External Device
Compensation menu, select Data Transfer.

The Data Transfer menu opens.
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2 In the External Devices tab, select a directory and file(s) on the
right-hand side and press < copy.
The selected files are transferred to the 9102.

Managing communication systems for channel power measurements

Editing communication
system parameters on
the PC

Measurements in channel power mode imply that a communication
system with predefined channel numbers and associated frequencies
has been defined. The 9102 comes with a few systems preinstalled;
more systems are available for download to the 9102 in the 9100 Data
Exchange Software, for example Wireless LAN, Bluetooth and TETRA.
For a complete listing of the communication systems available in the
9100 Data Exchange Software refer to “Predefined channel power
communication systems” on page 359. Here you will also find a listing
of the communication systems preinstalled on the 9102. Other
systems’ data can be easily entered on the PC using the 9100 Data
Exchange Software. Each set of system data can be stored in a sepa-
rate file; one or multiple files can be downloaded to the 9102. For
downloading and copying system files between the PC and the 9102,
see section “Managing files on the PC and on the 9102" below. Once
data are stored in the 9102, they can be used as described in section
“Operating in channel power mode” on page 86.

x
— Channel Spstem
First Channel IU

Last Channel 124 Save |
Channel ‘idth 200 IkHz vl Diata Transfe;l

Channel Spacing  |200 IkHz 'l
13t Ch. Center ISSD.D IMHZ vl

Cancel |

1 Select Tools > Channel System Editor... or by pressing Alt+C or by
clicking on the icon in the menu bar: []f].
The Channel System menu appears.

2 If you want to edit a communication system that is already stored
on the PC, press Open, select the appropriate directory and file,
and press ENTER or click on Save.

3 Enter the first and the last valid channel number of the system.

4 In the Channel Width line, enter the measurement bandwidth
(separate input fields for value and unit).

5 In the Channel Spacing line, enter the frequency spacing (including
the unit) between consecutive channel numbers.

6 Enter the carrier frequency (including the unit) corresponding to
the first channel number in the 1st Ch. Center line.
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7 Click on Save.
A dialog box appears, allowing you to enter a name for the file in
which the channel system parameters of the communication
system shall be stored.

8 Enter a file name and press ENTER or click on Save.
The data are stored and the dialog box disappears.

9 To transfer the data to the 9102, press Data Transfer. To close the
Channel System window, press Cancel.

Managing cable types for distance-to-fault measurements

Uploading predefined
cable types to the
instrument

246

If the 9130 VSWR/DTF Reflection Measurement Option is installed and
activated on your 9102 the VSWR/Tracking... menu offers the additional
measurement modes reflection, distance to fault and cable loss.
Distance-to-fault measurements focus on the cables whithin an
antenna system, measuring the reflection arising along it in order to
detect and locate weak connectors, cable kins, water ingress and other
cable-related problems.

For these measurements Aeroflex provides predefined cable param-
eter files for most known coaxial cables used flir antenna installations.
These parameter files come with the 9100 Data Exchange Software
and can easily be uploaded to the 9102. For rare cable types you can
also define the cable settings manually and transfer them to the 9102.

For further details on distance-to-fault measurements refer to
Chapter 10 “Distance to Fault Operation”.

NOTE

The functionality described in the following sections is specifically
dedicated to the usage of the 9130 VSWR/DTF Reflection Measure-
ment Option. If this option is not installed and activated on your
9102 this functionality is of no practical use as cable types cannot be
transferred to the instrument in this case.

In order to upload the predefined paramter files delivered with your
9100 Data Exchange Software to the 9102 proceed as follows:

1 Select Instrument > Data Transfer and select the Cable Type
register.
You can also select Tools > DTF Cable Type Editor... and click on the
Data Transfer button. A selection window for the cable type
transfer is displayed.
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C:"Program Files' Aeroflex’ 9100 Data Exchange'Cable Types 5'
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2 In the PC area on the righthand side the cable types stored on the
PC are displayed. Select the cable types you intend to upload to the
instrument and click on < copy. The selected cable types will be
transferred to your 9102.

NOTE

It is recommended to transfer only the cable types needed for mea-
surements to the 9102 for practical reasons. If you have too many
cable types stored on your 9102 finding the one requrired for your
distance-to-fault measurement could be time-consuming.

In order to define a new cable type not available in the predefined
parameter files proceed as follows:

1 Select Tools > DTF Cable Type Editor ... or Alt+C or click on the icon
in the menu bar: k2. The Cable Type window is displayed.

2 Enter the cable characteristics: cable dielectric, cable velocity
factor, cable attenuation and cable cutoff frequency. For details on
the values to be entered here refer to the manufacturer’s informa-
tion. For general information on cable parameters refer to “Speci-
fying cable settings” on page 166.

3 Click on Save to save the cable type on your PC. A file selection
window is displayed. The file will be saved with the file extension
*.ct.

You can now transfer the defined cable type to your 9102 using the
same procedure as described in “Uploading predefined cable types to
the instrument” on page 246.

You can also transfer cable types defined on the 9102 to your PC. The
procedure is virtually identical to the one described in “Uploading
predefined cable types to the instrument” on page 246. The cable
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types stored on the 9102 are displayed in the Instrument area on the
lefthand side of the data transfer screen. Simply select the required
cable types and click on copy >.

Managing antenna factors for EMF measurements

The antenna is one of the most important factors for EMF measure-
ments. For antenna calibration a correction table containing k factors
is required. These factors are proportionality factors which correct the
antenna’s frequency response and help to convert the measured
power or voltage to field strength or power density. Using the k factor
table the measured level is converted into the relevant quantities.

Aeroflex delivers its measurement antennas in conjunction with the
appropriate correction factor tables. Using the 9100 Data Exchange
Software you can transfer the k factor tables delivered to your instru-
ment. You can also use the 9100 Data Exchange Software to collect the
correction data for antennas from other vendors and transfer them to
your 9102.

For a detailed description of EMF measurements and the relevant
antenna types refer to Chapter 12 “EMF (EMI) Operation”.

EMF Antenna Factor - BICONICAL.9AF 5[
Frequency [ Hz Level [ dB/m

a 40.0
50000000 48.0
125000000 40.0
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T
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Edit
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The functionality described in the following sections is specifically
dedicated to the usage of the 9131 EMF Measurement Option. If this
option is not installed and activated on your 9102 this functionality is
of no practical use.
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Open the EMF Antenna Factor menu by selecting Tools > EMF
Antenna Factor Editor... or by pressing Alt+A or by clicking on the
icon in the menu bar: [44] .

To enter an interpolation point, select Insert.
A dialog box appears, allowing you to enter frequency and level.

Enter the frequency, select a unit (from hertz to gigahertz) and
enter the coupling factor (in dB). Positive factors indicate signal
attenuation, negative factors indicate gain in the signal line.

Close the box by pressing OK and repeat the last two steps with as
many interpolation points as available.

The frequency-dependent compensation curve appears on the
right-hand side as values are entered.

If you want to change a factor, either select a line from the table on
the left-hand side and click on Edit to change the values numeri-
cally, or point with the mouse to an interpolation point in the graph
on the right and drag it to a new position.

To move the whole interpolation curve up or down in steps of 1 dB,
click on the Level Offset arrow buttons.

When completed, save the antenna factor values in a file on the PC:
Click on Save, enter a file name and confirm by clicking on Save.

Press Cancel to close the EMF Antenna Factor Editor window.

One or more antenna factor files can be transferred to the 9102 and
reside in the internal memory of the 9102. They will not be taken into
account until they are activated.

1

Select Instrument > Data Transfer (Ctrl-D), or in the EMF Antenna
Factor Editor menu, select Data Transfer.
The Data Transfer menu opens.

In the EMF Antenna Factors tab, select a directory and file(s) on the
right-hand side and press < copy.
The selected files are transferred to the 9102.

9102 Handheld Spectrum Analyzer  Software version 5.31 249



Chapter 15 9100 Data Exchange Software
Managing cable factors for EMF measurements

Managing cable factors for EMF measurements

Defining a cable factor
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If you are using an extension cable for your EMF measurement setup,
for example in order to mount an antenna on a tripod and turning
device, cable attenuation has to be taken into account by using the
appropriate cable correction factors on the 9102. You maintain and
edit these cable factors within the 9100 Data Exchange software. In
order to employ them during EMF measurements on the 9102 you can
then transfer them to your instrument.

For further details on the usage of cable factors during EMF measure-
ments refer to Chapter 12 “EMF (EMD Operation”.
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NOTE

The functionality described in the following sections is specifically
dedicated to the usage of the 9131 EMF Measurement Option. If this
option is not installed and activated on your 9102 this functionality is
of no practical use.

1 Open the EMF Cable Factor menu by selecting Tools > EMF Cable
Factor Editor... or by pressing Alt+F or by clicking on the icon in the
menu bar:

o

2 To enter an interpolation point, select Insert.
A dialog box appears, allowing you to enter frequency and level.

3 Enter the frequency, select a unit (from hertz to gigahertz) and
enter the coupling factor (in dB). Positive factors indicate signal
attenuation, negative factors indicate gain in the signal line.

4 Close the box by pressing OK and repeat the last two steps with as
many interpolation points as available.
The frequency-dependent compensation curve appears on the
right-hand side as values are entered.

9102 Handheld Spectrum Analyzer  Software version 5.31



Loading cable factor files
to the 9102

Working with settings

Exchanging a settings
file between 9102 and
PC

Changing 9102 settings
on the PC

Chapter 15 9100 Data Exchange Software
Working with settings

5 If you want to change a factor, either select a line from the table on
the left-hand side and click on Edit to change the values numeri-
cally, or point with the mouse to an interpolation point in the graph
on the right and drag it to a new position.

6 To move the whole interpolation curve up or down in steps of 1 dB,
click on the Level Offset arrow buttons.

7 When completed, save the antenna factor values in a file on the PC:
Click on Save, enter a file name and confirm by clicking on Save.

8 Press Cancel to close the EMF Cable Factor Editor window.

One or more cable factor files can be transferred to the 9102 and
reside in the internal memory of the 9102. They will not be taken into
account until they are activated.

1 Select Instrument > Data Transfer (Ctrl-D), or in the EMF Cable Editor
menu, select Data Transfer.
The Data Transfer menu opens.

2 In the EMF Cable Factors tab, select a directory and file(s) on the
right-hand side and press < copy.
The selected files are transferred to the 9102.

The 9102 allows to store and recall settings (see section “Working with
stored settings” on page 52). This can be useful when you want to
perform measurements under exactly the same conditions as at an
earlier time. With the 9100 Data Exchange Software, you can transfer
the settings from a 9102 to the PC for backup purposes or to replicate
the settings to another 9102. Another useful application is to manipu-
late settings on the PC; this is easily done because the settings file is
editable and the format consists of SCPI commands. Changing or
adding a setting is equivalent to changing or adding a line in the
settings file.

The settings stored on the 9102 can be copied to the PC with the 9100
Data Exchange Software. Use the Settings tab within the Data Transfer
utility to copy files between the PC and the 9102. See section
“Managing files on the PC and on the 9102" on page 252 for more
details.

Take the following steps to change and amend a settings file for later
transfer and usage on the 9102.

1 Inthe 9100 Data Exchange Software, select Tools > Setting Editor

or press Alt+S.
The 9100 Settings box appears.
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2 Click on Open to open an existing settings file on the PC. The Open
Settings File... dialog box appears.

3 Select the directory and settings file that you want to modify, and
click on Open. An additional program window with the Microsoft
Windows text editor Notepad opens, and the selected file is

displayed.
JR1=TES
File Edit Farmat YWiew Help
# SETTING GIM; created: 200442 5:20:3 |

IMPUL tATTenuation 40,0
SENSe:REFLevel 10.0
SEMSe:FREQUency :SPAM 30000000, 0
SENSe!FREQUenCy ICENTer QO02200000,0
SENSE:FREngnCﬁ:FSTe? EQODOGG.G
SENSe:BANDwidth:RESolution 300000, 0
SENSe:BANDwidth:vIDeo 300000, 0
SEMSe:SwWEep:TIMe 0,005
SEMNZ2lSWEepITIMaAUTO OFF
SEMNSEIMEASUre CPOwer
SENSe:TRACE:A:STATe MAXHOd

w

4] o

4 Modify or add lines with SCPI commands for the desired settings.
Refer to chapter “SCPI Command Reference” on page 257 for
correct syntax and value range of the parameters.

5 Save and close the file within Notepad, and return to 9100 Data
Exchange Software to transfer the file to the 9102.

Managing files on the PC and on the 9102

There are various types of settings which can be maintained from the
PC using the 9100 Data Exchange Software. This section explains how
data can be transferred between the 9102 and the PC, maintained and
deleted.

File types and directory  Each type of setting stored on the PC has a preferred file name exten-
structure  Sion and directory for different sets of parameters. The table below
summarizes this file structure.
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Table 16 Configuration file types

Type Elilai‘les Directory

Traces * Otr 9100 Data Exchange\Traces

Modified traces *9tm 9100 Data Exchange\Traces

saved on the PC

Settings *.9st 9100 Data Exchange\Settings

Limits *.9Im 9100 Data Exchange\Limits

Systems *.9sy 9100 Data Exchange\Systems

External device *9ed 9100 Data Exchange\Extdev

DTF cable type *9ct 9100 Data Exchange\Cable
Types

EMF antenna fac-  *.9af 9100 Data Exchange\Antenna

tor Factor

EMF cable factor *9cf 9100 Data Exchange\Cable Fac-

tor

The files on the PC and on the 9102 can easily be selected, copied and
deleted via the Data Transfer window.

1 Inthe 9100 Data Exchange Software, select Instrument > Data
Transfer (or Ctrl-D).
The Data Transfer window is displayed.

C:"Program Files' Aeroflex’, 9100 Data Exchange' Traces x|
Traces | Settings | Limits | Channel Systems | Extemal Devices I DITF Cable Types | EMF Antenna Factors | EMF Cable Factors |
rInstrument ~PC

=| & = x|
Hame [ Date [Time | ID Traces j J
DYMRANGE 4 2005-0CT-13 023310
DYMRANGE 3 2005-0CT-13 033758 Mame | Date | Time__|
DYNRANGE 2 2005-0CT-13 033744
DYMRANGET 2005-0CT-13 08:37:30
TESTA 20053EF30 111214 _com |
TEST 2005-5EP15 14:43:00
TEAT 2005-5EP-15 14:39:44 %
BLTIVE 0SSEPIE 112816 o |
REW1MHZ 2005-5EP12 10:22:38
REW300KHZ 2005-5EP13 10:22:28
REW100KHZ 2005-5EP13 10:22:20
REW30KHZ 2005-5EP12 10:22:10
REW10KHZ 2005-5EP12 10:22:02
RBW3kKHZ 2005-5EP13 10:21:52
Select Al I Select all |
il il Clase

2 Select the appropriate tab (Traces, Settings, Limits, Systems, Ext.
Device) either by clicking on it with the mouse, or by moving the
tab selection with the << and >> buttons.

The window displays the appropriate files available on the 9102 on
the left-hand side, and the appropriate files available on the PC on
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the right-hand side. Files on the PC have a file extension and can
be stored on any drive and in any directory; there are no directo-
ries available on the 9102.

File names on the 9102 only carry 11 characters. When copying a file
from the PC to the 9102 that has more than 11 characters, the file
name will be truncated. Only trace files with the extension *.9tr can
be transferred to the 9102.

254 9102 Handheld Spectrum Analyzer  Software version 5.31




Chapter 15 9100 Data Exchange Software
Including the GPS position in the trace

Copying configuration  Files can be copied in both directions.

files from the 9102 to . . o
the PC 1 Select a PC directory where the file shall be stored or from which it

shall be copied.

2 Select one or several files for copying, either on the PC or on the
9102.

3 Press < copy to transfer the files from the PC to the 9102.
or
Press copy > to transfer files to the PC.
If a file on one side has been selected for transfer and a file with
the same name already exists on the other, the 9100 Data
Exchange Software will display a pop-up box with the file name in
question in the header bar, and offer several possibilities:

— Click on Yes if you want to overwrite the file in question.
— Click on No to cancel transmission of the file in question.

— Click on Yes to All to copy all files, irrespective of duplicate file
names.

— Click on No to All to prevent overwriting of all files with duplicate
file names.

— Click on Rename to enter a new file name applying to that file
when transferred.

Filetransfer - desd.9tr =

@ desd It already exists.

Ovenwrite?

Mo | “res to &l | Moo Al | Rename | Cancel |

4 Click on Cancel to cancel transmission of all files, no matter
whether file names already exist on the receiving side or not.

RN

Deleting files To delete a file either on the 9102 or on the PC, select (highlight)
the file name first. Several files may be selected concurrently by

holding the Shift or Ctrl key pressed while selecting individual files.

2 Click on the Delete button [%] above the files marked for deletion.
A box appears asking, “Are you sure to delete the selected items?”

3 Click on Yes to confirm deletion.
The selected files are removed.

Including the GPS position in the trace

The location at the time of the measurement can be recorded and
viewed using the 9168 GPS Receiver Option. This requires the option
to be installed; see also “Connecting the GPS receiver” on page 39.
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For the location to be calculated, the GPS receiver must be switched
on as described in “Enabling the GPS receiver” on page 39.

In the trace display of the 9100 Data Exchange Software, the display of
the GPS coordinates can be enabled or disabled. Select View > GPS to
toggle between GPS coordinates being displayed or not. Longitude,
latitude and altitude are displayed on the lower right-hand side.

The resulting trace display looks about as follows:

Spectrum Anahyzer 8102 Devee tame: HEAIE 22 08 2006 150725

Impedance 50 Chem

- Ent. Davic Comp. -

- Rt 00de

= Anruation [T 23
Scale 5.0 dBidrv

Refloction
Canter 2060000 GHz
Span 2600000 MHz
Start 1920000 GHz
Stop 2 200000 GHz
Maoasuremant Victor
Toce A (ACT)

Trace B {OFF)
Averags Cout 5
Type. 9160 VSWRIDTF Bridge
Cal Date 01.06 2005
SW Version £ 50,0000
Boot Version :  5a
Serial Number 7
Cal Data 10
Lt Chock 10
by W
Mt Chack
Latitude
Lengiude 011 40,8450
Alitude 52

ar 2 0000 GHz Soiap 280 0000 bz

See also notes in section “Logging the current position (GPS-assisted)”
on page 39.
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This chapter provides a reference list of commands for remote control
of the 9102 Handheld Spectrum Analyzer. Topics discussed in this
chapter are as follows:

— “Overview” on page 258

— “General commands” on page 258
— “System commands” on page 264

— “Sense commands” on page 271

— “Input commands” on page 298

— “MMemory commands” on page 299
— “Instrument commands” on page 311
— “Display commands” on page 317

— “Calculate commands” on page 321
— “Format commands” on page 330

— “Service commands” on page 331

— “SCPI errors” on page 334
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Overview

Overview

General commands

258

The command set of the 9102 Handheld Spectrum Analyzer follows
the SCPI standard and is broken down into the following subsystems:

— General commands
— System commands

— Sense commands

— Input commands

— Memory commands
— Display commands

— Calculate commands
— Format commands

Each keyword in the command can be used either in its long or its short
form. Uppercase letters are used to indicate the short-form command
syntax. Within one keyword, either the short form or the full version can
be used, but not a mix.

The syntax can be used to form either a command or a query (with a
question mark behind the command form). Many SCPI commands have
either a command form or a query form, but not both.

Please refer to the “Index of SCPI Commands” on page 351 for an
alphabetical list of commands.

:REBoot
Syntax REBoot
Parameters There are no parameters.
Command Reboots the 9102. The current settings are not affected by this command.
Query There is no query form of this command available.
Example :REBoot
:HCOPy[ : IMMediate]
Syntax HCOPy[ : IMMediate]
Parameters There are no parameters.
Command Starts a printout over the serial port. For further informations see command
:SYSTem:PRINter:TYPe.
Query There is no query form of this command available.
Example :HCOPy
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*CAL

Syntax *CAL?

Parameters There are no parameters.

Command The command form is not available.

Query Returns the date of the last calibration by Aeroflex in the format yyyy,
mm,dd.

Example *CAL?

Returns 2004 ,04,01.

*OPT

Syntax *OPT?

Parameters There are no parameters.

Description The command form is not available.

Query

Example *OPT?
*CLS

Syntax *CLS

Parameters There are no parameters.

Command Resets the entire status reporting system:
- The service register will be cleared (all bits will be set to 0).
- The event status register will be cleared (all bits will be set to 0).
- The error message queue will be emptied.
- All event-type registers will be cleared.

Query There is no query form of this command available.
*1DN

Syntax *1DN?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Returns a string, containing the following information:

manufacturer's name

name of the device

serial number

- software revision number

All parameters are separated by commas.

Note: In times of company mergers and acquisitions, it is a good idea to
check the name of the device, not the manufacturer's name which may
change between software updates. This does not preclude any name
changes at Aeroflex but rather applies to instrumentation in general.
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Example *IDN?
returns: "AEROFLEX, 9102, 0104012, 1.00"

*RST

Syntax *RST

Parameters There are no parameters.

Command Resets the entire test set. All parameters, limits etc. will be set to the inter-
nally predefined default values.

Query There is no query form available.
*WAI

Syntax *WAI

Parameters There are no parameters.

Description Postpones the execution of a command until all commands issued previ-
ously have been completed

Query There is no query form of this command available.
*0PC

Syntax *0PC?

Parameters There are no parameters.

Command Only the query form is available.

Query Waits until the previous command is completed. In addition, the query
returns the Operation Complete flag which is 1 in the successful case.

Commands affecting the  The event status register contains eight bits. The meaning of these bits
event status register is outlined in the table below.
The commands working on the event status register are described
below the table.

Bit Zeam Meaning
128 Power on — this bit is always set.

6 64 User Request — a 1 on this position indicates
that the 9102 is no longer controlled by
remote commands but by user interaction.

5 32 Command error — this bit indicates that a SCPI
command error occurred (SCPI error codes
100 to 199).

4 16 Execution error — is set after a SCPI execution

error did occur (SCPI error codes 200 to 299).
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3 8 Device-dependent error — this bit indicates
that a device-specific SCPI error did occur
(SCPI error codes 300 to 399).

2 4 Query error — is set after a SCPI query error
occurred (SCPI error codes 400 to 499).

1 2 Request control — this bit is reserved for future
use.

0 1 Operation complete flag — is set as soon as
the execution of a command has been com-
pleted.

*ESE

Syntax *ESE <intl>

Parameters intl is an integer.
The valid range is from O to 255 (8 bits).

Command Sets the enable filter (mask) of the event status register.
intl is the decimal representation of the binary mask.
The mask and the current contents of the event status register will be
ANDed. If the result is not zero, then bit 5 of the Service register will be set.

Query The query form reads out the enable filter (mask) currently set and returns
its binary representation in a string.

Example *ESE 128
As soon as power has been switched on, bit 7 (Power on) will be set.
ANDed with the mask 128, a binary 1 will occur and thus bit 5 of the ser-
vice register will be set.
*ESR

Syntax *ESR?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Returns the decimal representation of the current contents of the event sta-
tus register in a string.
Note: This register is self-destructive, i.e. its contents will be cleared after
reading.

Example After power-on, the *ESR? query will return "*128"". This means that bit 7 is
set and all the other bits of the event status register are 0.
The command will clear the event status register and a subsequent *ESR?
query will return 0™,

Commands affecting the
service register

The service register represents the highest level within the report struc-
ture of the 9102.

The service register contains eight bits.

If any of the bits O to 5 or 7 is set, the summary status bit (bit 6) of the
service register will be set as well.
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The service register is self-destructive. This means that its contents
will be cleared after reading.

Bit Zeam Meaning

7 128 OPERational status summary. When this bit is
set, an event within the general operation reg-
ister group (e.g. the 9102 is waiting for a trig-
ger) passed all filters.

6 64 Summary status bit. This bit will always be set
as soon as any other bit of the service register
has been set.

5 32 Event status summary. When this bit is set, an
event within the event status register group
(e.g. an error occurred) passed all filters.

4 16 Message available. This bit will be set to 1 as
soon as a query has been completed and
measurement results are available.

3 8 QUESTionable status summary. If this bit is set,
an event within the general questionable sta-
tus register group (e.g. 'value out of range')
passed all filters.

2 4 Error queue status. When this bit is set, the
error queue contains error messages. Up to
10 error messages can be logged in the error
queue. The error queue can be read out,
using the :SySTem:ERRor? query.

1 2 Remote command completed. This bit will be
set to 1 after a remote (SCPl) command has
been completed.

Note: When the 9102 receives a SCPI com-
mand, it will block any further input readings
until the command has been completed.

*SRE

Syntax *SRE <intl>

Parameters intl is an integer.
The valid range is from O to 255 (8 bits).

Command Sets the enable filter (mask) for the service register.
intl is the decimal representation of this binary mask.
The mask and the current contents of the service register will be ANDed.

Query The query form reads out the mask currently set and returns its binary rep-
resentation in a string.
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Example *SRE 68
As soon as an error occurs, bits 2 and 6 of the service register will be set.
ANDed with the mask (68), a binary 1 will be the result.
*STB

Syntax *STB?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Returns the decimal representation of the current contents of the service
register in a string.
Note: This register is self-destructive, i.e. its contents will be cleared after
reading.

Example A *STB? command returns "'68"".

The return value of 68 (= 64 + 4) means that an error occurred (4).
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System commands

With the system commands, the internal settings of the 9102 Handheld
Spectrum Analyzer can be changed.

:SYSTem:DATE

Syntax :SYSTem:DATE <intl>,<int2>,<int3>

Parameters intx are three integers.
The minimum value for intl is 1998, the maximum is 2100. The default
value is 1998.
The minimum value for int2 is 1, the maximum is 12. The default value is
1
The minimum value for int3 is 1, the maximum is 31. The default value is
1

Command Sets the system date. This command uses the following format:

yyyy,mm,dd where

yyyy stands for the four digits of the year (intb),
mm gives the current month (int2),

dd represents the day of the current month (int3).

Query Reads and returns the current system date in a string, using the format
explained above.

Example :SYST:DATE 2001,7,6
Sets the system date to the July 6, 2001.

:SYSTem:TIME

Syntax :SYSTem:TIME <intl>,<int2>,<int3>

Parameters intx are three integers.
The minimum value for intl is O, the maximum is 23. The default value is
0.
The minimum value for int2 is O, the maximum is 59. The default value is
0.
The minimum value for int3 is O, the maximum is 59. The default value is
0.

Command Sets the system time. This command uses the following format: hh,mm, ss
where
hh stands for the two digits of the current hour, using a 24 hour time format
(intd),
mm gives the current minute (int2) and,
ss represents the seconds of the system time (int3).

Query Reads and returns the current system time in a string, using the format
explained above.

Example :SYST:TIME?
String returned in this example: 14,56 ,05" meaning roughly four min-
utes to 3 pm.
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:SYSTem:COMMunicate:LOCal

Syntax
Parameters

Command

Query

Example

:SYSTem:COMMunicate:LOCal
There are no parameters.

Sets up the 9102 to allow manual operation on the front panel during SCPI

operation.

Notes:

- This command may be used e.g. to allow interactive alignment procedures in a
production flow.

- The instrument can also be set to local mode by pressing the Escape function key
on the front panel.

There is no query form of this command available.

:SYSTem:>COMM:LOC

:SYSTem:COMMunicate:ECHO

Syntax

Parameters

Command

Query

Example

:SYSTem:COMMunicate:ECHo <PredefExpr>

PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

This command determines how the Aeroflex 9102 acts after executing a
SCPI command.

If echo is set to ON, there will be a response. Either ""'ok™, if the execution
was successful or ""ERR" if an error occured. The echo-on mode is pre-
ferred for entering interactive commands.

If echo is set to OFF, there will be no response to a SCPI command. In this
case it is possible to check with the *OPC? query, when the SCPI command
is finished and the Aeroflex 9102 is ready to receive the next command.

Reads and returns the current echo setting.

:SYST:COMM:ECH ON

Returns the following string: "'ok"*

All subsequent commands returns "ok or ""ERR"
:SYST:COMM:ECH?

Returns the following string: ""ON"*

:SYST:COMM:ECH OFF

Returns nothing, all subsequent commands return nothing

:SYSTem:COMMunicate:ETHernet?

Syntax
Parameters
Command

Query

Example

:SYSTem:COMMunicate:ETHernet?
There are no parameters.
There is solely a query form of this command available.

Returns ON, if the Aeroflex 9102 is connected to a local area network (LAN)
via TCP/IP connector, otherwise returns OFF.

:SYSTem:COMM:ETH?
String returned in this example: ""OFF"
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:SYSTem:COMMunicate:ETHernet: IPADdress

Syntax :SYSTem:COMMunicate:ETHernet: 1PADdress
<intl>,<int2>,<int3>,<int4>

Parameters intx are four integers.
The minimum value for all integers is 0, the maximum is 255. The default
value is O.

Command This command sets the IP address of the Aeroflex 9102 to the parameter
values.

Query Reads and returns the current setting of the IP address as explained above.

Example SYST:COMM:ETH: IPAD 192,16,16,114 sets the IP address to a defined
value.

:SYSTem:COMMunicate:ETHernet: TNAMe

Syntax :SYSTem:COMMunicate:ETHernet:TNAMe <string>
Parameters string is a string only containing the device name of the Aeroflex 9102.
Command This command sets the device name of the Aeroflex 9102. It can be used

to announce a symbolic device name for the 9102, if the network supports
DHCP (Dynamic Host Configuration Protocol).

Query Reads and returns the current setting of the device name as explained
above.
Example SYST:COMM:ETHernet:TNAMe "TARGET9104'" sets the device name to

a defined value.

:SYSTem:COMMunicate:ETHernet:SUBNetmask

Syntax :SYSTem:COMMunicate:ETHernet:SUBNetmask
<intl>,<int2>,<int3>,<int4>

Parameters intx are four integers.
The minimum value for all integers is 0, the maximum is 255. The default
value is O.

Command This command sets the subnet mask of the Aeroflex 9102 to the parameter

values. Setting a subnet mask may speed up the traffic on the Ethernet.
Note: This command is supported from software version 2.00 on.

Query Returns the current setting of the subnet mask as explained above.

Example SYST:COMM:ETH:SUBN 255,255,255, 255 sets the subnet mask to a
defined value.

:SYSTem:COMMunicate:ETHernet:PORT

Syntax :SYSTem:COMMunicate:ETHernet:PORT <int>

Parameters int defines the TCP/IP port address of the Aeroflex 9102. The address
must be in the range from 1024 to 65535. Default value is 49200.

Command This command sets the port address on which the Aeroflex 9102 can be
controlled via LAN to a new value.
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Query Reads and returns the current setting of the port used by TCPIP as
explained above.

Example SYST:COMM:ETHernet:PORT 49200 sets the TCP/IP port address to its
default.

:SYSTem:COMMunicate:ETHernet:TERMinator

Syntax :SYSTem:COMMunicate:ETHernet:TERMinator <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
CRLF|LF]CR.

Default is CRLF.

Command Sets the terminator characters, which are appended to every SCPI respond
from the Aeroflex 9102 LAN interface.

Query Reads and returns the current terminator setting for the LAN interface.

Example :SYST:COMM:ETH:TERM CR
:SYST:COMM:ETH:TERM?

Returns the following string: "'CR""
:SYSTem:COMMunicate:SER:BAUDrate

Syntax :SYSTem:COMMunicate:SER:BAUDrate <intl>

Parameters intl is an integer.

The minimum value for intl is 300, the maximum value is 57600. The
default value for intl is 57600. Valid values are
300,1200,2400,4800,9600,19200,38400 and 57600.

Command Sets the data rate for the serial port. Only the data rate can be changed; all
other parameters are fixed. The number of bits per character is set to 8, the
number of stop bits is set to 1 and parity is set to NO.

Query Reads and returns the serial interface data rate currently set.

Example :SYST:COMM:SER:BAUD 9600
:SYST:COMM:SER:BAUD?

String returned in this example: "*9600"".
:SYSTem:COMMunicate:SER: TERMinator

Syntax :SYSTem:COMMunicate:SER:TERMinator <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
CRLF|LF]CR.

Default is CRLF.

Command Sets the terminator characters, which are appended to every SCPI
response from the Aeroflex 9102 serial interface.

Query Reads and returns the current terminator setting for the serial interface.

Example :SYST:COMM:SER:TERM LF

:SYST:COMM: SER:TERM?
Returns the following string: "'LF"
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-SYSTem:ERRor [ :NEXT]?

Syntax :SYSTem:ERRor[:NEXT]?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the oldest unread error message from the internal error queue of

the Aeroflex 9102. The queue entry returned will be a string (text). The
maximum length of the text is 255 characters.

Note: A list of error messages can be found in section “SCPI errors” on
page 334.

Example *RESET
:SYSTem:ERRor :NEXT?
String returned in this example: -113,""Undefined header™

:SYSTem:-ERRor:COUNt?

Syntax :SYSTem:ERRor :COUNt?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the number of unread error messages in the internal error queue

of the Aeroflex 9102. The string returned will contain one integer. The max-
imum number of errors stored internally is 10.

Example :SYSTem:ERRor :COUNt?
String returned in this example: **0™
This means that there are no unread error messages in the error queue.

:SYSTem:ERRor :CODE[ :NEXT]?

Syntax :SYSTem:ERRor :CODE[ :NEXT]?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the code of the oldest unread error message in the internal error

queue of the Aeroflex 9102. The string returned will contain one integer
(and no texb.

Note: A list of error messages can be found in section “SCPI errors” on
page 334.

Example *RESET
:SYSTem:ERRor:CODE?
String returned in this example: ""-113""
This means that an undefined header (*RESET) was received.

:SYSTem:-ERRor :CODE:-ALL?

Syntax :SYSTem:ERRor :CODE:ALL?
Parameters There are no parameters.
Command There is solely a query form of this command available.
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Query Returns the error codes of all unread error messages in the internal error
queue of the Aeroflex 9102. The string returned will contain a maximum of
100 integers, separated by commas.
Note: A list of error messages can be found in section “SCPI errors” on
page 334.

Example :SYSTem:ERRor :CODE:ALL?
String returned in this example: **-113,-112,0,0,0,0,0,0,0,0"
This means that there were two unread error messages in the error queue.
:SYSTem:DNAMe

Syntax :SYSTem:DNAMe <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Sets a user-definable device name for the 9102 to use this unique name on
protocols.

Query Reads and returns the device name set on this 9102.

Example :SYSTem:DNAMe "‘Develop5"
:SYST:DNAM?
String returned in this example: ""Develop5™
:SYSTem:OPTions

Syntax :SYSTem:0OPTions <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
25 characters.

Command Enables or disables a software option on the Aeroflex 9102 with the appro-
priate option key stringl.

Query There is no query form available.

Example :SYSTem:OPTions ""00172663845433"
Enables the option corresponding to the key.
:SYSTem:SCReendump :COLor?

Syntax :SYSTem:SCReendump:COLor? <intl>

Parameters intl is a integer in the range of O to 255.

Command There is only the query form available.

Query Returns the RGB color value (in hexadecimal) of the given color palette
entry. Max. 256 palette entries are available.

Example :SYST:SCR:COL? 5

String returned in this example:
"'a800a8"
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:SYSTem:SCReendump:LINe?

Syntax :SYSTem:SCReendump:LINe? <intl>

Parameters intl is a integer in the range of 0 to 479.

Command There is only the query form available.

Query Returns one pixel line (of 480) of the screen as pairs of hexadecimal val-
ues.

Example :SYST:SCR:LIN? 345
String returned in this example:
""0201420FFF00T600010¥0201080b1e0F1e0b™

:SYSTem:SCReendump :REMote

Syntax :SYSTem:SCReendump:REMote <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Command This command removes the Remote display when it is set to OFF. This is
useful for screen dumps.

Query Reads and returns the current setting.

Example :SYST:SCR:REM OFF

:SYST:SCR:REM?
Returns the following string: ""OFF"

:SYSTem:PRINter:TYPe

Syntax :SYSTem:PRINter:TYPe <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: OFF | PCL.
Default is OFF.

Command This command set the printer type for a hardcopy of the display. At the
moment, only PCL capable printer like HP Laserjet are supported. The
printer has to be connected to the serial port (normaly with a R5232/Cen-
tronics converter), therefore remote control of printer output is only possi-
ble via TCP/IP. The serial interface has to be set to the maximum possible
baudrate of the printer/converter with command SYSTem: COMMuni -
cate:SER:BAUDrate. The output to the printer is started with command
HCOPy[ : IMMediate].

Query Reads and returns the current setting.

Example :SYSTem:PRINter:TYPe PCL
:SYSTem:PRINter:TYPe?
Returns the following string: ""PCL""

:SYSTem:PRINter:BAUDrate

Syntax :SYSTem:PRINter:BAUDrate <intl>

Parameters intl is an integer.
The minimum value for intl IS 300, the maximum value is 57600. The
default value for intl is 19200. Valid values are
300,1200,2400,4800,9600,19200,38400 and 57600.
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Sets the data rate for the serial port if a printer is connected. The print out-
put can be started with HCOPy. Only the data rate can be changed; all other
parameters are fixed. The number of bits per character is set to 8, the num-
ber of stop bits is set to 1 and parity is set to NO.

Reads and returns the serial interface data rate currently set.

:SYST:PRINter:BAUD 9600
:SYST:PRINter:BAUD?
String returned in this example:
9600.

Sense commands

These commands affect the spectrum analyzer settings, start measure-
ments and return results.

:SENSe:BANDwidth:RESolution

Syntax

Parameters

Command
Query

Example

:SENSe :BANDwidth:RESolution <reall>

reall is a floating point real number.

The minimum value for reall is 100, the maximum value 1000000.
reall can be set as 1+10" or 3*10". The default value for reall is
1000000.

This command sets the resolution bandwidth of the 9102, in Hertz.
Reads and returns the current setting.

:SENSe:BANDwidth:RESolution 300000
:SENSe :BANDwidth:RESolution?
The value returned in this example is: **300000"".

:SENSe:BANDwidth:RESolution:AUTo

Syntax

Parameters

Command

Query

Example

:SENSe :BANDwidth:RESolution:AUTo <PredefExpr>

PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Switches the automatic selection of the bandwidth resolution on or off. If
switched on, the 9102 selects the resolution bandwidth depending on the
current span, video bandwidth, and sweep time.

Reads and returns the current setting.

:SENSe:BANDwidth:RESolution:AUTo ON
:SENSe :BANDwidth:RESolution:AUTO?
Returns the following string: *"ON**

:SENSe:BANDwidth:VIDeo

Syntax

:SENSe:BANDwidth:VIDeo <reall>
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Parameters reall is a floating point real number.
The minimum value for reall is 10, the maximum value 1000000.
Possible values are:
10,100,300,1000,3000,10000,30000,100000,300000,1000000.
The default value for real 1l is 2000000.

Command Sets the video bandwidth of the 9102. The unit of reall is Hertz.
Query Reads and returns the current setting.
Example :SENSe :BANDwidth:VIDeo 300000

:SENSe :BANDwidth:VIDeo?
The value returned in this example is: *300000"".

:SENSe:BANDwidth:VIDeo:AUTo

Syntax :SENSe :BANDwidth:VIDeo:AUTo <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON]OFF].
Default is ON.

Command Switches the automatic selection of the video bandwidth on or off. If

switched on, the 9102 selects the video bandwidth depending on the cur-
rent span, resolution bandwidth, and sweep time.

Query Reads and returns the current setting.

Example :SENSe:BANDwidth:VIDeo:AUTo OFF
:SENSe:BANDwidth:VIDeo:AUT0?
Returns the following string: **OFF*"

:SENSe:FREQuency:CENTer

Syntax :SENSe:FREQuency:CENTer <reall>

Parameters reall is a floating point real number.
The minimum value for real 1 is 5000, the maximum value 7500000000.
reall can be set in multiples of 1000. The default value for reall is
1800000000.

Command Sets the center frequency of the 9102, in Hertz. When a new center fre-
quency is selected, this affects the start and stop frequencies, leaving the
span unchanged so long as the new start and stop frequencies do not
exceed the limits of the 9102.

Query Returns the current setting.

Example :SENSe:FREQuency:CENTer 1500000000
:SENSe:FREQuency:CENTer?
The value returned in this example is: **1500000000"".

:SENSe:FREQuency : SPAN

Syntax :SENSe:FREQuency:SPAN <reall>

Parameters reall is a floating point real number.
The minimum value for real 1 is 0, the maximum value 7500000000. The
minimum resolution possible for reall is 1000. The default value for
reall is 3600000000.
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Command Sets the frequency span, i.e. the measured bandwidth, in Hertz. A new fre-
quency span setting will leave the center frequency unchanged but affect
start and stop frequencies; only if the new start or stop frequency exceeds
a limit of the 9102, the center frequency will be changed accordingly.

Query Reads and returns the current setting.

Example :SENSe :FREQuency : SPAN 1500000000
:SENSe :FREQuency : SPAN?

The value returned in this example is: "*1500000000"".
-SENSe :FREQuency:SPAN:FULL

Syntax :SENSe:FREQuency : SPAN:FULL

Parameters There are no parameters.

Command Sets the 9102 to the maximum supported frequency span. This command
affects start, stop and corresponding center frequency.

Note: If you set the span to 0, the 9102 will perform measurements in the
time rather than the frequency domain.

Query There is no query form of this command available.

Example :SENS:FREQ:SPAN:FULL
Sets the start frequency of the 9102 to 0 and the stop frequency to 4 GHz
(or 7.5 GHz if the frequency extension option is installed).
:SENSe:FREQuency :STARt

Syntax :SENSe:FREQuency:STARt <reall>

Parameters reall is a floating point real number.

The minimum value for reall is O, the maximum value 7500000000. The
minimum resolution possible for real 1 is 1000. The default value for
reallisO.

Command Sets the start frequency of the 9102, in Hertz. This command leaves the
span as is but affects the center frequency and the stop frequency.

Query Reads and returns the current setting.

Example :SENSe:FREQuency:STARt 1500000000
:SENSe:FREQuency :STARt?

The value returned in this example is: "*1500000000"".
:SENSe:FREQuency:STOP

Syntax :SENSe:FREQuency:STOP <reall>

Parameters reall is a floating point real number.

The minimum value for real 1 is 10000, the maximum value 7500000000.
The minimum resolution possible for reall is 1000. The default value for
reall is 3600000000.

Command Sets the stop frequency of the measured bandwidth, in Hertz. This com-
mand leaves the span unchanged but affects the center frequency and the
start frequency.

Query Reads and returns the current setting.
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Example :SENSe :FREQuency :STOP 2500000000
:SENSe :FREQuency:STOP?
The value returned in this example is: "*2500000000"".

-SENSe :FREQuency:STOP :MAX

Syntax :SENSe : FREQuency :MAX?

Parameters There are no parameters.

Command There is only the query form available.

Query Returns the maximum stop frequency supported by the instrument at hand.
Example :SENS:FREQ:STOP:MAX?

-SENSe :FREQuency :MODE

Syntax :SENSe:FREQuency :MODE <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:
CSPan | SSTop | SSPAN. Default is CSPan.
Command Defines which frequency mode is active.
Three modes are available: Center-Span, Start-Stop, Start-Span.
Query Returns the current setting.
Example :SENSe :FREQuency :MODe CSPan

:SENSe : FREQuency :MODe?
Returns the following string: **CSPan*"

-SENSe:FREQuency:FSTep

Syntax :SENSe:FREQuency:FSTep <reall>

Parameters reall is a floating point real number. The minimum value for reall is O,
the maximum value 1000000000. The minimum resolution possible for
reall is 1000. The default value for reall is 360000000.

Command Sets the step size for the center frequency setting using the cursor keys in
manual mode.

Query Reads and returns the current setting.

Example :SENSe:FREQuency:FSTep 2.5E6

:SENSe:FREQuency :FST?
Value returned in this example: 2500000

-SENSe:FREQuency:FSTep:AUTO

Syntax :SENSe:FREQuency:FSTep:AUTo <PredefExp>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Command Enables or disables the automatic selection of the step size for the center

frequency setting using the cursor keys in manual mode.

Query Reads and returns the current setting.
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Example :SENSe:FREQuency:FSTep:AUTo ON
:SENSe:FREQuency:FSTep:AUT0?
Returns the following string: *"ON"*
-SENSe :CPOWer - SPAN

Syntax :SENSe:CPOWer:SPAN <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: FULL | SIN-
Gle.
Default is FULL.

Command Sets the channel power display mode of the 9102.
FULL selects the whole system spectrum. SINGl e displays the spectrum of
the selected channel.

Query Reads and returns the current setting.

Example :CPOWer :SPAN SINGle
:SENSe :CPOWer :SPAN?
Returns the following string: **'SINGle™
:SENSe :CPOWer :CHANnel

Syntax :SENSe:CPOWer:CHANnel <intl>

Parameters intl is an integer. The minimum value for intl is O, the maximum is
1000000. The default value is 0.

Command Sets the actual channel number which is displayed in SINGle and FULL
mode.

Query Reads and returns the current setting.

Example :SENSe:CPOWer :CHANnel 50
:SENSe :CPOWer :CHANNnel?
The value returned in this example is: ""'50"".
-SENSe :CPOWer - OBW

Syntax :SENSe :CPOWer:0BW <intl>

Parameters intl is a integer. The minimum value for intl is 5, the maximum is 99.
The default value for intl is 90.

Command Sets the percentage value for which the 9102 shall determine the occupied
bandwidth (channnel power mode).

Query Reads and returns the current setting.

Example :SENSe :CPOWer:0BW 20
:SENSe :CPOWer -:OBW?
The value returned in this example is: "'20"
:SENSe :CPOWer :MEASure

Syntax :SENSe:CPOWer :MEASure <PredefExp>

Parameters PredefExpr is one of the following predefined expressions:

CPOWer | ACPR] OBW. Default is CPOWer.
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Command Starts measurements of the type described by PredefExpr.
Query Reads and returns the current setting.
Example :SENSe:CPOWer :MEASure ACPR

:SENSe :CPOWer :MEASure?

Returns the following string: ""ACPR"".

:SENSe:SWEep:TIME

Syntax :SENSe:SWEep:TIME <reall>

Parameters reall is a floating point real number.
The minimum value for reall is 0.0, the maximum value 250.0. The min-
imum resolution possible for reall is 0.0001. The default value for
reallis 0.0432.

Command Sets the sweep time, i.e. the measurement time to cover the full frequency
span. reall is the time in seconds.

Query Reads and returns the current setting.

Example :SENSe:SWEep:TIME 0.3

:SENSe:SWEep:TIME?
The value returned in this example is: ""0.3"".

:SENSe:SWEep:TIME:AUTO

Syntax :SENSe:SWEep:TIME:AUTO <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Command Switches the automatic selection of the sweep time on or off. If turned on,

the 9102 will decide on the best sweep time depending on the current set-
tings of span, resolution bandwidth and video bandwidth.

Query Reads and returns the current setting.

Example :SENSe:SWEep:TIME:AUTO ON
:SENSe:SWEep:TIME:AUTO?
Returns the following string: ""ON"".

:SENSe:SWEep:STATe

Syntax :SENSe:SWEep:STATe <PredefExpr>[,<intl>]

Parameters PredefExpr is one of the following predefined expressions:
CONTinuous | SINGIe|HOLD. Default is CONT inuous.
intl is an optional integer. It is only valid for SINGle sweeps. The mini-
mum value for intl is 1, the maximum is 999. The default value is 1.

Command Sets the measurement display mode of the 9102.
CONTinuous selects repetitive measurements.
SINGIe lets the 9102 perform and display one (or a limited number of)
measurement(s). The optional second parameter indicates how often a
sweep will be performed.
HOLD immediately stops any ongoing measurement.

Query Reads and returns the current setting.
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Example :SENSe:SWEep:STATe SINGle
:SENSe:SWEep:STATe?
Returns the following string: "'SINGlIe™.

:SENSe:TRIGger

Syntax :SENSe:TRIGger <PredefExpr>

Parameters PredefEXxpr is one of the following predefined expressions: OFF |V IDeo.
Default is OFF.

Command Sets the trigger mode of the 9102.
OFF means no trigger is active. VIDeo activates the trigger at choosen
level.

Query Reads and returns the current setting.

Example SENSe:TRI1Gger VIDeo

:SENSe:TRIGger?
Returns the following string: "'VIDeo".

:SENSe:TRIGger:LEVel

Syntax :SENSe:TRIGger:LEVel <reall>

Parameters reall is a floating point real number.
The minimum value for real 1 is -100, the maximum value 30.0. The min-
imum resolution possible for reall is 0.1 The default value is -40.

Command Sets the trigger level which is active, if SENSe - TR1Gger is set to VIDeo.
reall is the level in dBm.

Query Reads and returns the current setting.

Example :SENSe:TRIGger:LEVel -10

:SENSe:TRIGger:LEVel?
The value returned in this example is: ""-10"".

:SENSe:TR1Gger -EDGE

Syntax :SENSe:TRIGger:EDGE <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
POSitive|NEGative. Default is POSitive.

Command Sets either the positive or the negative slope for the trigger.

Query Reads and returns the current setting.

Example SENSe:TRI1Gger:EDGe NEGative

:SENSe:TRI1Gger?
Returns the following string: ""NEGative"".

:SENSe :DEMod[ :MODulation]

Syntax :SENSe:DEMod[ :MODulation] <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: OFF | AM] FM.
Default is OFF.
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Command

Query

Example

Sets the demodulation mode, which can be off, AM (amplitude modulation)
or FM (frequency modulation). FM demodulation is performed in a 30 kHz
bandwidth.

Reads and returns the current setting.

:SENSe:DEMod FM
:SENSe :DEMod :MODulation?
Returns the following string: *'"FM"*

:SENSe :DEMod : DEMod

Syntax

Parameters

Command
Query

Example

:SENSe :DEMod :DEMod <PredefExpr>

PredefExpr is one of the following predefined expressions:
PERManent|ATMarker.
Default is PERManent.

Sets the demodulation permanent to center frequency or at marker.
Reads and returns the current setting.

:SENSe :DEMod :DEMod PERManent
:SENSe : DEMod : DEMod?
Returns the following string: **PERManent"’

:SENSe :DEMod:VOLume

Syntax

Parameters

Command
Query

Example

:SENSe:DEMod:VOLume <intl>

intl is an integer. The minimum value for intl is O, the maximum is 100.
The default value for int1 is 50.

Sets the volume of the demodulated signal in percent.
Reads and returns the current setting.

:SENSe:DEMod:VOLume 20
:SENSe:DEMod: VOLume?
The value returned in this example is: *"20".

:SENSe:DEMod :DURation

Syntax

Parameters

Command
Query

Example

:SENSe:DEMod:DURation <reall>

reall is a floating point real number. The minimum value for reallis O,
the maximum value 10. The minimum resolution is 0.001. The default
value is 2.

Sets the duration of the demodulated signal in seconds.
Reads and returns the current setting.

:SENSe :DEMod:DURation 10
:SENSe :DEMod :DURation?
The value returned in this example is: ""10"".
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:SENSe:DETector :FUNCtion

Syntax

Parameters

Command

Query

Example

:SENSe:DETector:FUNCtion <PredefExpr>

PredefExpr is one of the following predefined expressions:
POSNeg | SAMPle | POSitive|NEGative].
Default is POSNeg.

Defines which measurement values shall be displayed.

The 9102 takes far more measurements than can be displayed on the
screen, so several results are summarized into one.

POSNeg indicates both the maximum and minimum values for each fre-
quency point in the form of a straight vertical line between these values.
SAMPIe lets the 9102 randomly select one of the measurement values for
each frequency point.

POSitive lets the 9102 pick the highest value.

NEGative lets the 9102 select the lowest value.

Reads and returns the current setting.

:SENSe:DETector:FUNCtion SAMPle
:SENSe:DETector :FUNCtion?
Returns the following string: "'SAMPle™.

:SENSe:TRACe:A[:STATe]

Syntax

Parameters

Command

Query

Example

:SENSe:TRACe:A[:STATe] <PredefExpr>

PredefExpr is one of the following predefined expressions:
ACTual [MAXHold [MINHoId |HOLD | AVG | OFF. Default is ACTual.

Sets the display mode for Trace A.

ACTual shows measurement by measurement.

MAXHo I d displays the maximum value for each frequency point over all the
measurements.

MINHold shows the minimum value for each frequency point over all the
measurements.

HOLD stops the measurement immediately.

AVG displays, for each frequency point, an average value over all the mea-
surements.

OFF switches the trace off.

Reads and returns the current settings.

:SENSe:TRACe:A MAXHold
:SENSe:TRACe:A:STATe?
Returns the following string: *"MAXHold"".
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:SENSe:TRACe:A:FETCh?

Syntax :SENSe:TRACe:A:FETCh? <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
ALL [MINEimum MAXTmum]FREQuency | FMINimum | FMAXimum.

Command There is solely a query form of this command available.

Query Reads and returns the data of trace A depending on the parameter:

Param ALL returns: <min><max>,<freq>,<min><max><freg>, ... .
Param MIN returns: <min><min>, ... .

Param MAX returns: <max>,<max>, ... .

Param FREQ returns: <freg><freg>, ... .

Param FMIN returns: <min><freqg>,<min><freg>, ... .

Param FMAX returns: <max> <freq><max><freq>, ... .

Example :SENSe:TRACe:A:FETCh? ALL
Returns the following string:
*1000000.0,-50.3,-45.5,1001000.0,-53.4,-48.2, .. .".

:SENSe:TRACe:B[:STATe]

Syntax :SENSe:TRACe:B[:STATe] <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
ACTual [MAXHold [MINHold |HOLD | AVG | OFF.
Default is OFF.

Command Sets the display mode for Trace B.
ACTual shows measurement by measurement.
MAXHo I d displays the maximum value for each frequency point over all the
measurements.
MINHold shows the minimum value for each frequency point over all the
measurements.
HOLD stops the measurement immediately.
AVG displays, for each frequency point, an average value over all the mea-
surements.
OFF switches Trace B off.

Query Reads and returns the current settings.

Example :SENSe:TRACe:B MAXHold
:SENSe:TRACe:B?
Returns the following string: *"MAXHold"".
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:SENSe:TRACe:B:FETCh?

Syntax :SENSe:TRACe:B:FETCh? <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:
ALL [MINEimum MAXimum]FREQuency | FMINimum | FMAXimum.
Command There is solely a query form of this command available.
Query Reads and returns the data of trace B depending on the parameter:
Param ALL returns: <min><max><freq>,<min><max><freg>, ... .
Param MIN returns: <min><min>, ... .
Param MAX returns: <max>,<max>, ... .
Param FREQ returns: <freg><freg>, ... .
Param FMIN returns: <min><freqg><min><fregq>, ... .
Param FMAX returns: <max> <freq><max><freq>, ... .
Example :SENSe:TRACe:B:FETCh? ALL
Returns the following string:
''1000000.0,-50.3,-45.5,1001000.0,-53.4,-48.2,..."
:SENSe:TRACe:AVGFactor
Syntax :SENSe:TRACe:AVGFactor <intl>
Parameters intl is an integer. The minimum value for intl is 1, the maximum is 125.
The default value for intl is 5.
Command Sets the trace averaging factor.
Query Reads and returns the current setting.
Example :SENSe:TRACe:AVGFactor 10
:SENSe:TRACe:AVGFactor?
Value returned in this example: **10™.
:SENSe:TRACe:CLEar
Syntax :SENSe:TRACe:CLEar
Parameters There are no parameters.
Command Clears the current trace.
Query There is no query form of this command available.
Example :SENSe:TRACe:CLEar
:SENSe:TRACe :COPY
Syntax :SENSe:TRACe:COPY <PredefExpr>[,<int>]
Parameters PredefExpr is one of the following predefined expressions: ATOB | BTOA.
Command Copies trace A to B or vice versa.
Query There is no query form of this command available.
Example :SENSe:TRACe:COPY ATOB

9102 Handheld Spectrum Analyzer  Software version 5.31 281



Chapter 16 SCPI Command Reference
Sense commands

:SENSe:TRACe:DATa?

Syntax :SENSe:TRACe:DATa? <PredefExpr>[,<int>]

Parameters PredefExpr is one of the following predefined expressions: A|B which
returns Trace A or Trace B.

Command There is solely a query form of this command available.

Query First return string: ""ALL" or ""MINM™. ""ALL"" returns, if minimum and max-

imum values are identical, e.g. *"Max hold" or "Min hold". 501 values
returned, no redundant data is sent. "MINM"* returns, if minimum and maxi-
mum Values are NOT identical, e.g. ""ACTUAL" or ""Average". 1002 Values
returned, the first 501 values are the minimum values and after them follow
the maximum values. Second return string: the trace data. Every level value
is represented by 3 bytes. The following formula is used to calculate the
level value in dBm: Level = Hexvalue / 10 - 200.

Example :SENSe:TRACe:DATa? A
The values returned in this example are:
“"ALL" ,""38D36F37238B38D3A63A73BC4103A63E33A13CB. . ."

:SENSe:TRACe:DATa:LIMIt

Syntax :SENSe:TRACe:DATa:LIMiIt?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Reads and returns the Pass/Fail criteria for the recently received trace with

SENSe:TRACe:DATa?. There will be returned one of the predefined
expressions: PASS|FAIL

Example :SENSe:TRACe:DATa:LIMit?
Returns the following string: ""PASS™

:SENSe:TRACe:MATH

Syntax :SENSe:TRACe :MATH?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Reads and returns the normalized criteria for the current trace. There will
be returned one of the predefined expressions: NA]JUNNormal i zed | NOR-
Malized

Example :SENSe:TRACe :MATH?
Returns the following string: **NORM™*

:SENSe:TRACe:MATH: [A]B]

Syntax :SENSe:TRACe:MATH:[A|B] <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: OFF | SUB-
tract|NORMalize.
Default is OFF.
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Command Switches math. function for traces A and B off or to Subtraction or to Nor-
malize.

Query Reads and returns the current setting.

Example :SENSe:TRACe:MATH:A SUB
:SENSe:TRACe:MATH:A?

Returns the following string: "*SUB™
:SENSe:TRACe:MATH:OFFSet

Syntax :SENSe:TRACe:MATH:OFFSet <reall>

Parameters reall is a floating point real number.

Command This command sets the trace offset for the subtracted trace (A-B->A trace).

Query Reads and returns the current setting.

Example :SENSe: TRACe:MATH:OFFSet -20
:SENSe: TRACe:MATH:OFFSet?

The value returned in this example is: *"-20"".
:SENSe:REFLevel

Syntax :SENSe:REFLevel <reall>

Parameters reall is a floating point real number.

The minimum and maximum value for real1 depend on the unit set by
SENS:REFLevel :UNIT. When the unit is set to dBm, the minimum value is
-100, the maximum value is 30. When the unit is set to dBuV, the minimum
value is 7, the maximum value is 137. When the unit is set to dBmV, the min-
imum value is -53, the maximum value is 77. When the unit is set to dBV,
the minimum value is -113, the maximum value is 17. The default value for
reallis O dBm.

Command This command sets the reference level of the 9102 (O dB line), in the unit
selected with the :SENS:REFLevel :UNIT command.

Query Reads and returns the current setting.

Example :SENSe:REFLevel -50
:SENSe:REFLevel?

The value returned in this example is: ""-50"".
:SENSe:REFLevel :UNIT

Syntax :SENSe:REFLevel :UNIT <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
DBM|DBUV |DBMV DBV ]V |MV UV MW]UW].

Default is DBM.

Command Defines the unit for the reference level to logarithmic units (dBm, dBpV,
dBmV or dBV) or linear units (V, mV, pvV, mW, uW). It also affects the unit in
which results (on the vertical axis) are displayed.

Query Reads and returns the current setting.

9102 Handheld Spectrum Analyzer  Software version 5.31 283



Chapter 16 SCPI Command Reference

Sense commands

284

Example :SENSe:REFLevel :UNIT DBMV
:SENSe:REFLevel :UNIT?
Returns the following string: *'DBMV"*
:SENSe:REFLevel :OFFSet
Syntax :SENSe:REFLevel :OFFSet <PredefExpr>
Parameters reall is a floating point real number.
The minimum value for real 1 is -113.0, the maximum value 9999999. 9.
reall can be set in multiples of 1000. The default value for reall is
5000000.
Command Defines the reference level offset.
Query Returns the current setting.
Example :SENSe:REFLevel :OFFset -10
:SENSe:REFLevel :OFFSet?
Returns the following string: *'-10""
:SENSe:STATe
Syntax :SENSe:STATe?
Parameters There are no parameters.
Command There is solely a query form of this command available.
Query Reads and returns the Uncal state.
Example :SENSe:STATe?
Returns the following string: ""ON"".
-SENSe :MEASure
Syntax :SENSe:MEASure <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:
NONe|CPOWer | ACPR] OBW. Default is NONe.
Command Starts measurements of the type described by PredefExp.
Query Reads and returns the current setting.
Example :SENSe:MEASure ACPR
:SENSe :MEASure?
Returns the following string: *'ACPR""
:SENSe :MEASure:0BW
Syntax :SENSe:MEASure:OBW <intl>
Parameters intl is an integer. The minimum value for intl is 5, the maximum is 99.
The default value for intl is 90.
Command Sets the percentage value for which the 9102 shall determine the occupied
bandwidth (spectrum analyzer mode).
Query Reads and returns the current setting.
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Example :SENSe :MEASure :0BW 20
:SENSe :MEASure :0BW?
The value returned in this example is: ""20"".

:SENSe :MEASure:CHANnel :WIDTh

Syntax :SENSe:MEASure:CHANnel :WIDTh <reall>

Parameters reall is a floating point real number. The minimum value for reall is
100000, the maximum value 2000000000. reall can be set in multiples
of 1000. The default value for reall is 5000000.

Command Sets the actual channel width in spectrum analyzer mode.
Query Reads and returns the current setting.
Example :SENSe:MEASure:CHANNnel :WIDTh 150000000

:SENSe :MEASure:CHANnel :WIDTh?
The value returned in this example is: **150000000"".

:SENSe:MEASure:CHANnel :SPACing

Syntax :SENSe:MEASure:CHANNnel : SPACing <reall>

Parameters reall is a floating point real number.
The minimum value for real 1 is 100000, the maximum value
2000000000. real 1 can be set in multiples of 1000. The default value for
reall is 10000000.

Command Sets the actual channel spacing in spectrum analyzer mode.
Query Reads and returns the current setting.
Example :SENSe :MEASure:CHANnel : SPACing 1500000000

:SENSe :MEASure :CHANnel : SPACINng?
The value returned in this example is: **1500000000"".

:SENSe:MEASure:ADJSettings

Syntax :SENSe:MEASure:ADJSettings

Parameters There are no parameters.

Command Adjusts settings in display made with ...CHAN:WIDTh and ...SPACing in the
corresponding measure mode CPOWer, ACPR or OBW.

Query Reads and returns the current setting.

Example :SENSe:MEASure:ADJSettings

:SENSe :DTF:CLENgth

Syntax :SENSe:DTF:CLENgth <reall>

Parameters reall is a floating point real number.
The minimum- and maximum value for real 1 depends on the unit set by
SENS:DTF:CLENgth:UNIT. When unit is set to m, the minimum value is 1,
the maximum value is 2000. When unit is set to Ft, the minimum value is
3, the maximum value is 6660. The default value for reallis 1 m.
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Command This command defines the cable length to be tested, in the unit selected
with the :SENS:DTF:CLENzUNIT command.

Query Reads and returns the current setting.

Example :SENSe:DTF:CLENgth 50
:SENSe:DTF:CLENgth?
The value returned in this example is: "50".
:SENSe:DTF:CLENgth:UNIT

Syntax :SENSe:DTF:CLENgth:UNIT <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
METer | FEET.
Default is METer.

Command Defines the unit for the cable length (m, fb. It also affects the unit for the
cable attenuation.

Query Reads and returns the current setting.

Example :SENSe:DTF:CLENgth:UNIT FEET
:SENSe:DTF:CLENgth:UNIT?
Returns the following string: "'"FEET""
:SENSe:DTF:REFerence

Syntax :SENSe:DTF:REFerence <reall>

Parameters reall is a floating point real number.
The minimum value for reallis -100.0 dB. The maximum value for
reallis 0.0 dB. The default value for reallis 0.0 dB

Command This command sets the reference level of the 9102 (0 dB line), in DTF
mode.

Query Reads and returns the current setting.

Example :SENSe:DTF:REFerence -50
:SENSe:DTF:REFerence?
The value returned in this example is: "*-50"".
:SENSe:DTF:REFerence:UNIT

Syntax :SENSe:DTF:REFerence:UNIT <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
DB|MRHO| VSWR.
Default is DB.

Command Defines the unit in which results (on the vertical axis) are displayed (dB,
mRho). It not affects the unit for the DTF reference level.

Query Reads and returns the current setting.

Example :SENSe:DTF:REFerence:UNIT DB

:SENSe:DTF:REFerence:UNIT?
Returns the following string: *'DB"*
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:SENSe:DTF:REFerence:VSWR

Syntax :SENSe:DTF:REFerence:UNIT <reall>

Parameters reall is a floating point real number.
The minimum value for reall is 1.0. The maximum value for reall is
1000.0. The default value for reallis 10.0.

Command This command sets the maximum VSWR value for DTF display when the
unit is set to VSWR.

Query Returns the current setting.

Example :SENSe:DTF:REFerence:VSWR 500
:SENSe:DTF:REFerence:VSWR?
The value returned in this example is: **'500.0"".
:SENSe:DTF:REFerence:RFACtor

Syntax :SENSe:DTF:REFerence:RFACtor <reall>

Parameters reall is a floating point real number.
The minimum value for reall is 0 mRho. The maximum value for reallis
2000 mRho. The default value for reall is 1000 mRho.

Command This command sets the maximum factor value for DTF display when the
unit is set to mRho.

Query Reads and returns the current setting.

Example :SENSe:DTF:REFerence:RFACtor 1000
:SENSe:DTF:REFerence:RFACtor?
The value returned in this example is: **1000.0".
:SENSe:DTF:CALibration

Syntax :SENSe:DTF:CALibration

Parameters There are no parameters.

Command Starts DTF calibration. Before executing this command, a SHORT has to be
connected to measurement port.

Query Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

Example :SENSe:DTF:CALibration
:SENSe:DTF:CALibration?
Returns the following string: ""YES"
:SENSe:DTF:CALibration:ENABled

Syntax :SENSe:DTF:CALibration:ENABled <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Command Switches the DTF calibration correction on or off.

Query Reads and returns the current setting.
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Example

:SENSe:DTF:CALibration:ENABled OFF
:SENSe:DTF:CALibration:ENABled?
Returns the following string: ""OFF"

:SENSe:TRANsmission:REFerence

Syntax

Parameters

Command

Query

Example

:SENSe:TRANsmission:REFerence <reall>

reall is a floating point real number.
The minimum value for real1l is -60.0 dB. The maximum value for
reall is 60.0 dB. The default value for reallis 0.0 dB.

This command sets the reference of the 9102 (0 dB line), in Transmission
mode. The reference refers to the current set output power level of the
tracking generator.

Reads and returns the current setting.

:SENSe:TRANsmission:REFerence -10
:SENSe:TRANsmission:REFerence?
The value returned in this example is: ""-10"".

:SENSe:TRANsmission:REFerence:UNIT

Syntax

Parameters

Command

Query

Example

:SENSe:TRANsmission:REFerence:UNIT <PredefExpr>

PredefExpr is one of the following predefined expressions: DB | DBM].
Default is DB.

Switches the display absolute or relative to the tracking generator output
power. This command is linked to INSTrument:GENerator:DISPlay.

Reads and returns the current setting.

:SENSe:TRANsmission:REFerence:UNIT DBM
:SENSe:TRANsmission:REFerence:UNIT?
Returns the following string: **DBM"*

:SENSe:EMF:REFerence

Syntax

Parameters

Command

Query

288

:SENSe:EMF:REFerence <reall>

reall is a floating point real number.

The minimum- and maximum value for real 1l depend on the unit set by
SENS:EMF:REFerence:UNIT. When the unit is set to dBm/m”2, the mini-
mum value is =100, the maximum value is 30. When the unit is set to
dBuV/m, the minimum value is 7, the maximum value is 137. When the unit
is set to dBmV/m, the minimum value is -53, the maximum value is 77.
When the unit is set to dBV/m, the minimum value is -113, the maximum
value is 17. When the unit is set to V/m, the minimum value is
0.000002236, the maximum value is 7.0710678. When the unit is set to
mW/m”2, the minimum value is 0.0001, the maximum value is 1000.0. The
default value for reallis 107.0 dBuvV/m.

This command sets the EMF reference level of the 9102, in the unit
selected with the :SENS:EMF:REFerence:UNIT command.

Reads and returns the current setting.
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Example :SENSe:EMF:REFerence -50
:SENSe:EMF:REFerence?

The value returned in this example is: ""-50"".
:SENSe:EMF:REFerence:UNIT

Syntax :SENSe:EMF:REFerence:UNIT <PredefExp>

Parameters PredefEXxp is one of the following predefined expressions:
DBUVmM|DBMVm|DBVM VM| MWM2].

Default is DBUVM.

Command Defines the unit for the EMF reference, either logarithmic (dBuV/m, dBmV/
m or dBV/m) or linear (V/m or mW/m* 2). It also affects the unit in which
results (on the vertical axis) are displayed.

Query Reads and returns the current setting.

Example :SENSe:EMF:REFerence:UNIT DBVM
:SENSe:EMF:REFerence:UNIT?

Returns the following string: *'DBVM™
:SENSe:EMF:ANTenna:DIRection

Syntax :SENSe:EMF:ANTenna:DIRection <PredefExp>

Parameters PredefExp is one of the following predefined expressions: X|Y]Z].
Default is X.

Command Defines the direction of the antenna.

Query Reads and returns the current setting.

Example :SENSe:EMF:ANTenna:DIRection Y
:SENSe:EMF:ANTenna:DIRection?

Returns the following string: **Y*"
:SENSe :EMF:MEASure

Syntax :SENSe:EMF:MEASure <PredefExp>

Parameters PredefExp is one of the following predefined expressions:
OFF [MANual JAUTo | QUICK].

Default is OFF.

Command Defines the mode of the antenna EMF measurement.

Query Reads and returns the current setting.

Example :SENSe:EMF:MEASure AUTo
:SENSe :EMF:MEASure?

Returns the following string: ""AUT""
:SENSe:EMF:MEASure:LAST?

Syntax :SENSe:EMF:MEASure:LAST?

Parameters There are no parameters.

Command There is only a no query form of this command available.
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Query

Example

Returns the last measurement setting, which was performed in EMF mode.

:SENSe :EMF:MEASure:LAST?
Returns the following string: ""AUT""

:SENSe:EMF:MEASure:DISPlay

Syntax

Parameters

Command

Query

Example

:SENSe:EMF:MEASure:DISPlay <PredefExp>

PredefExp is one of the following predefined expressions:
EFSTrength|PDENsity].
Default is EFSTrength.

Defines the display mode of the antenna EMF measurement. It can be
either “Electric field strength” or “Power density”.

Reads and returns the current setting.

:SENSe:EMF:MEASure:DISPlay PDEN
:SENSe :EMF:MEASure:DISPlay?
Returns the following string: ""PDEN""

:SENSe:EMF:MEASure:TIMe

Syntax

Parameters

Command
Query

Example

:SENSe:EMF:MEASure:TIMe <reall>

reall is a floating point real number.

The minimum value for real1 is 1000, the maximum value 1000000.
reall can be set as 1*10" or 3*10". The default value for reall is
1000000.

This command sets the measure time in EMF mode in seconds.
Reads and returns the current setting.

:SENSe:EMF:MEASure:TIMe 100
:SENSe:EMF:MEASure:TIMe?
The value returned in this example is: ""100".

:SENSe:RFLection:REFerence[ :RETurnloss]

Syntax

Parameters

Command

Query

Example

:SENSe:RFLection:REFerence[ :RETurnloss] <reall>

reall is a floating point real number.
The minimum value for reall is -60.0 dB. The maximum value for
reall is 60.0 dB. The default value for reallis 0.0 dB.

This command sets the reference of the 9102 (0 dB line), in Reflection
mode, when unit is set to Return Loss. The reference refers to the current
set output power level of the tracking generator.

Reads and returns the current setting.

:SENSe:RFLection:REFerence -10
:SENSe:RFLection:REFerence?
The value returned in this example is: ""-10"".
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:SENSe:RFLection:REFerence:UNIT

Syntax :SENSe:RFLection:REFerence:UNIT <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: RETurn-
loss|VSWR|RFACtor | RPOWer.
Default is RETurnloss.

Command Switches the display to following units: return loss (dB), VSWR (-), reflection
factor (mRho) or reflected power (%).

Query Reads and returns the current setting.

Example :SENSe:RFLection:REFerence:UNIT DBM
:SENSe:RFLection:REFerence:UNIT?
Returns the following string: "'DBM™*
:SENSe:RFLection:REFerence:VSWR

Syntax :SENSe:RFLection:REFerence:VSWR <reall>

Parameters reall is a floating point real nl_meer.
The minimum value for real1 IS 1.0. The maximum value for reall is
1000. 0. The default value for reall is 10.0.

Command This command sets the maximum VSWR value for reflection display when
the unit is set to VSWR.

Query Reads and returns the current setting.

Example :SENSe:RFLection:REFerence:VSWR 500
:SENSe:RFLection:REFerence:VSWR?
The value returned in this example is: ""*500.0".
:SENSe:RFLection:REFerence:RFACtor

Syntax :SENSe:RFLection:REFerence:RFACtor <reall>

Parameters reall is a floating point real number.
The minimum value for reallis 0 mRho. The maximum value for reall is
2000 mRho. The default value for reall is 2000 mRho.

Command This command sets the maximum factor value for reflection display when
the unit is set to reflection factor.

Query Reads and returns the current setting.

Example :SENSe:RFLection:REFerence:RFACtor 1000
:SENSe:RFLection:REFerence:RFACtor?
The value returned in this example is: "*1000.0".
:SENSe:RFLection:REFerence:RPOWer

Syntax :SENSe:RFLection:REFerence:RPOWer <reall>

Parameters reall is a floating point real number.
The minimum value for reallis 0.0 %. The maximum value for reall is
200.0 %. The default value for real1 1S 200.0 %.

Command This command sets the maximum power value for reflection display when

the unit is set to reflected power.

9102 Handheld Spectrum Analyzer  Software version 5.31 291



Chapter 16 SCPI Command Reference
Sense commands

Query

Example

Reads and returns the current setting.

:SENSe:RFLection:REFerence:RPOWer 120
:SENSe:RFLection:REFerence:RPOWer?
The value returned in this example is: *120.0".

:SENSe:RFLection:FILTer

Syntax

Parameters

Command
Query

Example

:SENSe:RFLection:FILTer <reall>

reall is a floating point real number.

The minimum value for real1 is 1000, the maximum value 1000000.
reall can be set as 1*10”n or 3*10"n. The default value for reall is
1000000.

This command sets the resolution bandwidth filter of the 9102, in Hertz.
Reads and returns the current setting.

:SENSe:RFLection:FILTer 300000
:SENSe:RFLection:FILTer?
The value returned in this example is: "*300000"".

:SENSe:RFLection:FILTer:AUToO

Syntax

Parameters

Command

Query

Example

:SENSe:RFLection:FILTer:AUTo <PredefExpr>

PredefTExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Switches the automatic selection of the bandwidth resolution filter on or off.

If switched on, the 9102 selects the resolution bandwidth depending on
the current span, video bandwidth, and sweep time.

Reads and returns the current setting.

:SENSe:RFLection:FILTer:AUTo ON
:SENSe:RFLection:FILTer:AUTo?
Returns the following string: *"ON"*

:SENSe:RFLection:CALibration

Syntax

Parameters

292

:SENSe:RFLection:CALibration <PredefExpr>

PredefExpr is one of the following predefined expressions:
OPEN ] SHORt | LOAD.
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Starts reflection calibration. The following sequence is necessary:
1. Scalar mode:

Connect an OPEN to measurement port. Then execute
:SENSe:RFLection:CALibration OPEN.

Connect a SHORT to measurement port. Then execute
:SENSe:RFLection:CALibration SHORt.

2. Vector mode:

Connect an OPEN to measurement port. Then execute
:SENSe:RFLection:CALibration OPEN.

Connect a SHORT to measurement port. Then execute
:SENSe:RFLection:CALibration SHORt.

Connect a LOAD to measurement port. Then execute
:SENSe:RFLection:CALibration LOAD.

The mode has to be set before with
:SENSe:RFLection:CALibration:MODe SCALar|VECTor

Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

:SENSe:RFLection:CALibration?
Returns the following string: ""YES"

:SENSe:RFLection:CALibration:MODe

Syntax

Parameters

Command

Query

Example

:SENSe:RFLection:CALibration:MODe <PredefExpr>

PredefExpr is one of the following predefined expressions: SCA-
Lar|VECTor.
Default is SCALar.

Sets reflection calibration mode to scalar or vector.

Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

:SENSe:RFLection:CALibration:MODe VECTor
:SENSe:RFLection:CALibration:MODe?
Returns the following string: ""VECT"

:SENSe:RFLection:CALibration:ENABled

Syntax

Parameters

Command

Query

Example

:SENSe:RFLection:CALibration:ENABled <PredefExpr>

PredefExpr is one of the following predefined expressions: ON|OFF.
Default is OFF.

Switches reflection calibration correction on or off.

Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

:SENSe:RFLection:CALibration:ENABled OFF
:SENSe:RFLection:CALibration:ENABled?
Returns the following string: "*OFF*"
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:SENSe:CLOSs:REFerence

Syntax :SENSe:CLOSs:REFerence <reall>

Parameters reall is a floating point real number.
The minimum value for real1 is -60.0 dB. The maximum value for reall
is

60.0 dB. The default value for reallis 0.0 dB.

Command This command sets the reference of the 9102 (0 dB line), in Cable Loss
mode. The reference refers to the current set output power level of the
tracking generator.

Query Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

Example :SENSe:CLOSs:REFerence -10
:SENSe:CLOSs:REFerence?
The value returned in this example is: **-10"".

:SENSe:CLOSs:FILTer

Syntax :SENSe:CLOSs:FILTer <reall>

Parameters reall is a floating point real number.
The minimum value for real1 is 1000, the maximum value 1000000.
reall can be set as 1*10”n or 3*10”n. The default value for reall is

1000000.
Command This command sets the resolution bandwidth filter of the 9102, in Hertz.
Query Reads and returns the current calibration state. This is one of the following

predefined expressions: NO|] YES.

Example :SENSe:CLOSs:FILTer 300000
:SENSe:CLOSs:FILTer?
The value returned in this example is: **300000"".

:SENSe:CLOSs:FILTer:AUTo

Syntax :SENSe:CLOSs:FILTer:AUTo <PredefExpr>

Parameters PredefEXxpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Command Switches the automatic selection of the bandwidth resolution filter on or off.

If switched on, the 9102 selects the resolution bandwidth depending on
the current span, video bandwidth, and sweep time.

Query Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

Example :SENSe:CLOSs:FILTer:AUTo ON
:SENSe:CLOSs:FILTer:AUTO?
Returns the following string: ""ON"*

:SENSe:CLOSs:CALibration

Syntax :SENSe:CLOSs:CALibration <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:
SHORt | OPEN.
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Starts Cable Loss calibration. The following sequence is necessary:
Connect a SHORT to measurement port. Then execute
:SENSe:CLOSs:CALibration SHORt.

Connect an OPEN to measurement port. Then execute
:SENSe:CLOSs:CALibration OPEN.

Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

:SENSe:CLOSs:CALibration?
Returns the following string: ""YES"

:SENSe:CLOSs:CALibration:ENABled

Syntax

Parameters

Command

Query

Example

:SENSe:CLOSs:CALibration:ENABled <PredefExpr>

PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Switches the cable loss calibration correction on or off.

Reads and returns the current calibration state. This is one of the following
predefined expressions: NO|] YES.

:SENSe:CLOSs:CALibration:ENABled OFF
:SENSe:CLOSs:CALibration:ENABled?
Returns the following string: ""OFF""

:SENSe :PSENsor :MODe

Syntax

Parameters

Command

Query

Example

:SENSe : PSENsor :MODe <PredefExpr>

PredefEXxpr is one of the following predefined expressions: DBM]W|.
Default is DBM.

Defines the unit for the power sensor measurement to logarithmic unit
(dBm) or linear unit (W).

Reads and returns the current setting.

:SENSe:CLOSs:CALibration:ENABled OFF
:SENSe:CLOSs:CALibration:ENABled?
Returns the following string: "*OFF*"
:SENSe:PSENsor:MODe LIN

:SENSe :PSENsor :MODe?

Returns the following string: "L IN*

:SENSe:PSENsor:TYPe

Syntax

Parameters

Command

Query

:SENSe :PSENsor:TYPe <PredefExpr>

PredefExpr is one of the following predefined expressions:
CW]|GSM]TETRa]JUMTS | CDMA|DVBT].
Default is CW.

Switches the power sensor system to the following settings: continuous
wave, GSM, TETRA, UMTS, CDMA and DVBT.

Reads and returns the current setting.
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Example :SENSe:PSENsor:TYPe UMTS
:SENSe :PSENsor:TYPe?
Returns the following string: ""UMTS""

-SENSe :PSENsor :FREQuency:CW

Syntax :SENSe:PSENsor :FREQuency:CW <reall>

Parameters reall is a floating point real number.
The minimum value for real 1 is 70000000, the maximum value
2700000000. The default value for real1 is 27000000000.

Command Sets the continuous wave frequency for the power sensor measurement in
Hertz.

Query Reads and returns the current setting.

Example :SENSe :PSENsor : FREQuency :CW 1500000000

:SENSe :PSENsor : FREQuency : CW?
The value returned in this example is: "*1500000000"".

-SENSe :PSENsor :FREQuency :GSM

Syntax :SENSe:PSENsor :FREQuency:GSM <reall>

Parameters reall is a floating point real number.
The minimum value for real 1 is 70000000, the maximum value
2700000000. The default value for reall is 900000000.

Command Sets the GSM frequency for the power sensor measurement in Hertz.
Query Reads and returns the current setting.
Example :SENSe :PSENsor : FREQuency :GSM 1800000000

:SENSe :PSENsor : FREQuency : GSM?
The value returned in this example is: "*1800000000".

:SENSe:PSENsor :FREQuency:TETRa

Syntax :SENSe:PSENsor:FREQuency:TETRa <reall>

Parameters reall is a floating point real number.
The minimum value for reall is 70000000, the maximum value
2700000000. The default value for reall is 900000000.

Command Sets the TETRA frequency for the power sensor measurement in Hertz.
Query Reads and returns the current setting.
Example :SENSe : PSENsor : FREQuency:TETRa 800000000

:SENSe :PSENsor :FREQuency:TETRa?
The value returned in this example is: *800000000"".

:SENSe :PSENsor :FREQuency - UMTS

Syntax :SENSe :PSENsor : FREQuency :UMTS <reall>

Parameters reall is a floating point real number.
The minimum value for real1 is 70000000, the maximum value
2700000000. The default value for real1 is 2000000000.
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Command Sets the UMTS frequency for the power sensor measurement in Hertz.
Query Reads and returns the current setting.
Example :SENSe :PSENsor : FREQuency :UMTS 2400000000
:SENSe :PSENsor : FREQuency :UMTS?
The value returned in this example is: "*2400000000"".
-SENSe : PSENsor :FREQuency : CDMA
Syntax :SENSe:PSENsor:FREQuency:CDMA <reall>
Parameters reall is a floating point real number.
The minimum value for reall is 70000000, the maximum value
2700000000. The default value for real1 is 1800000000.
Command Sets the CDMA frequency for the power sensor measurement in Hertz.
Query Reads and returns the current setting.
Example :SENSe : PSENsor : FREQuency : CDMA 1900000000
:SENSe : PSENsor : FREQuency : CDMA?
The value returned in this example is: *1900000000".
:SENSe:PSENsor :FREQuency :DVBT
Syntax :SENSe :PSENsor :FREQuency:DVBT <reall>
Parameters reall is a floating point real number.
The minimum value for real1 is 70000000, the maximum value
2700000000. The default value for real1 is 300000000.
Command Sets the DVBT frequency for the power sensor measurement in Hertz.
Query Reads and returns the current setting.
Example :SENSe :PSENsor : FREQuency : CDMA 600000000
:SENSe :PSENsor : FREQuency : CDMA?
The value returned in this example is: "*600000000"".
:SENSe:EDEVice:RFINput
Syntax :SENSe:EDEVice:RFINput <intl>
Parameters intlis ainteger.
The minimum value for Intl is 1, the maximum is 6. The default value for
intlis 1l
Command Sets the RF input channel on the external device.
Query Reads and returns the current setting.
Example :SENSe:EDEVice:RFINput 2

:SENSe:EDEVice:RFINput?
The value returned in this example is: ""2"".
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Input commands

With these commands, the input stage of the 9102 Handheld Spectrum
Analyzer is affected.

WARNING

The maximum input power level at the RF IN connector is 30 dBm
(1 W). Higher input levels may result in serious damage of the instru-
ment.

2 INPut:ATTenuation

Syntax

Parameters

Command

Query

Example

:INPut:ATTenuation <reall>

reall is a floating point real number.
The minimum value for real 1 is O, the maximum value 50. real 1 can be
set in steps of 10. The default value for reall is 30.

This command sets the RF preattenuation of the Aeroflex 9102. The physi-
cal dimension of reall is dB.

Reads and returns the current setting.

ZINP-ATT 20
:INPut:ATTenuation?
The value returned is in this example: ""20"".

s INPut:ATTenuation:AUTo

Syntax

Parameters

Command
Query

Example

:INPut:ATTenuation:AUTo <PredefExpr>

PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Lets the 9102 select the preattenuation depending on the reference level.
Reads and returns the current setting.

SINP:ATT:AUTO ON
2 INPut:ATTenuation:AUTO?
Returns the following string: ""ON"*

: INPut: IMPedance

Syntax

Parameters

Command
Query

Example

:INPut: IMPedance <PredefExpr>

PredefExpr is one of the following predefined expressions:
IMP50] IMP75.
Default is IMP50.

Lets the 9102 select between 50 Q and 75 Q impedance.
Reads and returns the current setting.

ZINP:IMP IMP75
: INPut: IMPedance?
Returns the following string: ""IMP75""
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:INPut:EDEVice

Syntax :INPut:EDEVice <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Command Switches the external device compensation on or off. A corresponding file
has to be loaded first with command MMEMory : LOAD:EDEVice.

Query Reads and returns the current setting.

Example :INP:EDEVice ON

INPut:EDEVice?
Returns the following string: *"ON"*

s INPut:AFACtor

Syntax :INPut:AFACtor <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: OFF ] ON.
Default is OFF.

Command Switches the antenna factor compensation on or off. A corresponding file
has to be loaded first with command MMEMory : LOAD : AFACtor.

Query Reads and returns the current setting.

Example :INPut:AFACtor ON

> INPut:AFACtor?
Returns the following string: ""ON"*

- INPut:CFACtor

Syntax INPut:CFACtor <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: OFF ] ON.
Default is OFF.

Command Switches the cable factor compensation on or off. A corresponding file has
to be loaded first with command MMEMory : LOAD : CFACtor.

Query Reads and returns the current setting.

Example INPut:CFACtor ON

> INPut:CFACtor?
Returns the following string: ""ON"*

MMemory commands

With the MMemory commands, you can fully exploit the capabilities of
the instrument to store and reload measurement results in its nonvola-
tile memory.
:MMEMory:STORe:STATe

Syntax :MMEMory:STORe:STATe <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.
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Command

Query

Example

Stores the actual parameter settings of the 9102 in the SETTINGS directory
on the flash disk in a file named <stringl>.

Reads and returns the file name last stored with this command.

:MMEMory:STORe:STATe "'sett3"

:MMEMory:STORe:TRACe

Syntax

Parameters

Command

Query

Example

:MMEMory:STORe:TRACe <stringl>[,<PredefExp>]

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

PredefExpr is an optional parameter and one of the following predefined
expressions: A|B. Default is A.

Stores the current trace A or B and the parameter settings on the flash disk
in the TRACE directory in a file named <stringl>.

Reads and returns the file name last stored with this command.

:MMEMory :STORe:TRACe "'GSM900",A

:MMEMory:STORe:LIMit

Syntax

Parameters

Command

Query

Example

:MMEMory:STORe:LIMit
<stringl>{,<PredefExpr>,<x1>,<yl>,<x2>,<y2>...}
:MMEMory:STORe:LIMit? <stringl>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

PredefExpr is one of the following predefined expressions:
MINImiumMAXEmum.

x1 yl x2 y2 are floating point real numbers.

The minimum value for all these reals is 0, the maximum value for the x val-
ues is 10, the maximum value for the y values is 8, the resolution for all real
values is 0.1 and the default is 0.

Stores the limits defined as lines in the LIMIT directory on the flash disk in a
file named <stringl>. A line is defined by a parameter set
PredefExpr,x1,yl,x2,y2. Up to 30 parameter sets can follow the
string parameter.

Reads and returns the parameter sets of the limit file which is given as
parameter.

:MMEMory:STORe:LIMit
"l1im2",UPP,2.3,4.5,6.9,7,2,L0W,2.3,1.5,6.9,3,2
:MMEMory:STORe:LIMit? "1im2"

String returned: UPP,2.3,4.5,6.9,7,2,L0W,2.3,1.5,6.9,3,2
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:MMEMory:STORe:CHANnel

Syntax :MMEMory:STORe:CHANnel <stringl>, <intl>, <int2>,
<reall>, <real2>, <real3>, <real4>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.
intl is an integer. The minimum value for intl is 1, the maximum is
1000000. The default value is 100.
int2 is an integer. The minimum value for int2 is 0, the maximum is
1000000. The default value is 0.
reall is a floating point real number. The minimum value for reall is O,
the maximum value 7500000000. The minimum resolution is 1000. The
default value is 1000000.
real2 is a floating point real number. The minimum value for real2 is O,
the maximum value 7500000000. The minimum resolution is 1000. The
default value is 1000000.
real3 is a floating point real number. The minimum value for real3 is O,
the maximum value 7500000000. The minimum resolution is 1000. The
default value is 21000000000.
real4 is a floating point real number. The minimum value for real4 is -
100, the maximum value 30. The minimum resolution is 1. The default
value is 0.

Command This command stores the present communication system settings within
the 9102 (e.g. for the channel power mode).
stringl is the name of system settings file in which the parameters are
stored. intl sets the number of channels. Int2 sets the start channel
number. reall sets the channel bandwidth over which to measure, in
Hertz. real 2 sets the frequency spacing of the channels, in Hertz. real 3
sets the frequency of the first channel, in Hertz. real4 sets the system ref-
erence level (0 dB line).

Query Reads and returns the parameter set from the limit file given as a parame-
ter.
Example MMEMory :STORe :CHANnel *‘P-

GSMoDO™,125,0,400000,200000,935000000,0.0

:MMEMory:STORe:EDEVice

Syntax :MMEMory:STORe:EDEVice <stringl>, <reallfreg>,
<realllev>, <real2freqg>, <real2lev>, ... <reallOO0freg>,
<reall100lev>

Parameters stringl is a string (text) parameter. The maximum length of stringl is

11 characters.

reallfreq to real100freq are floating point real numbers. The mini-
mum value is 0, the maximum value 4€9. The minimum resolution is 1.
realllev to real100lev are floating point real numbers. The minimum
value is -100, the maximum value 30. The minimum resolution is 0.01.

Command This command stores settings for external device compensation. stringl
is the name of the external device compensation file in which the parame-
ters are stored. realxfreq and realxlev are pairs of frequency and
level values to set the attenuation on the respective frequency. The instru-
ment applies linear interpolation for the level between frequency points.

Query Reads and returns the parameter sets of the external device compensation
file which is given as a parameter.
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Example

:MMEMory:STORe:EDEVice "EXT_DEV2',1000000, -5.1,
2000000,-3.2,5000000,-4.1,10000000,-3.8,20000000,-2.6
:MMEM:STOR:EDEV? "EXT_DEV2"

String returned: 1000000, -5.1,2000000,-3.2,5000000,-4.1,
10000000,-3.8,20000000,-2.6

:MMEMory:STORe:CTYPe

Syntax

Parameters

Command

Query

Example

:MMEMory:STORe:CTYPe <stringl>,<reall>,<real2>,
<PredefExpr>,<real3>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

reall is a floating point real number. The minimum value is 1.0, the max-
imum value 20.0. The minimum resolution is 0. 1. The default valueis 1. 0.
real2 is a floating point real number. The minimum value is 0.0, the max-
imum value 2000.0. The minimum resolution is 0.01. The default value is
0.0.

PredefExpr is optional and one of the following predefined expressions:
M100]FT100. Default is M100.

real 3 is a floating point real number and also optional. The minimum
value is 500000, the maximum value 4000000000. The minimum resolu-
tion is 0. 1. The default value is 4000000000.

This command stores settings for cable types. stringl is the name of the
cable type file in which the parameters are stored. reall is the cable
dielectric of the cable. real2 is the attenuation of the cable per meter or
feet. PredefEXxpr sets the attenuation to meter or feet. real 3 is the cable
cutoff frequency.

Reads and returns the parameter sets of the cable type file which is given
as parameter.

:MMEMory:STORe:CTYPe
"EXT_DEV2",2.4,9.3,"MET",2000000000

:MMEMory:STORe:CTYPe:CALiIbration

Syntax

Parameters

Command

Query

Example

:MMEMory :STORe:CTYPe:CALibration <reall>,<real2>

reall is a floating point real number. The minimum value is 1.0, the max-
imum value 20.0. The minimum resolution is 0. 1. The default value is 2.3.
real2 is a floating point real number. The minimum value is 1.0, the max-
imum value 2000. 0. The minimum resolution is 0.01. The default value is
1.0.

This command stores settings for cable type calibration. reall is the cable
dielectric of the calibration cable. real 2 is the length of the calibration
cable per meter.

Reads and returns the parameter sets of the calibration cable type file
which is given as parameter.

:MMEMory:STORe:CTYPe:CALibration 2.5,1.5
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-MMEMory:STORe:AFACtor

Syntax

Parameters

Command

Query

Example

:MMEMory :STORe : AFACtor
<stringl>,<reallfreq>,<realllev>,<real2freg>,
<real2lev>, ... ,<reall00freg>,<real100lev>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

reallfreqto real100freq are floating point real numbers. The mini-
mum value is 0, the maximum value 4e9. The minimum resolution is 1.
realllev to real100lev are floating point real numbers. The minimum
value is =100, the maximum value 30. The minimum resolution is 0.01.

This command stores settings for cable types. stringl is the name of the
cable type file in which the parameters are stored. reall is the cable
dielectric of the cable. real2 is the attenuation of the cable per meter or
feet. PredefExpr sets the attenuation to meter or feet. real 3 is the cable
cutoff frequency.

Reads and returns the parameter sets of the external device compensation
file which is given as parameter.

:MMEMory :STORe:AFACtor "AFAC2',1000000,-5.1,2000000,
-3.2,5000000,-4.1,10000000,-3.8,20000000,-2.6

:MMEMory :STORe : CFACtor

Syntax

Parameters

Command

Query

Example

:MMEMory :STORe : CFACtor
<stringl>,<reallfreq>,<realllev>,<real2freqg>,
<real2lev>, ... ,<reall00freg>,<real100lev>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

reallfreq to real100freq are floating point real numbers. The mini-
mum value is 0, the maximum value 4e9. The minimum resolution is 1.
realllev to real100lev are floating point real numbers. The minimum
value is =100, the maximum value 30. The minimum resolution is 0.01.

This command stores settings for cable factor compensation. stringl is
the name of cable factor compensation file in which the parameters are
stored. realxfreq and realxlev are pairs of frequency and level values
to set the attenuation on this frequency. Between frequency values there is
a linear interpolation for the level.

Reads and returns the parameter sets of the cable factor compensation file
which is given as parameter.

:MMEMory:STORe:CFACtor "CFAC7',1000000,-5.1,2000000,
-3.2,5000000,-4.1,10000000,-3.8,20000000,-2.6

:MMEMory[ :LOAD] :FILelist[:TRACe]?

Syntax

Parameters

Command

Query

:MMEMory:LOAD:FlILelist[:TRACe]? <PredefExpr>

PredefEXxpr is an optional parameter and one of the following predefined
expressions: SHORt | EXTent. Default is SHORt.

There is only a query form of this command available.

Reads and returns the list of files stored in the TRACE directory. The file
names are separated by commas.
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Example MMEMory:LOAD:FILelist:TRACe?
String returned in this example:
"TRACE1","TRACE2","TRACE3"

:MMEMory[ :LOAD] :FIlLelist:STATe?

Syntax :MMEMory[:LOAD]:FlLelist:STATe? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined
expressions: SHORt | EXTent. Default is SHORt.

Command There is only a query form of this command available.

Query Reads and returns the list of files stored in the SETTINGS directory. The file

names are separated by commas.

Example :MMEMory:LOAD:FlLelist:STATe?
String returned in this example:
“SETT1","SETT2","SETT3"

:MMEMory[ :LOAD]:FIlLelist:LIMIt?

Syntax :MMEMory[:LOAD]:FlLelist:LIMit? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined
expressions: SHORt | EXTent. Default is SHORt.

Command There is only a query form of this command available.

Query Reads and returns a comma-separated list of file names. Each file contains
spectrum limit values stored on the 9102.

Example :MMEMory:LOAD:FlLelist:LIMit?
String returned in this example:
“LIMLT,LIM2™

:MMEMory|[ :LOAD] :FlLelist:CHANnel?

Syntax :MMEMory[ :LOAD] :FIlLelist:CHANnel? <PredefExpr>

Parameters PredefEXxpr is an optional parameter and one of the following predefined
expressions: SHORt | EXTent. Default is SHORE.

Command There is only a query form of this command available.

Query Reads and returns a comma-separated list of file names. Each file contains

channel values stored on the 9102.

Example :MMEMory:LOAD:FlLelist:CHANnel?
String returned: ""GSM900"", **GSM1800"*

:MMEMory[ :LOAD] :FILelist:EDEVice?

Syntax :MMEMory[:LOAD]:FlLelist:EDEVice? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined
expressions: SHORt | EXTent. Default is SHORTt.

Command There is only a query form of this command available.
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Query Reads and returns a comma-separated list of file names. Each file contains
external device compensation values stored on the 9102.

Example MMEMory:LOAD:FlLelist:EDEVice?
String returned in this example: "EXT_DEV2',"EXT_DEV5"
:MMEMory[ :LOAD] :FILelist:CTYPe?

Syntax :MMEMory[:LOAD]:FlLelist:CTYPe? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined
expressions: SHORt|EXTent.
Default is SHORT.

Command There is only a query form of this command available.

Query Reads and returns a comma-separated list of file names. Each file contains
a cable type stored on the 9102.

Example MMEMory:LOAD:FILelist:CTYPe?
String returned in this example:
"CABLEZ2",""CABLE5"
:MMEMory[ :LOAD] :FlLelist:AFACtor?

Syntax :MMEMory[:LOAD] :FlLelist:AFACtor? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined
expressions: SHORt|EXTent.
Default is SHORT.

Command There is only a query form of this command available.

Query Reads and returns a comma-separated list of file names. Each file contains
antenna factor compensation stored on the 9102.

Example MMEMory:LOAD:FlLelist:AFACtor?
String returned in this example:
"AFAC2' ,""AFAC5™
:MMEMory[ :LOAD] :FlLelist:CFACtor?

Syntax :MMEMory[:LOAD] :FlLelist:CFACtor? <PredefExpr>

Parameters PredefExpr is an optional parameter and one of the following predefined
expressions: SHORt|EXTent.
Default is SHORT.

Command There is only a query form of this command available.

Query Reads and returns a comma-separated list of file names. Each file contains
cable factor compensation stored on the 9102.

Example MMEMory:LOAD:FlLelist:CFACtor?

String returned in this example:
"CFAC7" ,""CFAC8"
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:MMEMory:LOAD:STATe

Syntax :MMEMory:LOAD:STATe <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Loads 9102 parameter settings from file stringl located in the SETTINGS
directory on the flash disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory:LOAD:STATe 'sett3"

:MMEMory:LOAD:TRACe

Syntax MMEMory:LOAD:TRACe <stringl>,<PredefExpr>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.
PredefExpr is an optional parameter and one of the following predefined
expressions: A|B. Default is A.

Command Loads 9102 traces from file stringl located in the TRACE directory on
the flash disk to trace A or B.

Query Reads and returns the file name last loaded with this command.

Example MMEMory :LOAD:TRACe "TESTTRACE2"

:MMEMory:LOAD:LIMIt

Syntax :MMEMory:LOAD:LIMIt <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Loads 9102 limit settings from file stringl located in the LIMIT directory
on the flash disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory:LOAD:LIMit “sett3"

:MMEMory : LOAD :CHANnel

Syntax :MMEMory :LOAD:CHANnel <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
lllaracters.

Command Load saved channel data from file <string 1> in the CHANNEL directory on
the flash disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory : LOAD:CHANnel "GSM900"
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:MMEMory:LOAD:EDEVice

Syntax :MMEMory:LOAD:EDEVice <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
lllaracters.

Command Loads saved channel data from file <string1> in the external device direc-
tory on the flash disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory:LOAD:EDEVice "EXT_DEV2"
:MMEMory:LOAD:CTYPe

Syntax MMEMory:LOAD:CTYPe <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Loads saved cable type from file in the cable type directory on the flash
disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory:LOAD:CTYPe "RG58"
-MMEMory:LOAD: AFACtor

Syntax :MMEMory :LOAD:AFACtor <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Load saved cable factor data from file in the cable factor directory on the
flash disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory :LOAD:CFACtor "'CFAC7"
:MMEMory :LOAD:CFACtor

Syntax :MMEMory :LOAD:CFACtor <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Load saved antenna factor data from file in the antenna factor directory on
the flash disk.

Query Reads and returns the file name last loaded with this command.

Example :MMEMory :LOAD:AFACtor "AFAC2
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:MMEMory:DELete:STATe

Syntax :MMEMory:DELete:STATe <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Deletes file <stringl> in the SETTINGS directory on the flash disk. Files
in this directory usually contain parameter settings of the device.

Query Reads and returns the name of the file last deleted with this command.

Example :MMEMory:DELete:STATe "sett3"

:MMEMory:DELete:STATe:ALL

Syntax :MMEMory:DELete:STATe:-ALL

Parameters There are no parameters.

Command Deletes all the files in the SETTINGS directory on the flash disk. These files
usually contain parameter settings of the 9102.

Query There is no query form of this command available.

Example :MMEMory:DELete:STATe:ALL

:MMEMory:DELete:TRACe

Syntax :MMEMory:DELete:TRACe <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Deletes file stringl (saved trace data and parameter settings) from the
TRACE directory on the flash disk.

Query Reads and returns the name of the file last deleted with this command.

Example :MMEMory :DELete:TRACe "GSM900"

:MMEMory:DELete:TRACe:ALL

Syntax :MMEMory :DELete:TRACe:-ALL

Parameters There are no parameters.

Command Deletes all the files in the TRACE directory on the flash disk.
Query There is no query form of this command available.

Example :MMEMory:DELete:TRACe:-ALL

:MMEMory:DELete:LIMit

Syntax :MMEMory:DELete:LIMit <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Deletes file stringl in the LIMIT directory. Files in this directory contain
limit settings of the device.

308 9102 Handheld Spectrum Analyzer  Software version 5.31




Chapter 16 SCPI Command Reference
MMemory commands

Query Reads and returns the name of the file last deleted with this command.

Example :MMEMory:DELete:LIMit "lim3"
:MMEMory:DELete:LIMit:ALL

Syntax :MMEMory:DELete:LIMit:ALL

Parameters There are no parameters.

Command Deletes all the files in the LIMIT directory on the flash disk. These files con-
tain spectrum limit settings of the 9102.

Query There is no query form of this command available.

Example MMEMory:DELete:LIMit:ALL
:MMEMory:DELete:CHANNel

Syntax :MMEMory:DELete:CHANnel <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Deletes file stringl from the CHANNEL directory. Files in this directory
contain channel settings of the device.

Query Reads and returns the name of the file last deleted with this command.

Example :MMEMory :DELete:CHAN "'P-GSM™"
:MMEMory:DELete:CHANnel : ALL

Syntax :MMEMory :DELete:CHANnel :ALL

Parameters There are no parameters.

Command Deletes all the files in the CHANNEL directory on the flash disk.

Query There is no query form of this command available.

Example :MMEMory :DELete:CHANnel :ALL
:MMEMory:DELete:EDEVice

Syntax :MMEMory:DELete:EDEVice <stringl>

Parameters stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Command Deletes file stringl in the external device directory on the flash disk.
Files in this directory contain external device compensation settings on the
9102.

Query Reads and returns the name of the file last deleted with this command.

Example :MMEMory:DELete:EDEVice "EXT_DEV3

9102 Handheld Spectrum Analyzer  Software version 5.31 309



Chapter 16 SCPI Command Reference
MMemory commands

:MMEMory:DELete:EDEVice:ALL

Syntax
Parameters
Command
Query

Example

:MMEMory:DELete:EDEVice:ALL

There are no parameters.

Deletes all the files in the external device directory on the flash disk.
There is no query form of this command available.

:MMEMory :DELete:EDEVice:ALL

:MMEMory:DELete:CTYPe

Syntax

Parameters

Command

Query

Example

:MMEMory:DELete:CTYPe <stringl>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Deletes file stringl in the cable type directory on the flash disk. Files in
this directory contain cable type settings on the 9102.

Reads and returns the name of the file deleted last with this command.

:MMEMory:DELete:CTYPe "cable3"

:MMEMory:DELete:CTYPe:ALL

Syntax
Parameters
Command
Query

Example

:MMEMory:DELete:CTYPe:ALL

There are no parameters.

Deletes all the files in the cable type directory on the flash disk.
There is no query form of this command available.

:MMEMory:DELete:CTYPe:ALL

:MMEMory:DELete:AFACtor

Syntax

Parameters

Command

Query

Example

:MMEMory:DELete:AFACtor <stringl>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Deletes file stringl in the antenna factor directory on the flash disk. Files
in this directory contain antenna factor compensation settings on the 9102.

Reads and returns the name of the file deleted last with this command.

:MMEMory :DELete:AFACtor "AFAC2"
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-MMEMory:DELete:AFACtor:-ALL

Syntax
Parameters
Command
Query

Example

:MMEMory :DELete:AFACtor:-ALL

There are no parameters.

Deletes all the files in the antenna factor directory on the flash disk.
There is no query form of this command available.

:MMEMory:DELete:AFACtor:ALL

:MMEMory :DELete:CFACtor

Syntax

Parameters

Command

Query

Example

:MMEMory:DELete:CFACtor <stringl>

stringl is a string (text) parameter. The maximum length of stringl is
11 characters.

Deletes file stringl in the cable factor directory on the flash disk. Files in
this directory contain cable factor compensation settings on the 9102.

Reads and returns the name of the file deleted last with this command.

:MMEMory :DELete:CFACtor "'CFAC7"

:MMEMory :DELete:CFACtor:ALL

Syntax
Parameters
Command
Query

Example

:MMEMory :DELete:CFACtor:-ALL

There are no parameters.

Deletes all the files in the cable factor directory on the flash disk.
There is no query form of this command available.

:MMEMory :DELete:AFACtor:ALL

Instrument commands

:INSTrument:SELect

Syntax

Parameters

Command

Query

:INSTrument:SELect <PredefExpr>

PredefExpr is one of the following expressions:
SANalyzer |CPOWer | TRANsmission|DTF|SGENerator|
RFLection|CLOSs|EMF]PSENsor.

Default is SANalyzer.

Selects the measurement mode. Available modes are spectrum analysis
channel power, transmission, distance to fault, signal generator, reflection,
cable loss, electro magnetic field and power sensor.

Selects the measurement mode. Available modes are spectrum analysis,
channel power, transmission, distance to fault, signal generator, reflection,
cable loss, electro magnetic field and power sensor.

Reads and returns the current setting.
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Example

cINSTrument:SELect CPOWer
cINSTrument:SELect?
Returns the following string: ""CPOWer""

:INSTrument:EREFfreq

Syntax
Parameters
Command

Query

Example

:INSTrument:EREFfreq <PredefExpr>
There are no parameters.
There is solely a query form of this command available.

Reads and returns whether an external reference frequency is connected
or not.

:INSTrument:EREFfreqg?
Returns the following string: ""OFF""

:INSTrument:GENerator

Syntax

Parameters

Command
Query

Example

:INSTrument:GENerator <PredefExpr>

PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Switches the tracking generator on and off.
Reads and returns the current setting.

:INSTrument:GENerator ON
- INSTrument:GENerator?
Returns the following string: ""ON"*

- INSTrument:GENerator:LEVel

Syntax

Parameters

Command

Query

Example

2 INSTrument:GENerator:LEVel <reall>

reall is a floating point real number.

The minimum- and maximum value for reall depend on the unit set by
SENS:REFL :UNIT. When the unit is set to dBm, the minimum value is -
100, the maximum value is 30. When the unit is set to dBuV, the minimum
value is 7, the maximum value is 137. When the unit is set to dBmV, the min-
imum value is -53, the maximum value is 77. When the unit is set to dBV,
the minimum value is -113, the maximum value is 17. The default value for
reallis O dBm

This command sets output power of the 9102 tracking generator in the unit
selected with the :SENS:REFL:UNIT command.

Reads and returns the current setting.

2 INSTrument:GENerator:LEVel -50
2 INSTrument:GENerator:LEVel?
The value returned in this example is: ""-50"".
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:INSTrument:GENerator:MODe

Syntax :INSTrument:GENerator:MODe <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: CW | SWP.
Default is CW.

Command Switches the generator between continuous wave signal (CW) at a certain
frequency and sweeping signal which sweeps from start to stop frequency.
This command works only in SIGNAL GENERATOR mode.

Query Reads and returns the current setting.

Example :INSTrument:GENerator:MODe CW
INSTrument:GENerator :MODe?

Returns the following string: ""CW"
:INSTrument:GENerator:DISPlay

Syntax INSTrument:GENerator:DISPlay <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ABSo-
lute|RELative.

Default is ABSolute.

Command Switches the display absolute or relative to the tracking generator output
power. This command is linked to SENSe: TRANsmission:REFer-
ence:UNIT.

Query Reads and returns the current setting.

Example INSTrument:GENerator:DISPlay RELative
INSTrument:GENerator:DISPlay?

Returns the following string: ""REL"
ZINSTrument:GPS

Syntax INSTrument:GPS <PredefExp>

Parameters PredefTExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Command Switches to 9102 GPS receiving mode and sets serial port baud rate to
4800 baud if switched on.

Query Reads and returns the current setting.

Example INSTrument:GPS ON
INSTrument:GPS?

Returns the following string: *"ON"*
SINSTrument:GPS:QUALiIty

Syntax INSTrument:GPS:QUALiIty?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one enum value representing the quality of the

received GPS signal: FAIL means, no data is received; WARNing means,
data is received, but will be inaccurate; OK means, data is valid.
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Example INSTrument:GPS:QUALiIty?
The value returned in this example is: ""OK"".

2 INSTrument:GPS:LATitude

Syntax INSTrument:GPS:LATitude?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one real value representing the latitude of the

received GPS data. The value is in degree an in a range between -90 deg
(South) and +90 deg (North).

Example INSTrument:GPS:LATitude?
The value returned in this example is: -7.8323.

2 INSTrument:GPS:LONGi tude

Syntax INSTrument:GPS:LONGitude?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one real value representing the longitude of the

received GPS data. The value is in degree an in a range between -180 deg
(East) and +180 deg (Wesb).

Example INSTrument:GPS:LONGitude?
The value returned in this example is: -137.2475.

2 INSTrument:GPS:SPEed

Syntax :INSTrument:GPS:SPEed?

Parameters PredefExpr is one of the following predefined expressions: ABSo-
lute|RELative.
Default is ABSolute.

Command There is solely a query form of this command available.

Query Returns a string containing one real value representing the speed of the

received GPS data. The value returned is converted to the unit selected by
the INSTrument:GPS:SPEed:UNIT command.

Example INSTrument:GPS:SPEed?
The value returned in this example is: 54 4.

S INSTrument:GPS:SPEed:UNIT

Syntax INSTrument:GPS:SPEed:UNIT <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:
KPH|KTS|MPH.
Default is KPH.
Command Selects the unit for GPS speed result in km/h, knots or mile per hour.
Query Reads and returns the current setting.
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Example INST:GPS:SPE:UNIT FEET
INST:GPS:SPE:UNIT?

Returns the following string: "'"FEET""
:INSTrument:GPS: TRACK

Syntax 2 INSTrument:GPS:TRACK?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one real value representing the track (direction)
of the received GPS data. The value is in degree an in a range between 0.0
deg (North) and +359.9 deg.

Example > INSTrument:GPS:TRACK?

The value returned in this example is: 272.7.
s INSTrument:GPS:DATE

Syntax ZINSTrument:GPS:DATE?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing three integer values representing the date
(year,month,day) of the received GPS data.

Example :INSTrument:GPS:DATe?

The value returned in this example is: 2006,01,31.
SINSTrument:GPS:TIMe

Syntax INSTrument:GPS:TIMe?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing three integer values representing the time
(hour, minute, second) of the received GPS data.

Example ZINSTrument:GPS:DATe?

The value returned in this example is: 15,54 ,21.
:INSTrument:GPS:SATellites

Syntax INSTrument:GPS:SATellites?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one integer value representing the number of
satellites of the received GPS data.

Example INSTrument:GPS:SATel lites?

The value returned in this example is: 7.
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2 INSTrument:GPS:HDOP

Syntax INSTrument:GPS:HDOP?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one real value representing the HDOP value of

the received GPS data. This is a quality characteristic of the signal, values
below 2.0 representing a good signal.

Example INSTrument:GPS:HDOP?
The value returned in this example is: 1.8.

2 INSTrument:GPS:ALTitude

Syntax INSTrument:GPS:ALTitude?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string containing one real value representing the altitude of the

received GPS data. The value returned is converted to unit selected by
INSTrument:GPS:ALTitude:UNIT.

Example INSTrument:GPS:ALTitude?
The value returned in this example is: 574 _3.

2INSTrument:GPS:ALTitude:UNIT

Syntax INSTrument:GPS:ALTitude:UNIT <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
METer | FEET. Default is METer.

Command Selects the unit for GPS altitude result in meter or feet.

Query Reads and returns the current setting.

Example SINST:GPS:ALT:UNIT FEET

ZINST:GPS:ALT:UNIT?
Returns the following string: ""FEET"".

2 INSTrument:GPS:COORdinate:UNIT

Syntax INSTrument:GPS:COORdinate:UNIT <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions:
MINutes|DEGree. Default is MINutes.

Command Selects the unit for GPS latitude and longitude results. This setting only
affects the manual mode; in remote mode, the results are always returned
in degrees.

Query Reads and returns the current setting.

Example INST:GPS:COORdinate:UNIT DEG

INST:GPS:COORdinate:UNIT?
Returns the following string: "'DEGR".
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The display command subsystem affects the screen of the instrument.

:DISPlay:TRACe:Y[:SCALe][:LOGarithmic]

Syntax

Parameters

Command

Query

Example

:DISPlay:TRACe:Y[:SCALe][:LOGarithmic] <intl>

intl is an integer. The minimum value for <intl> is 1, the maximum is
20. Valid values are 1, 2, 5, 10, 20. The default value is 10.

Holds the upper limit of the power scale but changes the resolution (and
the lower limit) of the scale when intl defines how many dB per scale unit
are shown on the display.

Returns the current setting.

:DISPlay:TRACe:Y[:SCALe][:LOGarithmic] 20
:DISPlay:TRACe:Y[:SCALe][:LOGarithmic]?
The value returned in this example is: **20™.

:DISPlay:TRACe:Y[:SCALe]:LINear:VOLT

Syntax

Parameters

Command

Query

Example

:DISPlay:TRACe:Y[:SCALe]:LINear:VOLT <reall>

reall is a floating point real number.
The minimum value for reall is 0.00001. The maximum value for reall
is 1.0. The default value for reall is 0.001.

This command is only in effect when 9102 is set to voltage unit. It holds the
upper limit of the scale but changes the resolution (and the lower limit) of
the voltage scale. reall defines how many volts per scale unit are shown
on the display. The resolution depends on which unit is set with
SENSe:REFLevel :UNIT. If it set to V the command and query is in Volts.
If it set to MV the command and query is in Milli Volts. If it set to UV the
command and query is in Micro Volts.

Returns the current setting.

:DISPlay:TRACe:Y[:SCALe]:LINear:VOLT 0.0005
:DISPlay:TRACe:Y:[SCALe]:LINear:VOLT?
The value returned in this example is: **0.0005".

:DISPlay:TRACe:Y[:SCALe]:LINear:WATT

Syntax

Parameters

Command

Query

:DISPlay:TRACe:Y[:SCALe]:LINear:WATT <reall>

reall is a floating point real number.
The min_imum value for real1 1S 0.00000000001. The maximum value for
reall 1S 0.1 The default value for reall is 0.000001.

This command is only in effect when 9102 is set to Watt unit. It holds the
upper limit of the scale but changes the resolution (and the lower limit) of
the Watt scale. real1 defines how many Watts per scale unit are shown on
the display. The resolution depends on which unit is set with
SENSe:REFLevel :UNIT. If it set to MW the command and query is in Milli
Watts. If it set to UW the command and query is in Micro Watts.

Returns the current setting.
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Example :DISPlay:TRACe:Y[:SCALe]:LINear:WATT 0.0002
:DISPlay:TRACe:Y:[SCALe]:LINear:WATT?
The value returned in this example is: "*0.0002".

:DISPlay:TRACe:Y[:SCALe]:RFLection:VSWR

Syntax :DISPlay:TRACe:Y[:SCALe]:RFLection:VSWR <reall>

Parameters reall is a floating point real number.
The minimum value for reall is 1.0. The maximum value for reall is
1000.0. The default value for real1 is 100.0.

Command This command is only in effect when 9102 is set to reflection mode and the
unit is set to VSWR. It holds the upper limit of the VSWR scale but changes
the resolution (and the lower limib) of the scale. real1 defines how many
VSWR units per scale unit are shown on the display.

Query Returns the current setting.

Example :DISPlay:TRACe:Y[:SCALe]:RFLection:VSWR 0.5
:DISPlay:TRACe:Y:[SCALe]:RFLection:VSWR?
The value returned in this example is: ""0.5".

:DISPlay:TRACe:Y[:SCALe]:RFLection:RFACtor

Syntax :DISPlay:TRACe:Y[:SCALe]:RFLection:RFACtor <reall>

Parameters reall is a floating point real number.
The minimum value for reall is 1 mRho. The maximum value for reallis
2000 mRho. The default value for reall is 200 mRho.

Command This command is only in effect when 9102 is set to reflection mode and
unit is set to reflection factor. It holds the upper limit of the reflection factor
scale but changes the resolution (and the lower limit) of the scale. reall
defines how many mRho per scale unit are shown on the display.

Query Returns the current setting.

Example :DISPlay:TRACe:Y[:SCALe]:RFLection:RFACtor 100
:DISPlay:TRACe:Y:[SCALe]:RFLection:RFACtor?
The value returned in this example is: "*100".

:DISPlay:TRACe:Y[:SCALe]:RFLection:RPOWer

Syntax :DISPlay:TRACe:Y[:SCALe]:RFLection:RPOWer <reall>

Parameters reall is a floating point real number.
The minimum value for reallis 1.0 %. The maximum value for reall is
200.0 %. The default value for real1 is 20.0 %.

Command This command is only in effect when 9102 is set to reflection mode and
unit is set to reflection power. It holds the upper limit of the reflection
power scale but changes the resolution (and the lower limit) of the scale.
reall defines how many % per scale unit are shown on the display.

Query Returns the current setting.

Example :DISPlay:TRACe:Y[:SCALe]:RFLection:RPOWer 10
:DISPlay:TRACe:Y:[SCALe]:RFLection:RPOWer?
The value returned in this example is: ""10".
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:DISPlay:TRACe:Y[:SCALe] :DTF:VSWR

Syntax :DISPlay:TRACe:Y[:SCALe]:DTF:VSWR <reall>

Parameters reall is a floating point real number.

The minimum value for reall is 1.0. The maximum value for reall is
1000. 0. The default value for reall is 100.0.

Command This command is only in effect when 9102 is set to DTF mode and the unit
is set to VSWR. It holds the upper limit of the VSWR scale but changes the
resolution (and the lower limit) of the scale. real 1l defines how many
VSWR units per scale unit are shown on the display.

Query Returns the current setting.

Example :DISPlay:TRACe:Y[:SCALe]:DTF:VSWR 0.5
:DISPlay:TRACe:Y:[SCALe]:DTF:VSWR?

The value returned in this example is: ""'0.5".
:DISPlay:TRACe:Y[:SCALe]:DTF:RFACtor

Syntax :DISPlay:TRACe:Y[:SCALe]:DTF:RFACtor <reall>

Parameters reall is a floating point real number.

The minimum value for reallis 1 mRho. The maximum value for reallis
1000 mRho. The default value for reall is 100 mRho.

Command This command is only in effect when 9102 is set to Reflection Mode and
unit is set to Reflection Factor. It holds the upper limit of the Reflection Fac-
tor scale but changes the resolution (and the lower limit) of the scale.
reall defines how many mRho per scale unit are shown on the display.

Query Returns the current setting.

Example :DISPlay:TRACe:Y[:SCALe]:DTF:RFACtor 100
:DISPlay:TRACe:Y:[SCALe]:DTF:RFACtor?

The value returned in this example is: 100",
:DISPlay:BACKIight[ :BATTery]

Syntax :DISPlay:BACKlight[:BATTery] <intl>

Parameters intl is an integer. The minimum value for <intl> is O, the maximum is
100. The default value is 50.

Command Sets the brightness of the screen in battery mode. A setting of 100 leads to
the maximum brightness.

Query Returns the current setting.

Example :DISPlay:BACKlight 30
:DISPlay:BACKlight?
The value returned in this example is: "*30™".

:DISPlay:BACKIight:EXTern
Syntax :DISPlay:BACKlight:EXTern <intl>
Parameters intl is an integer. The minimum value for <intl> is O, the maximum is

100. The default value is 100.
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Command

Query

Example

Sets the brightness of the screen when external power supply is con-
nected. A setting of 100 leads to the maximum brightness.

Returns the current setting.

:DISPlay:BACKlight:EXTern 50
:DISPlay:BACKlight:EXTern?
The value returned in this example is: ""'50"".

:DISPlay:BEEP

Syntax

Parameters

Command
Query

Example

:DISPlay:BEEP <PredefExpr>

PredefExpr is one of the following predefined expressions: ON | OFF.
Default is ON.

Sets the beep tone on and off.
Reads and returns the current setting.

:DISPlay:BEEP ON
:DISPlay:BEEP?
Returns the following string: ""ON"*

:DISPlay:COLor:TRACe: [A]B]

Syntax

Parameters

Command
Query

Example

:DISPlay:COLor:TRACe:[A]|B] <intl>

intl is an integer. The minimum value for <intl> is 1, the maximum is 8.
The default value is 1 for trace A and 3 for trace B.

Sets the color from the color palette for trace A or B.
Reads and returns the current setting.

:DISPlay:COLor:TRACe:A 5
:DISPlay:COLor:TRACe:A?
The value returned in this example is: "*5"".

:DISPlay:COLor:TRACe:OFFSet

Syntax

Parameters

Command

Query

Example

:DISPlay:COLor:TRACe:OFFSet <intl>

intl is an integer. The minimum value for <intl>is 1, the maximum is 8.
The default value is 7.

Sets the color from the color palette for the trace offset for the subtracted
trace
(A-B->A trace).

Reads and returns the current setting.

:DISPlay:COLor:TRACe:0FFSet 5
:DISPlay:COLor:TRACe:0OFFSet?
The value returned in this example is: "'5".
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:DISPlay:COLor:GRATiIcule
Syntax :DISPlay:COLor:GRATicule <intl>

Parameters intl is an integer. The minimum value for <intl> is 1, the maximum is 8.
The default value is 2.

Command Sets the color from the color palette for the graticule.
Query Reads and returns the current setting.
Example :DISPlay:COLor:GRATicule 5

:DISPlay:COLor:GRATicule?
The value returned in this example is: 5.

:DISPlay:COLor:LIMits
Syntax :DISPlay:COLor:LIMits <intl>

Parameters intl is an integer. The minimum value for <intl>is 1, the maximum is 8.
The default value is 7.

Command Sets the color from the color palette for the limit lines.
Query Reads and returns the current setting.
Example :DISPlay:COLor:LIM 5

:DISP:COL:LIMits?
The value returned in this example is: "*5"".

Calculate commands

The markers of the 9102 can be set using the calculate commands.

:CALCulate:MARKer : AOFF

Syntax :CALCulate :MARKer :AOFF

Parameters There are no parameters.

Command All markers are switched off.

Query There is no query form of this command available.

Example :CALC:MARK:A:STAT NORM
:CALC:MARK:B:STAT DELT
:CALC:MARK:C:STAT DELT
:CALC:MARK:AQOFF

:CALCulate:MARKer:{A|B|CID]E|F}[:STATe]

Syntax :CALCulate:MARKer:{A|B|CID]E|F}[:STATe]
<PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:

OFFNORMal |DELTa.
Default is OFF.
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Command Selects an active marker and sets it to one of three different modes:
OFF|NORMal |COUNter or OFF|NORMal | DELTa.
OFF is used to switch off the selected marker.
NORMal switches the selected marker on.
DELTa changes the marker B, C or D to a delta marker; the REF marker is
always A. Marker A cannot be set to DELTa. Only Marker A can be set to
COUNter which switches on the frequency counter.

Query The query form of this command will return the current setting. The string
delivered back will contain the short-form version of one of the predefined
expressions explained above.

Example :CALC:MARK:A:STAT NORM
:CALC:MARK:A:STAT?
Value returned in this example: ""NORM*".

:CALCulate:MARKer:{A|B|CID|E|F}:DTF[:STATe]

Syntax :CALCulate:MARKer:{A|B|CID|E|F}:DTF[:STATe]
<PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:

OFFNORMal |DELTa.
Default is OFF.

Command Selects an active marker and sets it to one of three different modes:
OFF | NORMal | COUNter or OFF|NORMal | DELTa.
OFF is used to switch off the selected marker.
NORMal switches the selected marker on.
DELTa changes the marker B, C or D to a delta marker; the REF marker is
always A. Marker A cannot be set to DELTa. Only Marker A can be set to
COUNter which switches on the frequency counter.

Query The query form of this command will return the current setting. The string
delivered back will contain the short-form version of one of the predefined
expressions explained above.

Example :CALC:MARK:A:DTF NORM
:CALC:MARK:A:DTF?
Value returned in this example: ""NORM™,

-CALCulate:MARKer: {A|B|CIDIE|F}:Y?

Syntax :CALCulate:MARKer:{A|B|CID|E]F}:Y?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query The query form of this command returns the level value at the current

marker position set by CALCulate:MARKer:{A|B|C|D]E|F}:X. The
string delivered will contain one floating point real number with the physi-
cal dimension that has been selected for the reference level
(:SENSe:REFLevel -UNIT).

Example :CALCulate:MARKer:B:X 2200000000
:CALCulate:MARKer:B:Y?
The value returned is: "'-22.4"".
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:CALCulate:MARKer:{A|B|C|D|E|F}:X[:FREQuency]

Syntax :CALCulate:MARKer:{A|B|C|D|E|F}:X[:FREQuency] <reall>

Parameters reall is a floating point real number.

The minimum value for reall is O, the maximum value 7500000000. The
minimum resolution possible for reall is 1. The default value for reallis
1800000000.

Command This command sets the marker frequency for one of the six markers of the
Aeroflex 9102 when in spectrum analysis mode. The physical dimension of
reall is Hertz.

Query The query form of this command will return the current marker frequency
setting of the respective marker of the Aeroflex 9102 (A, B, C, D, E or P.
The string delivered back will contain one real number.

Example :CALCulate:MARKer:C:X 1500000000
:CALCulate:MARKer:C:X?

The value returned in this example is: **1500000000"".
:CALCulate:MARKer:{A|B|CIDIE|F}:X:TIMe

Syntax :CALCulate:MARKer:{A|B|CID]JE|F}:X:TIMe <reall>

Parameters reall is a floating point real number.

The minimum value for reall is 0.001, the maximum value 250.0. The
minimum resolution possible for reall is 1. The default value for reall is
0.0432.

Command This command sets the marker time for zero-span measurements for one
of the six markers of the Aeroflex 9102. The physical dimension of reall
is seconds.

Query The query form of this command will return the current marker time setting
of the respective marker of the Aeroflex 9102 (A, B, C, D, E or F). The string
delivered back will contain one real number.

Example :CALCulate:MARKer:C:X:TIME 0.5
:CALCulate:MARKer:C:X:TIME?

The value returned in this example is: "0 .5".
:CALCulate:MARKer:{A|B|CID]JE|F}:X:DISTance

Syntax :CALCulate:MARKer:{A|B|C|D|E|F}:X:DISTance <reall>

Parameters real1 is a floating point real number.

The minimum value for real1 is 0.0, the maximum value 2000.0. The
minimum resolution possible for reall is 1. The default value for reallis
0.0432.

Command This command sets the marker time for distance to fault measurements for
one of the six markers of the Aeroflex 9102. The physical dimension of
reall is meter or feet, respectively.

Query The query form of this command will return the current DTF marker length
setting of the respective marker of the Aeroflex 9102 (A, B, C, D, E or F).
The string delivered back will contain one real number.

Example :CALCulate:MARKer:C:X:DISTance 10.5

:CALCulate:MARKer:C:X:DISTance?
The value returned in this example is: "10.5".
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:CALCulate:{A|B|C|D]EJF}:MARKer:FSTep

Syntax :CALCulate:MARKer:{A|B|C|D|E|F}:FSTep

Parameters There are no parameters.

Command Sets Marker A, B, C, D, E or F to current frequency step (FSTep).
Query There is no query form of this command available.

Example :CALCulate:MARKer:A:FSTep

:CALCulate:MARKer : {A|B|CID|E|F}:TSELect

Syntax :CALCulate:MARKer:{A|B|C|D|E|F}:TSELect <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions: A|B.

Default is A.
Command Selects an active marker and sets it either to trace A or trace B. Note: Set to

trace B is only possible when trace B is active.

Query The query form of this command will return the current setting. The string
delivered back will contain the short-form version of one of the predefined
expressions explained above.

Example :CALC:MARK:A:TSELect B
:CALC:MARK:A:TSELect?
Value returned in this example: "B".

:CALCulate:MARKer :MAXPeak

Syntax :CALCulate:MARKer :MAXPeak
Parameters There are no parameters.
Command Sets the currently selected marker to the maximum measured level. A

marker is "selected" by way of the :CALCu-
late:MARKer:{A|BIC|D|E|F}[:STATe] command.

Query There is no query form of this command available.

Example :CALCulate :MARKer :MAXPeak.

:CALCulate:MARKer :NPEak

Syntax :CALCulate:MARKer :NPEak

Parameters There are no parameters.

Command Sets the currently selected marker to the next highest level value.
Query There is no query form of this command available.

Example :CALCulate :MARKer :NPEak.

:CALCulate:MARKer :MCENter

Syntax :CALCulate:MARKer :MCENter

Parameters There are no parameters.
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Command The center frequency is changed to the current marker frequency.

Query There is no query form of this command available.

Example :CALCulate:MARKer :MCENter.
:CALCulate:MARKer:MREFlevel

Syntax :CALCulate:MARKer :MREFlevel

Parameters There are no parameters.

Command The REFerence level is changed to the level at the marker position.

Query There is no query form of this command available.

Example :CALCulate:MARKer :MREFlevel.

:CALCulate:MARKer:FCOunt?

Syntax :CALCulate:MARKer :FCOunt?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns a string with the floating point value for the current result of the fre-
quency counter, in Hz. Marker M1 (CALC-MARK:A COUNter) has to be set
before to get a valid result.

Example :CALCulate:MARKer :FCOunt?

The value returned in this example is: ""'2694365000.0"".
:CALCulate:MARKer:FCOunt:RESolution

Syntax :CALCulate:MARKer :FCOunt:RESolution <reall>

Parameters reall is an integer. The minimum value for <real 1> is 1, the maximum is
1000. Valid values are 1, 10, 100, 1000. The default value is 1000.

Command Sets the counter resolution of the frequency counter in Hz.

Query Reads and returns the current setting.

Example :CALC:MARK:FCO:RES 10
:CALC:MARK:FCO:RES?

The value returned in this example is: ""10™".
:CALCulate:LIMIt[:STATe]
Syntax :CALCulate: :LIMit[:STATe] <PredefExpr>
Parameters PredefExpr is one of the following predefined expressions:

OFFJUPPer | LOWer | UPPLow.
Default is OFF.
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Command Selects the limit lines to one of four different modes:
OFFJUPPer | LOWer | UPPLow.
OFF is used to switch off the limit lines.
UPPer switches only the upper limit line on.
LOWer switches only the lower limit line on.
UPPLow switches both upper and lower limit lines on.

Query The query form of this command will return the current setting. The string
delivered back will contain the short-form version of one of the predefined
expressions explained above.

Example CALC:LIM:STAT UPPLOW
:CALC:LIM?
Value returned in this example: ""UPPL"" .

:CALCulate:LIMit:FCOunt

Syntax :CALCulate:LIMit:FCOunt <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Command Enables (and resets) or disables the failure counter. When enabled,
requires that limit checking is also active (see CALC:LIM:STAT).

Query Reads and returns the current setting.

Example :CALCulate:LIMit:FCOunt ON
:CALCulate:LIMit:FCOunt?
Returns the following string: *"ON**

:CALCulate:LIMit:FCOunt:COUNt?

Syntax :CALCulate:LIMit:FCOunt:COUNt?

Parameters There are no parameters.

Command There is solely a query form of this command available.
Query Gets the current count of fails in the limit check.
Example :CALCulate:LIMit:FCOunt:COUNt?

The value returned in this example is: "'5™.

:CALCulate:LIMit:FBEep

Syntax :CALCulate:LIMit:FBEep <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Command Enables or disables a sound that can be output each time a measurement
fails the limits.

Query Reads and returns the current setting.

Example :CALC:LIMit:FBEep ON

:CALCulate:LIMit:FBEep?
Returns the following string: *"ON"".
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:CALCulate:LIMit:-FHOLd

Syntax :CALCulate:LIMit:FHOLd <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Command Enables or disables hold, if measurement fails the limits.

Query Reads and returns the current setting.

Example :CALCulate:LIMit:FHOLd ON

:CALCulate:LIMit:FHOLd?
Returns the following string: ""ON"".

:CALCulate:LIMit:SIMPle

Syntax :CALCulate:LIMit:SIMPle <PredefExpr>

Parameters PredefExpr is one of the following predefined expressions: ON | OFF.
Default is OFF.

Command Enables or disables the simple limit lines.

Query Reads and returns the current setting.

Example :CALCulate:LIMit:SIMPle ON

:CALCulate:LIMit:SIMPle?
Returns the following string: **ON"".

:CALCulate:LIMit:SIMPle:UPPer

Syntax :CALCulate:LIMIt:SIMPle:UPPer <reall>

Parameters reall is a floating point real number.
The minimum value for real1 is 0.0, the maximum value 8.0. The mini-
mum resolution possible for reall is 0. 1. The default value for reall is

7.0.

Command Sets the simple upper limit line. The unit is one grid. 0.0 means the lower
border of the visible display and 8.0 means the upper border.

Query Reads and returns the current setting.

Example :CALCulate:LIMit:SIMPle:UPPer 6

:CALCulate:LIMit:SIMPle:UPPer?
The value returned in this example is: "'6.0"".

:CALCulate:LIMit:SIMPle:LOWer

Syntax :CALCulate:LIMit:SIMPle:LOWer <reall>

Parameters reall is a floating point real number.
The minimum value for reall1 IS 0.0, the maximum value 8.0. The mini-
mum resolution possible for real1l IS 0. 1. The default value for reall is
1.0

Command Sets the simple lower limit line. The unit is one grid. 0.0 means the lower
border of the visible display and 8.0 means the upper border.

Query Reads and returns the current setting.
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Example

:CALCulate:LIMit:SIMPle:LOWer 2
:CALCulate:LIMit:SIMPle:LOWer?
The value returned in this example is: "'2.0".

:CALCulate:MEASure:ACPR

Syntax
Parameters
Command

Query

Example

:CALCulate:MEASure:ACPR?
There are no parameters.
There is solely a query form of this command available.

Returns a string containing three floating point values; these represent the
relative power in the lower adjacent channel (in dB), the in-channel power
(in dBm) and the relative power in the upper adjacent channel (in dB).

:CALCulate:MEASure:ACPR?
The value returned in this example is: "*-14.9,-31.5,-14_.1".

:CALCulate:MEASure:0BW

Syntax
Parameters
Command

Query

Example

:CALCulate:MEASure:0BW?
There are no parameters.
There is solely a query form of this command available.

Returns a string with the floating point value for the occupied bandwidth, in
Hz.

:CALCulate:MEASure:0BW?
The value returned in this example is: **2694000.0".

:CALCulate:MEASure:CPOWer

Syntax
Parameters
Command
Query

Example

:CALCulate:MEASure:CPOWer?

There are no parameters.

There is solely a query form of this command available.
Returns the measured in-channel power, in dBm.

:CALCulate:MEASure:CPOW?
Returns the following string: "-32_2".

NOTE

The :CALCulate:MEASure:CPOWer? command only returns a valid
measurement result after a complete sweep has been made. Should
the channel power be determined before the sweep is complete,
the value -9999 will be returned. This value will also be returned, if
the channel system settings defined cause an invalid measurement
result. The value -9999 always indicates an invalid measurement
value.

:CALCulate:MEASure:ACLoss

Syntax

328

:CALCulate:MEASure:ACLoss?
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Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the average cable loss, in dB. This query returns valid results only
in Cable Loss mode.

Example :CALCulate:MEASure:ACLoss?

The value returned in this example is: ""-22_.5".
:CALCulate:MEASure:EMF

Syntax :CALCulate:MEASure:EMF?

Parameters There are no parameters.

Command There is solely a query form of this command available

Query Returns the EMF measurement value. The result depends on the setting of
the :SENSe:EMF:MEASure:DISPlay command. If it is set to
EFSTrength (electric field strength) the unit for the result is Volt/meter. If it
is set to PDENsity (power density) the unit for the result is Watt/squa-
remeter. This query only returns valid results in EMF mode.

Example :CALCulate:MEASure:EMF?

The value returned in this example is: ''0.103352".
:CALCulate:MEASure:PSENsor[:ALL]?

Syntax :CALCulate:MEASure:PSENsor[:ALL]?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the power sensor measurement values. The first result represent
the forward power, the second result represent the reverse power. The
results depends on the setting : SENSe : PSENSor :UNIT command. If it is
set to DBM the unit for the result is dBm. If it is set to W the unit for the result
is Watt. This query returns valid results only in power sensor mode.

Example :CALCulate:MEASure:PSENsor?

The value returned in this example is: *'20.1,18.5".
:CALCulate:MEASure:PSENsor:FPOWer?

Syntax :CALCulate:MEASure:PSENsor:FPOWer?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the power sensor measurement value for the forward power. The
result depends on the setting : SENSe : PSENSor :UNIT command. If it is
set to DBM the unit for the result is dBm. If it is set to W the unit for the result
is Watt. This query returns valid results only in power sensor mode.

Example :CALCulate:MEASure:PSENsor:FPOWer?

The value returned in this example is: *'20._1"".
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:CALCulate:MEASure:PSENsor :RPOWer?

Syntax :CALCulate:MEASure :PSENsor :RPOWer?

Parameters There are no parameters.

Command There is solely a query form of this command available.

Query Returns the power sensor measurement value for the reverse power. The

result depends on the setting : SENSe : PSENSor :UNIT command. If it is
set to DBM the unit for the result is dBm. If it is set to W the unit for the result
is Watt. This query returns valid results only in power sensor mode.

Example :CALCulate:MEASure :PSENsor :RPOWer?
The value returned in this example is: "20.1"".

Format commands

These commands are used for formatting the SCPI output of the 9102
Handheld Spectrum Analyzer.

:FORMat:ADELimiter

Syntax :FORMat:ADELimiter <PredefExp>

Parameters PredefExp is one of the following predefined expressions:
COMMa | COLONn|SEMIcolon.
Default is COMMa.

Command Selects the delimiter to be used to separate parameters in SCPI commands,
and also to separate the individual measurement result values in a result
return string.

COMMa stands for commas (defaulb),
COLOnN sets the delimiter to be a colon (), while
SEMIcollon will use and expect a semicolon (;) to be used.

Query Reads and returns the current setting.

Example :FORM:ADEL
Defines the comma to be used as delimiter for both commands and mea-
surement results.

:FORMat:RESolution

Syntax :FORMat:RESolution <intl>

Parameters intl is an integer. The minimum value for <intl> is O, the maximum is
20. The default value is 6.

Command Defines the number of digits after the decimal point to be used for floating
point real figures.

Query Reads and returns the current setting.

Example :FORM:RES O

Defines that there will be no digits after the decimal point.
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These commands are used for information regarding the status of the
9102.

:SERVice:BOOTversion?

Syntax
Parameters
Command

Query

Example

:SERVice:BOOTversion?
There are no parameters.
There is only a query form of this command available.

Reads and returns the version of the boot software of your Aeroflex 9102.
The command will return a string.

:SERVice:BOOTversion?
String returned in this example: **2.00"".

:SERVice:BOOTversion:DATe?

Syntax
Parameters
Command

Query

Example

:SERVice:BOOTversion:DATe?
There are no parameters.
There is only a query form of this command available.

Reads and returns the date of the Boot Software of your Aeroflex 9102.
The command will return a string.

:SERVice:BOOTversion:DATe?
String returned in this example: ""2004/10/22".

:SERVice:BATTery

Syntax
Parameters
Command

Query

Example

:SERVice:BATTery?
There are no parameters.
There is only a query form of this command available.

Reads and returns the the current loading state of the battery in %. The
command will return an integer.

:SERVice:BATTery?
String returned in this example: *'40".

:SERVice:BATTery:SERialnumber?

Syntax
Parameters
Command

Query

Example

:SERVice:BATTery:SERialnumber?
There are no parameters.
There is only a query form of this command available.

Reads and returns the serial number of the battery of your Aeroflex 9102.
The command will return a string.

:SERVice:BATTery:SERialnumber?
String returned in this example: '"00300402".
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:SERVice:POWerline?

Syntax :SERVice:POWerline?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Returns ON, if the Aeroflex 9102 is connected to the 12 V power line, other-

wise returns OFF.

Example :SERV:POW?
String returned in this example: ""OFF".

:SERVice:CHECK:LAST

Syntax :SERVice:CHECK:LAST <intl>,<int2>,<int3>,<string>
Parameters intx are three integers.
The minimum value for intl is 1998, the maximum is 2100. The default
value is 1998.
The minimum value for int2 is 1, the maximum is 12. The default value is
1
The minimum value for int3 is 1, the maximum is 31. The default value is
1
string is a string (text) parameter. The maximum length of stringl is 16
characters.
Command Sets date and name of the last check of this device.
Query Reads and returns current settings. The command will return 3 integers
and a string.
Example :SERVice:CHECK:LAST?
String returned in this example: 2004 ,04,01,"John Williams™.

:SERVice:CHECK:NEXT

Syntax :SERVice:CHECK:NEXT?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the date of the next check to be performed on this

device. The command will return 3 integers.

Example :SERVice:CHECK:>NEXT?
String returned in this example: 2005,04,01.

:SERVice:DEVice:TYPe?

Syntax :SERVice:DEVice:TYPe?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the type of your Aeroflex 9102. The command will

return a string.
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Example :SERVice:DEVice:TYPe?
String returned in this example: ""9102".

:SERVice:DEVice:TEXT?

Syntax :SERVice:DEVice:TEXT?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the description text of your Aeroflex 9102. The com-

mand will return a string.

Example :SERVice:DEVice:TEXT?
String returned in this example:
"Aeroflex 9102 Handheld Spectrum Analyzer".

:SERVice:DEVice:CALibration:NUMBer?

Syntax :SERVice:DEVice:CALibration:NUMBer?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the calibration number of your Aeroflex 9102. The com-

mand will return a string.

Example :SERVice:DEVice:CALibration:NUMBer?
String returned in this example: 1234,

:SERVice:EDEVice:SERialnumber?

Syntax :SERVice:EDEVice:SERi1alnumber?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the serial number of the external device connected to

your Aeroflex 9102. The command will return a string.

Example :SERVice:EDEVice:SERTalnumber?
String returned in this example: '"00100202".

:SERVice:EDEVice:TYPe?

Syntax :SERVice:EDEVice:TYPe?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the type of the external device connected to your Aero-

flex 9102. The command will return a string.

Example :SERVice:EDEVice:TYPe?
Let's assume that the 9168 GPS Receiver Option is connected to your
9102. String returned in this example: ""9168".

9102 Handheld Spectrum Analyzer  Software version 5.31 333



Chapter 16 SCPI Command Reference

SCPI errors

:SERVice:EDEVice:TEXT?

Syntax :SERVice:EDEVice:TEXT?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the description text of the external device connected to
your Aeroflex 9102. The command will return a string.

Example :SERVice:EDEVice:TEXT?
String returned in this example: ""VSWR Bridge".
:SERVice:EDEVice:CALibration:DATe?

Syntax :SERVice:EDEVice:CALibration:DATe?

Parameters There are no parameters.

Command The command form is not available.

Query Returns date of last calibration by Aeroflex of the external device con-
nected in the form yyyy,mm,dd.

Example :SERVice:EDEVice:CALiIbration:DATe?
String returned in this example: *"2004/12/31".
:SERVice:EDEVice:CALibration:NUMBer?

Syntax :SERVice:EDEVice:CALiIbration:NUMBer?

Parameters There are no parameters.

Command There is only a query form of this command available.

Query Reads and returns the calibration number of the external device connected
to your Aeroflex 9102. The command will return a string.

Example :SERVice:EDEVice:CALibration:NUMBer?
String returned in this example: '1234".

SCPI errors

The following table lists the error numbers which the 9102 may return
in case of a problem.

Error

numbe  Error description

r
Command errors

-100 Internal error only, for debugging purposes (Command
error)

-101 Invalid character in command string
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-102

-103
-104

-108
-109
-111

112

13
114

-121

-123
-128
-131
-134

138
141

144

-158
-160

-168

-201

-202

-210

-222

SCPI syntax error: Command is not available as a query,
or vice versa

Invalid separator between parameters

Data type error (mismatch between parameters and
allowable data formats)

Parameter not allowed (too many parameters)
Missing parameter (too few parameters)

Header separator error (probably colon missing
between command keywords)

Program mnemonic too long (i.e. longer than 12 charac-
ters)

Keyword not found in command list

Header suffix out of range (invalid character in com-
mand keyword)

Invalid character in number (not a digit, or exponent
value missing)

Exponent out of range
Numerical data not allowed
Invalid suffix (appended unit not found)

Suffix too long (@appended unit is longer than 12 charac-
ters)

Suffix not allowed (parameter type is not real)

Invalid character data (parameter expression is not in
predefined list)

Character data too long (string data longer than
allowed)

String data not allowed for this parameter type

Internal error only, for debugging purposes (block data
error)

Internal error only, for debugging purposes (block data
not allowed)

Execution errors

Internal error only, for debugging purposes (SCPI execu-
tion function not defined)

Internal error only, for debugging purposes (SCPI query
function not defined)

Internal error only, for debugging purposes (out of
memory)

Data out of range
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-230

-231

-232

-233

-234

-235
-236
-260
-261

-262

-264

-300
-310

-311

-319
-320
-321

-322
-323
-330
-331

-400
-401

-402

-410

Internal error only, for debugging purposes (invalid
token received by EXEC)

Internal error only, for debugging purposes (invalid
index for parameter)

Internal error only, for debugging purposes (invalid
parameter)

Internal error only, for debugging purposes (parameter
has wrong type)

Internal error only, for debugging purposes (parameter
missing)

Internal error only, for debugging purposes (index error)
Parameter out of range

File name not found in defined directory

File creation failed in defined directory

Internal error only, for debugging purposes (label not
found, config file)

Error while saving or recalling trace file
Device-dependent errors
SYSTEM_ERROR

Internal error only, for debugging purposes (error no.
not found)

Internal error only, for debugging purposes (function not
yet supported)

Error queue overflow (more than 10 entries)
Wrong password

Internal error only, for debugging purposes (serial num-
ber error)

Wrong option key

Option not available

Download command error

Upload command error

Query errors

Checkrule conflict, parameters outside limits

Internal error only, for debugging purposes (EPROM
write error)

Internal error only, for debugging purposes (EPROM
read error)

Result not valid
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Programming Examples

This chapter provides examples how to use the SCPI commands to set
up and control the 9102 Handheld Spectrum Analyzer.

— “Overview” on page 340
— “Command examples” on page 340
— “Application examples” on page 348
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Overview

This chapter describes how to control the 9102 from a personal
computer via a serial or LAN connection. It explains the basic
commands for the 9102 Handheld Spectrum Analyzer and describes a
few typical applications together with the SCPI command sequence.

This documents does not show every command possible. It is assumed
that the user has some basic knowledge about remote control and also
some experience in the use of a spectrum analyzer.

Command examples

Introduction  The whole command set can be divided into three categories: settings,
measurements and others. Each category is descriped in a separate
section.

The word <val> stands for a numerical value.

The word <enum> is a placeholder for a string.

Prerequisites

Over serial interface The 9102 must be powered on. A serial cable (null modem cable with
crossed lines) must connect the 9102 with the PC. The interface
settings should be set to 57600 bps, 8 bits per character, no parity, 1
stop bit.

Over LAN interface  The 9102 must be powered on. A crosspatch LAN cable must connect
the 9102 with the PC, or a normal LAN cable must connect the 9102
to a local area network. The 9102 must be programmed with its own IP
address.

Settings  Please note that the 9102 always tries to execute the commands.
However, under some circumstances, the 9102 must adjust or change
other settings. If this happens, please check all previous settings and
try to resolve this conflict.

Center frequency  SENSe:FREQuency:CENTer <val>

Sets the center frequency in Hz.
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Examples:
Long format:
SENSE : FREQUENCY :CENTER 96500000
Center frequency set to 96.5 MHz

Short format:

SENS:FREQ:CENT 96.5E06 Center programmed to 96.5 MHz
SENSe :FREQuency:SPAN <val> Sets the span (dimension Hz)
Examples:

Long format:
SENSE : FREQUENCY - SPAN 20000000 Span programmed to 20 MHz

Short format:

SENS:FREQ:SPAN 20E06 Span programmed to 20 MHz
SENS:FREQ:SPAN:FULL Full span programmed
SENS:FREQ:SPAN O Zero span activated

SENSe:BANDwidth:RESolution <val>
Sets the resolution bandwidth (dim. Hz)

Valid values for <val>: 10 kHz, 30 kHz, 100 kHz, 300 kHz or 1 MHz.
Examples:

Long format:
SENSE :BANDWIDTH:RESOLUTION 30000 Resolution set to 30 kHz

Short format:
SENS:BAND:RES 30EO03 Resolution set to 30 kHz

SENS:BAND:RES:AUTO ON Automatic selection active

SENSe :BANDwidth:VIDeo <val> Sets the video bandwidth (dim. Hz)

Valid values for <val>: 100, 300 Hz. 1, 3, 10, 30, 100, 300 kHz or 1
MHz.

Examples:

Long format:
SENSE :BANDWIDTH:VIDEO 300000 Video set to 300 kHz

Short format:
SENS:BAND:VID 10EO03 Video set to 10 kHz
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Sweep time

Reference level

Scale

Input attenuation

A\

SENS:BAND:VID:AUTO ON

SENSe:SWEep:TIME <val>

Automatic selection active

Sets the sweep time (dimension ms)

Valid values for <val>: 1, 2, 5, 10, 20, 50, 100, 200 or 500 ms; 1, 2, 5,

10 or 20 s.
Examples:

Long format:
SENSE:SWEEP:TIME 200

Short format:
SENS:SWE:TIME 10

SENS:SWE:TIME:AUTO ON

SENSe:RFLevel <val>
Examples:

Long format:
SENSE:RFLEVEL -30.0

Short format

SENS:RFL 10
DISPlay:TRACe:Y <val>
Examples:

Long format:
DISPLAY:TRACE:Y 10

Short format:
DISPL:TRAC:Y 20

INPut:ATTenuation <val>

Sweep time set to 200 ms

Sweep time set to 10 ms

Automatic selection active

Defines the reference level (in dBm)

Reference level set to -30.0 dBm

Reference level set to +10 dBm

Defines scale per div. (in dB)

Scale set to 10 dB per division

Scale set to 20 dB per div.

Sets the input attenuation (in dB)

Valid input attenuation values: 0, 10, 20, 30, 40 or 50 dB.

WARNING

Be careful with O dB. This value may damage the unit if the actual

power is too high.
Examples:

Long format:
INPUT-ATTENUATION 10

9102 Handheld Spectrum Analyzer
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Trace

Marker
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Short format:
INP:ATT 20 20 dB attenuation

SENSe:DETector:FUNCtion <enum>

Sets the behavior of the detector
Valid entries for <val>: POSNeg, SAMPle, POSitive or NEGative.
Examples:

Long format:

SENSE:DETECTOR:FUNCTION POSITIVE Positive sampling
Short format:

SENS:DET:FUNC NEG Negative sampling
SENSe:TRACe:<x> <enum> Sets the trace behavior for trace A or B

<x> is the trace (A or B)

Valid entries for <enum> are: ACTual, MAXHold, MINHold, HOLD, AVG
or OFF.

Examples:

Long format:
SENSE:TRACE:A ACTUAL Normal trace for A

Short format:

SENS:TRAC:B AVG Average trace for B
CALCulate:MARKer:<x>:X <val> Sets the marker frequency (in Hz)
<x> is the trace (A to D)

Examples:

Long format:
CALCULATE:MARKER:B:X 98500000 Marker B set to 98.5 MHz

Short format:

CALC:MARK:A:-X 1.2E09 Marker A set to 1.2 GHz
CALC:MARK:AOFF All markers disabled
CALC:MARK:C:OFF Only marker C disabled
CALC:MARK:MAXP Selected marker set to MaxPeak
CALC:MARK:NPE Selected marker set to NextPeak
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Measurements

Trace SENSe:TRACe:<x>:FETCh? <enum>
Reads the trace data in a definable format

<x> is the trace (A or B)
Valid entries for <enum>: ALL, MIN, MAX, FREQ, FMIN or FMAX.
Examples:

Long format:
SENSE:TRACE:A:FETCH? ALL All measured data requested

Short format:
SENS:TRAC:B:FETC? MAX Trace B (only MAX) requested

Format examples:

ALL: <min level>, <max level>, <freg>, <min level>, ...
MAX: <max level>, <max level>, ....
MIN: <min level>, <min level>, ....
FREQ: <freg>, <fregq>, ....
FMAX: <max level>, <freg>, <max level>, <freq>, <max
level>, ...
FMIN: <min level>, <freg>, <min level>, <freg>, <min
level>, ...

= | NOTE

One trace contains 500 samples.

Sweep  SENSe:SWEep:STATe <enum> Controls the sweep
Valid entries for <enum>: CONTinuous, SINGle or HOLD
Examples:

Long format:
SENSE :SWEEP:STATE SINGLE One sweep performed

Short format:
SENS:SWE:STAT CONT Repetitive sweeps started
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Max Peak

Next Peak

Marker level

Marker frequency

CALCulate:MARKer :MAXPeak
Examples:

Long format:
CALCULATE :MARKER :MAXPEAK

Short format:
CALC:MARK ::MAXP

NOTE

Chapter 17 Programming Examples
Command examples

Sets the marker to the maximum peak

Marker set to max. peak

Marker set to max. peak

A marker must be activated first using the following command:
CALC:MARKer :<x>[:STATE] {NORMal |DELTa|NOISe}.

CALCulate:MARKer :NPEak
Examples:

Long format:
CALCULATE:MARKER :NPEAK

Short format:
CALC:MARK:NPE

NOTE

Sets the marker to the next highest peak

Marker set to the next peak

Marker set to the next peak

A marker must be activated first using the following command:
CALC:MARKer:<x>[:STATE] {NORMal |DELTa|NOISe}.

CALCulate:MARKer :<x>:Y?Reads the level at the actual marker position

<x> selects the trace (A to D)
Examples:

Long format:
CALCULATE:MARKER:B:Y?

Short format:
CALC:MARK:A:Y?
CALCulate:MARKer:<x>:X?
<x> selects the trace (A to D)
Examples:

Long format:
CALCULATE:MARKER:B:X?

9102 Handheld Spectrum Analyzer

Marker B level requested

Marker A level requested

Reads the actual marker frequency

Marker B frequency requested
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Others

Identity

Reset

Error queue

Echo

Short format:
CALC:MARK:A:=X? Marker A frequency requested

*IDN? Reads serial number of the instrument

Format returned: "<Manufacturer>, <Model>, <Serial number>,
<Software version>"

Manufacturer:  Aeroflex
Model: 9102
Serial number: (seven digits)

Software version: 2.00 (for example)

*RST Resets the unit
Example:

*RST Unit set to idle state
SYST:ERR? Queries the error queue

Format returned: <Error number>, "<Error description>"

If no error is present, 0,"No Error" is returned.

NOTE

The error queue can hold up to 10 error messages. Read always
until the NO ERROR is given back.

SYST:COMM:ECHO <enum> Enables/disables echo function
Range: ON or OFF.
Example:

SYST:COMM:ECHO ON Echo feature activated

NOTE

We recommend to always activate the echo. It gives back "OK" after
a command was successfully executed or in case of errors "ERR".
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The additional advantage of this is to create a kind of handshake mech-

anism.

Local mode SYST:COMM: LOCAL Switches unit back to local mode
Example:
SYST:COMM: LOCAL Remote session finished
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Signal monitoring

348

The application examples below use three subroutines which transmit
a command (Output9100), read a result (Input9100) or send a
command and read the acknowledgement (OutAck9100). These
subroutines are not printed here but available from Aeroflex on
request. The program examples are written in BASIC.

Task: Permanently monitor a signal and check, if it is still present. The
signal frequency is 97.3 MHz and the signal strength is around -40
dBm.

OutAck9100 ("SENS:FREQ:CENT 97300000")' set the center to the
frequency
OutAck9100 ("SENS:FREQ:SPAN 2E06")' set span to 2 MHz

OutAck9100 ("SENS:REFL -30") ' set a sensitive ref level
OutAck9100 ("INP:ATT 10" ' set a low attenuation
OutAck9100 ("SENS:TRAC:A ACT") " activate an normal trace

OutAck9100 ("SENS:DET:FUNC POS") ' use only positive samples
OutAck9100 ("CALC:MARK:AOFF") " switch all markers off
OutAck9100 ("CALC:MARK:A NORM") ' activate marker A
SIG_FLAG = True

While SIG_FLAG = True
OutAck9100 ("SENS:SWE:STAT SING")' do one measurement

OutAck9100 ("CALC:MARK:A:X 97.3E06")' set marker to the signal

Output9100 ("CALC:MARK:A:Y?") ' read the signal level
Lvl = Valllnput91000)

If Lvl <-45 Then SIG_FLAG = False 'signal lost
Wend

Print "Signal disappeared!!!"
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Task: Search for transmitters within a frequency band. If a signal is
present and higher than a level of -80 dBm, the frequency is printed.

OutAck9100 ("SENS:FREQ:SPAN 2000000")" set span to 2 MHz
OutAck9100 ("SENS:FREQ:CENT 936000000"' start with channel O

OutAck9100 ("SENS:REFL -40") ' set a sensitive ref-level

OutAck9100 ("INP:ATT Q") ' remove any attenuation !!
OutAck9100 ("SENS:TRAC:A MAXH") ' activate a max hold trace
OutAck9100 ("SENS:DET:FUNC POS") ' use only positive samples

OutAck9100 ("CALC:MARK:AOFF") " switch all markers off

channel = 1

For 1 =9360 To 9594 Step 18 ' scan the gsm band in small por-
tions

Msg$ = "SENS:FREQ:CENT" & Str$() & "00000"
OutAck9100 (Msg$) ' set frequeny

ForJ=0To 4

OutAck9100 ("SENS:SWE:STAT SING")' do the measurements 5
times

Next J

Output9100 ("SENS:TRAC:A:FETC? MAX")

MXdata$ = Input91000 ' read trace data
ForJ=0 To 499 " isolate the data into an
array

P = InStr(MXdata$, ",") ' search for the COMMA between two
values

Yfeld()) = Val(Mid$(MXdata$, 1, P)

MXdata$ = Right$(MXdata$, Len(MXdata$) - P)
' remove the actual value

Next J

For J =45 To 445 Step 50

P=-120
ForK=0To 8 " do a maximum search
If YfeldUJ + K) > P Then
P = YfeldJ + K) ' store the new maximum
End If
Next K

If P> -80 And channel < 125 Then ' blocked channel found
Print "Channel " & Str$(channel) & "=" & Str$(P) & " dBm."

End If

channel = channel + 1
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Next J
Next |
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:CALCulate:{A|B|C|D|E|F}:MARKer:FSTep .................... 324
‘CALCulate:LIMit:FBEep ........ ... .. ... ... 326
:CALCulate:LIMit:FCOunt . ............ ... . . . . . . . . . ..., 326
:CALCulate:LIMit:FCOunt:COUNt? . ........................ 326
:CALCulate:LIMit:FHOLd . ....... ... ... ... . . .. . . . . .. .. ... . 327
:CALCulate:LIMit:SIMPle . .. ... ... .. . .. 327
:CALCulate:LIMit:SIMPle:LOWer . ........ . ... . ... ... ...... 327
:CALCulate:LIMit:SIMPle:UPPer .. ...... ... ... ... ... ....... 327
:CALCulate:LIMIt:STATel . ... .. ... . 325
:CALCulate:MARKer:{A|B|C|D|E|F}:DTFL.STATel ............... 322
:CALCulate:MARKer:{A|B|C|D|E|F}-TSELect . ................. 324
:CALCulate:MARKer:{A|B|C|D|E|F}:X:DISTance ............... 323
:CALCulate:MARKer:{A|B|CIDIE|F}:X:TIMe ................... 323
:CALCulate:MARKer:{A|B|C|D|E|F}:X[:FREQuency] ............. 323
:CALCulate:MARKer:{A|BICIDIE|F}:Y? .. ... 322
:CALCulate:MARKer:{A|B|C|DIE|F}L.STATel . .................. 321
:CALCulate:MARKer:AOFF . . ... .. ... . ... . . . . . . . . .. ..., 321
:CALCulate:MARKer:FCOunt:RESolution . ................... 325
:CALCulate:MARKer:FCOunt? . .......... ... ... ... .. ..... 325
:CALCulate:MARKer:MAXPeak ........... ... ... ... ...... 324
:CALCulate:MARKer:MCENter . ......... .. ... ... ... . ..... 324
:CALCulate:MARKer:MREFlevel ............................ 325
:CALCulate:MARKer:NPEak .......... .. ... . ... ... ... ..... 324
:CALCulate:MEASuUre:ACLOSS . ......... .. 328
:CALCulate:MEASure:ACPR ... ... . ... . . ... 328
:CALCulate:MEASure:CPOWer ......... ... . ... . ... 328
:CALCulate:MEASure:EMF . ... ... . ... ... .. ... 329
:CALCulate:MEASure:OBW ... ... ... ... .. . ... 328
:CALCulate:MEASure:PSENsor:FPOWer? . ................... 329
:CALCulate:MEASure:PSENsor:RPOWer? .. .................. 330
:CALCulate:MEASure:PSENsor[:ALLI? . ...................... 329
:DISPlay:BACKIlight:EXTern .. ............. .. ... ... .. ....... 319
:DISPlay:BACKIight:BATTeryl . . ... ... ... . 319
DISPlay:BEEP . .. ... . . . . . 320
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:DISPlay:COLor:GRATicule ............. .. .. ... ..., 321
:DISPlay:COLor:LIMits . ....... ... ... ... . . . 321
:DISPlay:COLor:TRACe:[AIBI . . ... ... 320
:DISPlay:COLor:TRACe:OFFSet ............................ 320
:DISPlay:TRACe:Y[.SCALel:DTF.RFACtor . .................... 319
:DISPlay: TRACe:Y[.SCALel.DTF:-VSWR . ..................... 319
:DISPlay:TRACe:Y[:SCALel:.LINear:VOLT . .................... 317
:DISPlay:TRACe:Y[.:SCALel:.LINear WATT .................... 317
:DISPlay:TRACe:Y[:SCALel:RFLection:RFACtor . .. ............. 318
:DISPlay:TRACe:Y[:SCALel:RFLection:RPOWer ............... 318
:DISPlay:TRACe:Y[:SCALel:RFLection:VSWR . ................ 318
:DISPlay: TRACe:Y[.SCALell:LOGarithmicl .................... 317
‘FORMat:ADELImiter . ........... .. ... . . . 330
:FORMat:RESolution . ....... ... ... ... .. . .. . . ... 330
‘HCOPyLIMMediatel ......... ... . ... ... .. ... . ... ... . ..... 258
ANPULAFACIOr ..o 299
INPut:ATTenuation ........ ... ... ... . . . . 298
INPut:ATTenuationtAUTO ... ... . ... . . . . . . . ... 298
ANPUt:CFACIOr .o 299
ANPut:EDEVice . ... .. . . e 299
ANPutiIMPedance ........ ... ... . . ... . . . . . 298
ANSTrument:EREFfreq .......... ... . ... .. .. .. .. ... ... ... 312
INSTrument:GENerator . .......... ... . .. . . . . ... ... ..., 312
INSTrument:GENerator:DISPlay . .......................... 313
INSTrument:GENerator:LEVel .. ....... ... ... ... ... ..... 312
INSTrument:GENeratorMODe . ............. ... ... ....... 313
ANSTrument:GPS . ... .. 313
INSTrument:GPS:ALTitude . ....... ... .. ... .. ... ... .. ..... 316
INSTrument:GPS:ALTitude:UNIT . ........ ... ... ... ....... 316
INSTrument:GPS:COORdinate:UNIT ....................... 316
ANSTrument:GPS:DATE . ... ... . 315
ANSTrument:GPS:HDOP ... ... .. . 316
ANSTrument:GPS:LATitude .......... .. ... ... ... ... ..... 314
INSTrument:GPS:LONGitude .......... ... ... ... . ....... 314
ANSTrument:GPS:QUALIty . ........ ... .. ... .. ... ... ....... 313
INSTrument:GPS:SATellites . ...... ... .. ... ... .. ... ...... 315
ANSTrument:GPS:SPEed . ........ ... . ... . ... . ... ... ... ... 314
ANSTrument:GPS:SPEed:UNIT . ... ... ... ... ... ... ....... 314
ANSTrument:GPS:TIMe . ... ... . ... 315
ANSTrument:GPS:TRACK ... ... .. . 315
INSTrument:SELect . ....... ... . .. . . . . . . . 311
‘MMEMory:DELete:AFACtor ........... ... ... . 310
‘MMEMory:DELete:AFACtor:ALL . ....... ... ... ... ....... 311
:MMEMory:DELete:CFACtor ........... ... ... .. ... ... ..... 311
:MMEMory:DELete:CFACtor:ALL ........................... 311
:MMEMory:DELete:CHANnNel .............................. 309
‘MMEMory:DELete:CHANnel:ALL .......................... 309
‘MMEMory:DELete:CTYPe ...... ... .. ... .. ... .. .. ... ...... 310
‘MMEMory:DELete:CTYPe:ALL ......... ... .. .. ... .. ....... 310
:MMEMory:DELete:EDEVice ... ........ ... ... .. ... ... . ... 309
:MMEMory:DELete:EDEVice:ALL . .......................... 310
‘MMEMory:DELete:LIMit .. ... ... .. ... .. ... ... ... 308
‘MMEMory:DELete:LIMitALL .............................. 309
‘MMEMory:DELete:STATe ...... ... ... .. ... 308
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‘MMEMory.DELete:STATe:ALL ...... ... ... ... ........... 308
‘MMEMory.DELete:TRACe ... ... ... . . 308
:MMEMory:DELete:TRACe:ALL ............ ... ... ........ 308
‘MMEMory:LOAD:AFACtor ........ ... ... . .. 307
‘MMEMory:LOAD:CFACtor ......... ... i 307
‘MMEMory:LOAD:CHANnNel ........ ... .. ... .. . ... ... ...... 306
‘MMEMory:LOAD:CTYPe . ... .. ... . . . . 307
‘MMEMory:.LOAD:EDEVice ............. ... ... .. 307
MMEMory:LOAD:LIMIt . ... ... . . 306
‘MMEMOory:LOAD:STATE . ... ... 306
‘MMEMory:LOADTRACE . ... ... i, 306
‘MMEMory:STORe:AFACIOr . ... ... . i, 303
‘MMEMory:STORe:CFACtor ......... ... .. .. ... .. 303
‘MMEMory:STORe:CHANnel ....... ... ... ... ... ........ 301
‘MMEMory:STORe:CTYPe . ...... .. ... .. . . . .. 302
:MMEMory:STORe:CTYPe:CALibration ...................... 302
‘MMEMory:STORe:EDEVice ........ ... ... ... ... .. ... ...... 301
‘MMEMory:STORe:LIMit . ..... ... .. ... .. ... . . ... ... ... ... 300
‘MMEMory:STORe:SSTATe . ... ... . 299
MMEMory: STORe:TRACe . ... ... ... .. .. . . .. 300
:MMEMory[:LOADI:FILelist: AFACtor? ....................... 305
‘MMEMory[:LOADIFiLelist:CFACtor? . ...................... 305
:MMEMory[:LOADI:FILelist:CHANnel? ...................... 304
‘MMEMory[:LOADIFiLelist:CTYPe? .. ... ... ... ... .. ......... 305
‘MMEMory[:LOADIFiLelist:EDEVice? ....................... 304
‘MMEMory[:LOADIFILelist:LIMit? . ........ ... ... ........... 304
:MMEMory[:LOADI:FILelist:STATe? .. ...... ... .. ... ... ...... 304
‘MMEMory[:LOADIFILelisttTRACeI? . ... .. .................. 303
REBOOt . ... 258
:SENSe:BANDwidth:RESolution .. ........ ... .. ............ 271
:SENSe:BANDwidth:RESolution:AUTo ... .................... 271
:SENSe:BANDwidth:VIDeo . ............ .. ... ... ... .. .... 271
:SENSe:BANDwidth:VIDeo:AUTO ......... ... ... ... . ..... 272
:SENSe:CLOSs:CALibration ............ .. ... ... ... . ..... 294
:SENSe:CLOSs:CALibration:ENABled . ...................... 295
SENSe:CLOSSFILTer . ... . i 294
SENSe:CLOSs:FILTer:AUTO . ....... ... ... ... .. ... 294
:SENSe:CLOSs:REFerence ............. .. ... . ... ... .. .... 294
SENSe:CPOWer:CHANnNel . ........... .. .. ... ... .. .. .. ... 275
SENSe:CPOWer:MEASUre . ... .. 275
SENSe:CPOWer:OBW . ... ... . 275
SENSe:CPOWer:SPAN . . .. ... . . . 275
SENSe:DEMod:DEMod . ...... ... ... . ... . . 278
:SENSe:DEMod:DURation ........... ... ... ... ... .. ..... 278
SENSe:DEMod:VOLume ........ ... ... . . . . . 278
:SENSe:DEMod[:MODulation] . ........ ... ... ... ... ..... 277
:SENSe:DETector:FUNCtion . ......... ... ... .. .. ... .. ..... 279
:SENSe:DTF:CALibration . ........... ... . . . ... . ... ... ..... 287
:SENSe:DTF:CALibration:ENABled . ........................ 287
SENSe:DTF:CLENgth . ... ... ... ... . . ... . . . .. . . ... ... 285
SENSe:DTF:CLENgth:UNIT . ........ ... .. ... ... ... .. ...... 286
:SENSe:DTF:REFerence ......... ... .. . . . . . . . . . ... . .. ... 286
:SENSe:DTF:REFerence:RFACtor .. ........ ... .. ... .. ..... 287
‘SENSe:DTF:REFerence:UNIT . ........ ... ... . ... ... ..... 286
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:SENSe:DTF:REFerence:VSWR . ... ... .. .. .. . . .. ... ... ..., 287
:SENSe:EDEVice:RFINput .............. ... ... .. ... ....... 297
:SENSe:EMF:ANTenna:DIRection . .......................... 289
SENSe:EMF:MEASuUre ....... ... .. . . . . . . 289
SENSe:EMF-MEASure:DISPlay . ............................ 290
SENSe:EMF:MEASure:LAST? . ... ... ... . . . 289
SENSe:EMF:MEASure:TIMe . ... .. . . . . . . ... 290
SENSe:EMF:REFerence ............. . . . . . . . . . . .. 288
:SENSe:EMF:REFerence:UNIT . ........ ... ... ... ... ....... 289
SENSe:FREQuency:CENTer ........... ... .. ... ... .. ....... 272
SENSe:FREQuency:FSTep ......... ... ... ... ... .. ... .. .... 274
SENSe:FREQuency:FSTep:AUTO . ........ ... . ... ... ..... 274
SENSe:FREQuency:MODE . ............ .. .. .. ... .. .. ..... 274
:SENSe:FREQuency:SPAN . ... ... ... ... .. ... . .. .. ... 272
:SENSe:FREQuency:SPAN:FULL ........................... 273
SENSe:FREQuency:STARt ......... ... ... ... ... ......... 273
:SENSe:FREQuency:STOP . ... ... .. ... .. . .. . 273
SENSe:FREQuency:STOP-MAX .. ... ... ... .. ... ... ....... 274
SENSe:MEASUIe . . ... 284
:SENSe:MEASure:ADJSettings . ........... ... ... . ... ..... 285
:SENSe:MEASure:CHANnNel:SPACing ....................... 285
:SENSe:MEASure:CHANnelWIDTh . ....... ... ... ... ..... 285
SENSe:MEASure:OBW . .. ... .. . . . 284
‘SENSe:PSENsor:FREQuency:CDMA . ....................... 297
:SENSe:PSENsor:FREQuency:CW . ....... ... .. ... ......... 296
:SENSe:PSENsor:FREQuency:DVBT . ........................ 297
:SENSe:PSENsor:FREQuency:GSM . ........................ 296
:SENSe:PSENsor:FREQuency:TETRa ... ..................... 296
:‘SENSe:PSENsor:FREQuency:UMTS ........................ 296
:SENSe:PSENsor:-MODe . .......... .. . . . . . 295
:SENSe:PSENsor:TYPe . ... ... . . .. . i 295
SENSe:REFLevel .. ... ... . .. . . . . 283
:SENSe:REFLevel:OFFSet ....... ... ... .. ... . ... ... ....... 284
SENSe:REFLevel:UNIT .. ... ... ... .. ... . . . . ... 283
:SENSe:RFLection:CALibration .. ............ ... ... ... ..... 292
:SENSe:RFLection:CALibration:ENABled .................... 293
:SENSe:RFLection:CALibration-MODe . . . .................... 293
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:SENSe:RFLection:REFerence:RPOWer . . .................... 291
:SENSe:RFLection:REFerence:UNIT . . ... ... .. ... ... ....... 291
:SENSe:RFLection:REFerence:VSWR ... ... ... ... ... ..... 291
:SENSe:RFLection:REFerencel:RETurnloss] . .................. 290
SENSe:STATe ... 284
SENSe:SWEep:STATe . . ... .. i 276
SENSe:SWEep:TIME . ... ... ... .. . . . . 276
SENSe:SWEep: TIME:AUTO ........ ... ... .. ... . ......... 276
SENSe:TRACe:A:FETCh? ... ... . . . . 280
SENSe:TRACe:ALSTATel . ... ... . . 279
SENSe:TRACe:AVGFactor ........... .. ... . . . ... 281
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SENSe:TRACe:BI:STATel . ... ... . .. . 280
SENSe:TRACe:CLEar .......... ... . . 281
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SENSe:TRACe:COPY . ... .. 281
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OPC . 260
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OPT 259
ROT 260
ORE 262
OB 263
WAL 260
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Predefined Settings

This appendix provides an overview on settings and parameters
predefined on the 9102 as well as in the 9100 Data Exchange Software
for your convenience. The topics discussed in this appendix are as
follows:

— “Predefined measurement settings” on page 358
— “Predefined channel power communication systems” on page 359
— “Predefined cable types” on page 363
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Predefined measurement settings

358

The 9102 provides the capability of storing all parameters for a partic-
ular measurement for reuse when repeating the measurement under
the same conditions. In the 9100 Data Exchange Software delivered
with your instrument a number of predefined settings for common
measurements are available. For details on working with these settings
refer to “Working with settings” on page 251.

The following table provides an overview on the settings available
within the 9100 Data Exchange Software. The names for the
predefined settings files have prefixes assigned to them indicating the
measurement modes used for performing the individual measure-
ments:

— SP for spectrum analysis mode
— CH for channel power mode

— SG for signal generator mode
— TR for transmission mode

— RFL for reflection mode

— DTF for distance to fault mode
— CL for cable loss mode

— EMF for EMF (EMD mode

Table 1 Predefined measurement settings

Name Meaning Frequency range

SP-UKW Ultra short wave 875 to 108 MHz

SP-DAB | Digital audio broadcast 223 to 230 MHz
band |

SP-DAB I Digital audio broadcast 1452 to 1479.5
band Il MHz

SP-VHF | Very high frequency TV 47 to 68 MHz
band |

SP-VHF llI Very high frequency TV 174 to 230 MHz
band Ill

SP-UHF IV Ultra high frequency TV 470 to 606 MHz
band IV

SP-UHF V Ultra high frequency TV 606 to 862 MHz
band V

SP-LNB SAT-ZF 950 to 2050 MHz

RFL-GSM900  GSM 900 frequency range 875 to 965 MHz

RFL- GSM 1800 frequency 1700 to 1890

GSM1800 range MHz

RFL-UMTS UMTS band | frequency 1890 to 2200
range MHz
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Predefined channel power communication systems

Preinstalled systems on

the 9102

Measurements in channel power mode imply that a communication
system with predefined channel numbers and associated frequencies
has been defined. The 9102 comes with a few systems preinstalled.
More systems are available for download to the 9102 in the 9100 Data
Exchange Software. The following two sections provide you with an
overview on the communication systems preinstalled on your 9102 as
well as on the systems available in the 9100 Data Exchange Software.

The following table lists all communication systems preinstalled as a
default on your 9102. For details on working with the preinstalled
systems refer to “Working with communication systems and frequency
settings” on page 87.

Table 2 Default preinstalled channel power systems

Channel .
System Meaning Frequency numbers Center frequencies Chz?nnel
name range P ) width
DECT 1880 to 1900 0to9 fo= 1897344 - 1728 kHz
MHz n*1.728
PGSM900- Primary 935 to 960 1to 124 fc=935+ 0.2"n 200 kHz
DL GSM Down-  MHz
link
RGSM900- Railways 921t0 960 MHz 955 to fc =935 + 0.2*(n- 200 kHz
DL GSM Down- 1023 1024)
link
PCN1800- GSM 1800 1805 to 1880 512 to fo=1805.2 + 0.2*(n- 200 kHz
DL Downlink MHz 885 512)
PCS1900- GSM 1900 1930 to 1990 512 to fc=1930.2 + 0.2*(n- 200 kHz
DL Downlink MHz 810 512)
WCDMA-DL  UTRA-FDD 2110 to 2170 10562to0 f.=n/5 5 MHz
Downlink MHz 10838
WCDMA-UL  UTRA-FDD 1920 to 1980 9612 to fc=n/5 5 MHz
Uplink MHz 0888
WLAN IEEE 2400 to 2484 1to 13 fo=2412 + (n-1)*5 22 MHz
802.11b,g MHz
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Predefined systems in  The following table lists all further communication systems available in
the 9100 Data Exchange the 9100 Data Exchange Software for download to the 9102. For
Software details on using these systems refer to “Managing communication
systems for channel power measurements” on page 245.

Table 3 9100 Data Exchange Software channel power systems

Frequenc Channel Center frequencies Channel
System name Meaning q y numbers a .
range P ) width

GSM450-UL GSM 450 450.4 to 259 to fc=450.6 + 0.2*(n - 200 kHz
Uplink 457.6 MHz 293 259)

GSM450-DL GSM 450 460.4 to 259 to fo=460.6 + 0.2*(n - 200 kHz
Downlink 467.6 MHz 293 259)

GSM480-UL GSM 480 478.8 to 468 306 to fc=479 + 0.2*(n - 200 kHz
Uplink MHz 340 306)

GSM480-DL GSM 480 488.8 to 496 306 to fc=489 + 0.2*(n - 200 kHz
Downlink MHz 340 306)

GSM850-UL GSM 850 824 t0 849 MHz 128 to fc=2824.2 + 0.2*(n - 200 kHz
Uplink 251 128)

GSM850-DL GSM 850 869 to 894 128 to fc=2869.2 + 0.2*(n - 200 kHz
Downlink MHz 251 128)

EGSM900-UL  Extended 880t0 915 MHz 975 to fc=2890 + 0.2*(n - 200 kHz
GSM 1023 1024)
Uplink

EGSM900-DL  Extended 925 to 960 MHz 975 to fc =935+ 0.2*(n - 200 kHz
GSM 1023 1024)
Downlink

PGSM900-UL  Primary 890t0 915 MHz 1to 124 fc=2890 + 0.2*n 200 kHz
GSM
Uplink

RGSM900-UL  Railways 876to 915 MHz 955 to fc=2890 + 0.2*(n - 200 kHz
GSM 1023 1024)
Uplink

PCN1800-UL  GSM 1800 1710 to 1785 512 to fc=1710.2 + 0.2* 200 kHz
Uplink MHz 885 (n -512)

PCS1900-UL GSM 1900 1850 to 1910 512 to fc=1850.2 + 0.2* 200 kHz
Uplink MHz 810 (n-512)

BLUETOOTH USA/ 2402 to 2480 Oto 78 fc=2402 +n 1 MHz
Europe MHz

USCELL-UL u.S. cellu- 824 t0 849 MHz 1 to 799 fc=2825+ 0.03*n 1.25 MHz
lar Uplink

USCELL-DL U.S. cellu- 869 to 894 1to 799 fc =870+ 0.03*n 1.25 MHz
lar Down- MHz
link
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Table 3 9100 Data Exchange Software channel power systems (Continued)

Frequenc Channel Center frequencies Channel
System name Meaning q y numbers a .
range P f) width

USPCS-UL North 1850 to 1910 Oto 1199 f.= 1850 + 0.05*n 1.25 MHz
America MHz
PCS Uplink

USPCS-DL North 1930 to 1990 Oto 1199 .= 1930 + 0.05™n 1.25 MHz
America MHz
PCS Down-
link

TACS-UL TACS 872t0 915 MHz Oto 1000 f. =889.9875 + 1.25 MHz
Uplink 0.025*n

TACS-DL TACS 917t0 960 MHz Oto 1000 f.=934.9875 + 1.25 MHz
Downlink 0.025*n

JTACS-UL JTACS 887 t0 925 MHz 1 to 799 fc=915 + 0.0125™n 1.25 MHz
Uplink

JTAGS-DL JTACS 832t0 870 MHz 1to 799 fc =860 + 0.0125™n 1.25 MHz
Downlink

KORPCS-UL Korean 1850 to 1780 0 to 599 fc= 1750 + 0.05*n 1.25 MHz
PCS Uplink  MHz

KORPCS-DL Korean 1840 to 1870 0 to 599 fo= 1840 + 0.05*n 1.25 MHz
PCS Down- MHz
link

NMT450-UL NMT-450 411 to 484 MHz 1 to 300 fc =450 + 0.025*(n - 1.25 MHz
Uplink 1

NMT450-DL NMT-450 421 to 494 MHz 1 to 300 fo =460 + 0.025*(n - 1.25 MHz
Downlink 1

IMT2000-UL IMT-2000 1920 to 1980 Oto 1199 .= 1920 + 0.05*n 1.25 MHz
Uplink MHz

IMT2000-DL IMT-2000 2110 to 2170 Oto 1199 f.=2110 + 0.05™n 1.25 MHz
Downlink MHz

CDMA700-UL CDMA 776 to 794 MHz 0O to 359 fc=776 + 0.05*n 1.25 MHz
700 MHz
Uplink

CDMA700-DL CDMA 746 to 764 MHz 0 to 359 fc=746 + 0.05"n 1.25 MHz
700 MHz
Downlink

CDMA1800- CDMA 1710 to 1785 Oto 1499 f.= 1710+ 0.05*n 1.25 MHz

uL 1800 MHz  MHz
Uplink

CDMA1800- CDMA 1805 to 1880 Oto 1499 f.= 1805 + 0.05"n 1.25 MHz

DL 1800 MHz  MHz
Downlink
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Table 3 9100 Data Exchange Software channel power systems (Continued)

Frequenc Channel Center frequencies Channel
System name Meaning q y numbers q .
range P ) width

CDMA900- CDMA 880to 915 MHz 0 to 699 fc=2880 + 0.05*n 1.25 MHz
uL 900 MHz

Uplink
CDMA900- CDMA 925 t0 960 MHz 0O to 699 fc =925+ 0.05"n 1.25 MHz
DL 900 MHz

Downlink
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Appendix B Predefined Settings
Predefined cable types

For DTF measurements in the distance to fault measurement mode
Aeroflex provides predefined cable types for most known coaxial
cables. These cable types are available in the 9100 Data Exchange
Software. You can upload the cable types you use frequently to the
9102. For further details on the usage of cable types in distance to fault
measurements refer to “Specifying cable settings” on page 166. For
information on managing cable types within the 9100 Data Exchange
Software refer to “Managing cable types for distance-to-fault measure-
ments” on page 246.

The following table provides an overview on all predefined cable types
implemented in the 9100 Data Exchange Software.

Table 4 9100 Data Exchange Software cable types

Velocit Attn.
Cable type Description Y B/ Dielec.
(Vf %)
100m)
ANAVA5-50 AVA5-507/8" 91.00 5.530 1.21
ANAVA7-50 AVA7-50 15/ 92.00 3.360 1.18
8”
ANEFX2-50 EFX2-50 85.00 17.800 1.38
ANFSJ 1- FSJ1-50A 84.00 28.500 1.42
50A
ANFSJ2-50 FSJ2-50 83.00 19.600 1.45
ANFSJ4- FSJ4-50B 81.00 17.600 1.52
50B
ANHJ12-50 HJ12-50 93.10 2.890 1.15
ANHJ45-50 HJ4.5-50 92.00 7.860 1.18
ANHJ4-50 HJ4-50 91.40 13.700 1.20
ANHJ5-50 HJ5-50 91.60 6.260 1.19
ANHJ7-50A  HJ7-50A 92.10 3.420 1.18
ANHL4RP- HL4RP-50 88.00 12.200 1.29
50
ANLDF12- LDF12-50 88.00 3.260 1.29
50
ANLDF1-50 LDF1-50 86.00 20.000 1.35
ANLDF2-50 LDF2-50 88.00 17.000 1.29
ANLDFA45- LDF4.5-50A 89.00 8.020 1.26
50A
ANLDF4- LDF4-50A 88.00 10.700 1.29
50A
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Table 4 9100 Data Exchange Software cable types (Continued)

N Velocity Attn. .
Cable type Description VF %) (dB/ Dielec.
100m)
ANLDF5- LDF5-50A 89.00 6.110 1.26
50A
ANLDF5- LDF5-50B 91.00 6.100 1.21
50B
ANLDF6-50  LDF6-50 89.00 4.430 1.26
ANLDF7- LDF7-50A 88.00 3.710 1.29
50A
ANVXL5-50  VXL5-50 88.00 6.590 1.29
ANVXL5- VXL5-50 7/8" 88.00 6.590 1.29
5078
ANVXL6-50 VXL6-50 88.00 4.830 1.29
ANVXL6-50 VXL6-50 1 1/ 88.00 4.830 1.29
4"
ANVXL7-50  VXL7-50 88.00 3.710 1.29
BERG10 RG10 65.90 26.201 2.30
BERG10A RG10A 65.90 26.201 2.30
BERG 142 RG142 65.90 44.300 2.30
BERG17 RG17 65.90 18.000 2.30
BERG174 RG174 65.90 98.400 2.30
BERG178B RG178B 65.90 150.900 2.30
BERG17A RG17A 65.90 18.000 2.30
BERG188 RG188 65.90 101.700 2.30
BERG213 RG213 65.90 29.200 2.30
BERG214 RG214 65.90 29.200 2.30
BERG223 RG223 65.90 53.500 230
BERG55 RG55 65.90 54100 2.30
BERG55A RG55A 65.90 54.100 2.30
BERG55B RG55B 65.90 54.100 2.30
BERG58 RG58 65.90 55.800 2.30
BERG58A RG58A 66.00 55.900 2.30
BERG58B RG58B 65.90 78.700 2.30
BERG58C RG58C 65.90 78.700 2.30
BERGS RG8 65.90 26.201 2.30
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Table 4 9100 Data Exchange Software cable types (Continued)

Velocit Attn,
Cable type Description Y @B/ Dielec.
(Vf %)
100m)

BERGSA RG8A 65.90 26.201 2.30
BERG9 RG9 65.90 28.900 2.30
BERG9A RG9A 65.90 28.900 2.30
CSCR50107 CR50 1070PE  88.00 5.510 1.29
0
CSCR50187 CR50 1873PE  88.00 3.440 1.29
3
CSCR50540 CR50 540PE 88.00 10.300 1.29
EUEC12-50 EC12-50 2-1/ 88.00 3.370 1.29

4
EUEC1-50 EC1-50 1/4 82.00 20.980 1.49
EUEC1-50- EC1-50-HF 1/ 83.00 26.890 1.45
HF 4
EUEC2-50 EC2-50 3/8 88.00 15.100 1.29
EUEC45-50 EC4.5-50 5/8 88.00 8.150 1.29
EUEC4-50 EC4-50 1/2 88.00 10.880 1.29
EUEC4-50- EC4-50-HF 1/ 82.00 16.080 1.49
HF 2
EUEC5-50 EC5-50 7/8 88.00 6.100 1.29
EUEC6-50 EC6-50 1-1/4  88.00 4510 1.29
EUEC7-50 EC7-50 1-5/8 88.00 3.810 1.29
NKRF114- RF 1 1/4"-50 88.00 4.290 1.29
50
NKRF158- RF 1 5/8"-50 88.00 3.630 1.29
50
NKRF12-50 RF 1/2"-50 88.00 10.700 1.29
NKRF214- RF 2 1/4"-50 88.00 3.220 1.29
50
NKRF38-50 RF 3/8"-50 86.00 16.200 1.35
NKRF58-50 RF 5/8"-50 88.00 7.460 1.29
NKRF78-50 RF 7/8"-50 88.00 5.850 1.29
NKRFE114- RFE 1 1/4"- 88.00 4.440 1.29
50 50
NKRFE 158- RFE 1 5/8"- 88.00 3.680 1.29
50 50
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Table 4 9100 Data Exchange Software cable types (Continued)

Velocit Attn.
Cable type Description Y @B/ Dielec.
(Vf %)
100m)
NKRFE78- RFE 7/8"-50 84.00 6.290 1.42
50
NKRFF12- RFF 1/2"-50 82.00 15.700 1.49
50
NKRFF 14- RFF 1/4"-50 83.00 27.200 1.45
50
NKRFF38- RFF 3/8"-50 81.00 20.900 1.52
50
RFHCA118- HCA118-50 92.00 4.550 118
50
RFHCA12- HCA12-50 93.00 11.100 116
50
RFHCA158- HCA158-50 95.00 2.890 1.1
50
RFHCA214-  HCA214-50 95.00 2.880 1.1
50
RFHCA300- HCA300-50 96.00 1.483 1.09
50
RFHCA318- HCA318-50 96.00 1.260 1.09
50
RFHCA38- HCA38-50 89.00 13.200 1.26
50
RFHCA418- HCA418-50 97.00 0.957 1.06
50
RFHCAS58- HCA58-50 92.00 8.180 118
50
RFHCA78- HCA78-50 93.00 5.750 116
50
RFHF4-18 HF 4-1/8" 97.00 1.000 1.06
Cu2y
RFHF5 HF 5" Cu2y 96.00 0.700 1.09
RFHF6-18 HF 6-1/8" 97.00 0.600 1.06
Cu2y
RFLCF12-50 LCF12-50 88.00 10.500 1.29
RFLCF14-50 LCF14-50 83.00 20.200 1.45
RFLCF158- LCF158-50A 89.00 3.640 1.26
50
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Table 4 9100 Data Exchange Software cable types (Continued)

N Velocity Attn. .
Cable type Description VF %) (dB/ Dielec.
100m)
RFLCF214- LCF214-50A 88.00 3.260 1.29
50
RFLCF38-50 LCF38-50 88.00 16.500 1.29
RFLCF58-50 LCF58-50 88.00 8.260 1.29
RFLCF78- LCF78-50A 89.00 5.820 1.26
50A
RFLCFS114 LCFS114-50A  89.00 4.420 1.26
RFSCF114- SCF114-50A 89.00 4.720 1.26
50
RFSCF12-50 SCF12-50 82.00 16.400 1.49
RFSCF14-50 SCF14-50 82.00 28.500 1.49
RFSCF38-50 SCF38-50 82.00 20.600 1.49
RFSCF78- SCF78-50A 88.00 6.160 1.29
50A
TMLMR 100 LMR100A 66.00 115.463 2.30
A
TMLMR120 LMR1200 88.00 6.532 1.29
0
TMLMR170 LMR1700 89.00 4.931 1.26
0
TMLMR 195 LMR195 80.00 55.443 1.56
TMLMR200 LMR200 83.00 49.249 1.45
TMLMR240 LMR240 84.00 37.684 1.42
TMLMR300 LMR300 85.00 30.325 1.38
TMLMR400 LMR400 85.00 19.646 1.38
TMLMR500 LMR500 86.00 15.876 1.35
TMLMR600 LMR600 87.00 12.789 1.32
TMLMRO00 LMRO00 87.00 8.645 1.32
310801 310801 8210 11.500 1.48
311201 311201 82.00 18.000 1.49
311501 311501 80.00 23,000 1.56
311601 311601 80,00 26.200 1.56
311901 311901 80.00 37.700 1.56
352001 352001 80.00 37.700 1.56
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Menu Structure

This appendix provides an overview of the menu structure of the 9102
Handheld Spectrum Analyzer.
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Warranty and Repair

This chapter describes the customer services available through Aero-
flex. Topics discussed in this chapter include the following:

— “Warranty information” on page 376
— “Equipment return instructions” on page 377
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Warranty information

376

Aeroflex warrants that all of its products conform to Aeroflex's
published specifications and are free from defects in materials and
workmanship for a period of one year from the date of delivery to the
original buyer, when used under normal operating conditions and
within the service conditions for which they were designed. This
warranty is not transferable and does not apply to used or demonstra-
tion products.

In case of a warranty claim, Aeroflex's obligation shall be limited to
repairing, or at its option, replacing without charge, any assembly or
component (except batteries) which in Aeroflex’s sole opinion proves
to be defective within the scope of the warranty. In the event Aeroflex
is not able to modify, repair or replace nonconforming defective parts
or components to a condition as warranted within a reasonable time
after receipt thereof, the buyer shall receive credit in the amount of the
original invoiced price of the product.

It is the buyer's responsibility to notify Aeroflex in writing of the defect
or nonconformity within the warranty period and to return the affected
product to Aeroflex’s factory, designated service provider, or autho-
rized service center within thirty (30) days after discovery of such
defect or nonconformity. The buyer shall prepay shipping charges and
insurance for products returned to Aeroflex or its designated service
provider for warranty service. Aeroflex or its designated service
provider shall pay costs for return of products to the buyer.

Aeroflex’s obligation and the customer’s sole remedy under this hard-
ware warranty is limited to the repair or replacement, at Aeroflex’s
option, of the defective product. Aeroflex shall have no obligation to
remedy any such defect if it can be shown: (a) that the product was
altered, repaired, or reworked by any party other than Aeroflex without
Aeroflex’s written consent; (b) that such defects were the result of
customer’s improper storage, mishandling, abuse, or misuse of the
product; (c) that such defects were the result of customer’s use of the
product in conjunction with equipment electronically or mechanically
incompatible or of an inferior quality; or (d) that the defect was the
result of damage by fire, explosion, power failure, or any act of nature.

The warranty described above is the buyer’s sole and exclusive remedy
and no other warranty, whether written or oral, expressed or implied by
statute or course of dealing shall apply. Aeroflex specifically disclaims
the implied warranties of merchantability and fitness for a particular
purpose. No statement, representation, agreement, or understanding,
oral or written, made by an agent, distributor, or employee of Aeroflex,
which is not contained in the foregoing warranty will be binding upon
Aeroflex, unless made in writing and executed by an authorized repre-
sentative of Aeroflex. Under no circumstances shall Aeroflex be liable
for any direct, indirect, special, incidental, or consequential damages,
expenses, or losses, including loss of profits, based on contract, tort, or
any other legal theory.

9102 Handheld Spectrum Analyzer  Software version 5.31



Appendix D Warranty and Repair
Equipment return instructions

Equipment return instructions

Please contact your local service center for Aeroflex products via tele-
phone or web site for return or reference authorization to accompany
your equipment. For each piece of equipment returned for repair,
attach a tag that includes the following information:

— Owner’'s name, address, and telephone number.
— Serial number, product type, and model.

— Warranty status. (If you are unsure of the warranty status of your
instrument, include a copy of the invoice or delivery note.)

— Detailed description of the problem or service requested.

— Name and telephone number of the person to contact regarding
questions about the repair.

— Return authorization (RA) number or reference number.

If possible, return the equipment using the original shipping container
and material. Additional Aeroflex shipping containers are available
from Aeroflex on request. If the original container is not available, the
unit should be carefully packed so that it will not be damaged in transit.
Aeroflex is not liable for any damage that may occur during shipping.
The customer should clearly mark the Aeroflex-issued RA or reference
number on the outside of the package and ship it prepaid and insured
to Aeroflex.
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Software License

This chapter contains the license conditions for use of the 9102 Hand-
held Spectrum Analyzer and the 9100 Data Exchange Software.
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End-user license agreement

380

All copyrights in and to the software product are owned by Aeroflex
Communications or its licensors. The software is protected by copy-
right laws and international copyright treaties, as well as other intellec-
tual property laws and treaties.

This end-user license agreement grants you the right to use the soft-
ware contained in this product subject to the following restrictions. You
may not:

(i) use the software and/or any copy of the software in different
computers concurrently, unless the software is an update that has
been downloaded from the Internet at aeroflex.com;

(i) copy the software, except for archive purposes consistent with
your standard archive procedures;

(iii) transfer the software to a third party apart from the entire
product;

(iv) modify, decompile, disassemble, reverse engineer or otherwise
attempt to derive the source code of the software;

(v) export the software in contravention of applicable export laws
and regulations of the country of purchase;

(vi) use the software other than in connection with operation of the
product.

The licensor's suppliers do not make or pass on to end users or any
other third party, any express, implied or statutory warranty or repre-
sentation on behalf of such suppliers, including but not limited to the
implied warranties of noninfringement, title, merchantability or fitness
for a particular purpose.

Aeroflex shall not be held liable for any damages suffered or incurred
by you or any other third party (including, but not limited to, general,
special, consequential or incidental damages including damages for
loss of business profits, business interruption, loss of business informa-
tion and the like), arising out of or in connection with the delivery, use
or performance of the software.
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Numerics
9100 Data Exchange Software 223 - 255
connecting PC and the instrument 226
copying configuration files 255
creating screen shots 235
defining antenna factor files 249
defining cable factor files 250
defining cable types for DTF measurements 247
directory structure 252
external coupling factor definition 244
external device compensation 243
file management 252
File Manager 253
file types 252
license information 379
limit templates 239
loading a trace file on the PC 231
loading antenna factor files 249
loading cable factor files 251
loading external coupling loss files 244
loading measurement results from the instrument 227
managin cable factors for EMF measurements 250
managing antenna factors for EMF measurements 248
managing cable types for DTF measurements 246
managing communication systems 245
predefined cable types 363
predefined channel power communication systems 360
printing results 231
saving results on the PC 231
transferring cable types from the 9102 247
uploading predefined cable types for DTF measurements 246
working with measurement results 236
working with settings 251
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A

Accessories s

ACPR see also Adjacent channel power ratio
Actual trace mode 68, 94, 129, 154

Adjacent channel power ratio 75

Application examples 357

Attenuation 60, 91, 123, 203

Average trace mode 68, 94, 129, 154

B

Backspace key 25
Battery status 17
Biconical antennas 189

C
Cable loss mode 173 - 180
changing the vertical scale 179
full span 177
level settings 179
reference level 179
selecting step size for frequency input 177
viewing parameters 180
Cable settings 166
Cable types 166
Calibration for VSWR/DTF measurements 142
Calibration information 42
Calibration Information menu 43
Calibration sets 142
Cent function key 23
Center frequency 57, 111, 120, 147, 167, 176, 199, 202
Channel power 75
level settings 90
Channel power measurements
managing communication systems 245
Channel power modesi - 101
adding trace B to trace A o7
changing the occupied bandwidth g7
changing the sweep time 90
compensating gains and losses 92
copying traces 98
deleting traces 100
external device compensation 92
reading the channel power g7
reference level 91
selecting the trace mode 94
setting up the trace 94
storing and loading traces 99
subtracting trace B from trace A 9
trace detectors 97
traces 94
turning the second trace on and off 96
viewing parameters 101
working with communication systems g7
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CIr Trc function key 23
Communication systems 87 - 90

usage in channel power mode g7
Connecting the VSWR/DTF Bridge 140
Connectors 14
Copying traces 72, 98, 132, 157
Cursor keys 24

D
Date and time settings
adjustment 46
DC in connector 14
Deleting traces 74, 100, 135, 159
Device name
assigning a device name to the instrument 45
Direct printing 38
Directional antennas 193
Display
changing the brightness 44
horizontal axis 19
icons 19
input field 22
Marker field 21
sections 18
selecting the user interface colors 50
softkey descriptions 22
trace finder 21
vertical axis 19
Display brightness 44
Distance to fault mode 163 - 172
calibration 168
changing the vertical scale 170
preparational steps 165
reference level 170
selecting the unit 165
setting up the trace 171
specifying cable settings 166
specifying the cable length 166
traces 171
using predefined cable types 166
viewing parameters 171, 171

E

EMF (EMD mode 181 - 211
antenna factor settings 204, 208
Auto measurements 205
automatic measurements 203
cable factor settings 204, 208
display calculation 202
full span 200
manual measurements 207
Quick measurements 207
reference level 202
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selecting step size for frequency input 200
setting the attenuation 203
setting up the trace 210
traces 210

EMF measurement antennas 1ss

EMF measurement methods 185
multipoint method 187
stirring method 187

Emission measurements 184

Enter keys
Enter 25
GHz/dBM 25
kHz/dBuV/m 25
MHz/dB/ps 25

Entering numbers and text 27

Errors see also Troubleshooting

Escape key 25

External device compensation 61, 92, 124
defining and saving parameter files 243
external coupling factor definition 244

F
Factory settings
restoring defaults for all modes 54
File Manager 253
Frequency
center frequency 57, 111, 120, 147, 167, 176, 199, 202
Span 57, 120, 147, 167, 176, 199, 202
Start and stop 57, 112, 119, 146, 176, 199
Frequency menu
cable loss 175
distance to fault 169
EMF (EMD 198, 204, 205
reflection 146, 149
spectrum analysis 56
transmission 119
Frequency range s6
Frequency settings 56, 110
Frequency step size 58, 112, 121, 148, 177, 200
Front panel 17 - 29
entering numbers and text 27
function keys 22
keypad 22
usage 17
Full span 58, 121, 148, 177, 200
Function keys
Cent23
Clr Trc 23
Hold/Run 23
Mkr 24
Mode 23
Param 23
Preset 23
RCL/Store 23
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Span 23
Function softkeys 26

G
Gains and losses
compensation 61, 92, 124
General settings 41-51
calibration information 42
date and time 46
device name 45
display brightness 44
instrument IP address 47
instrument IP port 49
options 43
PC IP address 48
RS-232 port baud rate 46
serial number 41
software version number 42
user interface colors 50
warning and error beeps 45
General Settings menu 46
GHz/dBM enter key 25

H

Handling errors and problems see also Troubleshooting

Hardware attenuation 60, 91, 123, 203
Hold trace mode 68, 94, 129, 154
Hold/Run function key 23

|
Icons 19
Immission measurements 184
In 170
Input
acoustical reaction 28
numbers and text 27
Input field 18, 22
Installing options 44
IP address configuration 47, 48
IP port 49
Isotropic antennas 191

K

Keypad 22

Keys
Backspace key 25
cursor keys 24
enter keys 25
Escape key 25
function keys 22
numeric keys 24
Print key 25
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softkeys 25
kHz/dBpuV/m enter key 25

L
LAN connector 16
Level 113
selecting unit for input and output 61, 92
Level settings 60, 90, 122, 151, 179
Limit lines
usage 34
Limit templates 37, 239
changing limit lines 241
defining limits 240
loading a template 242
storing a template 241
transfer 242

M

Marker field 18, 21

Markers 31 - 34
disabling a marker 32
enabling a delta marker 32
enabling and moving a marker 31
working with 31 - 34

Max hold trace mode 68, 94, 129, 154

Measurement mode selection 29, 85, 110, 116, 145, 165, 174, 197

Measurement type 77

Menu softkeys 26

Menu structure 369
application menus 371
Mode function key menus 370

Menus
Cable loss Frequency Menu 175
Calibration Information 43
Distance to fault Frequency Menu 169
EMF (EMD Frequency Menu 198, 204, 205
General Settings 46
Mode 30
Reflection Frequency Menu 146, 149
Setup Application Software Menu 218
Spectrum Analysis Frequency menu ss
System Information 42
TCP/IP Configuration 50
Trace Function menu 72,73, 79, 133
Transmission Frequency Menu 119
Trigger menu 64, 65, 125, 126
VSWR/Tracking menu 139

MHz/dB/us enter key 25

Min hold trace mode 68,94, 129, 154

Mkr function key 24

Mode function key 23

Mode menu 30

Mode selection 29, 85, 110, 116, 145, 165, 174, 197
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Modes
cable loss 139,173
channel power g1
distance to fault 139, 163
EMF (EMI) 181
reflection 139, 143
restoring factory settings for all modes 54
signal generator 109
spectrum analysis 55, 55
transmission 115

N

Normalizing 117
Numeric keys 24

0]
OBW see also Occupied bandwidth
Occupied bandwidth 75
Options 5,43
installing a new option 44

P
Param function key 23
Power switch 17
Predefined settings
cable types 363
channel power communcation systems 359
measurement settings 358
Preset function key 23
Print key 25
Printer configuration 50
Printing screens 3s

R
Radiation emission 183
Radiation immission 183
RBW see also Resolution bandwidth
RCL/Store function key 23
Ref function key 24
Reference level 60, 91, 123, 151, 151, 152, 152, 170, 179, 202
Reflection mode 143 - 161
changing the vertical scale 151, 151, 152, 152
copying traces 157
deleting traces 159
full span 148
level settings 151
reference level 151, 151, 152, 152
selecting step size for frequency input 148
selecting the trace mode 154
setting up the trace 154
storing and loading traces 158
subtracting trace B from trace A 156
traces 154
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turning the second trace on and off 156
viewing parameters 160

Resolution bandwidth s9, 201

Restoring factory settings 54

Results area 1s

RF in connector 14

RF out connector 15

RS-232 configuration 46

S
Safety warnings xx
Scale 61, 92, 124, 151, 151, 152, 152, 170, 179
SCPI commands 257 - 337
application examples 34s
Calculate 321
Display 317
Format 330
general 258
Input 298
Instrument 311
MMemory 299
programming examples 339
Sense 271
Service 331
System 264
SCPI error messages 334
Selecting modes
cable loss 174
channel power 85
distance to fault 165
EMF (EMI) 197
reflection 145
signal generator 110
transmission 116
Selecting the measurement type 77
Serial (RS-232) connector 16
Serial number 41
Settings
storing 52
working with stored settings s2
Setup Application Software Menu 218
Signal generator 110
Signal generator mode 109 - 113
frequency settings 110
level 113
selecting step size for frequency input 112
selecting the frequency mode 110
special functions 113
switching the signal generator on and off 110
Softkey descriptions 18, 22
Softkeys
horizontal (menu) softkeys 26
vertical (function) softkeys 26
Software license 379 - 380
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Software update 217 - 222
LAN 221
serial 219
setting a password for updates 218
Software version number 42
Span 57, 120, 147, 167, 176, 199, 202
Span function key 23
Special functions
demodulating AM or FM signals es

limiting the number of measurements 66, 113, 127, 154, 180
Special spectrum analysis measurement functions 7s - 77

adjacent channel power ratio 75
channel power 75
occupied bandwidth 75

switching special measurement functions off 77

Spectrum analysis 55

Spectrum analysis modess - 79
adding trace B to trace A 70
changing the vertical scale 61, 92
compensating gains and losses 61
copying traces 72

Index

defining the number of measurements for averaging 71, 97,97, 131, 157

deleting traces 74
external device compensation 61
frequency range s6
frequency settings 56
full spanss
level settings 60
reference level 6o, 123
selecting step size for frequency input 58
selecting the trace mode 68
setting the attenuation 6o, 91
setting up the trace 67
special functions 64
storing and loading traces 73
subtracting trace B from trace A 69
trace detector 71
traces 67
turning the second trace on and off 69
viewing parameters 79
Storing and loading traces 73, 99, 134, 158
Storing settings s2
Sweep time 59, 201
Switching special measurement functions off 77
Switching the instrument on 17
SWT see also Sweep time
Symbols 19
System Information Menu 42

T
TCP/IP configuration 47, 48, 49
TCP/IP Configuration menu 50
The 171

Trace finder 21
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Trace Function Menu 72,73, 79, 133
Trace modes
Actual 68, 94, 129, 154
Average 68,94, 129, 154
Hold 68, 94, 129, 154
Max hold 68, 94, 129, 154
Min hold 68, 94, 129, 154
Traces
adding trace B to trace A 70,97
copying traces 72,98, 132, 157
defining the number of measurements for averaging 71, 97,97, 131, 157
deleting traces 74, 100, 135, 159
selecting the detection method 71, 97, 97, 132
storing and loading traces 73,99, 134, 158
subtracting trace B from trace A 69, 96, 130, 156
trace detectors 71,97, 97,132
turning the second trace on and off 69, 96, 130, 156
Tracking generator 117
setting the output power 118
Transmission mode 115 - 136
changing the vertical scale 124
compensating gains and losses 124
copying traces 132
deleting traces 135
external device compensation 124
full span 121
level settings 122
normalizing 117
selecting step size for frequency input 121
selecting the trace mode 129
setting the attenuation 123
setting the tracking output power 118
setting up the trace 127
special functions 125
storing and loading traces 134
subtracting trace B from trace A 130
switching the tracking generator on and off 117
trace detector 132
traces 127
turning the second trace on and off 130
viewing parameters 136
Trigger menu 64, 65, 125, 126
Triggering
external trigger 65, 126
video trigger 64, 125
Troubleshooting 213 - 215

\"%

VBW see also Video bandwidth

Vertical scale 61,92, 124, 151, 151, 152, 152, 170, 179
Video bandwidth 59, 201

Video Trigger 64, 125

Viewing parameters 79, 101, 136, 160, 171, 180
VSWR/DTF Bridge 140
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VSWR/DTF Reflection Measurement Option 137 - 142

W
Warranty information 375
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